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Preface

This guide describes how to administer the Oracle Fusion Applications environment,
including how to start and stop components, change ports and passwords, manage the
Oracle Database, monitor the environment, logging, back up and recover, configure
high availability, move components across environments, and troubleshoot runtime
issues.

This document is intended for administrators of the Oracle Fusion Applications
environment. The Oracle Fusion Applications administrator performs tasks to manage
the Oracle Fusion Applications environment. These tasks are performed to the Oracle
Fusion applications, Oracle Fusion Middleware components, and the Oracle Database.

Documentation Accessibility
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Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
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hearing impaired.
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Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

UNIX is used as a generic reference to all UNIX-based platforms. Where information
for a particular UNIX platform is different, this is noted in the text.
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What's New in This Guide

This preface introduces the new and changed administrative features of Oracle Fusion
Applications that are described in this guide, and provides pointers to additional
information.

New and Changed Features for Release 11.1.4

For Release 1 (11.1.4), this guide has been updated in several ways. The following table
lists the chapters or sections that have been added or changed.

Chapter/Section Change Description

Chapter 3, "Performing Routine Administrative Tasks"

Section 3.3.3, "Starting and Stopping the Entire Oracle Revised these sections to add
Fusion Applications Environment" support for starting and stopping
Managed Servers with the
fastartstop utility using the
-domains option with the server

Section 3.3.2.1, "fastartstop Syntax"

suboption.

Section 3.3.2.2, "fastartstop Examples” Added this section to provide
common start, stop, and restart
examples.

Chapter 13, "Managing Oracle Fusion Applications Log

Files and Diagnostic Tests"

Section 13.7.5, "Using Profile Options to Configure Modified this section to correct

Standard Log Settings" detailed instructions for configuring
log profile settings.

Section 13.10.1.2, "Using the diagctl Command Line Modified this section to add a

Interface to Run Diagnostic Tests" command to set the
DIAGIPSCONFIGFILE environment
variable.

Chapter 14, "Troubleshooting Oracle Fusion
Applications Using Incidents, Logs, QuickTrace, and
Diagnostic Tests"

Section 14.2.9, "Adjusting ApplSession Log Levels for Added this section to describe how

Troubleshooting" to adjust the amount of information
logged by the ApplSession
component and how to view the
results.

Chapter 17, "Moving Components for Oracle Fusion
Applications Across Environments"
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Chapter/Section Change Description

Section 17.1 through Section 17.3 Introductory material was rewritten
and restructured for greater clarity.

Section 17.4, "Moving the Transaction Database Schemas Added section to clarify full process
and Seed Data" of creating transaction database in
target environment.

Section 17.5.4, "Moving Oracle Access Manager Revised section to explain Webgate

Artifacts” movement is performed
automatically as part of the Oracle
Middleware home binary file
movement. Subsequent references
to Webgate movement in the
chapter were also updated to reflect
the automation.

Section 17.5, "Moving the Oracle Identity Management = Added information on how to

Domain Component Artifacts” upgrade a non-Fusion Applications
edition of Oracle Identity
Management to work with Oracle
Fusion Applications.

Section 17.7.2, "Setting the JVM System Variable on Added this section to prevent
Windows" pasteConfig errors due to
insufficient memory space.

Section 17.7.7.5, "Moving Oracle WebCenter Portal Data  Added this section to enable

for Discussions (Optional)" moving transaction data for the
Discussions feature, if Discussions
were used in the source
environment.

Section 17.8, "Moving Binary and Configuration Files to =~ Commands edited throughout for
a Non-Distributed Target Environment" greater accuracy.

New and Changed Features for Release 11.1.3

For Release 1 (11.1.3), this guide was updated in several ways. The following table lists
the chapters or sections that were added or changed.

Chapter/Section Change Description

Chapter 2, "Getting Started with Administering Oracle
Fusion Applications"

Section 2.7.1, "Starting Cloud Control and Discovering Revised this section to include
Oracle Fusion Applications Targets" information on enabling business
metrics in Cloud Control.

Chapter 3, "Performing Routine Administrative Tasks"

Section 3.3, "Starting and Stopping" Revised this section to clarify
starting and stopping Node
Manager, Administration Servers,
and Managed Servers.

Section 3.8, "Managing Oracle Fusion Added this section to describe how

Applications-Specific Labels in the Oracle Metadata to manage labels for Oracle Fusion

Repository” Applications in the Oracle Metadata
Repository.

XXiv



Chapter/Section

Change Description

Section 3.9, "Modifying Oracle Application Development
Framework Connections in Oracle Fusion Applications"

Added this section to describe how
to modify the connections for all the
applications in an Oracle WebLogic
Server domain using Fusion
Applications Control.

Chapter 5, "Managing Oracle Enterprise Scheduler
Service and Jobs"

Removed redundant information
already captured in the Oracle
Fusion Middleware Administrator’s
Guide for Oracle Enterprise Scheduler.

Chapter 10, "Monitoring the Oracle Fusion
Applications Middle Tier"

Modified this chapter to reflect
performing procedures through
Cloud Control

Section 10.5.2, "Creating Monitoring Templates”

Removed metric tables already
present in the Oracle Fusion
Applications Performance and Tuning
Guide.

Chapter 11, "Diagnosing the Oracle Fusion
Applications Middle Tier Performance"

Modified this chapter to reflect
performing procedures through
Cloud Control

Chapter 13, "Managing Oracle Fusion Applications Log
Files and Diagnostic Tests"

Section 13.6.2, "Searching for Specific Information in Log
Files within a Single Domain"

Revised section to add details about
selected targets within product
families or clusters, available search
operators, and use of wildcard
characters.

Section 13.6.3, "Searching for Specific Information in Log
Files Across Multiple Domains"

Added this section to describe how
to use Cloud Control to search log
files in multiple domains within a
single Fusion instance.

Section 13.10.1.1, "Using the Diagnostic Dashboard to
Run Diagnostic Tests"

Revised section to correct detailed
instructions on how to supply input
parameters in the Diagnostic
Dashboard.

Section 13.10.1.2, "Using the diagctl Command Line
Interface to Run Diagnostic Tests"

Revised this section to add
instructions for setting two
environment variables that the
diagctl command line interface
requires.

Section 13.10.2, "Searching for Diagnostic Tests by Name,
Categorization Tag, or Module"

Revised this section to clarify the
available ways to search for
diagnostic tests that have specific
characteristics.

Section 13.10.4, "Providing Input Parameters for
Diagnostic Tests"

Revised this section to add
information about the message that
the Diagnostic Dashboard displays
when all required inputs for a
diagnostic test have been supplied.

Section 13.10.7.2, "Using the diagctl Command Line
Interface to Check the Status of a Diagnostic Test"

Revised this section to clarify the
location of the diagctl command
line interface in UNIX and
Windows environments.
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Chapter/Section Change Description

Section 13.10.9.2, "Using the diagctl Command Line Revised this section to clarify the

Interface to View the Results of Diagnostic Tests" location of the diagctl command
line interface in UNIX and
Windows environments.

Section 13.10.10, "Identifying Diagnostic Test Launch Revised this section to clarify the

Methods from Test Run Names" circumstances in which it may be
useful to know test run naming
conventions.

Chapter 14, "Troubleshooting Oracle Fusion
Applications Using Incidents, Logs, QuickTrace, and
Diagnostic Tests"

Section 14.4.1.1, "Process for Investigating, Reporting, Revised this section to clarify how

and Solving a Problem Using Cloud Control" to work with diagnostic tests during
the troubleshooting process in an
environment that includes Cloud

Control.
Section 14.4.2.1, "Viewing Incidents Using Support Revised this section to add
Workbench" information about locating and

using the Support Workbench
rollup page to work with problems
and incidents.

Section 14.4.2.2, "Viewing Incidents Using the Automatic Revised this section to clarify the

Diagnostic Repository Command Interpreter (adrci)" location of the Automatic
Diagnostic Repository Command
Interpreter (adrci).

Section 14.4.2.4, "Creating Incidents Manually Using Added this section to describe how

Support Workbench" to create incidents manually in an
environment that includes Cloud
Control.

Section 14.4.2.5, "Packaging Incidents Using Support Added this section to describe how

Workbench" to package incidents for transmittal

to Oracle Support in an
environment that includes Cloud

Control.
Section 14.4.2.6, "Creating and Packaging Incidents Revised this section to clarify when
Using the Automatic Diagnostic Repository Command  to use adrci to create and package
Interpreter (adrci)” incidents, rather than using Support
Workbench to do so.

Section 14.4.5, "Working with Other Diagnostic Dumps" Revised this section to clarify the
behavior of incidents generated
from SOA code.

Chapter 17, "Moving Components for Oracle Fusion Updated this chapter with inclusion

Applications Across Environments" of automated scripts, streamlining
the movement process, especially
for non-distributed environments.
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Part |

Understanding Oracle Fusion Applications

This part provides an overview to Oracle Fusion Applications and its concepts as they
relate to administering Oracle Fusion Applications.

Part I contains the following chapters:

»  Chapter 1, "Introduction to Oracle Fusion Applications for Systems
Administrators”
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Introduction to Oracle Fusion Applications
for Systems Administrators

Oracle Fusion Applications is Oracle's next-generation applications suite built on a
service-oriented platform. It brings together next-generation enterprise technologies,
applications, and services, including Oracle Fusion Applications and Oracle Fusion
Middleware, to fundamentally change the dynamics in the applications marketplace
and revolutionize business. This chapter provides an introduction to the architecture,
components, and concepts of Oracle Fusion Applications.

This chapter contains the following topics:
= Architecture of Oracle Fusion Applications
s Key Oracle Fusion Applications Concepts

s Roadmap for Administering Oracle Fusion Applications

1.1 Architecture of Oracle Fusion Applications

Oracle Fusion applications are built on the Oracle Fusion Middleware stack and utilize
the Oracle Database. This architecture is depicted in Figure 1-1.
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Figure 1-1 Oracle Fusion Applications Architecture
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The section contains the following topics

»  Oracle Fusion Applications Product Families

= Oracle Fusion Middleware Infrastructure Components
s Oracle Fusion Middleware Components

s Oracle Database

s Oracle Enterprise Manager Fusion Applications Control

s Oracle Enterprise Manager Cloud Control
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= Oracle Enterprise Manager Database Control

1.1.1 Oracle Fusion Applications Product Families

An installation of Oracle Fusion Applications is logically broken up into groups of
features known as product offerings, which represent the highest-level collection of
functionality that you can license and implement. A provisioning configuration is a
collection of one or more product offerings. During installation, you select a product
offering or a combination of offerings as a way to install the product families. Product
families are comprised of one or more Java EE applications specific to Oracle Fusion
Applications.

An application can contain multiple products, and a product can also span multiple
applications. A product typically has a one-to-one correspondence with an EAR file.
Figure 1-2 shows two applications, PayablesApp and ReceivablesApp, each of which
is mapped to the same product, Payments.

Figure 1-2 Relationship of Products and Applications

Products Oracle Fusion
Assets L Applications
Cash Managsament 1
Expenses —_._ FayablesApp
Payables f
Payments —_
Advanced Collections ———H ReceivablesApp
Receivables e

Oracle Fusion Applications includes the product families described in Table 1-1.

Table 1-1 Product Families

Oracle Fusion
Applications Product
Families Description

Oracle Fusion Customer Manages customers, contacts, and resources, including data
Relationship Management quality configuration.

Oracle Fusion Financials Manages financial flows, including assets, ledgers, cash cycle,
invoices and payments, accounts receivable, collections, and
setup of subledger accounting and tax configuration.
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Table 1-1 (Cont.) Product Families

Oracle Fusion
Applications Product
Families

Description

Oracle Fusion Governance,
Risk, and Compliance

Provides critical business controls to manage risk,
multi-regulatory compliance, and controls enforcement. The
connector for Oracle Fusion Applications provides a prebuilt
solution for managing Separation of Duties (SoD) within and
across product families. You can also utilize Oracle Fusion
Governance, Risk, and Compliance to analyze suspect
transactions and configuration settings based on user defined
conditions. This allows organizations to actively determine the
risk that exists within their application that can materially
impact the reliability of the information that exists for reporting
and decision making purposes. Finally, Oracle Fusion
Governance, Risk, and Compliance can apply preventive
controls that will limit what a user can see and do within an
Oracle Fusion Applications user interface according to
user-defined conditions. The objective is to pro-actively mitigate
the risk of extraneous access or improper transactions from
existing.

Oracle Fusion Human
Capital Management

Provides employee management for an organization.

Oracle Fusion Procurement

Manages the procurement process including requisitions,
purchase orders, and supplier negotiations.

Oracle Fusion Project

Manages projects, including how to plan, budget, forecast,
collect costs, bill customers, and report performance.

Oracle Fusion Supply Chain
Management

Integrates and automates all key supply chain processes, from
design, planning and procurement to manufacturing and
fulfillment, providing a complete solution set to enable
companies to power information-driven value chains.

Oracle Fusion Setup

Supports the other product families.

In addition to Oracle Fusion Functional Setup Manager for
setting up functional data, this product family includes
applications to assist application users:

s The Oracle Fusion Home page provides a Welcome
dashboard with a collection of portlets and task flows for
answering common questions.

s Oracle Fusion Applications Help delivers content users
need to complete their tasks. You can optionally install a
local version of Oracle Fusion Applications Help, enabling
you to extend and customize the help. For more information
about using and customizing a local install of the help, see
the Oracle Fusion Applications Installation Guide and the
Oracle Fusion Applications Common Implementation Guide.

To aid with performing current-state analysis of the applications, you can use Oracle
Transactional Business Intelligence, which is built on Oracle BI Enterprise Edition. For
more information about configuring Oracle Transactional Business Intelligence, see the
Oracle Fusion Administrator’s Guide for Transactional Business Intelligence.

1.1.2 Oracle Fusion Middleware Infrastructure Components

The product families use the following common core framework and infrastructure for
Oracle Fusion Applications described in Table 1-2.
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Table 1-2  Oracle Fusion Middleware Infrastructure Components

Oracle Fusion Middleware
Infrastructure
Components Description

Oracle Fusion Middleware = Provides design time and runtime infrastructure to help

Extensions for Applications standardize complex development patterns for Oracle Fusion

(Applications Core) Applications. It simplifies the development process of these
patterns and provides a consistent user experience. Examples of
these patterns include extensibility (Flexfields), hierarchical
relationships (Trees), data security, and Ul patterns. Applications
Core creates simplified methods of implementing these complex
requirements by providing robust metadata and comprehensive
UI components and services. All of the Applications Core
components have been intricately integrated with the rest of the
Oracle Fusion Middleware infrastructure so they are available
across every layer of the Oracle Fusion Applications platform.

Applications Core provides shared libraries referenced by all the
Oracle Fusion Applications, a standalone application for
application setup and configuration, an Oracle JDeveloper
extension to seamlessly integrate our components with the rest
of the Oracle Fusion Applications technology stack, PLSQL
APT's, C libraries, and common seed data.

See the "Oracle Fusion Middleware Extensions for Applications"
section in the Oracle Fusion Applications Concepts Guide.

Oracle Enterprise Scheduler Enables you to manage and schedule jobs for Oracle Fusion
Applications.

See Chapter 5, "Managing Oracle Enterprise Scheduler Service
and Jobs."

Oracle Enterprise Crawland Oracle Enterprise Crawl and Search Framework (ECSF) enables

Search Framework (ECSF)  Oracle Fusion Applications Search for performing full-text
searches securely and simultaneously against multiple logical
business objects. Any application that connects to multiple data
sources or manages a significant amount of unstructured
(non-database) information—or both—needs advanced search
capabilities so that application users can easily locate and take
action on data that is relevant to them.

See Chapter 7, "Managing Search with Oracle Enterprise Crawl
and Search Framework."

1.1.3 Oracle Fusion Middleware Components

Oracle Fusion Middleware includes the following components describes in Table 1-3.

Table 1-3 Oracle Fusion Middleware Components

Oracle Fusion Middleware

Components Description

Oracle Application Provides an end-to-end application framework that builds on
Development Framework Java Platform, Enterprise Edition (Java EE) standards and
(Oracle ADF) open-source technologies to simplify and accelerate

implementing service-oriented applications.

See the Oracle Fusion Middleware Administrator’s Guide for Oracle
Application Development Framework.
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Table 1-3 (Cont.) Oracle Fusion Middleware Components

Oracle Fusion Middleware
Components

Description

Oracle Business Intelligence

Oracle Business Intelligence provides a complete, integrated
solution of analytics and reporting for Oracle Fusion
Applications.

See the following documentation on Oracle Business Intelligence
components in Oracle Fusion Applications:

s Oracle Bl Enterprise Edition: Oracle Fusion Middleware
System Administrator’s Guide for Oracle Business Intelligence
Enterprise Edition

= Oracle Business Intelligence Publisher: Chapter 6

s Oracle Essbase: Oracle Essbase Database Administrator’s Guide
and Oracle Essbase Technical Reference

s Oracle Enterprise Performance Management:
http://www.oracle.com/technetwork/middleware
/performance-management/documentation/index.
html

= Oracle Real-Time Decisions: Oracle Fusion Middleware
Platform Developer’s Guide for Oracle Real-Time Decisions

s Oracle Transactional Business Intelligence: Oracle Fusion
Administrator’s Guide for Transactional Business Intelligence

After the Oracle Fusion applications are running, you can
configure the Oracle Business Intelligence Applications for
analyzing historical data. See the Oracle Fusion Middleware
Installation and Configuration Guide for Oracle Business Intelligence
Applications.

Oracle Data Integrator

Oracle Data Integrator provides a comprehensive data
integration platform that covers bulk data movement
requirements for Oracle Fusion Applications.

See the Oracle Fusion Middleware Developer’s Guide for Oracle Data
Integrator.

Oracle HTTP Server

Provides a web listener for applications and the framework for
hosting static and dynamic pages and applications over the web.
Based on the proven technology of the Apache HTTP Server,
Oracle HTTP Server includes significant enhancements that
facilitate load balancing, administration, and configuration.

See the Oracle Fusion Middleware Administrator’s Guide for Oracle
HTTP Server.
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Table 1-3 (Cont.) Oracle Fusion Middleware Components

Oracle Fusion Middleware

Components Description

Oracle Identity Provides a shared infrastructure for all applications, enabling

Management developers to incorporate identity management into
applications.

For more information about documentation for Oracle Identity
Management components in Oracle Fusion Applications, see the
following guides:

s Oracle Platform Security Services (OPSS: Oracle Fusion
Middleware Application Security Guide and Oracle Fusion
Middleware Security Overview

= Oracle Access Manager: Oracle Fusion Middleware
Administrator’s Guide for Oracle Access Manager with Oracle
Security Token Service

= Oracle Authorization Policy Manager: Oracle Fusion
Middleware Oracle Authorization Policy Manager
Administrator’s Guide (Oracle Fusion Applications Edition)

= Oracle Identity Manager: Oracle Fusion Middleware
Administrator’s Guide for Oracle Identity Manager

s Oracle Internet Directory: Oracle Fusion Middleware
Administrator’s Guide for Oracle Internet Directory

= Oracle Virtual Directory: Oracle Fusion Middleware
Administrator’s Guide for Oracle Virtual Directory

Oracle SOA Suite Provides a complete set of service infrastructure components for
designing, deploying, and managing composite applications.
Oracle SOA Suite enables services to be created, managed, and
orchestrated into composite applications and business processes.
Composites enable you to easily assemble multiple technology
components into one SOA composite application.

An important component of Oracle SOA Suite is Oracle WSM
Policy Manager. Oracle WSM Policy Manager provides the
infrastructure for enforcing global security and auditing policies.
By securing various endpoints and setting and propagating
identity, it secures applications. Oracle WSM Policy Manager
provides a standard mechanism for signing messages,
performing encryption, performing authentication, and
providing role-based access control. You also can change a
policy without having to change the endpoints or clients for this
endpoints, providing greater flexibility and security monitoring
for your enterprise.

The Oracle Business Process Management (Oracle BPM) Suite
provides an integrated environment for developing,
administering, and using business applications centered around
business processes. The Oracle BPM Suite is layered on the
Oracle SOA Suite and shares many of the same product
components.

See the Oracle Fusion Middleware Administrator’s Guide for Oracle
SOA Suite and Oracle Business Process Management Suite.

Introduction to Oracle Fusion Applications for Systems Administrators 1-7



Architecture of Oracle Fusion Applications

Table 1-3 (Cont.) Oracle Fusion Middleware Components

Oracle Fusion Middleware

Components Description
Oracle Secure Enterprise Provides a search engine for Oracle Fusion Applications Search.
Search (Oracle SES)

For more information on Oracle SES, see the following guides:
»  Oracle Secure Enterprise Search Administrator’s Guide

»  Oracle Secure Enterprise Search Administration API Guide

s Oracle Secure Enterprise Search Java API Reference

For more information on how Oracle SES and ECSF provide
Oracle Fusion Applications Search, see Chapter 7, "Managing
Search with Oracle Enterprise Crawl and Search Framework."

Oracle WebCenter Content  Provides a comprehensive suite of digital content management
tools. These tools can be used across the enterprise to cohesively
track, manage, and dispose of content whether written, in digital
images, or as email.

For more information about documentation for Oracle
Enterprise Content Management components in Oracle Fusion
Applications, see:

s WebCenter Content: Oracle WebCenter Content System
Administrator’s Guide for Content Server

= Oracle WebCenter Content: Imaging: Oracle WebCenter
Content Administrator’s Guide for Imaging

Oracle WebCenter Portal Enables you to create social applications, enterprise portals,
collaborative communities, and composite applications, built on
a standards-based, service-oriented architecture. Oracle
WebCenter Portal combines dynamic user interface technologies
with which to develop rich internet applications, the flexibility
and power of an integrated, multichannel portal framework, and
a set of horizontal Enterprise 2.0 capabilities delivered as
services that provide content, collaboration, presence, and social
networking capabilities. Based on these components, Oracle
WebCenter Portal also provides an out-of-the-box,
enterprise-ready customizable application, WebCenter Spaces,
with a configurable work environment that enables individuals
and groups to work and collaborate more effectively.

See the Oracle Fusion Middleware Administrator’s Guide for Oracle
WebCenter Portal.

Oracle WebGate Acts as a communicator plug-in that accepts users requests
through Oracle HTTP Server and communicates with Oracle
Access Manager.

See the Oracle Fusion Middleware Administrator’s Guide for Oracle
Access Manager with Oracle Security Token Service.

Oracle WebLogic Provides click-to-dial functionality for applications primarily

Communication Services through contextual actions. Contextual actions provide related
information and actions to users within the immediate context of
the object instances upon which they act.

For more information for enabling these services, see Chapter 8,
"Managing Oracle WebLogic Communication Services for
Click-to-Dial Functionality."

Oracle WebLogic Server Supports the deployment of mission-critical applications in a
robust, secure, highly available, and scalable environment.
Oracle WebLogic Server is an ideal foundation for building
applications based on service-oriented architecture (SOA).

See the Oracle Fusion Middleware Introduction to Oracle WebLogic
Server.
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1.1.4 Oracle Database

The Oracle Database contains the schemas and tablespaces required for both the
Oracle Fusion Applications and for your applications. Oracle Fusion Applications does
not support other databases.

Oracle Fusion Applications encryption APIs mask data such as credit card numbers in
application user interface fields. For encryption and masking beyond that, Transparent
Data Encryption (TDE) and Oracle Database Vault (ODV) are certified but optional
with Oracle Fusion Applications.

TDE and ODV provide information lifecycle protections, such as the following:

s Data access restrictions on database administrators and other privileged users
=  Sensitive data at rest in database files and file backups

= Sensitive data in transit

= Sensitive attributes in non-production databases

ODV establishes limitations on the power of privileged users to access sensitive data
through segregation of duties policies on DBA roles and by securely consolidating
application data in the database. These limitations prevent DBAs and other privileged
users from overriding the protections placed on sensitive data by the Virtual Private
Database (VPD). Oracle Fusion Applications deploys with the ODV enabled when it is
installed.

TDE prevents access to PII in the file system or on backups or disk. TDE protects
confidential data, such as credit card and social security numbers. TDE encrypts
sensitive table data stored in data files at the tablespace level.

For more information about ODV and TDE, see the Oracle Fusion Applications Security
Guide.

1.1.5 Oracle Enterprise Manager Fusion Applications Control

Oracle Enterprise Manager Fusion Applications Control (Fusion Applications Control)
enables you to manage a single product family in an Oracle WebLogic Server domain
for the Oracle Fusion Applications environment, including the products, applications,
and Oracle Fusion Middleware components. As a part of management, you can
monitor the runtime performance metrics for the various Oracle Fusion Applications
and Oracle Fusion Middleware components. See Section 2.5 for more information
about Fusion Applications Control and Section 2.2 for a comparison with Cloud
Control.

1.1.6 Oracle Enterprise Manager Cloud Control

Oracle Enterprise Manager Cloud Control (Cloud Control) enables you to monitor and
manage the complete IT infrastructure for Oracle Fusion Applications from a single
console. You can monitor all the product families, Oracle Fusion Middleware
components, and the Oracle Database. For example, you can monitor all the Oracle
WebLogic Server domains for all the product families from one console. See Section 2.7
for more information about Fusion Applications Control and Section 2.2 for a
comparison with Fusion Applications Control.

1.1.7 Oracle Enterprise Manager Database Control

Oracle Enterprise Manager Database Control (Database Control) enables you to
manage the Oracle Database.
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Using Database Control, you can perform administrative tasks such as creating
schema objects (tables, views, indexes, and so on), managing user security, managing
database memory and storage, backing up and recovering your database, and
importing and exporting data. You can also view performance and status information
about your database.

For more information, see the "Introduction to Oracle Enterprise Manager Database
Control" section in the Oracle Database 2 Day DBA.

1.2 Key Oracle Fusion Applications Concepts

Before you begin administering Oracle Fusion Applications, it is important to
understand the basics of installation, how Oracle WebLogic Server domains are
configured, and the basic directory structure.

This section contains the following topics:
= Provisioning and the Installation Process
s Oracle WebLogic Server Domains Configuration

= Provisioned Oracle Fusion Applications Home Directories

1.2.1 Provisioning and the Installation Process

Provisioning is the entire set of operations required to install, configure, and deploy
applications product offerings from a system point of view. It performs these
operations:

» Installation provides the operations related to laying down all the component
needed to create an Oracle Fusion Applications environment.

= Configuration tailors components based on the applications topology, the creation
of Oracle WebLogic Server Managed Servers and clusters, and the updating of
endpoints and virtual hosts.

= Deployment starts the Managed Servers and clusters and facilitates the actual use
of product offerings.

This orchestration by a single processing engine ensures that all components interact
smoothly and consistently in the applications environment.

For detailed information about provisioning and installing an Oracle Fusion
Applications environment, see Oracle Fusion Applications Installation Guide.

This section contains the following topics:
= Installation Options

» Installing an Oracle Database and Loading Content

1.2.1.1 Installation Options

You choose options from the Provisioning Wizard menu to initiate one
installation-related processes:

» Install an empty, single-instance Enterprise database
»  Create a new provisioning plan
» Install, configure, and deploy the product offerings in a provisioning plan

s Uninstall an existing environment
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1.2.1.2 Installing an Oracle Database and Loading Content

You must have installed and configured a transaction database before you install
product offerings. You can use the Provisioning Wizard to create an empty,
single-instance database instance. This is a discrete and separate task from the other
provisioning options. Alternatively, you can install the database manually without
using the wizard.

In either case, you finish the database installation by running the Oracle Fusion
Applications Repository Creation Utility (Applications RCU) to load applications and
middleware content into the database. This process creates the applications and
middleware schemas, loads seed data, and creates the tablespaces, as well all other
required packages.

For more information about creating a database with Applications RCU, see the Oracle
Fusion Applications Installation Guide.

1.2.2 Oracle WebLogic Server Domains Configuration

See "What Is an Oracle WebLogic Server Domain?" in the Oracle Fusion Middleware
Administrator’s Guide to understand the following concepts for Oracle WebLogic
Server:

»  Oracle WebLogic Server domains
= Managed Servers and the Administration Server

During installation, the applications for a single product family are deployed to one
Oracle WebLogic Server domain. Within a single domain, an Administration Server
hosts the application for Fusion Applications Control, and the Java EE applications for
the product family deploy to the Managed Servers. The Managed Servers are grouped
together into a cluster for each application of the product family. Figure 1-3 shows a
domain with an Administration Server and three Managed Servers in clusters. If you
want to scale out the Java EE application, you simply add new servers to the cluster. In
an Oracle Fusion Applications environment, the domains are predefined so that the
product families and their dependencies are always stored in a standardized
arrangement.

Figure 1-3 Oracle WebLogic Server Domain

Administration Cluster Cluster Cluster

Server
| Managed Server | Managed Server Managed Server

Administration
Console | Managed Server | Managed Server Managed Server

Fusion Applications
Control

As an example of greater detail for a product family, Figure 1-4 shows a portion of the
domain for the Oracle Fusion Financials product family with an Administration Server
and eight Managed Servers in a cluster. The applications are each deployed to a
Managed Server within a cluster. In addition to the applications for Oracle Fusion
Financials, the domain also contains an Oracle Enterprise Scheduler cluster and a SOA
cluster. The Oracle Enterprise Scheduler (ESSAPP) application manages job requests for
the product family. The SOA Infrastructure (soa-infra) application hosts the SOA
composites for the applications in the product family.
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Figure 1-4 Oracle WebLogic Server Domain for the Oracle Fusion Financials Family
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Figure 1-5 shows an Oracle Fusion Applications environment with multiple product
families, each in separate Oracle WebLogic Server domains. The CommonDomain is the
domain in the Oracle Fusion Setup product family.
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Figure 1-5 Multiple Product Families
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1.2.3 Provisioned Oracle Fusion Applications Home Directories

An installation of Oracle Fusion Applications contains two mount point directories,
APPLICATIONS_BASE for the binaries and APPLICATIONS_CONFIG for the configuration
files. The APPLICATIONS_BASE and APPLICATIONS_CONFIG directories contain various
types of home directories. The home directories described in Table 1-4.
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Table 1-4 Home Directories

Home Directory

Description

Variable Representation

Applications base

This directory is the top-level directory for the Oracle
Fusion Applications binaries. You specify the location
of this top-level directory at the time of provisioning.
Figure 1-6 represents this directory as
/net/mountl/appbase for the purpose of showing an
example directory structure.

APPLICATIONS_BASE

Applications
configuration

This directory is the top-level directory for the Oracle
Fusion Applications configuration files. You specify a
location for this top-level directory at the time of
provisioning. Figure 1-6 represents this directory as
/net/mount2 for the purpose of showing an example
directory structure. Provisioning automatically creates
a subdirectory named instance as a container for the
configuration files.

APPLICATIONS_CONFIG

Middleware home

This directory provides a container for the Oracle
WebLogic Server home, an Oracle Common home,
and one or more Oracle homes for components. A
Middleware home can reside on a local file system or
on a remote shared disk that is accessible through
Network File System (NFS).

An installation of Oracle Fusion Applications creates
two Middleware homes:

= fusionapps for the Oracle WebLogic Server home
and Oracle homes for Oracle Fusion Middleware
components, such as Oracle Business Intelligence,
Oracle SOA Suite, Oracle Data Integrator,
WebCenter, Oracle Enterprise Content
Management, Oracle Secure Enterprise Search,
and Oracle Fusion Middleware Extensions for
Applications (Applications Core)

= webtier mwhome for the system components, such
as Oracle HTTP Server

For operations on specific Middleware home
directories, this guide refers to each Middleware home
by its product name or specifies the directory. For
example, the Middleware home for Oracle Fusion
Applications is referred to as the Oracle Fusion
Applications Middleware home or the fusionapps
Middleware home directory and its variable is FA_Mi_
HOME, while the Middleware home for Oracle Web Tier
is referred to as the Web Tier Middleware home or the
webtier_mwhome Middleware home directory and its
variable is WT_Mw_HOME. In cases where differentiation
is not necessary, this guide refers to the Middleware
home and uses the Miw_HOME variable.

MW_HOME
FA_MW_HOME
WT_MyW_HOME

Oracle Business
Intelligence
configuration home

This directory contains the configuration files for the
Oracle Business Intelligence installation.

BI_CONFIG_HOME

Oracle Common
home

This directory contains the binary and library files
required for Fusion Applications Control, test to
production, and Java Required Files (JRF). The Java
Required Files include the Oracle ADF libraries, a
number of other components shared by the product
suites included in a given installation, and
components such as Oracle Metadata Service (MDS)
and Oracle Platform Security Services (OPSS).

ORACLE_COMMON_HOME
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Table 1-4 (Cont.) Home Directories

Home Directory Description Variable Representation
Oracle Database This directory provides a container for the Oracle DBCLIENT_ORACLE_HOME
client home Database client software files.

Oracle WebLogic This directory contains installed files necessary to host WwI._HOME

Server home Oracle WebLogic Server. The Oracle WebLogic Server

home directory is a peer of Oracle home directories
and resides within the directory structure of the
Middleware home.

Oracle home This directory contains installed files necessary to host ATGPF_ORACLE_HOME
a specific component or software suite. For example, = Fa_ORACLE_HOME
the files for Oracle SOA Suite are stored in an Oracle  JrROCKIT ORACLE HOME
home directory named soa, and the application SOA ORACLE HOME
artifacts for Oracle Fusion Applications are stored in .+ 002 10 Houm
an Oracle home directory named applications. WG_ORACLE_HOME

An Oracle home resides within the directory structure wr_ ORACLE HOME
of the Middleware home. There can be multiple Oracle
homes within each Middleware home.

This guide refers to each Oracle home by product
name or specifies the directory. For example, the
Oracle home for Oracle SOA Suite is referred to as the
SOA Oracle home or the soa Oracle home directory
and its variable is SOA_ORACLE_HOME, while the Oracle
home for Oracle Fusion Applications is referred to as
the Oracle Fusion Applications Oracle home or the
applications Oracle home and its variable is FA_

ORACLE_HOME.
Oracle Web Tier This directory contains the configuration files for the = WI_CONFIG_HOME
configuration home Oracle Web Tier installation.
Oracle WebLogic This directory contains the configuration files for the = DOMAIN_HOME
Server domain home Administration Server and the Managed Servers for

the product family.

Figure 1-6 shows the relationship of the home directories using the Oracle Fusion
Financials product family on a UNIX environment as an example. The Oracle Database
and the Oracle Identity Management is not included, as they are installed separately
from provisioning.
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Figure 1-6 Relationship of Home Directories
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For more information about the detailed directory structure, see the Oracle Fusion
Applications Installation Guide.

1.3 Roadmap for Administering Oracle Fusion Applications

To gain a better understanding of where administration fits into the overall process for
installing, administering, and implementing Oracle Fusion Applications, see the Oracle
Fusion Applications Administrator and Implementor Roadmap.

Prior to using the administrative procedures in this guide, ensure the Oracle Fusion
Applications environment is provisioned, as described in the Oracle Fusion Applications
Installation Guide.

The following provides a summary of the steps to configure, manage, and perform
ongoing maintenance of an Oracle Fusion Applications environment after you have
installed the software:

1. Start components. See Section 3.3.

Configure ports. See Section 3.4.

Configure passwords. See Section 3.5.
Manage the Oracle database. See Section 3.6.
Configure security. See Chapter 4.

Deploy customizations. See the Oracle Fusion Applications Extensibility Guide.

N o a » o Db

Monitor your environment. See Chapter 9, Chapter 10, Chapter 11, and
Chapter 12.

®

Manage log files and diagnostic information. See Chapter 13.
9. Backup your environment. See Chapter 15.

10. Configure load balancing between different components or applications. See
Chapter 16.

11. Configure Oracle Transactional Business Intelligence to perform real-time analysis
of the Oracle Fusion applications. See the Oracle Fusion Administrator’s Guide for
Transactional Business Intelligence.

12. After the Oracle Fusion applications are running, configure the Oracle Business
Intelligence Applications applications for analyzing historical data. See the Oracle
Fusion Middleware Installation and Configuration Guide for Oracle Business Intelligence
Applications.

In addition to this guide, refer to the following guides for tasks that you may need to
perform, depending on your business needs:

»  Oracle Fusion Applications Common Implementation Guide for common setup and
maintenance tasks for Oracle Fusion applications

»  Oracle Fusion Applications Post-Installation Guide for configuration tasks to perform
after installation

»  Oracle Fusion Applications Administrator’s Troubleshooting Guide for common issues
in the runtime environment
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Part li

Basic Administration

This part describes basic administration tasks.

Part II contains the following chapters:

Chapter 2, "Getting Started with Administering Oracle Fusion Applications"
Chapter 3, "Performing Routine Administrative Tasks"

Chapter 4, "Securing Oracle Fusion Applications"

Chapter 5, "Managing Oracle Enterprise Scheduler Service and Jobs"
Chapter 6, "Managing Report Delivery Servers"

Chapter 7, "Managing Search with Oracle Enterprise Crawl and Search
Framework"

Chapter 8, "Managing Oracle WebLogic Communication Services for Click-to-Dial
Functionality"






2

Getting Started with Administering Oracle
Fusion Applications

This chapter provides information you need to get started administering your Oracle
Fusion Applications environment, including information about the tools you use.

Prior to using the administrative procedures in this chapter and the rest of this guide,
ensure the Oracle Fusion Applications environment is provisioned, as described in the
Oracle Fusion Applications Installation Guide.

This chapter contains the following topics:
= Introduction to the Tools Used to Administer Oracle Fusion Applications
= Key Differences Between Fusion Applications Control and Cloud Control

= When to Use Fusion Applications Control Tool, When to Use Oracle WebLogic
Server Administration Console

» Finding the Administration Server Port and Other Administrative URLs for
Domains

s Using Fusion Applications Control

= Using Oracle WebLogic Server Administration Console
= Using Cloud Control

s Using Oracle Fusion Functional Setup Manager

= Using Database Tools to Modify Oracle Fusion Applications Data

2.1 Introduction to the Tools Used to Administer Oracle Fusion
Applications

Oracle provides several tools to administer the Oracle Fusion Applications, the Oracle
Fusion Middleware layer, and the Oracle Database within your Oracle Fusion
Applications installations. Use these tools, rather than directly editing configuration
files, to perform all administrative tasks unless a specific procedure requires you to
edit a file. Editing a file may cause the settings to be inconsistent and generate
problems.

The primary administration tools for Oracle Fusion Applications are described in
Table 2-1.
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Table 2-1 Administration Tools for Oracle Fusion Applications

Tool

Description

Oracle Enterprise Manager
Fusion Applications Control
(Fusion Applications
Control)

Enables you to monitor and administer a product family within
the Oracle Fusion Applications environment. See Section 2.5.

Oracle Enterprise Manager
Cloud Control (Cloud
Control)

Enables you to monitor and administer the entire Oracle Fusion
Applications environment, including product families, Oracle
Fusion Middleware components across all Oracle WebLogic
Servers, and the Oracle Database. See Section 2.2 to understand
the key difference between Cloud Control and Fusion
Applications Control, and see Section 2.7 to get started with
using Cloud Control.

Oracle Fusion Functional
Setup Manager

Guides you through the tasks of setting up the functional data
and reference data. See Section 2.5.

Oracle Fusion Applications
Diagnostic Dashboard

Enables you to register, execute, and monitor diagnostic tests for
Oracle Fusion Applications, and also work with diagnostic test
registration tags and purge diagnostic test results. See

Chapter 13.

The primary administration tools for Oracle Fusion Middleware are described in

Table 2-2.

Table 2-2 Administration Tools for Oracle Fusion Middleware

Tool

Description

Fusion Applications Control

Enables you to monitor and administer Oracle Fusion
Middleware components within an Oracle WebLogic Server
domain for a specific product family within the Oracle Fusion
Applications environment. See Section 2.5.

Fusion Applications Control also includes a System MBean
Browser that enables you browse the MBeans for an Oracle
WebLogic Server or for a selected application. See "Getting
Started Using the Fusion Middleware Control MBean Browsers"
in the Oracle Fusion Middleware Administrator’s Guide.

Oracle Enterprise Manager
Cloud Control (Cloud
Control)

Enables you to monitor and administer the entire Oracle Fusion
Applications environment, including product families, Oracle
Fusion Middleware components across all Oracle WebLogic
Servers, and the Oracle Database. See Section 2.2 to understand
the key difference between Cloud Control and Fusion
Applications Control, and see Section 2.7 to get started with
using Cloud Control.

Oracle WebLogic Server
Administration Console

Enables you to manage the Oracle WebLogic Server in each
domain. See Section 2.3 to understand the when to use
Administration Console, and see Section 2.7 to get started with
using the Administration Console.

Oracle Fusion Middleware
command-line tools

Enables you to manage Oracle Fusion Middleware components.
See "Getting Started Using Command Line Tools" in the Oracle
Fusion Middleware Administrator’s Guide to learn about the Oracle
WebLogic Scripting Tool (WLST) and the Oracle Process
Manager and Notification Server (OPMN).
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Table 2-2 (Cont.) Administration Tools for Oracle Fusion Middleware

Tool Description
Middleware support for The Oracle Fusion Applications environment includes the
application security following tools for managing application security:

= Oracle WebLogic Server Administration Console enables
you to manage policies of enterprise applications. See the
Oracle Fusion Middleware Securing Resources Using Roles and
Policies for Oracle WebLogic Server.

= Oracle Authorization Policy Manager enables you to
manage application policies. See the Oracle Fusion
Middleware Oracle Authorization Policy Manager
Administrator’s Guide (Oracle Fusion Applications Edition).

s Oracle Access Manager Administration Console enables
you to manage system configurations, including Oracle
Access Manager server instances and data sources, access
policies, agent profiles, and other security elements. See the
Oracle Fusion Middleware Administrator’s Guide for Oracle
Access Manager with Oracle Security Token Service.

s Oracle Identity Manager Administrative and User Console
enables you to access the organization's resources (through
self-service) and enable administrators to manage the access
(by creating users and roles, and defining authorization
policies). See the Oracle Fusion Middleware Administrator’s
Guide for Oracle Directory Integration Platform.

= Oracle Web Service Policy Manager enables you manage
and secure web services for SOA composite applications.
See the Oracle Fusion Middleware Security and Administrator’s
Guide for Web Services.

For an overview and information about Fusion security as it is
relevant specifically to Oracle Fusion Applications, including
details about how to interact with the Fusion Security
infrastructure to implement and administer security for your
enterprise, see the Oracle Fusion Applications Security Guide.

The primary administration tools for the Oracle Database are described in Table 2-3.

Table 2-3 Administration Tools for the Oracle Database

Tool Description

Oracle Enterprise Manager  Enables you to monitor and manage the Oracle Database for the
Database Control Oracle Fusion Applications. See the Oracle Database 2 Day DBA.
Cloud Control Enables you to monitor historical data for the Oracle Database.

See Section 2.7.

2.2 Key Differences Between Fusion Applications Control and Cloud

Control

You can manage your Oracle Fusion Applications environment using Fusion
Applications Control or Cloud Control.

Fusion Applications Control organizes a wide variety of performance data and
administrative functions into distinct, Web-based home pages for the farm, cluster,
domain, servers, components, and applications. The Fusion Applications Control
home pages make it easy to locate the most important monitoring data and the most
commonly used administrative functions all from your Web browser. Fusion
Applications Control is automatically installed with each Oracle WebLogic Server
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domain for each product family during an Oracle Fusion Applications installation. For
more information about this control, see Section 2.5.

Managing several farms from different, distinct Fusion Applications Controls becomes
very difficult in an Oracle Fusion Applications environment. For centralized
management and additional management functionality (such as historical data
collections for performance trending, email and page notifications for potential
availability or performance problems, and service level management), you can use
Cloud Control.

Cloud Control enables you to monitor all the product families, Oracle Fusion
Middleware components, and the Oracle Database across the entire Oracle Fusion
Applications environment from one console. To use Cloud Control, you need to
separately install Oracle Enterprise Manager Cloud Control 12c (12.1.0.1) with the
Application Management Pack for Oracle Fusion Applications. For more information
about this control, see Section 2.7. For more information about installing Cloud
Control, see the following documentation:

»  Oracle Enterprise Manager Cloud Control Basic Installation Guide for more
information about the installation process

»  Oracle Enterprise Manager Licensing Information for more information about the
Application Management Pack

2.3 When to Use Fusion Applications Control Tool, When to Use Oracle
WebLogic Server Administration Console

Fusion Applications Control and Oracle WebLogic Server Administration Console are
graphical user interfaces that you can use to monitor and administer your
environment. Use Table 2—4 to locate the task you are performing.

Table 2-4 Comparing Fusion Applications Control and WebLogic Server Administration

Console
Task Tool to Use
Manage Oracle WebLogic Server Use:

Create additional Managed Servers

WebLogic Server Administration Console

Clone Managed Servers

WebLogic Server Administration Console

Cluster Managed Servers

WebLogic Server Administration Console

Start and stop Oracle WebLogic Server

Fusion Applications Control or WebLogic Server
Administration Console

Add users and groups

WebLogic Server Administration Console if using the
default embedded LDAP:; if using another LDAP
server, use the LDAP server's tool

Manage Data Sources

Use:

Create data sources

WebLogic Server Administration Console

Create connection pools

WebLogic Server Administration Console

Manage JMS Resources

Use:

Create JMS queues

WebLogic Server Administration Console

Configure advanced queuing

WebLogic Server Administration Console

Manage SOA environment

Use:
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Table 2-4 (Cont.) Comparing Fusion Applications Control and WebLogic Server
Administration Console

Task Tool to Use

Deploy and undeploy SOA Composite  Fusion Applications Control
applications

Monitor SOA Composite applications Fusion Applications Control

Modify Oracle BPEL Process Manager  Fusion Applications Control
MBean properties

Debug applications such as Oracle Fusion Applications Control
BPEL Process Manager applications

ADF Applications Use:

Deploy and undeploy ADF applications Fusion Applications Control

Java EE applications Use:

Deploy and undeploy Java EE WebLogic Server Administration Console or Fusion

applications Applications Control

Security Use:

Configure and manage auditing Fusion Applications Control

Configure SSL WebLogic Server Administration Console for Oracle
WebLogic Server

Fusion Applications Control for Java components
and system components. See Chapter 4.

Change passwords WebLogic Server Administration Console
Manage Components Use:
View and manage log files Fusion Applications Control for most log files. See

Section 13.6.

WebLogic Server Administration Console for the
following logs:

DOMAIN_HOME/servers/server.
name/logs/access.log
DOMAIN_HOME/servers/server.
name/data/ldap/log/EmbeddedLDAP. log
DOMAIN_HOME/servers/server.
name/data/ldap/log/EmbeddedLDAPAccess.log

Change ports WebLogic Server Administration Console for Oracle
WebLogic Server and Java components

For some system components, Fusion Applications

Control.
Manage Oracle HTTP Server Fusion Applications Control
Start and stop components Fusion Applications Control
Start and stop applications Fusion Applications Control

2.4 Finding the Administration Server Port and Other Administrative
URLs for Domains

To locate the port for the Administration Server and other administrative URLs for the
Oracle WebLogic Server domains, use the summary file saved during provisioning.
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During provisioning of Oracle Fusion Applications, on the Summary page of the
Provisioning Wizard, when you clicked Finish, you saved the plan and the summary
in a text document that summarizes the details of this plan. For more information
about using the Provisioning Wizard, see "Creating a Provisioning Plan" section in the
Oracle Fusion Applications Installation Guide.

In the summary file, under the Admin Server entry for the domain, locate the

following subentries:
s Managed Server Port for the Administration Server port
m Enterprise Manager Welcome Page for the URL for Fusion Applications Control
u

Admin Server for the URL for the Oracle WebLogic Server Administration Console

Example 2-1 shows an excerpt of the summary file.

Example 2-1 Summary File Excerpt

Common Domain

Admin Server
Host: hostname
Managed Server

.domain
Port: 7001

Secure Managed Server Port: 7002

Admin Console

http://commoninternal.domain:7777/console
Enterprise Manager Welcome Page
http://commoninternal .domain:7777/em

Functional Setup

Host: hostname.

Managed Server

Manager
domain
Port: 7004

Secure Managed Server Port: 7005
Home Page
Host: hostname.domain
Managed Server Port: 7006
Secure Managed Server Port: 7007
Home Page
Host: hostname.domain
Managed Server Port: 7006
Secure Managed Server Port: 7007
Help Portal
Host: hostname.domain
Managed Server Port: 7008
Secure Managed Server Port: 7009
Business Process Server
Host: hostname.domain
Managed Server Port: 7010
Secure Managed Server Port: 7011
Content Server
Host: hostname.domain
Managed Server Port: 7012
Secure Managed Server Port: 7013
Secure Enterprise Search
Host: hostname.domain
Managed Server Port: 7016
Secure Managed Server Port: 7017
Enterprise Scheduler
Host: hostname.domain
Managed Server Port: 7020
Secure Managed Server Port: 7021

WebCenter Spaces
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Host: hostname.domain
Managed Server Port: 7022
Secure Managed Server Port: 7023
WebCenter Collaboration
Host: hostname.domain
Managed Server Port: 7024
Secure Managed Server Port: 7025
OWLCS Server
Host: hostname.domain
Managed Server Port: 7030
Secure Managed Server Port: 7031
OWLCS SIP State Server
Host: hostname.domain
Managed Server Port: 7032
Secure Managed Server Port: 7033
Web Tier
Host: hostname.domain
CRM Domain
Admin Server
Host: hostname.domain
Managed Server Port: 9001
Secure Managed Server Port: 9002
Admin Console
http://crminternal.domain:7777/console
Enterprise Manager Welcome Page
http://crminternal.domain:7777/em

Financial Domain
Admin Server
Host: hostname.domain
Managed Server Port: 7401
Secure Managed Server Port: 7401
Admin Console
http://fininternal.domain:7777/console
Enterprise Manager Welcome Page
http://fininternal.domain:7777/em

2.5 Using Fusion Applications Control

Fusion Applications Control is a Web browser-based, graphical user interface that you
can use to monitor a product family and its products. It also enables you to monitor
and administer Oracle Fusion Applications and an Oracle Fusion Middleware farm.

A farm is a collection of components managed by Fusion Applications Control. It can
contain an Oracle WebLogic Server domain, one Administration Server, one or more
Managed Servers, clusters, and the Oracle Fusion Middleware components that are
installed, configured, and running in the domain.

Fusion Applications Control organizes a wide variety of performance data and
administrative functions into distinct, Web-based home pages for the product family,
products, Oracle Fusion Applications, farm, domain, servers, and Oracle Fusion
Middleware components. The Fusion Applications Control home pages make it easy
to locate the most important monitoring data and the most commonly used
administrative functions for various targets—all from your Web browser.

The section contains the following topics:

s Understanding How Fusion Applications Control Compares with Fusion
Middleware Control
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s Starting Fusion Applications Control

s Using Fusion Applications Control Help

= Navigating within Fusion Applications Control

s Understanding the Targets in the Target Navigation Pane

= Navigating to the Product Family and Product Administration Pages
s Viewing the Performance of Targets

s Understanding Users and Roles for Fusion Applications Control

For information about the System MBean Browser, see the "Getting Started Using the
Fusion Middleware Control MBean Browsers" section in the Oracle Fusion Middleware
Administrator’s Guide.

2.5.1 Understanding How Fusion Applications Control Compares with Fusion
Middleware Control

If you have worked with Oracle Fusion Middleware, then you may already be familiar
with Fusion Middleware Control. Fusion Middleware Control enables you to monitor
and administer a farm. Fusion Applications Control provides all the functionality
available in Fusion Middleware Control plus functionality specific to Oracle Fusion
Applications.

Many procedures throughout this guide reference content in Oracle Fusion
Middleware guides, which describes using Fusion Middleware Control. Where these
references occur, the same procedures also apply to Fusion Applications Control.
Where the controls vary, the procedures for Fusion Applications Control are contained
within this guide.

2.5.2 Starting Fusion Applications Control

To display Fusion Applications Control for a given Oracle WebLogic Server domain:
1. Enter the URL in your Web browser:

http://product_familyinternal.domain:port/em

where product_familyinternal.domain. port is the host and domain of the
Oracle HTTP Server or a Load Balancer.

During provisioning of Oracle Fusion Applications, on the Summary page of the
Provisioning Wizard, when you clicked Finish, you saved the plan and the
summary in a text document that summarizes the details of this plan. For more
information about using the Provisioning Wizard, see "Creating a Provisioning
Plan" in the Oracle Fusion Applications Installation Guide.

In the summary file, for the domain, find the Enterprise Manager Welcome Page
entry to locate the URL. For example:

CommonDomain
Enterprise Manager Welcome Page
http://commoninternal .domain:7777/em

CRM Domain

Enterprise Manager Welcome Page
http://crminternal .domain:7777/em
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Financial Domain
Enterprise Manager Welcome Page
http://fininternal.domain:7777/em

The login page displays.

ORACLE" 0
Enterprise Manager 11g
Fusion Applications Control

Login to Fusion Applications Control

Farm Farm_FinandalDomain
* User Name ||

*Password |

Liaon |

You can customize the default performance summary

. {ﬁ'l.rdym ml:-nf—lhe“

- b pages for Fusion Applications by choosing the
A;_;imhmsae performing as expected. " performance metric charts to be displayed, arranging the
Diagnose Performance Problems Easier order of the charts, and selecting to display performance
lize Relationships via Topok Map data from multiple Fusion Applications in a single chart.

Configure Logging and Search Log Files
Improve Performance by Scaling Out

2. Enter Oracle Fusion Middleware administrative user name and password, and
then click Login.

In an Oracle Fusion Applications installation, this user is the super user specified
on the Identity and Policy Management page of the Provisioning Wizard. See
"Identity and Policy Management Configuration" section in the Oracle Fusion
Applications Installation Guide for information about using the Identity and Policy
Management Configuration page and Section 4.8.5.2 to change the password.

2.5.3 Using Fusion Applications Control Help

At any time while using the Fusion Applications Control, you can click Help >
Enterprise Manager at the top of the page to get more information. In most cases, the
Help window displays a help topic about the current page. Click Contents in the Help
window to browse the list of help topics, or click Search to search for a particular word
or phrase.

2.5.4 Navigating within Fusion Applications Control

Fusion Applications Control displays the target navigation pane on the left and the
content pane on the right. For example, when you first log in to Fusion Applications
Control, the product family home page is displayed on the right.

From the target navigation pane, you can expand the tree and select either targets for
the product family or the farm. See Section 2.5.5 for more information about the target
navigation pane.

When you select a target, the target home page displays in the content pane and that
target's menu is displayed at the top of the page, in the context pane. For example, if
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you select a product family, the product family menu is displayed. You can also view

the menu for a target by right-clicking the target in the navigation pane.

Figure 2-1 shows the target navigation pane and the home page of a product family.
Because a product family was selected, the dynamic target menu listed in the context
pane is the product family menu.

Figure 2-1 Overview of Fusion Applications Control
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In the preceding figure, the following items are called out:

Target Navigation Pane lists all of the targets for an Oracle Fusion Applications
product family and the farm navigation tree.

Content Pane shows the current page for the target. When you first select a target,
that target's home page is displayed.

Dynamic Target Menu provides a list of operations that you can perform on the
currently selected target. The menu that is displayed depends on the target you

select. The menu for a specific target contains the same operations as those in the
Right-Click Target Menu.

Right-Click Target Menu provides a list of operations that you can perform on the
currently selected target. The menu is displayed when you right-click the target
name in the target navigation pane. In the figure, the user has right-clicked the

product family.

The menu for a specific target contains the same operations as those in the
Dynamic Target Menu.

Topology Viewer displays the topology of the product family, including the
middleware relationships and the products and applications in the product family.
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»  Target Name is the name of the currently selected target.

= General Information Icon provides information about the target. For example, for
a domain, it displays the target name, the version, and the domain home.

= Context Pane provides the name of the target, the name of the current user, the
host name, and the time of the last page refresh, as well as the Refresh icon.

= Expand All/Collapse All lets you expand or collapse the navigation tree.

= Refresh indicates when the page is being refreshed. Click it to refresh a page with
new data. (Refreshing the browser window refreshes the page but does not

retrieve new data.)

= Go To Home takes you to the product family home page, when you click the

Oracle logo.

Table 2-5 describes some common ways you can navigate within Fusion Applications

Control.

Table 2-5 Navigating within Fusion Applications Control

To:

Take This Action:

View all of the targets in the
farm

Click the Expand All icon at the top of the target navigation
pane.

Navigate to a target

Select the target in the target navigation pane.

Selecting the product family from the top of the displays the
product family home page and selecting the farm displays the
farm home page. You can expand the product family and the
farm for additional targets.

Operate on a target

Right-click the target in the target navigation pane. The target
menu display.

Alternatively, you can select the target and use the dynamic
target menu in the context pane.

Return to the target's home
page

Click the target name at the top left-hand corner of the context
pane.

Refresh a page with new
data

Click the Refresh icon in the top right of the context pane.

Return to a previous page

Click the breadcrumbs, which appear below the context pane.
The breadcrumbs appear when you drill down in a target. For
example, from the WebLogic Server menu, choose Logs >View
Log Messages. Select a log file and click View Log File. The
breadcrumbs show:

Log Messages > Log Files > View Log File: logfile_name

View the host on which the
target is running

Select the target in the target navigation pane and view the host
name in the target's context pane. You can also view the host
name by clicking the General Information icon.

Return to the product family
home page

Click the Oracle Enterprise Manager logo at the top left of the
page.

View the topology

Click Topology.

View a server log file

Right-click the server name in the target navigation pane.
Choose Logs > View Log Messages to see a summary of log
messages and to search log files.

In addition, from Fusion Applications Control, from the home pages of targets such as
the Administration Server or Managed Servers, you can access the WebLogic Server
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Administration Console. For information about configuring single sign-on between
Fusion Middleware Control and the WebLogic Server Administration Console, see
"Configuring Single Sign-On for Administration Consoles" in the Oracle Fusion
Middleware Enterprise Deployment Guide for Oracle Identity Management (Oracle Fusion

Applications Edition).

2.5.5 Understanding the Targets in the Target Navigation Pane

Figure 2-2 shows the target navigation pane. The product family tree enables you to
view an Oracle Fusion Applications product or application target. The farm tree
enables you to select an Oracle WebLogic Server domain, an Oracle WebLogic Server
Managed Server, an Oracle Fusion Middleware component, an application, or an

Oracle Metadata Repository.

Figure 2-2 Target Navigation Pane
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=l [#] Financials
= [ Products

Accounting Hub

Advanced Collections
Assets

[%] Cash Management

[%] Commitment Control
Expenses

Financials Common Module
Financials For &siafPacific
[%] Financials for EMER

[%] Financials for India
Financials Far the Americas
General Ledger

Legal Entity Configuratar
[&] Pavables

@ Payments

Public Sector Financials {International)

Receivables
Subledger Accounting
@ Tax

@ Treasury
1.5, Federal Financials

= [ Fusion Applications
FinancialZommondpp
@ FacrdnalyticsApp
@ Ledgerspp
Pavablesapp
ReceivablesApp

= % Farm_FinancialDornain

3 Application Deployments

[ soa

[ weblLogic Domain

[ Enterprise Crawl and Search Framewaork

[ Metadata Repositarizs

3 scheduling Services

[0 User Messaging Service

Applications Control:

1.

2-12 Oracle Fusion Applications Administrator's Guide

Navigate to the product family and product home page:



Using Fusion Applications Control

s To access the product family home page, from the navigation pane, select the
name of the product family.

= To access the product home page, from the navigation pane, expand the
product family, then Products, and then select the product.

2. Select the Product Family or Product menu.

The following figure shows the Product Family menu:

[&] Praduct Family +

Home
Control ¥
Logs ¥

Key Performance Indicators
System Performance

Applications and Infrastructure

General Information

The following figure shows the Product menu:

Product «

Home

Key Performance Indicators

Syskem Performance

General Information

The Product Family and Product menu displays the options described in
Table 2-6.

Table 2-6 Product Family and Product Target Menu Options

Menu Option Description

Home Displays the product family or product home page. For more
information about this page, see Section 9.2 and Section 9.3.

Control This option provides options for starting and stopping all the
cluster applications in the product family. These options do not
start and stop the Managed Servers, which is recommended
when starting and stopping all applications in a product family.
Instead of these options, use one of the start and stop use cases
described in Section 3.3.

Logs Displays the options to either view log messages or configure
log messages for all the applications in the product family. For
more information, see Section 13.6.

Key Performance Displays the Key Performance Indicators page for viewing the
Indicators middle-tier metrics for the product family or product. see
Section 2.5.7, Section 9.9, and Section 9.10.

System Performance Displays the System Performance page for viewing the
middle-tier metrics for the product family, see Section 2.5.7 and
Section 10.3.1.
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Table 2-6 (Cont.) Product Family and Product Target Menu Options

Menu Option

Description

Applications and
Infrastructure

Displays the Applications and Infrastructure page to view the

status of Oracle Fusion Applications and Oracle Fusion
Middleware components for the product family. See Section 9.8
for more information about using this page for monitoring
applications, and see Section 10.2.1 for more information about
using this page for monitoring Oracle Fusion Middleware.

General Information

Displays general details about the target.

2.5.7 Viewing the Performance of Targets

Fusion Applications Control automatically and continuously measures run-time
performance. The performance metrics are automatically enabled; you do not need to
set options or perform any extra configuration to collect them.

If you encounter a problem, such as an application that is running slowly or is
hanging, you can view more detailed performance information, including
performance metrics for a particular target, to find out more information about the
problem. In many cases, these metrics are shown in interactive charts; other times they
are presented in tabular format. The best way to use and correlate the performance
metrics is from the Performance Summary page for the component or application you
are monitoring.

To view the performance of a target with Fusion Applications Control:

1.

From the menu for a specific target, choose Performance Summary. If the target is
a product family or product, choose Key Performance Indicators to view business
metrics or System Performance to view middle tier metrics.

The Performance Summary page displays.

To see additional metrics, click Show Metric Palette and expand the metric

categories.

The following figure shows the System Performance page for a product family

with the Metric Palette displayed:
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Select additional metrics to add them to the Performance Summary.
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4. To re-organize the display of performance charts in the System Performance page,
select View > Reorder Chart Sets and move charts up or down, or remove a
particular chart from the page.

5. To overlay another target, click Overlay, and select the target. The target is added
to the charts, so that you can view the performance of more than one target at a
time, comparing their performance.

Alternatively, you can display historical business metrics of the same product
instance. Select Overlay > Today with Yesterday, This Week with Last Week or
This Month with Last Month.

6. To customize the time frame shown by the charts, you can:

s Click Slider to display a slider tool that lets you specify that more or less time
is shown in the charts. For example, to show the past 10 minutes, instead of
the past 15 minutes, slide the left slider control to the right until it displays the
last 10 minutes.

s Click the Enter Time clock icon. Then, enter the Start Time and End Time, and
click OK. If there is no data available from the earlier time point, a
confirmation message displays, explaining the timeline will be automatically
adjusted to the time period for which the data is available.

7. To save the chart set so as to preserve a specific set of metrics selected for display,
as opposed to the default metrics, select View > Save Chart Set and enter a name
for the chart set to be saved.

Use the Fusion Applications Control online help to obtain a definition of a specific
performance metric. There are two ways to access this information:

= Browse or search for the metric in the Fusion Applications Control online help.

= Navigate to the Performance Summary page for your component or application
and perform the following;:

a. Click Show Metric Palette.

b. Browse the list of metrics available for the component or application to locate
a specific metric.

¢. Right-click the name of the metric and select Help from the context menu.

2.5.8 Understanding Users and Roles for Fusion Applications Control

To access Fusion Applications Control and perform tasks, you must have the
appropriate role. Fusion Applications Control uses the Oracle WebLogic Server
security realm and the roles defined in that realm. If a user is not granted one of these
roles, the user cannot access Fusion Applications Control.

Each role defines the type of access a user has. For example, a user with the role
Admin has full privileges. A user with the role Operator has privileges to perform
essential day-to-day operations. A user with the role Monitor has privileges only to
view the configuration.

For more information, see "Users, Groups, and Security Roles" in the Oracle Fusion
Middleware Securing Resources Using Roles and Policies for Oracle WebLogic Server.

2.6 Using Oracle WebLogic Server Administration Console

Oracle WebLogic Server Administration Console is a Web browser-based, graphical
user interface that you use to manage an Oracle WebLogic Server domain.
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While Fusion Applications Control is the primary administrative interface, use
Administration Console as specified by Table 2—4 and wherever recommended in
procedures in this guide.

The section contains the following topics:

Starting Oracle WebLogic Server Administration Console

Locking the WebLogic Server Configuration

2.6.1 Starting Oracle WebLogic Server Administration Console

To display Oracle WebLogic Server Administration Console for a given Oracle
WebLogic Server domain:

1.

Enter the URL in your Web browser:

http://product_rfamilyinternal.domain:port/em

where product_familyinternal.domain. port is the host and domain of the
Oracle HTTP Server or a Load Balancer.

During provisioning of Oracle Fusion Applications, on the Summary page of the
Provisioning Wizard, when you clicked Finish, you saved the plan and the
summary in a text document that summarizes the details of this plan. For more
information about using the Provisioning Wizard, see "Creating a Provisioning
Plan" in the Oracle Fusion Applications Installation Guide.

In the summary file, for the domain, find the Enterprise Manager Welcome Page
entry to locate the URL. For example:

CommonDomain
Admin Console
http://commoninternal .domain:7777/console

CRM Domain
Admin Console
http://crminternal .domain:7777/console

Financial Domain
Admin Console

http://fininternal.domain:7777/console

The login page displays.
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ORACLE
WebLogic Server® 11g

Administration Console

ORACLE WeblLogic Server® Administration Console

Welcome

Log in to work with the WebLogic Server domain

Username: | |

Password: |

Enter Oracle Fusion Middleware administrative user name and password, and
then click Login.

In an Oracle Fusion Applications installation, this user is the super user specified
on the Identity and Policy Management page of the Provisioning Wizard. See
"Identity and Policy Management Configuration" section in the Oracle Fusion
Applications Installation Guide for information about using the Identity and Policy
Management Configuration page and Section 4.8.5.2 to change the password.

The home page displays, as shown in the following figure:

Change Center
¥Yiew changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain.

| Lock & Edit

ﬁ Home Log Out Preferences [&d record Help ||:| Q.

Welcome, FAadmin |C0nnected to: CommonDomain
Home

Home Page

— Information and Resources

| Fieleaze Configuration

Helpful Tools General Information

£

£

Domain Structure

C
[

ormmonCanmain
tH-Environment
-~Deployments
t-Services
--Security Realms
tH-Tnkeroperahility
tH-Diagnostics

S--SipServer

= Configure applications = Common Administration Task Descriptions

= Configure Gridlink for RAC Data
Source

= Read the documentation

= Ask a question on My Oracle Support
S necertiackioralls = Oracle Guardian Overview

» Set your console preferences

= Oracle Enterprise Manager

~ Domain Configurations

How do I...

# Search the configuration
# Use the Change Center
+ Record WLST Scripts

Domain

= Damain

Environment

* Servers

Clusters

Wirtual Hosts

Migratable Targets

Coherence Servers

Services
= Messaging
m M3 Servers

Store-and-Forward
Agents

M3 Madules

Path Services

Bridges
+ [Data Sources

= Persistent Stores

Interoperability
= WTC Servers

* Jolt Connection Pools

Diagnostics

Log Files

Diagnostic Modules

Diagnostic Images

Request Performance

* Change Console preferences * Coherence Clusters 3 sumay * Archives
« Monitor servers * Machines il * Conkexk
RNy LA o e » XML Entity Caches . SHMP

Alternatively, you can access the Administration Console from Fusion
Applications Control, from the home pages of targets such as the Administration
Server or Managed Servers.
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2.6.2 Locking the WebLogic Server Configuration

Before you make configuration changes, lock the domain configuration, so you can
make changes to the configuration while preventing other accounts from making
changes during your edit session. To lock the domain configuration:

1. Locate the Change Center in the upper left of the Administration Console screen.
2. Click Lock & Edit to lock the configuration edit hierarchy for the domain.

As you make configuration changes using the Administration Console, you click Save
(or in some cases Finish) on the appropriate pages. This does not cause the changes to
take effect immediately. The changes take effect when you click Activate Changes in
the Change Center. At that point, the configuration changes are distributed to each of
the servers in the domain. If the changes are acceptable to each of the servers, then
they take effect. If any server cannot accept a change, then all of the changes are rolled
back from all of the servers in the domain. The changes are left in a pending state; you
can then either edit the pending changes to resolve the problem or revert to the
previous configuration.

2.7 Using Cloud Control

Cloud Control enables you to monitor runtime and historical data for the Oracle
Fusion applications, Oracle Fusion Middleware components, and Oracle Database
across the entire environment.

For an overview of Cloud Control, see the "Overview of Enterprise Manager Cloud
Control 12¢" chapter in Oracle Enterprise Manager Concepts.

Application Management Pack for Oracle Fusion Application is required to be licensed
with Oracle Fusion Applications, and must match the number of licenses for the
associated Oracle WebLogic Suite and Oracle WebLogic Suite for Oracle Fusion
Applications and Oracle SOA Suite for Oracle Middleware or Oracle SOA Suite for
Oracle Middleware for Oracle Fusion Applications. For more information about other
Oracle Enterprise Manager products that can be licensed with Oracle Fusion
Applications, see the Oracle Enterprise Manager Licensing Information.

The section contains the following topics:

s Starting Cloud Control and Discovering Oracle Fusion Applications Targets
=  Rediscovering Oracle Fusion Applications Targets

= Removing Oracle Fusion Applications Targets

= Navigating the Fusion Applications Target Home Page in Cloud Control

= Using Cloud Control Help

For specific uses of Cloud Control with an Oracle Fusion Applications environment,
see the following sections:

= Section 10.5, "Performing Proactive Performance Monitoring with Cloud Control"

»  Chapter 11, "Diagnosing the Oracle Fusion Applications Middle Tier Performance”

2.7.1 Starting Cloud Control and Discovering Oracle Fusion Applications Targets

To use Cloud Control, you need to separately install Oracle Enterprise Manager Cloud
Control 12¢ (12.1.0.2) with the Application Management Pack for Oracle Fusion
Applications. For more information about installing Cloud Control, see the Oracle
Enterprise Manager Cloud Control Basic Installation Guide.
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To display Cloud Control:

1.

Enter the URL in your Web browser:

http://oms_hostname.domain:port/em

where oms_hostname and oms_hostname are the host and port number of the
Oracle Management Service.

The login page displays.

Login

User Mame

Passward

Login

Enter the default super administrator account, SYSMAN, that is created with the
password you specified during the installation, and then click Login.

The home page displays. This page provides a high-level view of your entire
enterprise. For more information about this page, see Section 2.7.4 and click the
Help link at the top of the page.

Enable licenses according to your licensing agreement with Oracle.

For more information, access the Enterprise Manager documentation library at the
following URL and view the Oracle Enterprise Manager Licensing Information Guide:
http://www.oracle.com/technetwork/indexes/documentation/index
.html

To enable business metrics, perform the following prior to performing discovery:

a. Install the agent on the host where the specified Administration Server is
running.

b. Give the agent read access to all the files in the directory that contains the
jps-config-jse.xml file. The jps-config-jse.xml file is located in one of the
following directories:

(UNIX) DOMAIN_HOME/config/fmwconfig
(Windows) DOMAIN_HOME\config\fmwconfig

The agent must be installed a host that has NFS access to the domain home
directory using the path as would be used on the Administration Server host.
In addition, the agent user must have read access to this file.

Discover the Oracle Fusion Applications environment:
a. From the Targets menu, choose Fusion Applications.
b. Click Add Fusion Instance.
The Add Fusion Instance: Functional Setup wizard displays.

c. Enter the host name for the Administration Server for the CommonDomain is in
the Administration Server Host field.

d. Enter the Administration Server port in the Port field.
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e. In the Username and Password fields, enter the username and password for
the Administration Server.

f. Inthe Unique Fusion Instance Identifier, enter an intuitive name for the
Fusion Instance. This name will be used to identify the Fusion Instance
throughout Cloud Control. It must be unique and can include alphanumeric
as well as dash (-), underscore (_) or period (.) characters.

g. If the Fusion Instance is deployed within a secured Functional Setup Domain,
click Secured.

h. Enter the host name and port for the Management Agent that will enable
monitoring of the Fusion Instance targets. To search for an agent, click the icon
next to the Agent field. Local Agents deployed on the WebLogic Admin Server
host will be displayed first.

i. Click Next to complete the configuration.

2.7.2 Rediscovering Oracle Fusion Applications Targets

As you work with your Oracle Fusion Applications environment, you may add
additional targets through provisioning and scalability. When these types of changes
occur, you can refresh the instance to add the new components as targets within a
Fusion Instance already being managed by Cloud Control. You will typically do this
because you need to:

= Add anew product family that is part of an already managed Fusion Instance as
an additional target

= Add new instances within a product Family or an Oracle WebLogic Server domain
that is already being managed by Cloud Control as new targets

To re-discover Oracle Fusion Applications environment:
1. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.
2. From the table, choose the Fusion Instance you want to refresh.
3. From the Fusion Instance menu, choose Refresh Fusion Instance.

The Refresh Fusion Instance wizard opens, pre-populated with existing data for
the Fusion Instance.

4. Use the wizard to complete the refresh.

2.7.3 Removing Oracle Fusion Applications Targets

To re-discover the Oracle Fusion Applications environment:
1. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

2. From the table, choose the Fusion Instance, Product Family, or Product you want
to remove.

3. From the Fusion Instance, Product Family, or Product menu, choose Target Setup
> Remove Target.

4. Inthe Remove Target page, choose Yes to remove the target.

2-20 Oracle Fusion Applications Administrator's Guide



Using Cloud Control

2.7.4 Navigating the Fusion Applications Target Home Page in Cloud Control

Figure 2-3 shows the Fusion Applications target home page. This page displays the
instance as a whole, product families, and products, giving an aggregate status of
incidents and recent configuration changes.

Figure 2-3 Fusion Applications Target Home Page of Cloud Control

ORACLE Enterprise Manager Cloud Control 12¢ setup » Help~ | 18 egout O
&g Enterprise v () Targets ~ o Favorites » (@) History = Search Target Mame +
Fusion Applications Page Refreshed Oct 10, 2011 5:11:53 PM PDT (5
search [Name [=] ﬂ
View + | o Add Fusion Instance
Incidents Configuration
Name Type Database ° ‘ @| A | " Changes [‘Ija::s))' Patches Applied
7 (@ Fusionl Fusion Instance Fusionl 0 21 8 0 o a
I [&] Orade Fusion Financials Fusion Applications Financdials Product F 0 21 14 0 1]
=S @ Orade Fusion Finandials and Supply Chain Management Fusion Applications Finandals and Suppl... o0 2z 0 0
7 (@ Fusion2 Fusion Instance Fusion2 o 9 18 0 1} 0
1> b Oradle Fusion Applications Technology Fusion Applications ATF Product Family o 3 0 0 [t}
= @ Orade Fusion Common Fusion Applications Commen Product Fa... o1 0 0 1]
= é Orade Fusion Governance, Risk, and Compliance Fusion Applications GRC Product Family o1 0 0 1]
= & Qrade Fusion Incentive Compensation Fusion Applications IC Product Family o1 2 0 1]
= G Qrade Fusion Projects Fusion Applications Projects Product Fa... a 1 0 0 1]
[ @ QOradle Fusion Setup Fusion Applications SETUP Product Family o 7 0 0 1]
V(G Fusion3 Fusion Instance Fusion3 69 406 9 0 148 i}
[ -:%Orade Fusion Customer Relationship Management Fusion Applications CRM Product Family 032 3 0 18
[= Orade Fusion Finandials Fusion Applications Finandials Product F 221 0 0 53
= @ Orade Fusion Finandals and Supply Chain Management Fusion Applications Finandals and Suppl o o 0 0 8
= @ Orade Fusion Incentive Compensation Fusion Applications IC Product Family o o 0 0 12
[ = Orade Fusion Procurement Fusion Applications Procurement Produ... o o0 0 0 a

To access the Fusion Applications target home page in Cloud Control:
1. From the Targets menu, choose Fusion Applications.

The Fusion Applications target home page displays. The table on the page lists the
Fusion Instances, product families and products for the environment.

The Targets menu enables you to select the type of target you want to monitor. For
more information about the Middleware option, see Section 10.5.1.

2. View the current data reported for each target.

The Fusion Applications overview page displays a table of Fusion instances. You
can expand a given Fusion instance to display the Fusion Applications product
families deployed to that instance. Each Fusion Applications product family can
be expanded to display the applications within each product family. The following
information displays for each item in the table.

s Name: This column displays the name of the Fusion instance or Fusion
Applications product family.

s Type: This column indicates whether the item in the row is a Fusion instance,
a Fusion Applications product family or a product.

= Database: This column displays the name of the database to which the Fusion
instance is written.

= Incidents: This column displays incidents that have occurred within the scope
of each item in the table. Incidents are categorized in sub-columns from left to
right as follows: fatal, critical, warning and escalation level.
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s Configuration Changes (last 7 days): This column displays any configuration
changes to the given item in the row during the last seven days.

s Patches Applied: This column displays the number of software patches
applied to the Fusion instance.

The Fusion Applications overview page allows you to create and view Fusion
instances. Use the View menu to expand and collapse instances in the table. Click
the Add Instance button to add a Fusion instance as a managed target in Cloud
Control.

You can drill down to a Fusion instance, product family or product by clicking the
relevant item in the table.

From this page, you can also access the global operations for the enterprise from the
Enterprise menu:

Summary enables to view the aggregate status of all managed targets, giving a big
picture of system availability, alerts, and job status. Use this page to manage the
grid by exception. Even with hundreds of managed targets, this page enables you
to quickly detect and begin troubleshooting of problem areas without being
distracted by noncritical issues.

Monitoring provides options for global monitoring.

Job provides information about all scheduled, currently running, and past jobs. It
also enables you to display and manage jobs in the job library. The job library
allows users to share and re-use library jobs that have been created.

Reports enables you to manage all report definitions to which you have been
granted access.

Configuration enables you to manage configuration changes. For example, you
can compare configuration to track down updates.

Compliance enables you to view the policies for specific targets and obtain a
summary of all the policy violations in your enterprise.

Quality Management provide a complete testing solution for the Oracle Fusion
applications.

My Oracle Support provides access to software and patches.

2.7.5 Using Cloud Control Help

If you need information about the page or the use cases supported by a particular
functionality exposed by the page, then click the Help link on that page at the top of
the page. In most cases, the Help window displays a help topic about the current page.
Click Contents in the Help window to browse the list of help topics, or click Search to
search for a particular word or phrase

2.8 Using Oracle Fusion Functional Setup Manager

Oracle Fusion Functional Setup Manager guides you through the tasks of setting up
the functional data and reference data after installation and helps you move the setup
data from one environment to another (such as from the development environment to
the production environment).

To access the administrative area of Oracle Fusion Functional Setup Manager:

1.

Sign in to Oracle Fusion Applications with a user account that is provisioned with
the necessary role. Contact your security administrator for details.
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2. From the Administration menu in the work area of Oracle Fusion Applications,
choose Setup and Maintenance.

2.9 Using Database Tools to Modify Oracle Fusion Applications Data

Do not use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to
modify Oracle Fusion Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Fusion Applications data, you risk destroying the integrity
of your data and you lose the ability to audit changes to your data.

Because Oracle Fusion Applications tables are interrelated, any change you make
using an Oracle Fusion Applications form can update many tables at once. But when
you modify Oracle Fusion Applications data using anything other than Oracle Fusion
Applications, you may change a row in one table without making corresponding
changes in related tables.

If your tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Fusion
Applications.

When you use Oracle Fusion Applications to modify your data, Oracle Fusion
Applications automatically checks that your changes are valid. Oracle Fusion
Applicationsalso keeps track of who changes information. If you enter information
into database tables using database tools, you may store invalid information. You also
lose the ability to track who has changed your information because SQL*Plus and
other database tools do not keep a record of changes.
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3

Performing Routine Administrative Tasks

This chapter describes the common, essential tasks for administering your Oracle
Fusion Applications environment.

This chapter contains the following topics:
s Introduction to Performing Routine Administrative Tasks

= Running Administration Servers and Managed Servers from Shared and Local
Disks

= Starting and Stopping

= Viewing and Changing Ports for Components
»  Changing Passwords

»  Managing the Oracle Database

= Patching

= Managing Oracle Fusion Applications-Specific Labels in the Oracle Metadata
Repository

»  Modifying Oracle Application Development Framework Connections in Oracle
Fusion Applications

3.1 Introduction to Performing Routine Administrative Tasks

An important aspect of system administration of the Oracle Fusion Applications
environment is performing a range of maintenance life-cycle and management
operations. Section 1.3 provides a roadmap of when to perform these essential
administrative tasks. In addition to following this roadmap, if you run into
performance or security issues, then use the tasks in the chapter to maintain the
environment.

In addition to the tasks in this guide, refer to the following documentation for tasks
that you may need to perform, depending on your business needs:

»  Oracle Fusion Applications Common Implementation Guide for common setup and
maintenance tasks for Oracle Fusion applications

»  Oracle Fusion Applications Post-Installation Guide for configuration tasks to perform
after installation

»  Oracle Fusion Applications Administrator’s Troubleshooting Guide for common issues
in the runtime environment
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3.2 Running Administration Servers and Managed Servers from Shared
and Local Disks

Configuration for domains is stored centrally on a shared disk. This location is
accessible to all hosts, so the Administration Servers can run from this shared location.
Managed Servers can run from either the shared location or from a local disk, that is, a
non-network disk, visible only to the processes running on that host. During
provisioning of Oracle Fusion Applications, in the Installation Location page of the
Provisioning Wizard, you make this decision with the Enable Local Application
Configuration option. When you select this option, provisioning copies the domain
configuration from the shared server location to the specified local disk, and you run
the Managed Servers from the local disk. If you chose not to select this option, then all
the Managed Servers are configured to run from the shared disk. See the "Installation
Location" section in the Oracle Fusion Applications Installation Guide for information
about using the Installation Location page.

3.3 Starting and Stopping

You start and stop the Oracle Fusion Applications environment and its components to
perform a range of maintenance operations that require process downtime.
Understanding the state (that is, up, down, starting, and stopping) of each component
in the Oracle Fusion Applications environment is an essential activity when
diagnosing and resolving availability and performance issues, and when performing
life-cycle and management operations.

A typical Oracle Fusion Applications environment contains the applications, the
Oracle Database, and the Oracle Fusion Middleware components. Depending on
whether you need to start and stop an individual component or the entire
environment, there are many several supported scenarios for performing these
operations correctly.

This sections contains the following topics:

s Starting and Stopping Components in the Oracle Fusion Applications
Environment

s Starting and Stopping the Entire Oracle Fusion Applications Environment
s Understand the Starting and Stopping with the fastartstop Utility
s Starting and Stopping a Product Family Oracle WebLogic Server Domain

= Starting and Stopping an Oracle WebLogic Server Cluster in a Product Family for
a Configuration Change

s Starting and Stopping Specific Applications

3.3.1 Starting and Stopping Components in the Oracle Fusion Applications

Environment

For many of the Oracle Fusion Middleware components, you can start and stop in
different ways, depending on your requirements.

Table 3-1 describes the Oracle Fusion Applications, Oracle Fusion Middleware, and
Oracle Database components you can start and stop, and provides information on
where to find related documentation for each component.
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The procedures referenced in the Oracle Fusion Middleware guides describe using
Fusion Middleware Control. These procedure also apply to Fusion Applications

Control.
Table 3-1 Starting and Stopping
Component Description Documentation

Oracle Fusion Applications

Oracle Fusion
applications

You can start and stop applications
using the WLST command line, Fusion
Applications Control, Cloud Control, or
WebLogic Server Administration
Console.

Section 3.3.6, "Starting and Stopping Specific
Applications"

"Start applications and modules" and "Stop
applications and modules" in the Oracle Fusion
Middleware Oracle WebLogic Server Administration
Console Online Help for the WebLogic Server
Administration Console

Oracle Fusion Middleware

Administration
Server

The Administration server operates as
the central control entity for the
configuration of the entire Oracle
WebLogic Server domain. It maintains
the domain's configuration documents
and distributes changes in the
configuration documents to Managed
Servers. The Administration Server
serves as a central location from which
to manage and monitor all resources in
a domain.

You can use the fastartstop utility to
start all or specific Administration
Servers in all or specific domains for the
product families.

Section 3.3.3.1.4, "Task 4: Start the Administration
Servers and Managed Servers"

Section 3.3.3.2.4, "Task 4: Stop the Administration
Servers and Managed Server"

Managed Servers
for the Oracle
Fusion applications
and Oracle Fusion
Middleware
components

Managed Servers host Oracle Fusion
applications, application components,
Web services, and their associated
resources. Managed Servers also host
applications for the following Oracle
Fusion Middleware components:

»  Oracle Business Intelligence

s Oracle Data Integrator

= Oracle Enterprise Scheduler

= Oracle Secure Enterprise Search
=  Oracle SOA Suite

»  Oracle WebCenter Content

s Oracle WebCenter Content:
Imaging

s Oracle WebCenter Portal's
Discussion Server

= Oracle WebCenter Portal: Spaces

You can use the fastartstop utility to
start all or specific Administration
Servers and Managed Server in all or
specific domains. Alternatively, you can
use Fusion Applications Control or
WebLogic Server Administration.

Section 3.3.3.1.4, "Task 4: Start the Administration
Servers and Managed Servers"

Section 3.3.3.2.4, "Task 4: Stop the Administration
Servers and Managed Server"
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Table 3-1 (Cont.) Starting and Stopping

Component Description

Documentation

Node Manager Node Manager is an Oracle WebLogic
Server utility that enables you to start,
shut down, and restart the
Administration Servers and the
Managed Server instances.

On Windows, Node Manager is
configured to automatically start by
default.

"Starting Node Manager" section in the Oracle
Fusion Middleware Node Manager Administrator’s
Guide for Oracle WebLogic Server

Section 3.3.3.1.3, "Task 3: Start Node Manager"

Oracle Business You can use Fusion Applications

Intelligence Suite Control or the opmnctl command to
start and stop Oracle Business
Intelligence system components.

You can use the fastartstop utility to
start and stop the BI Presentation Server
component.

"Starting and Stopping Oracle Business
Intelligence" chapter in the Oracle Fusion
Middleware System Administrator’s Guide for Oracle
Business Intelligence Enterprise Edition

Oracle Enterprise ~ You can use Fusion Applications
Scheduler Control to start and stop the Oracle
Enterprise Scheduler.

Section 5.7, "Starting and Stopping Oracle
Enterprise Scheduler Service Components"

Oracle HTTP Server You can use Fusion Applications
Control or the opmnctl command to
start and stop Oracle HTTP Server.

"Starting, Stopping, and Restarting Oracle HTTP
Server" section in the Oracle Fusion Middleware
Administrator’s Guide for Oracle HT'TP Server

Oracle SOA Suite You can use Fusion Applications
Control to start and stop the SOA
Infrastructure and the Managed Servers
for Oracle SOA Suite.

"Stopping and Starting the Managed Server and
SOA Infrastructure" section in the Oracle Fusion
Middleware Administrator’s Guide for Oracle SOA
Suite and Oracle Business Process Management Suite

Oracle WebCenter ~ Always ensure Content Server is

Portal: Spaces running when starting Oracle
WebCenter Portal: Spaces. If Content
Server is not running when Spaces is
started up Spaces will consider the
Document service as unavailable. After
Content Server is started, a restart of
Spaces is needed for it to recheck if the
Document service is configured.

"Starting Content Server" section in the Oracle
WebCenter Content System Administrator’s Guide for
Content Server

"Starting and Stopping the Spaces Application”
section in the Oracle WebCenter Content System
Administrator’s Guide for Content Server

Oracle WebLogic When applying a patch that only

Server domain for a applies to one product family, stop the

product family Oracle WebLogic Server domain for the
product family and restart it after you
apply the patch without stopping the
entire Oracle Fusion Applications
environment.

Use the fastartstop utility for this task.
You can alternatively use Fusion
Applications Control.

Section 3.3.4, "Starting and Stopping a Product
Family Oracle WebLogic Server Domain"
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Table 3-1 (Cont.) Starting and Stopping

Component Description Documentation

Oracle WebLogic If you modify the Oracle WebLogic Section 3.3.5, "Starting and Stopping an Oracle
Server cluster fora Server configuration, you must stop and WebLogic Server Cluster in a Product Family for a
product family restart the cluster for the configuration =~ Configuration Change"

changes to take effect.

Use the fastartstop utility for this task.
You can alternatively use Fusion
Applications Control and WebLogic
Server Administration Console.

Oracle Database

Oracle Database

You can start and stop the Oracle "Accessing the Database Home Page" section in
database with the Oracle Enterprise the Oracle Database 2 Day DBA
Manager Database Control.

3.3.2 Understand the Starting and Stopping with the fastartstop Utility

The fastartstop script is installed with the Oracle Fusion Applications patching
framework. After installation, the registry file for each product family is populated
with Oracle WebLogic Server domain entries for all product families, including the
Oracle Fusion Applications Common Domain in the Oracle Fusion Setup product
family. You can use this utility to start all the domains or a select domain. When the
fastartstop utility is used to start a domain, all the Managed Servers will be started
and the Administration Server of the domain will be stopped after all the Managed
Servers have been started. The fastartstop utility requires Node Manager to run.

While the utility starts and stops the domains, it does not start and stop Oracle HTTP
Server, Oracle Identity Management, and the Oracle Database. Therefore, you must
start these components separately.

This section contains the following topics:
» fastartstop Syntax
» fastartstop Examples

= Registry Entries

3.3.2.1 fastartstop Syntax

If the Oracle Fusion Applications patching framework was installed, the fastartstop
utility is available from the following directories:

(UNIX) FA ORACLE_HOME/lcm/ad/bin
(Windows) FA_ORACLE_HOME\lcm\ad\bin

FA_ORACLE_HOME is a directory named applications, located under the fusionapps
Oracle Fusion Applications Middleware home.

(UNIX) ./fastartstop.sh -Start|-Stop|-Bounce|-StartBIPS|-StopBIPS
-all|-domains domain_name, domain_nameN, domain nameN|-BIPServerComponents
—all|—domains domain_name\(server:all,server:managed_server_name|AdminServer\),
domain_name\ (server:all, server:managed_server.
name|AdminServer\) | -BIPServerComponents

[-clusterType soal

-username user._name

-appbase APPLICATIONS_BASE

[-setup setup_details.xml_file_location]

[-loglevel Iog level]

[-timeout timeout_period]

Performing Routine Administrative Tasks 3-5



Starting and Stopping

[--help]

(Windows) .\fastartstop.cmd -Start|-Stop|-Bounce|-StartBIPS|-StopBIPS
-all | -domains domain_name, domain_nameN, domain_nameN| -BIPServerComponents
-all | -domains domain_name" (server:all, server:managed_server_name|AdminServer) ",
domain_name" (server:all, server:managed_server.

name|AdminServer) " | -BIPServerComponents

[-clusterType soal

-username user._name

-appbase APPLICATIONS BASE

[-setup setup details.xml_file_location]

[-loglevel Iog level]

[-timeout timeout_period]

[--help]

Table 3-2 describes the options for the fastartstop script.

Table 3-2 Options for the fastartstop Script

Options Description

-Start|Stop|Bounce|-Star Specify the operation to execute:
tBIPS|-StopBIPS s Use -Start to start Managed Servers.

s Use -Stop to stop Managed Servers.

s Use -Bounce to restart Managed Servers.

= Use -StartBIPS to start only the BI Presentation Server.

= Use -StopBIPS to stop only the BI Presentation Server.

-all|-domains|-BIPServer Specify what to start, stop, or restart:

Components s Use -all for all domains.

= Use -domains for specific domains and Managed Servers
and Administration Server within the domains. Delineate
the domain names with a comma and space (domain_name,
domain_name).

s Use -BIPServerComponents for BI Presentation Server
components. This option should be used only in conjunction
with the -StartBIPS or -StopBIPS option.

= Use suboption server to specify the Administration Server
or Managed Servers for the domains you want to start, stop,
or bounce. Use a backslash (\) before each of the parenthesis
on UNIX, \ (server:all, server:managed_server.
name|AdminServer\), and use quotes (") before and after
the parenthesis on Windows,
"(server:all, server:managed_server.
name|AdminServer) ".

This -domains option is mutually exclusive to the following
options:

. -startAdminServer
u -clusterType
n -adminServersOnly

You cannot include these options in the same fastartstop
command as the -domains options.

If you use the server suboption for one domain, you must use it
for all domains. Example 3-23 shows a mix, which would
generate an error.
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Table 3-2 (Cont.) Options for the fastartstop Script

Options Description

-clusterType Specify to start, stop, or restart Managed Servers within a
cluster. This parameter is currently only supported for Oracle
SOA Suite clusters (soa).

This option is mutually exclusive to the server suboption of the
-domain option. You cannot include this option in the same
fastartstop command as the server suboption.

This option is mutually exclusive to the following options:
. -adminServersOnly
= server suboption of the -domains option

You cannot include the -clusterType option in the same
fastartstop command as these options.

-username Specify the Oracle Fusion Middleware administration user.
-appbase Specify the path for the Oracle Fusion Applications installation.
-adminServersOnly Use to start, stop, or restart the Administration Servers only,

leaving the Managed Servers untouched.

This option is mutually exclusive to the following options:
m -startAdminServer

n -clusterType

= server suboption of the -domains option

You cannot include the -adminServersOnly option in the same
fastartstop command as these options.

When used with Bounce, fastartstop performs a restart for
Administration Servers. If some Administration Servers fail
during the Bounce command, in next run, failed servers will be
acted upon. The servers bounced successfully in the previous
runs will be skipped in the next run.

-startAdminServer Specify true to start the Administration Server; specify false to
stop the Administration Server. The default is false.

This option is mutually exclusive to the following options:
. -adminServersOnly
= server suboption of the -domains option

You cannot include the -startAdminServer option in the same
fastartstop command as these options.

--help Specify to display the syntax.

-setup Specify the location of the SetupDetails.xml file. If this
parameter is not specified, then the following defaults are used:

(UNIX) FA_ORACLE_HOME/admin
(Windows) FA_ORACLE_HOME\admin
FA_ORACLE_HOME is a directory named applications, located

under the fusionapps Oracle Fusion Applications Middleware
home.

-loglevel Specify the log level for the fastartstop.log file:
= INFO: Provides informational messages.
= FINER: Provides detailed log messages.
= WARNING: Provides messages for potentially problems.
INFO is the default.
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Table 3-2 (Cont.) Options for the fastartstop Script

Options Description

-timeout Specify the timeout in seconds for the utility to run.

The utility prompts you for the Oracle Fusion Middleware administration user. See
Section 4.8.5.2 for more information about changing this password.

The fastartstop utility generates fastartstop.log in the following subdirectories:

(UNIX) FA_ORACLE _HOME/lcm/ad/bin
(Windows) FA_ORACLE_HOME\lcm\ad\bin

FA_ORACLE_HOME is a directory named applications, located under the fusionapps
Oracle Fusion Applications Middleware home.

3.3.2.2 fastartstop Examples

The following examples provide syntax examples for common scenarios:
= Starting Examples with fastartstop

= Stopping Examples with fastartstop

= Bouncing Examples with fastartstop

= Starting and Stopping Bl Presentation Server

= Using the AdminServersOnly Option with fastartstop

= Using Combination Commands with fastartstop

3.3.2.2.1 Starting Examples with fastartstop

Example 3-1 shows starting the Administration Server and all the Managed Servers in
the SCMDomain domain.

Example 3-1 Syntax Sample to Start the Administration Server and All Managed Servers
in a Single Domain

./fastartstop.sh -Start -domains SCMDomain\ (server:all\) -username FAAdmin
-appbase /scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-2 shows starting the Administration Server and the soa_serverl Managed
Server in the SCMDomain domain.

Example 3-2 Syntax to Start the Administration Server and Another Managed Server in
a Single Domain

./fastartstop.sh -Bounce -domains SCMDomain)\ (server:AdminServer, server:soa_
serverl\) -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-3 shows starting Managed Servers soa_serverl and
AdvancedPlanningServer_1 in the SCMDomain domain.

Example 3-3 Syntax to Start Multiple Managed Servers in a Single Domain

./fastartstop.sh -Start -domains SCMDomain\ (server:soa_
server, server :AdvancedPlanningServer_1\) -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER
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Example 3—4 shows starting Managed Servers soa_serverl and
AdvancedPlanningServer_1 in the SCMDomain domain and soa_server from the
HCMDomain domain.

Example 3—-4 Syntax to Start Multiple Managed Servers in Multiple Domains

./fastartstop.sh -Start -domains SCMDomain\ (server:soa_
server, server :AdvancedPlanningServer_1\),HCMDomain\ (server:soa_server\) -username
FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-5 shows starting all the Managed Servers and the Administration Server in
the HCMDomain domain.

Example 3-5 Syntax to Start the Managed Servers and Administration Server in the SOA
Cluster of a Single Domain

fastartstop.sh -Start -domains HCMDomain -username username
appbase /scratch/aimel/appltop/fusionapps/applications
-clusterType soa -startAdminServer true

Example 3-6 shows starting the CommonDomain domain. Starting a domain starts its
Managed Servers and Administration Server.

Example 3-6 Syntax to Start a Specific Domain

./fastartstop.sh -Start -domains CommonDomain -username FUSION_APPS_PROV_PATCH_
APPID -appbase /slot/ems7770/oracle/apphome/fusionapps/applications

Example 3-7 shows starting all the domains. Starting a domain includes starting its
Managed Servers and Administration Server.

Example 3-7 Syntax to Start All Domains

./fastartstop.sh -Start -all -username FUSION_APPS_PROV_PATCH_APPID -appbase
/slot/ems7770/oracle/apphome/fusionapps/applications

Example 3-8 shows starting multiple domains. Starting domains starts all the
Managed Servers and Administration Server for each product family domain.

Example 3-8 Syntax to Start Multiple Domains

/fastartstop.sh -Start -domains HCMDomain,BIDomain, ProjectsDomain -username
FUSION_APPS_PROV_PATCH_APPID -appbase
/scratch/aime/V1HCM/APPTOP/fusionapps/applications -startAdminServer true
-clusterType soa

3.3.2.2.2 Stopping Examples with fastartstop

Example 3-9 shows stopping the Administration Server and all the Managed Servers
in the SCMDomain domain.

Example 3-9 Syntax to Stop the Administration Server and All Managed Servers in a
Single Domain

./fastartstop.sh -Stop -domains SCMDomain\ (server:all\) -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-10 shows stopping Managed Servers soa_serverl and
AdvancedPlanningServer_1 in the SCMDomain domain.
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Example 3-10 Syntax to Stop Multiple Managed Servers in a Single Domain
./fastartstop.sh - Stop -domains SCMDomain\ (server:soa_

server, server :AdvancedPlanningServer_1\) -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-11 shows stopping Managed Servers soa_serverl and
AdvancedPlanningServer_1 in the SCMDomain domain and soa_server in the
HCMDomain domain.

Example 3—-11 Syntax to Stop Multiple Managed Servers in Multiple Domains

./fastartstop.sh - Stop -domains SCMDomain\ (server:soa_

server, server :AdvancedPlanningServer_1\), HCMDomain\ (server:soa_server)\)
-username FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications
-loglevel FINER

Example 3-12 shows stopping the CommonDomain domain. Stopping a domain stops its
Managed Servers and Administration Server.

Example 3-12 Syntax to Stop a Specific Domain

./fastartstop.sh -Stop -domains CommonDomain -username FUSION_APPS_PROV_PATCH_
APPID -appbase /slot/ems7770/oracle/apphome/fusionapps/applications

Example 3-13 shows stopping all the product family domains. Stopping a domain
stops its Managed Servers and Administration Server.

Example 3-13 Syntax to Stop All Domains

./fastartstop.sh -Stop -all -username FUSION_APPS_PROV_PATCH_APPID -appbase
/slot/ems7770/oracle/apphome/fusionapps/applications

Example 3-14 shows stopping multiple domains. Stopping domains stops all the
Managed Servers and Administration Server for each product family domain.

Example 3-14 Syntax to Stop Multiple Domains

./fastartstop.sh -Stop -domains HCMDomain,BIDomain, ProjectsDomain -username
FUSION_APPS_PROV_PATCH_APPID -appbase
/scratch/aime/V1HCM/APPTOP/fusionapps/applications -startAdminServer true
-clusterType soa

3.3.2.2.3 Bouncing Examples with fastartstop

Example 3-15 shows restarting the Administration Server and all the Managed Servers
in the SCMDomain domain.

Example 3-15 Syntax to Bounce the Administration Server and All Managed Servers in
a Single Domain

./fastartstop.sh -Bounce -domains SCMDomain (server:all) -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-16 shows restarting Managed Servers soa_serverl and
AdvancedPlanningServer_1 in the SCMDomain domain.

Example 3-16 Syntax to Bounce Multiple Managed Servers in a Single Domain

./fastartstop.sh - Bounce -domains SCMDomain\ (server:soa_
server, server :AdvancedPlanningServer_1\) -username FAAdmin -appbase
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/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-17 shows restarting Managed Servers soa_serverl and
AdvancedPlanningServer_1 in the SCMDomain domain and soa_server in the
HCMDomain domain.

Example 3—17 Syntax to Bounce Multiple Managed Servers in Multiple Domains

./fastartstop.sh - Bounce -domains SCMDomain\ (server:soa_
server, server:AdvancedPlanningServer_1\),HCMDomain\ (server:soa_server\) -username
FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-18 shows restarting the CommonDomain domain. Restarting a domains
restarts the Managed Servers and Administration Server in the domain.

Example 3-18 Syntax to Bounce a Specific Domain

./fastartstop.sh -Bounce -domains CommonDomain -username FUSION_APPS_PROV_PATCH_
APPID -appbase /slot/ems7770/oracle/apphome/fusionapps/applications

3.3.2.2.4 Starting and Stopping Bl Presentation Server

Example 3-19 shows starting the BI Presentation Server.

Example 3-19 Syntax to Start the Bl Presentation Server

./fastartstop.sh -StartBIPS -BIPServerComponents -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

Example 3-20 shows stopping the BI Presentation Server.

Example 3-20 Syntax to Stop the Bl Presentation Server

./fastartstop.sh -StopBIPS -BIPServerComponents -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER

3.3.2.2.5 Using the AdminServersOnly Option with fastartstop

Example 3-21 Syntax to Restart all the Administration Servers

./fastartstop.sh -Bounce -all -username FAAdmin -appbase
/scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER
-adminServersOnly

3.3.2.2.6 Using Combination Commands with fastartstop

If the server suboption is set to all and another Managed Server or Administration
Server with the -domain option (Example 3-23), all will take precedence and all
servers will be processed.

Example 3-22 Syntax with Contradicting server Suboption Settings

./fastartstop.sh -Bounce -domains SCMDomain\ (server:all, server:soa_serverl)\)
-username FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications
-loglevel FINER

If you use the server suboption for one domain, you must use it for all domains. In

addition, you cannot use the server suboption with the -adminServersOnly option.
Example 3-23 shows server:all for the SCMDomain domain, but not for the HCMDomain
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domain. It also shows the -adminServersOnly option in combination with the server
suboption. This syntax would generate an error.

Example 3-23 Syntax with server Suboption Settings Not Consistently Used

./fastartstop.sh -Start|Stop|Bounce -domains SCMDomain\ (server:all\),HCMDomain
-username FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications
-loglevel FINER -adminServersOnly

If the server suboption of the -domains option is used, the following options cannot
be used:

m -startAdminServer
m -clusterType
s -adminServersOnly

Example 3-24 shows incorrect combinations of these commands. If these examples are
entered, you would see error messages.

Example 3-24 Sample Syntax with Contradicting server Suboption Settings
./fastartstop.sh —Start|Stop|Bounce -domains SCMDomain\ (server:all\) -username

FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER
-clusterType SOA

./fastartstop.sh -Start|Stop|Bounce -domains SCMDomain\ (server:alll) -username
FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER
-startAdminServer true

./fastartstop.sh -Start|Stop|Bounce -domains SCMDomain (server:all) -username
FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications -loglevel FINER
-adminServersOnly

./fastartstop.sh —Start|Stop|Bounce -domains SCMDomain\ (server:all\),HCMDomain
-username FAAdmin -appbase /scratch/aime/work/APPTOP/fusionapps/applications
-loglevel FINER -adminServersOnly

3.3.2.3 Registry Entries

Example 3-25 shows the format of a typical entry in the SetupDetails.xml. It is
populated with the CommonDomain domains details. The other domains are not
represented, because they are automatically read from the API. The file contains
Oracle WebLogic Server domain information, including the Administration Server, the
Managed Servers, and Node Manager.

Example 3-25 Registry File Format

<ServerInfo DomainName="CommonDomain" DomainType="CommonDomain"
ServerHostName="host_name AdminServerName="AdminServer" AdminPort="port"
DomainRootDir="DOMAIN HOME" NodeManagerHost="host_name"
NodeManagerPort="port"/>

3.3.3 Starting and Stopping the Entire Oracle Fusion Applications Environment

Some components in the Oracle Fusion Applications environment dependent on one
another. Therefore, it is important to start and stop components in the proper order. In
the course of normal IT operations, common operations include shutting down
computers and starting them back up. Therefore, it is crucial to start and stop Oracle
Fusion Applications in a sequential manner.
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This section contains the following topics:
s Starting an Oracle Fusion Applications Environment

= Stopping an Oracle Fusion Applications Environment

3.3.3.1 Starting an Oracle Fusion Applications Environment

To perform a complete start of the Oracle Fusion Applications environment, you must
start the Oracle WebLogic Server domain for the Oracle Fusion Setup product family
before the domains for the other product families.

Applications may not work correctly until all the Managed Servers in all domains
have been started.

The section contains the following topics for performing a complete start of the Oracle
Fusion Applications environment:

s Task 1: Start the Oracle Database

s Task 2: Start the Oracle Identity Management Suite

s Task 3: Start Node Manager

s Task 4: Start the Administration Servers and Managed Servers
s Task 5: Start Oracle Business Intelligence

s Task 6: Start the Oracle HTTP Server

3.3.3.1.1 Task 1: Start the Oracle Database
To start the Oracle database instance using Oracle Database Control:
1. Go to the Database Home page.

For information about how to access the Database Home page in Oracle Enterprise
Manager, see "Accessing the Database Home Page" section in the Oracle Database 2
Day DBA.

2. In the Database Home page, click Startup.
The Startup /Shutdown Credentials page appears.
3. Enter credentials as follows:

a. Enter the host computer credentials of the user who installed Oracle Database,
or of any user who is authorized to use SQL*Plus.

b. Enter the database credentials consisting of the user name SYS and the
password that you assigned to SYS during the installation.

c. From the Connect As list, select SYSOPER.
4. Click OK.

A confirmation page appears.
5. Click Yes.

The Startup page appears, indicating that the database is being started up. When
startup is complete, the Login page appears.

6. Log in to the database.

The Database Home page appears indicating that the database instance status is
Up.
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For information about shutting down and starting up the Oracle database instance, see
the "Shutting Down and Starting Up the Oracle Instance" section in the Oracle Database
2 Day DBA.

3.3.3.1.2 Task 2: Start the Oracle Identity Management Suite

To start the Oracle Identity Management system components:

1. Setthe ORACLE_HOME environment variable to the Oracle home for the Oracle
Identity Management components.

2. Start Oracle Process Manager and Notification Server (OPMN) and all system
components:

opmnctl startall

3.3.3.1.3 Task 3: Start Node Manager

Each host has its own copy of the Node Manager and all the Node Managers should
be running before attempting to start any Administration Servers or Managed Servers.

Start Node Manager for each of the hosts for which you want to start the
Administration Servers:

1. Set the JAVA_OPTIONS environment variable:

setenv JAVA_OPTIONS "${JAVA_OPTIONS} -Dserver.group=AdminServer"

2. Set the WLST_PROPERTIES environment variable:

setenv WLST_PROPERTIES "-Dweblogic.security.SSL.trustedCAKeyStore=WL,_
HOME/server/lib/fusion_trust.jks"

where WL_HOME is the Oracle WebLogic Server home directory under the
fusionapps Middleware subdirectory.

3. Start Node Manager with the startNodeManagerWrapper utility from the Oracle
WebLogic Server home directory under the fusionapps Middleware subdirectory:

(UNIX) WL_HOME/nodemanager/host_name/startNodeManagerWrapper.sh
(Windows) WIL_HOME\nodemanager\host_name\startNodeManagerWrapper .cmd

4. For all the hosts, verify that Node Manager is running. For example, on UNIX
platforms, enter the following command:

netstat -a|grep 5556

The 5556 port should be in a listening state. If your environment uses a different
port, then use the port number in the System Port Allocation page during the
creation of a provisioning plan. See the "System Port Allocation" section in the
Oracle Fusion Applications Administrator’s Guide.

3.3.3.1.4 Task 4: Start the Administration Servers and Managed Servers

You must start the Oracle WebLogic Server Administration Server for the
CommonDomain domain in the Oracle Fusion Setup product family from a shared disk.
The applications and other product families depend on topology information in the
Administration Server in the Oracle Fusion Setup product family. For more
information about running the Administration Server and Managed Servers from a
shared location, see Section 3.2.

Optionally, if you need to perform administration tasks for other product families,
start the Administration Server for those product families.
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When you start an Administration Server, you also start the applications that run on
the Administration Server, including the WebLogic Server Administration Console
and Fusion Applications Control.

To start the Administration Servers and Managed Servers:

1.

At an operating system command prompt, navigate to the location of the
fastartstop script:

(UNIX) FA_ORACLE_HOME/lcm/ad/bin
(Windows) FA ORACLE_HOME\lcm\ad\bin

FA_ORACLE_HOME s a directory named applications, located under the fusionapps
Oracle Fusion Applications Middleware home.

From the shared host location, run the fastartstop utility to start the
Administration Servers and the Managed Servers:

To start only Administration Servers, use either the -adminServersOnly option
or the -startAdminSever option. Use the -all option to start the
Administration Servers for all the domain or the -domains option to start the
Administration Server for specific domains.

fastartstop.sh/fastartstop.cmd -Start

-a11|-domains domain_name, domain_nameN, domain nameN
-username user._name

-appbase APPLLICATIONS BASE

-adminServersOnly

[-setup setup details.xml_file location]

[-loglevel Iog level]

[-timeout timeout_period]

fastartstop.sh/fastartstop.cmd -Start

-all|-domains domain_name, domain_nameN, domain_nameN
-username user._name

-appbase APPLLICATIONS_ BASE

-startAdminServer true

[-setup setup details.xml_file_location]

[-loglevel log level]

[-timeout timeout_period]

fastartstop.sh/fastartstop.cmd -Start

-all|-domains domain name(server:AdminServer), domain_
name (server :AdminServer)

-username user._name

-appbase APPLLICATIONS BASE

[-setup setup details.xml_file location]

[-loglevel Iog level]

[-timeout timeout_period]

Use a backslash (\) before each of the parenthesis on UNIX,
\ (server:all, server:AdminServer\), and use quotes (") before and after the
parenthesis on Windows, " (server:AdminServer) ".

To start only the Managed Servers, use the -domains option with the server
suboption to specify the Managed Servers to start:

fastartstop.sh/fastartstop.cmd -Start

-domains domain_name(server:managed server_ name,server:managed_server.
name), domain_name(server:managed_server_name,Server:managed_server._name)
-username user._name

-appbase APPLICATIONS BASE
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[-setup setup_details.xml_file_location]
[-loglevel log_level]
[-timeout timeout_period]

Use a backslash (\) before each of the parenthesis on UNIX,

\ (server:managed_server name, server:managed_server_name\), and use
quotes (") before and after the parenthesis on Windows,

"(server:all, server:managed_server._name)".

= To start the Administration Servers and Managed Servers in one fastartstop
command, use the -all option to start the Administration Servers and
Managed Servers for all the domains or the -domains option with the
server:all suboption to start the servers for specific domains.

fastartstop.sh/fastartstop.cmd -Start

-all\-domains domain_name, domain_nameN, domain_nameN
-username user_name

-appbase APPLICATIONS_BASE

[-setup setup details.xml_file location]

[-loglevel log level]

[-timeout timeout_period]

fastartstop.sh/fastartstop.cmd -Start

-all\—domains domain_name (server:all), domain_name(server:all)
-username user._name

-appbase APPLICATIONS_ BASE

[-setup setup details.xml_file location]

[-loglevel log level]

[-timeout timeout_period]

Use a backslash (\) before each of the parenthesis on UNIX, \ (server:all\),
and use quotes (") before and after the parenthesis on Windows,
"(server:all)".

For more information about the fastartstop syntax, see Table 3-2.

Note: Do not use the following Oracle WebLogic Server scripts to
start the Administration Servers:

(UNIX) DOMAIN_HOME/bin/startWebLogic.sh
(Windows) DOMAIN_HOME\bin\startWebLogic.cmd

Starting Managed Servers with Fusion Applications Control

If you are working on a specific domain in Fusion Applications Control, you can also
start the Managed Servers for that domain.

To start the Managed Servers for a specific domain with Fusion Applications Control:
1. From the navigation pane, expand the farm, WebLogic Domain.

2. From the WebLogic Domain menu, choose Control, then Start Up.

Starting Managed Servers with WebLogic Server Administration Console

If you prefer to use the WebLogic Server Administration Console instead of Fusion
Applications Control, see "Start Managed Servers from the Administration Console"
and "Start Managed Servers in a cluster" in the Oracle Fusion Middleware Oracle
WebLogic Server Administration Console Online Help.
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3.3.3.1.5 Task 5: Start Oracle Business Intelligence See "Starting and Stopping Oracle
Business Intelligence" in the Oracle Fusion Middleware System Administrator’s Guide for
Oracle Business Intelligence Enterprise Edition.

3.3.3.1.6 Task 6: Start the Oracle HTTP Server

To start the Oracle HTTP Server using opmnct1:

(UNIX) WT_CONFIG_HOME/bin/opmnctl startproc process-type=0HS
(Windows) WT_CONFIG_HOME\bin\opmnctl startproc process-type=0HS

To start Oracle HTTP Server using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Web Tier installation
type.
2. Select the Oracle HTTP Server.

3. From the Oracle HTTP Server menu, choose Control, then Start Up.

3.3.3.2 Stopping an Oracle Fusion Applications Environment

You can follow these procedures when you need to completely shut down the Oracle
Fusion Applications environment. For example, when preparing to perform a
complete backup of your environment, or apply a patch.

The section contains the following topics for performing a complete stop of the Oracle
Fusion Applications environment:

»  Task 1: Stop the Oracle HTTP Server

»  Task 2: Stop Oracle Business Intelligence

»  Task 3: Stop the Oracle Identity Management Suite

s Task 4: Stop the Administration Servers and Managed Server

»  Task 5: Stop the Oracle Database

3.3.3.2.1 Task 1: Stop the Oracle HTTP Server
To stop the Oracle HTTP Server using opmnctl:

(UNIX) WT_CONFIG_HOME/bin/opmnctl stopproc process-type=0HS
(Windows) WT_CONFIG_HOME\bin\opmnctl stopproc process-type=0HS

To stop the Oracle HTTP Server using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Web Tier installation
type.
2. Select the Oracle HTTP Server.

3. From the Oracle HTTP Server menu, choose Control, then Shut Down.

3.3.3.2.2 Task 2: Stop Oracle Business Intelligence

See "Starting and Stopping Oracle Business Intelligence" in the Oracle Fusion
Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise
Edition.

3.3.3.2.3 Task 3: Stop the Oracle Identity Management Suite

To stop the Oracle Identity Management system components:
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1. Set the ORACLE_HOME environment variable to the Oracle home for the Identity
Management components.

2. Start OPMN and all system components:

opmnctl stopall

3.3.3.24 Task 4: Stop the Administration Servers and Managed Server

When stopping the Oracle Fusion Applications environment, stop the Administration
Server for the product families other than the Oracle Fusion Setup product family first,
and then stop the Administration Server for the Oracle Fusion Setup product family.
The applications and other product families depend on topology information in the
Administration Server in the Oracle Fusion Setup product family. Therefore, you need
to stop the Administration Server in the Oracle Fusion Setup product family after the
other product families. You stop the Administration Servers from a shared disk.

When you start the Administration Server, you also start the applications that run on
the Administration Server, including the WebLogic Server Administration Console
and Fusion Applications Control.

To start the Administration Servers and Managed Servers:

1. At an operating system command prompt, navigate to the location of the
fastartstop script:

(UNIX) FA_ORACLE_HOME/lcm/ad/bin
(Windows) FA_ORACLE_HOME\lcm\ad\bin

FA_ORACLE_HOME s a directory named applications, located under the fusionapps
Oracle Fusion Applications Middleware home.

2. From the shared host location, run the fastartstop utility to stop the
Administration Servers and the Managed Servers:

= To stop only Administration Servers, use either the -adminServersOnly option
or the -startAdminSever option. Use the -all option to stop the
Administration Servers for all the domain or the -domains option to stop the
Administration Server for specific domains.

fastartstop.sh/fastartstop.cmd -Stop

-a11|-domains domain _name, domain_nameN, domain nameN
-username user._name

-appbase APPLLICATIONS_ BASE

-adminServersOnly

[-setup setup details.xml_file_location]

[-loglevel Iog level]

[-timeout timeout_period]

fastartstop.sh/fastartstop.cmd -Stop

-all|-domains domain_name, domain_nameN, domain_nameN
-username user._name

-appbase APPLLICATIONS BASE

-startAdminServer false

[-setup setup _details.xml_file location]

[-loglevel log level]

[-timeout timeout_period]

fastartstop.sh/fastartstop.cmd -Stop

-all|-domains domain name(server:AdminServer), domain_
name (server:AdminServer)

-username user._name
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-appbase APPLLICATIONS BASE

[-setup setup details.xml_file location]
[-loglevel Iog level]

[-timeout timeout_period]

For the server suboption, use a backslash (\) before each of the parenthesis
on UNIX, \ (server:AdminServer\), and use quotes (") before and after the
parenthesis on Windows, " (server:AdminServer) ".

= To stop only the Managed Servers, use the -domains option with the server
suboption to specify the Managed Servers to stop:

fastartstop.sh/fastartstop.cmd -Stop

-domains domain_name(server:managed server_name,server:managed_server.
name), domain_name(server:managed_server_name,Server:managed_server._name)
-username user._name

-appbase APPLICATIONS_ BASE

[-setup setup details.xml_file_location]

[-loglevel Iog level]

[-timeout timeout_period]

For the server suboption, use a backslash (\) before each of the parenthesis
on UNIX, \ (server:managed_server, server:managed_server\) and use
quotes (") before and after the parenthesis on Windows, " (server : managed_
server, server:managed_server)".

= To stop the Administration Servers and Managed Servers in one fastartstop
command, use the -all option to stop the Administration Servers and
Managed Servers for all the domains or the -domains option with the
server:all suboption to stop the servers for specific domains.

fastartstop.sh/fastartstop.cmd -Stop

-a11|-domains domain _name, domain_nameN, domalin nameN
-username user._name

-appbase APPLICATIONS BASE

[-setup setup _details.xml_file location]

[-loglevel log level]

[-timeout timeout_period]

fastartstop.sh/fastartstop.cmd -Stop

-all|-domains domain name(server:all), domain name(server:all)
-username user._name

-appbase APPLICATIONS_BASE

[-setup setup details.xml_file location]

[-loglevel Iog level]

[-timeout timeout_period]

For the server suboption, use a backslash (\) before each of the parenthesis on
UNIX, \ (server:all\), and use quotes (") before and after the parenthesis on
Windows, " (server:all)".

For more information about the fastartstop syntax, see Section 3.3.2.1.

Note: Do not use the following Oracle WebLogic Server scripts to
stop the Administration Servers:

(UNIX) DOMAIN_HOME/bin/stopWebLogic.sh
(Windows) DOMAIN_HOME\bin\stopWebLogic.cmd
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Stopping Managed Servers with Fusion Applications Control

If you are working on a specific domain in Fusion Applications Control, you can also
stop the Managed Servers for that domain.

To stop the Managed Servers for a specific domain with Fusion Applications Control:
1. From the navigation pane, expand the farm, WebLogic Domain.

2. From the WebLogic Domain menu, choose Control, then Shut Down.

Stopping Managed Servers with WebLogic Server Administration Console
If you prefer to use the WebLogic Server Administration Console, see "Start Managed

Servers from the Administration Console" and "Shutdown servers in a cluster” in the
Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.
3.3.3.2.5 Task 5: Stop the Oracle Database

To stop the Oracle database instance using Oracle Database Control:

1. Go to the Database Home page.

For information about how to access the Database Home page in Oracle Enterprise
Manager, see "Accessing the Database Home Page" section in the Oracle Database 2
Day DBA.

2. In the Database Home page, click Shutdown.
The Startup/Shutdown Credentials page appears.
3. Enter credentials as follows:

a. Enter the host computer credentials of the user who installed Oracle Database,
or of any user who is authorized to use SQL*Plus.

b. Enter the database credentials consisting of the user name SYS and the
password that you assigned to SYS during the installation.

c. From the Connect As list, select SYSOPER.

4. (Optional) Select the Save as Preferred Credential option if you want these
credentials to be automatically filled in for you the next time that this page
appears.

5. Click OK.
A confirmation page appears.
6. Click Yes to start the SHUTDOWN IMMEDIATE operation on the database.

The Shutdown: Activity Information page appears, informing you that the
database is being shut down.

7. After a short period (approximately 2 minutes), click Refresh to be returned to the
Database Home page.

The Database Home page indicates that the database instance status is Down.

For information about shutting down and starting up the Oracle database instance, see
the "Shutting Down and Starting Up the Oracle Instance" section in the Oracle Database
2 Day DBA.

3.3.4 Starting and Stopping a Product Family Oracle WebLogic Server Domain

When applying a patch that only applies to a product family, you can stop the Oracle
WebLogic Server domain for the product family and restart it after you apply the
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patch. Your environment may require a restart of a domain for reasons other than a
patch.

This section contains the following topics:
= Stopping an Oracle WebLogic Server Domain for a Product Family

= Starting an Oracle WebLogic Server Domain for a Product Family

3.3.4.1 Stopping an Oracle WebLogic Server Domain for a Product Family
You stop an Oracle WebLogic Server domain for a product family before applying a
patch.

This section contains the following topics for stopping an Oracle WebLogic Server
domain for a product family:

s Task 1, "Stop the Oracle HTTP Server"
s Task 2, "Stop the Product Family Domain"

Task 1 Stop the Oracle HTTP Server

Oracle HTTP Server is typically installed on a computer separate from the product
family. By stopping Oracle HTTP Server, you stop requests to the entire Oracle Fusion
Applications environment. Stopping Oracle HTTP Server before the product family
ensures a cleaner shutdown.

To stop the Oracle HTTP Server using opmnctl:

(UNIX) WT_CONFIG_HOME/bin/opmnctl stopproc process-type=0HS
(Windows) WT_CONFIG_HOME\bin\opmnctl stopproc process-type=0HS

To stop Oracle HTTP Server using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Web Tier installation
type.
2. Select an Oracle HTTP Server.

3. From the Oracle HTTP Server menu, choose Control, then Shut Down.

Task 2 Stop the Product Family Domain

When you stop an Oracle WebLogic Server domain for a product family, you stop all
the applications on the cluster of Managed Servers in the domain. For example, the
Oracle Enterprise Scheduler ESSAPP application and the SOA Infrastructure soa-infra
application stop running.

To stop a product family domain, use the fastartstop utility with the -domains
option.

fastartstop.sh/fastartstop.cmd -Stop

-domains domain_name, domain_namelN, domain_nameN
-username user_name

-appbase APPLICATIONS BASE

[-setup setup details.xml_file_location]
[-loglevel log level]

[-timeout timeout_period]

For more information about the fastartstop syntax, see Section 3.3.2.1.
To stop a product family domain using Fusion Applications Control:

1. From the navigation pane, expand the farm, then WebLogic Domain.
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2. Select the Oracle WebLogic Server domain.

3. From the WebLogic Domain menu, choose Control, then Shut Down.

3.3.4.2 Starting an Oracle WebLogic Server Domain for a Product Family

You start an Oracle WebLogic Server domain for a product family after applying a
patch.

This section contains the following topics for starting an Oracle WebLogic Server
domain for a product family:

s Task 1, "Start the Oracle HTTP Server"
s Task 2, "Start the Product Family Domain"

Task 1 Start the Oracle HTTP Server
To start the Oracle HTTP Server using opmnctl:

(UNIX) WT_CONFIG_HOME/bin/opmnctl startproc process-type=0HS
(Windows) WT_CONFIG_HOME\bin\opmnctl startproc process-type=0HS
To stop Oracle HTTP Server using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Web Tier installation
type.
2. Select the Oracle HTTP Server.

3. From the Oracle HTTP Server menu, choose Control, then Start Up.

Task 2 Start the Product Family Domain

When you start an Oracle WebLogic Server domain for a product family, you start the
cluster of Managed Servers in the domain and all the applications.

To start a product family domain, use the fastartstop utility with the -domains
option.

fastartstop.sh/fastartstop.cmd -Start

-domains domain_name, domain_namelN, domain_nameN
-username user_name

-appbase APPLICATIONS_ BASE

[-setup setup details.xml_file_location]
[-loglevel log level]

[-timeout timeout_period]

For more information about the fastartstop syntax, see Section 3.3.2.1.
To start a product family domain using Fusion Applications Control:

1. From the navigation pane, expand the farm, then WebLogic Domain.
2. Select the Oracle WebLogic Server domain.

3. From the WebLogic Domain menu, choose Control, then Start Up.

3.3.5 Starting and Stopping an Oracle WebLogic Server Cluster in a Product Family for
a Configuration Change

If you modify the Oracle WebLogic Server configuration, you must stop and restart the
cluster for the configuration changes to take effect. Starting and stopping a cluster
stops all the Managed Servers within that cluster.
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This section contains the following topics:

Starting and Stopping an Oracle WebLogic Server Cluster Using fastartstop

Starting and Stopping an Oracle WebLogic Server Cluster Using Fusion
Applications Control

Starting and Stopping an Oracle WebLogic Server Cluster WebLogic Server
Administration Console

See "Using Node Manager to Start Managed Servers in a WebLogic Domain or
Cluster" section in Oracle Fusion Middleware Oracle WebLogic Scripting Tool.

3.3.5.1 Starting and Stopping an Oracle WebLogic Server Cluster Using fastartstop
The fastartstop utility enables you to start or stop a cluster in a product family
domain. Starting and stopping a cluster stops all the Managed Servers within the
cluster.

To start the Oracle WebLogic Server cluster:

1.

At an operating system command prompt, navigate to the location of the
fastartstop script:

(UNIX) FA_ORACLE_HOME/lcm/ad/bin
(Windows) FA_ ORACLE_HOME\lcm\ad\bin

FA_ORACLE_HOME s a directory named applications, located under the fusionapps
Oracle Fusion Applications Middleware home.

From the shared host location, run the fastartstop utility.

From the shared host location, run the fastartstop utility with the -domains
option with the server suboption to specify all the Managed Servers in the cluster
to start:

fastartstop.sh/fastartstop.cmd -Start

-domains domain_name (server:managed_server_name, Server:managed_server._name)
-username user._name

-appbase APPLICATIONS BASE

[-setup setup _details.xml_file location]

[-loglevel log level]

[-timeout timeout_period]

For the server suboption, use a backslash (\) before each of the parenthesis on
UNIX, \ (server:managed_server, server:managed_server\) and use quotes (")
before and after the parenthesis on Windows, " (server :managed_

server, server :managed_server) ".

For a SOA cluster, you can start all the Managed Servers in the cluster with the
-domains option and the -clusterType option. The -clusterType option only
supports SOA clusters.

fastartstop.sh/fastartstop.cmd -Start

-domains domain_name, domain_nameN, domain_nameN
-clusterType soa

-username user._name

-appbase APPLICATIONS_BASE

[-setup setup_details.xml_file_location]
[-loglevel Iog level]

[-timeout timeout_period]

For more information about the fastartstop syntax, see Section 3.3.2.1.
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3.3.5.2 Starting and Stopping an Oracle WebLogic Server Cluster Using Fusion
Applications Control
To stop or restart a cluster using Fusion Applications Control:

1. Modify the Oracle WebLogic Server configuration as required.

2. From the navigation pane, expand the farm, WebLogic Domain, and then domain
name.

3. Select the Oracle WebLogic Server cluster.
4. Expand the Oracle WebLogic Server cluster to show each target Managed Server.
5. From the WebLogic Cluster menu, choose Control, then Shut Down or Start Up.

3.3.5.3 Starting and Stopping an Oracle WebLogic Server Cluster WebLogic Server
Administration Console

If you prefer to use the WebLogic Server Administration Console, see "Start Managed
Servers in a cluster” and "Shutdown servers in a cluster" in the Oracle Fusion
Middleware Oracle WebLogic Server Administration Console Online Help.

3.3.6 Starting and Stopping Specific Applications

Applications may not work correctly until all Managed Servers in all domains have
been started.

This section contains the following topics:
s Starting and Stopping Java EE Applications Using WLST

s Starting and Stopping an Individual Application Instance for a Cluster Using
Fusion Applications Control or Cloud Control

s Starting and Stopping All Application Instances for a Cluster Using Fusion
Applications Control or Cloud Control

3.3.6.1 Starting and Stopping Java EE Applications Using WLST
To start or stop applications with the WebLogic Scripting Tool (WLST):

1. At an operating system command prompt, navigate to the location of the WLST
script:

(UNIX) FA MW _HOME/oracle_common/common/bin
(Windows) FA_MW_HOME\oracle_common\common\bin

FA_Mw_HOME is named fusionapps and located under the APPLICATIONS BASE.
2. Run the wlst script:

(UNIX) wlst.sh
(Windows) wlst.cmd

3. Connect to Oracle WebLogic Server with the following WLST command:

connect ( [options])

See the "connect" section in the Oracle Fusion Middleware WebLogic Scripting Tool
Command Reference.

4. Use the following WLST commands:

startApplication (appName, [options])
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stopApplication (appName, [options])

The application must be fully configured and available in the domain. The
startApplication command returns a WLSTProgress object that you can access to
check the status of the command. In the event of an error, the command returns a
WLSTException. For more information about the WLSTProgress object, see
"WLSTProgress Object” in the Oracle Fusion Middleware Oracle WebLogic Scripting Tool.

3.3.6.2 Starting and Stopping an Individual Application Instance for a Cluster
Using Fusion Applications Control or Cloud Control
To start or stop an application using Fusion Applications Control or Cloud Control:

1. Navigate to a product family home page:

s From Fusion Applications Control, from the navigation pane, select the
product family.

s From Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, click the
appropriate Product Family target.

2. From the navigation pane, expand the product family, then Fusion Applications,
and then the cluster application.

3. Select the application instance you want to stop.

4. From the Fusion J2EE Application menu, choose Control, then Start Up or Shut
Down.

If you prefer to use the WebLogic Server Administration Console, see "Start
applications and modules" and "Stop applications and modules" in the Oracle Fusion
Middleware Oracle WebLogic Server Administration Console Online Help.

3.3.6.3 Starting and Stopping All Application Instances for a Cluster Using Fusion
Applications Control or Cloud Control

To start or stop all the application instances in a cluster using Fusion Applications
Control or Cloud Control.

1. Navigate to a product family home page:

= From Fusion Applications Control, from the navigation pane, select the
product family.

s From Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, click the
appropriate Product Family target.

2. From the navigation pane, expand the product family, then Fusion Applications,
and then the cluster application.

3. From the Fusion Cluster Application menu, choose Control, then Start Up or
Shut Down.
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3.4 Viewing and Changing Ports for Components

Oracle Database and Oracle Fusion Middleware components and services use ports.
Most numbers are assigned during installation. As an administrator, it is important to
know the numbers used by these services, and to ensure that the same number is not
used by two services on your host.

For some ports, you can specify a number assignment during installation.

Table 3-3 lists the port types and provides information on where to find
documentation related to changing ports. The procedures referenced in the Oracle
Fusion Middleware guides describe using Fusion Middleware Control. These
procedure also apply to Fusion Applications Control.
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Table 3-3 Changing Ports

Port Type

Documentation for Changing Ports

Oracle Database

"Changing the Oracle Database Net Listener" section in the Oracle
Fusion Middleware Administrator’s Guide

Oracle Business Intelligence Suite

"Using Fusion Middleware Control to Scale System Components"
section in the Oracle Fusion Middleware System Administrator’s Guide
for Oracle Business Intelligence Enterprise Edition

Oracle Essbase

"Using Fusion Middleware Control to Scale System Components”
section in the Oracle Fusion Middleware System Administrator’s Guide
for Oracle Business Intelligence Enterprise Edition

You may also need to modify the port range used by Essbase
Applications. These are managed separately from the rest of the
ports.

To modify the port range:

1. Atan operating system command prompt, navigate to the
location of the opmn .xml file:

(UNIX) APPLICATIONS
BASE/instance/BIInstance/config/OPMN/opmn

(Windows) APPLICATIONS
BASE\Instance\BIInstance\config\OPMN\opmn

This is the port range used by Essbase Applications. These are
allocated by the Essbase server as required. The Essbase server
will use the ports, even if they are explicitly allocated elsewhere
to another component. Therefore, it is important to not use the
same port range as the rest of the Oracle Business Intelligence
domain port range.

2. Modify the port range:
<port id="essbase-port-range" range="9500-9599"/>

3. Ensure that the OPMN server re-reads its configuration after
changing the contents of opmn.xml:

(UNIX) APPLICATIONS
BASE/instance/BIInstance/bin/opmnctl reload
(Windows) APPLICATIONS_
BASE\instance\BIInstance\bin\opmnctl reload

4. Restart the Essbase server:

(UNIX) APPLICATIONS
BASE/instance/BIInstance/bin/opmnctl restartproc
process-type=Essbase

(Windows) APPLICATIONS_
BASE\instance\BIInstance\bin\opmnctl restartproc
process-type=Essbase

Oracle HTTP Server

"Manage Ports" section in the Oracle Fusion Middleware
Administrator’s Guide for Oracle HTTP Server

Oracle Enterprise Content Management
Suite

"Modifying Server Configuration Parameters for Oracle UCM
Content Server" section in the Oracle Fusion Middleware
Administrator’s Guide for Oracle Internet Directory for information
about changing the for Oracle WebCenter Content Content Server
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Table 3-3 (Cont.) Changing Ports

Port Type Documentation for Changing Ports

Oracle Internet Directory "Configuring Server Properties" section or the "Setting System
Configuration Attributes by Using ldapmodify" section in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Internet Directory

Oracle Virtual Directory "Configuring Oracle Virtual Directory to Listen on Privileged Ports"
section in the Oracle Fusion Middleware Administrator’s Guide for
Oracle Virtual Directory

Node Manager "Overview of Node Manager Configuration” section in the Oracle
Fusion Middleware Node Manager Administrator’s Guide for Oracle
WebLogic Server

3.5 Changing Passwords

Before you begin configuration, change the passwords for the various accounts to
secure passwords. Table 3—4 describes the accounts and provides information on
where to find related documentation for each account. The procedures referenced in
the Oracle Fusion Middleware guides describe using Fusion Middleware Control.
These procedure also apply to Fusion Applications Control.
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Table 3-4 Changing Passwords

Password Account Description

Documentation for Changing the Passwords

Oracle Fusion
Middleware
administration for
the Oracle
WebLogic Server
domain

During the Oracle Fusion Applications
installation, you must provide a
password for the Oracle Fusion
Middleware administration user. By
default, this administrator takes the
Super User value you specified on the
Identity Management page when
creating the provisioning plan. The
super user is described in the next row
of this table.

Section 4.8.5.2

Super User

The super user has the following
privileges:

= Administrative privileges for all
Oracle WebLogic Server domains
and all middleware.

= Functional setup privileges for all
Oracle Fusion applications.

= Administrative privileges to Oracle
Fusion applications. These do not
include transactional privileges.
You use this username and
password to access the Fusion
Applications Control and the
Oracle WebLogic Server
Administration Console.

You can change the credentials using
Fusion Applications Control or Oracle
Platform Security Services (OPSS)
scripts.

This user is specified on the Identity and
Policy Management page of the
Provisioning Wizard during installation.
See "Identity and Policy Management
Configuration" section in the Oracle
Fusion Applications Installation Guide for
information about this page. Installation
establishes the same username and
password for all the domains.

Section 4.8.5.2 to change the administrative
password

"Managing the Credential Store" section in the
Oracle Fusion Middleware Application Security Guide

Oracle Metadata
Repository schema

Oracle Metadata Services (MDS)
repository contains metadata for the
Oracle Fusion Applications and some
Oracle Fusion Middleware component
applications. The schema passwords are
stored in the Oracle database.

"Changing Metadata Repository Schema
Passwords" section in the Oracle Fusion Middleware
Application Security Guide
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Table 3—-4 (Cont.) Changing Passwords

Password Account

Description

Documentation for Changing the Passwords

App IDs

Oracle Fusion Applications must rely on
a type of credential known as the App
ID. Each application has its own App ID
which is initially provisioned for the
application.

Section 4.8.5.1
Oracle Fusion Applications Security Hardening Guide

Node Manager

The Node Manager account
authenticates the connection between a
client (for example, the Administration
Server) and Node Manager.

In an Oracle Fusion Applications
installation, this user is specified on the
Installation Location page of the
Provisioning Wizard. See the
"Installation Location" section in the
Oracle Fusion Applications Installation
Guide for information about using this

page.

"Specify Node Manager Username and Password"
section in the Oracle Fusion Middleware Node
Manager Administrator’s Guide for Oracle WebLogic
Server

BISystemUser

The BISystemUser account provides
access to the Oracle Business
Intelligence system components.

"Default Users and Passwords" section in the
Oracle Fusion Middleware Security Guide for Oracle
Business Intelligence Enterprise Edition

3.6 Managing the Oracle Database

To manage your Oracle database:

1.
2.

Start the Oracle database instance, if not already started. See Section 3.3.3.

Review database initialization parameters. Modify initialization parameters as

needed. See Section 3.6.1.

Review your database storage structures: tablespaces and data files, online redo
log files, and control files. Create or modify storage structures as needed. See

Section 3.6.2.

Review memory allocation and adjust as needed. See Section 3.6.3.

Review, unlock, and reset passwords for predefined database users as needed.
Create new users, and assign privileges and roles to them as needed. See

Section 3.6.4.

Create or review the backup strategy for the database and back up the database.

See Chapter 15.

3.6.1 Viewing and Modifying Initialization Parameters

Managing an Oracle instance includes configuring parameters that affect the basic
operation of the Oracle instance. These parameters are called initialization parameters.
The Oracle instance reads initialization parameters from a file at startup.

After being read from a file, initialization parameters are retained in memory, where
the values for many of them can be changed dynamically. There are two types of
parameter files. The type of file used to start the instance determines if dynamic
initialization parameter changes persist across database shutdown and startup. The
parameter file types are:

Server parameter file
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The server parameter file is a binary file that can be written to and read by the
database. It must not be edited manually. It is stored on the host system on which
Oracle Database is running. Changes are made when you use Database Control to
modify one or more initialization parameters, or when Oracle Database itself
makes changes for self-tuning purposes. Any changes to it persist across database
shutdown and startup operations.

s Text initialization parameter file

A text initialization parameter file is a text file that can be read by the Oracle
instance, but it is not written to by the instance. You can change a text initialization
parameter file with a text editor, but changes do not take effect until you restart the
Oracle instance. When you start the instance with this type of file, you can still
change many initialization parameters dynamically with Database Control, but
only for the current instance. Unless you also edit the text initialization parameter
file and make the same change, the change is lost when you restart the database
instance.

As the number of database users increases and the workload increases, you might
have to alter some initialization parameters. You can make these changes using the
Initialization Parameter page in Oracle Enterprise Manager Database Control,
accessible from the Database Configuration section of the Server tab.

Table 3-5 lists specific initialization parameters that you should set and their
recommended values.

Table 3-5 Initialization Parameters

Parameter Recommended Values

CONTROL_MANAGEMENT_PACK_  Set this parameter to DIAGNOSTIC+TUNING (default) or

ACCESS DIAGNOSTIC to enable Automatic Database Diagnostic Monitor
(ADDM).

STATISTICS_LEVEL Set this parameter to TYPICAL (default) to enable the automatic

performance tuning features of Oracle Database, including
Automatic Workload Repository (AWR) and ADDM.

For information about viewing and modifying initialization parameters, see the
"Viewing and Modifying Initialization Parameters" section in the Oracle Database 2 Day
DBA.

3.6.2 Managing Database Storage Structures

Oracle Database is made up of physical and logical structures. Physical structures can
be seen and operated on from the operating system, such as the physical files that store
data on a disk.

Logical structures are created and recognized by Oracle Database and are not known
to the operating system. The primary logical structure in a database, a tablespace,
contains physical files. The applications developer or administrator may be aware of
the logical structure, but may not be aware of the physical structure. The database
administrator (DBA), on the other hand, must understand the relationship between the
physical and logical structures of a database.

Oracle Database can automate much of the management of its structure. To view a
database storage structure using Oracle Enterprise Manager Database Control, go to
the Storage section of the Server tab, where you can access the following storage
options:

s Control files

Performing Routine Administrative Tasks 3-31



Managing the Oracle Database

n  Tablespaces

s Temporary tablespace groups
s Datafiles

= Rollback segments

= Redo log groups

= Archive legs

= Disk groups

s Other storage structures

For more information about managing database storage structures, see the "Managing
Database Storage Structures” chapter in the Oracle Database 2 Day DBA.

3.6.3 Managing Memory

Memory management involves maintaining optimal sizes for the Oracle instance
memory structures as demands on the database change. The memory that must be
managed are the System Global Area (SGA) memory and the instance Program Global
Area (PGA) memory. The instance PGA memory is the collection of memory
allocations for all individual PGAs.

Oracle Database can manage the SGA memory and instance PGA memory
automatically. You designate only the total memory size to be used by the instance,
and Oracle Database dynamically exchanges memory between the SGA and the
instance PGA as needed to meet processing demands. This capability is referred to as
automatic memory management. In this memory management mode, the database
also dynamically tunes the sizes of the individual SGA components and the sizes of
the individual PGAs.

To have more direct control over the sizes of the SGA and instance PGA, use the
Memory Advisors page of Oracle Enterprise Manager Database Control to disable
automatic memory management and enable automatic shared memory management.
With automatic shared memory management, you set target and maximum sizes for
the SGA. Oracle Database then tunes the total size of the SGA to your designated
target, and dynamically tunes the sizes of all SGA components. In this memory
management mode, you also implicitly enable automatic PGA memory management.
With automatic PGA memory management, you set a target size for the instance PGA.
The database then tunes the size of the instance PGA to your target, and dynamically
tunes the sizes of individual PGAs.

If you want complete control of individual SGA component sizes, then use the
Memory Advisors page of Oracle Enterprise Manager Database Control to disable
both automatic memory management and automatic shared memory management.
This is called manual shared memory management. In this mode, you set the sizes of
several individual SGA components, thereby determining the overall SGA size. You
then manually tune these individual SGA components on an ongoing basis. Manual
shared memory management mode is intended for experienced DBAs only. Note that
in this mode, automatic PGA memory management remains enabled.

To manage memory, use the Memory Advisor page in Database Control, accessible
from the Database Configuration section of the Server tab.

For more information about memory management, see the "Managing Memory"
section in the Oracle Database 2 Day DBA.
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3.6.4 Administering User Accounts

For users to access your database, you must create user accounts and grant
appropriate database access privileges to those accounts. A user account is identified
by a user name and defines the attributes of the user, including the following;:

= Authentication method

= Password for database authentication

s Default tablespaces for permanent and temporary data storage
= Tablespace quotas

s Account status (locked or unlocked)

= Password status (expired or not)

When you create a user account, you must not only assign a user name, a password,
and default tablespaces for the account, but you must also do the following:

s Grant the appropriate system privileges, object privileges, and roles to the account.

= If the user will be creating database objects, then give the user account a space
usage quota on each tablespace in which the objects will be created.

In addition, you may want to create user accounts that are used by applications only,
such as Fusion Applications. Users do not log in with these accounts; instead,
applications use these accounts to connect to the database, and users log in to the
applications. This type of user account avoids giving application users the ability to
log in to the database directly, where they could unintentionally cause damage.

To administer user accounts using Oracle Enterprise Manager Database Control, go to
the Security section of the Server tab, where you can access users and roles.

For more information about administering user accounts, see the "Administering User
Accounts and Security" chapter in the Oracle Database 2 Day DBA.

3.7 Patching

It is necessary to perform various maintenance actions on your applications, their
middleware dependencies, and their database components. Maintenance actions
include fixing issues that affect the way the applications perform, adding new
functionality and features, updating to a higher maintenance level, or providing
interoperability to new technology stacks. Patches may be required for maintenance of
middleware artifacts, database artifacts, or both. Table 3-6 describes the types of
patching and provides information on where to find related documentation.
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Table 3—-6 Patching

Type of Patching

Description Documentation for Patching

Oracle Fusion
Applications

The Oracle Fusion Applications Oracle Fusion Applications Patching Guide
Patching Framework provides the tools

needed to sup updates to Oracle Fusion

Applications software between major or

patch set releases. These tools manage

the processes for applying individual

patches, patch sets, and release update

packs.

Oracle Fusion
Middleware

OPatch patches any Oracle Fusion Oracle Fusion Middleware Patching Guide for
Middleware component, except Oracle  information about patching middleware artifacts
WebLogic Server. For Oracle WebLogic

Server, use Smart Update.

Oracle Database

Oracle Universal Installer and OPatch Oracle Universal Installer and OPatch User’s Guide

manage the patching for Oracle for Windows and UNIX
database and third-party software.

3.8 Managing Oracle Fusion Applications-Specific Labels in the Oracle
Metadata Repository

The Oracle Metadata Repository (MDS Repository) contains metadata for Oracle
Fusion Middleware components. It can also contain metadata about the configuration
of Oracle Fusion Middleware and metadata for your applications. For general
instructions on managing the metadata for Oracle Fusion Middleware components in
the Oracle Metadata Repository, see the "Managing the Metadata Repository" chapter
in the Oracle Fusion Middleware Administrator’s Guide.

As a part of MDS Repository management, you work with metadata labels. You select
a version for the repository to select a particular version of each object from a metadata
repository partition. Also, if you take actions that affect the MDS Repository, such as
deploying, patching, or doing some customizations, you can potentially put the
repository into a broken state. When this happens, you can rollback to a previous label.
For example, when you roll back to a label, all objects within that repository move to
that state. To manage labels, note the following prefixes for Oracle Fusion Applications
in the MDS Repository:

= postDeployLabel_ for labels created by MDS Repository at deployment time

» Creation_ for labels created by Oracle Fusion Middleware Extensions for
Applications (Applications Core) in the MDS Repository

»  PrelMerge_ for labels created by Applications Core in the MDS Repository during
sandbox creation.

= composer_PostMerge_ for labels created by Applications Core in the MDS
Repository during a sandbox publish operation

» mds_ for labels created during a Flexfield changes applied during a patch
= soa_ for labels created during SOA deployments

= composer_ for labels created by Oracle Composer when using the Save and Label
button. For more information about Save and Label button, see "Create Labels On
Saving Application Customizations" in the Oracle Fusion Middleware Developer’s
Guide for Oracle WebCenter Portal (Oracle Fusion Applications Edition).

For more information about managing labels, see the "Managing Metadata Labels in
the MDS Repository" section in the Oracle Fusion Middleware Administrator’s Guide.
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3.9 Modifying Oracle Application Development Framework Connections
in Oracle Fusion Applications

A connection configuration (connections.xml) contains information that a client
application uses to identify the Oracle Application Development Framework (Oracle
ADF) application module's deployment scenario. For more information about
modifying the configuration of a single application, see the following sections in the
Oracle Fusion Middleware Administrator’s Guide for Oracle Application Development
Framework:

= How to Modify Connection Configurations
= Configuring Application Properties Using the MBean Browser

In an Oracle Fusion Applications environment, you may need to change the internal
and external settings for several applications. For example, if there was an outage of
the Oracle Fusion Customer Relationship Management (CRM) applications due to a
lost Oracle HTTP Server host, then you would need update all the applications that
depend on the CRM-provided web services. If all the applications in an Oracle
WebLogic Server domain use the same connections.xml, which is the default
behavior after provisioning, you can make this edit in one place using Fusion
Applications Control.

To modify the connections for all the applications in an Oracle WebLogic Server
domain using Fusion Applications Control:

1. From the navigation pane, expand the farm and then WebLogic Domain.
2. Click the domain.
The Oracle WebLogic Server Domain home page displays.
3. From the WebLogic Domain menu, choose ADF Domain Configuration.
The ADF Common Properties page displays.

4. In the Property Sets table, click the property set to modify, and in the Details for
Property Set table, modify the property values.

These property sets and properties reside in the adf-domain-config.xnl file, and
are used in the ELs in the connections.xml file.

5. Click Save.
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Securing Oracle Fusion Applications

This chapter explains the security features available to all Oracle Fusion applications.
It explains the enterprise identity store, identity provisioning, authorization policies,
roles, audit trail, SSL configuration, data masking, securing Web services, and
customizing security.

This chapter explains the security features available to all Oracle Fusion applications,
and it contains the following topics:

s Introduction to Security

= About the Enterprise Identity Store

= Provisioning Identities

»  Managing Authorization Policies

= Configuring Roles

s Configuring Audit Trail

s Configuring SSL for Oracle Fusion Applications

= Managing Wallets, Keystores, Credentials, and Certificates
» Data Masking

= Securing Web Services

= Securing Oracle Fusion Middleware Products

s Extracting Data from an LDAP- Based Store to a File

s Customizing Security from Installation to Deployment

The high-level information presented in this chapter includes links to other documents
where the topic is explained in detail.

For additional information about application security, see the following documents:
»  Oracle Fusion Applications Security Guide
»  Oracle Fusion Applications Security Hardening Guide

For a detailed list of administrative tasks and pointers to further documentation, see
Oracle Fusion Applications Administrator and Implementor Roadmap.

4.1 Introduction to Security

Oracle Fusion Applications use the services of the Oracle Platform Security Services
(OPSS) to secure applications.
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OPSS is a security platform that provides enterprise product development teams,
systems integrators, and independent software vendors with a standards-based
enterprise-grade security framework for Java SE and Java EE applications. Using
OPSS, Oracle Fusion Applications benefit from the same, uniform security, identity
management, and audit services across the enterprise.

The intended audience for this chapter are application security administrators and
system security administrators.

Oracle Fusion Applications provisioning sets up the security infrastructure, including:
= theidentity store

= authorization policies

= enterprise roles

= SSL wiring and its support structure including keystores and certificates

= data masking

= setting protected URISs for the infrastructure to work as expected

For instructions about protected URIs and configuring Oracle ADF applications with
Oracle Access Manager SSO, see the "Integration with Oracle ADF Applications"
section in the Oracle Fusion Middleware Administrator's Guide for Oracle Access Manager
with Oracle Security Token Service.

For details about security tasks, including creating and managing users and roles,
function and data security, audit, and compliance tasks, see the Oracle Fusion
Applications Security Guide.

4.2 About the Enterprise Identity Store

Oracle Fusion applications run within a container in the Oracle WebLogic Server. This
container handles authentication automatically for the application running in it by
intercepting all requests to the application and ensuring that users are properly
authenticated and the security context is propagated, as appropriate, before the
request can proceed forward.

Note: The Subject creation is automatic, but the security context
propagation requires application configuration.

Fusion Applications use LDAP-based authenticators; Fusion Application identity
provisioning sets up and wires WebLogic domains with the appropriate authenticators
during the Fusion Application installation.

Important: Any LDAP-based authenticator, other than the
DefaultAuthenticator, requires that the flag
UseRetrievedUserNameAsPrincipal be set. During installation, this
flag is automatically set in the DefaultAuthenticator.

For details about bootstrap identity provisioning, such as super administrators for
Fusion pillars, see Section 4.3.
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4.2.1 Supported LDAP Identity Providers
Fusion Applications support the following LDAP identity store types:
s Oracle Internet Directory 11g
= Active Directory 2008

4.2.2 Configuring the Identity Store

Multiple LDAP authenticators can be configured in a given context. For the algorithm
that selects the identity store to initialize from a stack of authenticators, see the
"Configuring the Identity Store Service" section in the Oracle Fusion Middleware
Application Security Guide.

Note: The Oracle WebLogic Server Administration Console is the
recommended tool to configure authenticators, but this configuration
can also be alternatively carried out with WLST commands. For the
list of all available WLST commands, see Oracle Fusion Middleware
WebLogic Scripting Tool Command Reference.

The specification and configuration of LDAP authenticators is carried out with the
Oracle WebLogic Administration Console. For details, see the "Configuring
Authentication Providers" chapter in the Oracle Fusion Middleware Securing Oracle
WebLogic Server.

It is important to keep the username attribute on the authenticator synchronized with
the corresponding identity store property. For details, see note at the end of the table of
identity store properties in the "LDAP Identity Store Properties" section in the Oracle
Fusion Middleware Application Security Guide.

It is also important that the following two time intervals be equal:

s The number of seconds that cached entries stay in the cache. This value is
controlled by the WebLogic authenticator parameter Group Hierarchy Cache TTL,
which by default is 60 seconds.

s The number of seconds after which group membership changes are in effect. This
value is controlled by the system property jps.subject.cache.ttl, which by
default is 60 seconds.

If the Group Hierarchy Cache TTL value is changed, then that new value must also be
set with the system property jps.subject.cache.ttl. For example, if the value of
Group Hierarchy Cache TTL is changed to 55,000 (milliseconds), then
jps.subject.cache.ttl must be reset as follows:

-Djps.subject.cache.ttl 55000

4.3 Provisioning Identities

Provisioning as a whole encompasses all the operations required to install, configure,
and deploy applications product offerings. Identity provisioning is a subset of this
process which populates the users and groups needed for deployment and ongoing
administration.

This section contains the following topics:
= Identity Provisioning Concepts

s WebLogic Authenticators and the Primary Identity Store
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= Provisioning Steps
m  Best Practices for the Administrator Groups

= Managing Identities after Deployment

4.3.1 Identity Provisioning Concepts

During the identity provisioning stage of installation, Oracle Fusion Applications
require the existence of certain users with specific privileges. These administrative
users reside in a secure, central repository called the identity store. This section
explains the phases of identity provisioning, what users or groups are needed for
provisioning, and the users and groups that exist at the end of the process.

This section contains the following topics:
= Administrators For Fusion Applications

s Two Types of Users During Provisioning

4.3.1.1 Administrators For Fusion Applications

The application provisioning process bootstraps the provisioned environment with
two administrator groups for each application family.

These two administrator groups are:
= A system administrator

A directory group representing the WebLogic Server domain administrators for all
the domains.

= An application administrator

A directory group with an assigned enterprise role reflecting all the application
roles and delegation privileges for all the applications in a given family.

The purpose of creating these "Super Administrators" during provisioning is to enable
ongoing administration and /or delegation privileges.

The above process facilitates separation of duties between system administration and
application administration responsibilities, but you are free to assign the same user to
both hierarchies ("system admin" and "application admin").

Table 4-1 shows the groups that are created for each application family:

Table 4-1 Provisioned Administrator Groups

Product
Family/Product System Administrator Group Application Administrator Group

Oracle Fusion FSCMSysAdmin FSCMAppAdmin
Supply Chain
Management

Oracle Fusion CRMSysAdmin CRMAppAdmin
Customer

Relationship

Management

Oracle Fusion HCMSysAdmin HCMAppAdmin
Human Capital
Management

Oracle Fusion FINSysAdmin FINAppAdmin
Financials
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Table 4-1 (Cont.) Provisioned Administrator Groups

Product
Family/Product System Administrator Group Application Administrator Group

Oracle Fusion PRCSysAdmin PRCAppAdmin
Procurement

Oracle Fusion PRJISysAdmin PRJAppAdmin
Project

Oracle Fusion 0ICSysAdmin OICAppAdmin
Incentive
Compensation

In addition a single user, known as the super user, is set up to belong to all the
administrator groups. That user becomes the administrator for all middleware and the
application administrator for all product families.

Figure 4-1 shows the relationship between these groups.

Figure 4-1 Super-User and Administrators

L

Super User LI. J

«
FusionSystemAdmin i FusionApplicationAdmin
Global System | Global Application
Administrator Administrator

System Az:‘lmn:trat’jl ------- { I_"_._._I ii;:lgalt?:: IMclrninis,trator
ﬁdminist‘:tlrtLg Hva . L"L‘1. -l- ....... Lh ':,. 'v { LILI [{IILI i :r;zi:ﬁtion

S =2

Fusion Fusion Fusion Fusion
Application Application Application Application
Domain Domain Domain Domain

4.3.1.2 Two Types of Users During Provisioning

It is important to distinguish between the two types of super-administrators that exist
in the provisioning process.

»  Pre-seeded bootstrap user
s Designated super-user

In the context of the pre-seeded user, provisioning employs an identity known as the
App ID that is required to bootstrap the WebLogic domains. The pre-configuration
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phase of provisioning automatically generates the credential needed for this App ID
user.

In the context of the designated super user, during the interview phase of
provisioning, you are asked to specify the user ID of the designated "real" user who
will be set up as the Middleware Administrator and Functional Setup Manager.

For example, if you want a "real" user such as

"cn=john.doe, cn=users, cn=acme, cn=con" to be the super user, provide "john.doe"
as the user ID during provisioning. This user will be set up as the super user in the
identity store.

Note: It should be emphasized that the identity seed data that is
used in the LDIF file to configure the WebLogic domains does not use
real user DNs.

4.3.2 WebLogic Authenticators and the Primary Identity Store

When Oracle WebLogic Server is installed, the default authenticator is based on an
embedded LDAP store.

As part of Oracle Fusion Applications provisioning, the default authenticator based on
the embedded LDAP is deleted. Upon completion of Oracle Fusion Applications
provisioning, the primary and only identity store will be your external LDAP store.
The bootstrap identity used to configure the domains during the provisioning process
will be pre-seeded in the external LDAP through the LDIF file, as explained in

Section 4.3.1.2.

4.3.3 Provisioning Steps

The identity provisioning process consists of distinct phases.
In the interview phase, Provisioning Wizard collects the following information:

s The DN of the user designated as the super user. This user must already exist in
the identity store.

= Whether the system administrators group exists or must be created.
= If the group exists, the DN of the group.

»  The LDAP authenticator, either Oracle Internet Directory (OIDAuthenticator) or
Oracle Virtual Directory (OVDAuthenticator) that will serve as the LDAP identity
store.

The next step of the process verifies that the designated super-user exists in the
identity store.

The system administrator group is created if needed, and the super user is made a
member of the group.

Next, the application domains are created, the LDAP authenticator is enabled, and the
WebLogic domain is started up.

Following configuration, the system administrator groups are assigned the
appropriate family-level enterprise roles.

At the end of this process, the super user has:
= Administrator privileges for all WebLogic domains and all middleware.

= Function setup privileges for all Oracle Fusion applications.
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= Administration privileges to Oracle Fusion Applications. These do not include
transactional privileges.

For more information about identity provisioning and using the interview wizard to
create a provisioning plan, see the Oracle Fusion Applications Installation Guide.

4.3.4 Best Practices for the Administrator Groups

While there are logical sets of "super" administrative groups (a set of two per
application family, consisting of the super-user administrator and the application
administrator) you can choose to distribute these functions among fewer individuals.
The recommended best practice is to carefully plan the separation of duties, taking
into account the real-world operational needs of your site.

4.3.5 Managing Identities after Deployment

Oracle Identity Manager is the best-in-class user provisioning and administration
component in Oracle Fusion Middleware.

Oracle Identity Manager automates the process of adding, updating, and deleting user
accounts from applications and directories.

Identities can be created and managed when user records are created through
activities such as employee hiring and creation of contacts through CRM.

In addition, identities can also be created and managed administratively through the
Oracle Identity Manager Administrative Console.

For more information about provisioning and managing identities, see:
»  Oracle Fusion Middleware User’s Guide for Oracle Identity Manager
»  Oracle Fusion Middleware Administrator’s Guide for Oracle Identity Manager

4.4 Managing Authorization Policies

Authorization is the most sensitive and application-specific security concept. At its
very core, authorization protects access to application resources through the
enforcement of policies, which are stored in the domain policy store. Authorization
determines what types of actions, tasks, or services a user can access.

In most cases, the definition of application policies begins during the design of the
application. This definition includes identifying application privileges and application
roles, the hierarchical relationships between application roles, and categorizing them
into products and Java EE applications.

The policy model is based on a number of logical entities, such as resource types,
resource instances, entitlements (also known as permission sets), application roles, and
enterprise roles. For details about these entities and the logical model of a policy, see
the "Terminology" section in the Oracle Fusion Middleware Application Security Guide.

This section includes the following topics:

= Managing Oracle Fusion Application Policies
= Managing System Policies

= Reconciling GUIDs

= Managing Data Security
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4.41 Managing Oracle Fusion Application Policies

An Oracle Fusion application policy is either a functional policy or a data security
policy. Both these policies define who can do what on a resource.

A data security policy includes a condition, while a functional policy does not. The
condition identifies a row or a set of rows in a business object, and the privileges the
data security grants are for only the data that meets the condition. A functional policy,
instead, assigns permissions to resources or code artifacts (such as task flows, pages,
Java methods, or UI components) and grants a specific set of actions on each resource.

Data security policies are stored in the transactional database; functional policies are
stored in the domain policy store.

Oracle Authorization Policy Manager is the recommended tool to administer
application policies once the application has been deployed. This graphical interface
tool allows application security administrators to provision, search, and modify
application functional and data security policies. Using this tool they can, for example,
remove a resource from an entitlement or change the actions granted to a resource in
an entitlement.

For details about the most frequently uses of Oracle Authorization Policy Manager, see
the "Managing Policies and Policy Objects" section in the Oracle Fusion Middleware
Oracle Authorization Policy Manager Administrator’s Guide (Oracle Fusion Applications
Edition) where the following typical administrative tasks are described:

»  Managing application roles

= Managing application resource types

= Managing application resources

»  Managing application entitlements

s Creating and modifying an application policy
= Viewing the enterprise role hierarchy

= Managing the application role hierarchy

= Mapping application roles to an enterprise role
= Mapping enterprise roles to an application role

For details about configuring application roles, see Section 4.5.1.

4.4.2 Managing System Policies

Oracle Enterprise Manager Fusion Middleware Control is the recommended tool to
administer system policies. These are policies that pertain to the whole domain, as
opposed to application policies, which pertain a particular application.

A principal policy is a system policy that grants permissions to a list of users or
enterprise groups. A codebase policy is a system policy that grants permissions to a
piece of code or a URL (typically represented by an EAR or a JAR file); for example, an
application using the Credential Store Framework requires an appropriate codebase

policy.
Fusion Middleware Control allows the creation and modification of both these types of

system policies. For details about the procedure to follow, see the "Managing System
Policies" section in the Oracle Fusion Middleware Application Security Guide.

An alternative way to administer policies (both system and application policies),
although not as convenient but occasionally useful, is using WLST commands. For a
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complete list of security-related commands, see the "OPSS Scripts" appendix in the
Oracle Fusion Middleware Application Security Guide.

4.4.3 Reconciling GUIDs

The recipient of a grant can be either an application role or an enterprise role. In Oracle
Fusion Data Security and policy grants this recipient is identified by a GUID, and it is
crucial for the security system to work as expected that these GUIDs be consistent.
Since GUIDs are not preserved by migration, the GUIDs in the Oracle Fusion Data
Security policies and in the policy store policies must be reconciled when, for instance,
migrating to a staging or a production environment.

The java utility program DSDataMigrator reconciles GUIDs by modifying GUIDs in
Oracle Fusion Data Security so that the GUIDs of the role entries in the identity and
policy stores are consistent with those in Oracle Fusion Data Security.

DSDataMigrator needs not be run when:
= The user interface is used to create new policies or to modify existing ones.

s The system is provisioned for the first time (GUID reconciliation happens
automatically in this case).

= A patch containing Grants Seed Data is applied to the environment (GUID
reconciliation happens automatically in this case).

DSDataMigrator must be run when:

= A policy stripe was dropped or recreated.

= A role was dropped or recreated.

= AnSQL script was used to upload grants data.

s Patching the infrastructure fails, such as, when the LDAP server went down.
s The LDAP server was swapped out.

= FndGrantsSD.xml data was loaded to the database using SDF programs directly
bypassing the patching infrastructure.

s The file jps-config-jse.xml contains invalid or incorrect configurations.
= Security data was migrated to a staging or to a production environment.

= Enterprise roles in the identity store were dropped and imported again using a
migration tool.

This section includes the following topics:
s Prerequisites to Running DSDataMigrator

s DSDataMigrator Syntax

4.4.3.1 Prerequisites to Running DSDataMigrator

Before an administrator runs this command, it is assumed that:

s The Fusion Application has been installed (so that Oracle Fusion Data Security has
been loaded).

s The XML policies (jazn-data.xml) have been migrated to an Oracle Internet
Directory server.

s The FND_GRANTS table has been backed up, as illustrated in the following
invocation:
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>sglplus sys as sysdba
create table FUSION.FND_GRANTS OLD as select * from FUSION.FND_GRANTS;

s The classpath in the shell where the command is to be run contains the following
JAR files:

— MW_HOME/atgpf/atgpf/modules/oracle.applcore.model_
11.1.1/Common-Model. jar.

— MW_HOME/atgpf/atgpf/modules/oracle.applcore.model_
11.1.1/DataSecurity-Model.jar.

— MW_HOME/oracle_common/modules/oracle.adf.model_11.1.1/adfm.jar.

— MW_HOME/oracle_common/modules/oracle.adf.share_
11.1.1/adf-share-support.jar.

— MW_HOME/oracle_common/modules/oracle.adf.share.ca_
11.1.1/adf-share-ca.jar.

— MW_HOME/oracle_common/modules/oracle.adf.share.ca_
11.1.1/adf-share-base.jar.

— MW_HOME/oracle_common/modules/oracle.adf.share_
11.1.1/jsp-el-api.jar.

— MW_HOME/oracle_common/modules/oracle.adf.businesseditor_
11.1.1/adf-businesseditor.jar.

— MW_HOME/oracle_common/modules/oracle.adf.share_
11.1.1/adflogginghandler. jar.

— MW_HOME/oracle_common/modules/oracle.jps_11.1.1/jps-manifest.jar.
— MW_HOME/modules/javax.jsp_1.2.0.0_2-1.jar.
— MW_HOME/oracle_common/modules/oracle.mds_11.1.1/mdsrt.jar.

— MW_HOME/oracle_common/modules/oracle.javatools_
11.1.1/resourcebundle. jar.

— MW_HOME/oracle_common/modules/oracle.javatools_
11.1.1/javatools-nodeps. jar.

— MW_HOME/wlserver_10.3/server/ext/jdbc/oracle/11g/ojdbch. jar.

= Optionally, the identity store has been seeded.

Notes: The files Common-Model.jar and DataSecurity-Model.jar
are expected to be in the paths indicated above, but, depending on the
environment, the could be installed in some other location. To find out
the location of those files in your environment, invoke the following
commands at the top of the Mi_HOME directory:

>find . -name "Common-Model.jar"

>find . -name "DataSecurity-Model.jar"

DSDataMigrator is executed automatically when (and only when) a
patch containing the data security grants seed data file
FndGrantsSD.xml is applied to the environment. In particular, the
script is not executed automatically if the seed data file is applied
manually.
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4.4.3.2 DSDataMigrator Syntax

DSDataMigrator is located in the directory
oracle.apps.fnd.applcore.dataSecurity.util, and it has the following syntax
(arguments are written in separate lines for the sake of clarity only):

java -classpath S$SCLASSPATH
-Doracle.security.jps.config=path to the jps-config-jse.xml file
-DFND_DS_GUID_RECON_LOG_DIR=path to the log output directory
DSDataMigrator -dsdburl dsdbURL
-dsdbuser dsdbUser
-silentMode <true_or_false>
-forceProcessAllRows truelfalse
-policyStripe FA policy stripe name
-idStoreOnly true|false
-validationMode true|false
-multiTenantAware true|false
-enterprise_id enterpriseId

When run and before processing security data, the command prompts the
administrator for the database password.

The meaning of the arguments is as follows:

m oracle.security.jps.config specifies the location of the configuration file
jps-config-jse.xml where the policy store and identity store are configured. This
file must include the appropriate bootstrap credentials to access the policy store.
The following fragment of a configuration file illustrates the specification of
credentials for a policy store instance:

<serviceInstance provider="ldap.policystore.provider" name="policystore.ldap">
<property value="OID" name="policystore.type"/>
<property value="bootstrap_123456" name="bootstrap.security.principal.key"/>
<property value="cn=st2_d8b3" name="oracle.security.jps.farm.name"/>
<property value="cn=FusionAppsPolicies"
name="oracle.security.jps.ldap.root.name" />
<property value="ldap://adc2110301.us.oracle.com:33060" name="ldap.url"/>
</servicelnstance>

<servicelInstance location="./bootstrap" provider="credstoressp"
name="bootstrap.cred">

<property value="./bootstrap" name="location"/>
</servicelnstance>

Typically, the file jps-config-se.xml is located in the directory DOMAIN_
HOME/servers/server_name/CommonDomain/config/fmwconfig. If this file is
moved to a different location, the bootstrap directory (which contains the file
cwallet.sso) must also be moved to that new location.

= dsdburl specifies the URL of the data base where Oracle Fusion Data Security is
stored.

= dsdbuser specifies the name of the user that can access the data base.

= silentMode specifies whether the command should raise exceptions when an
entry is not found in the OID server. Set to TRUE to prevent raising these kind of
exceptions; otherwise, set to FALSE. Default value: FALSE.

» forceProcessAllRows specifies whether all rows in the FND_GRANTS table should
be processed. Set to TRUE to process all rows in that table; otherwise, set to FALSE.
The default behavior is FALSE and processes just those rows with the compile_
flagissettoY.
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»s policyStripe specifies the name of the Oracle Fusion application stripe in the
policy store. Typical values are fscm, crm, and hem.

= idStoreOnly specifies whether only data security grants granting to enterprise
roles should be processed. Set to TRUE to process only grants granting to
enterprise roles; otherwise, set to FALSE to process all grants. When set to TRUE, the
value of the argument policyStripe is ignored. Default value: FALSE.

= validationMode specifies to run the script in read only mode (validation mode).
Set to TRUE to run the script without updating the database data. Set to FALSE to run
the script and update database data. Default value: FALSE. A validation run of the
script is useful to find out if any reconciliation is needed between the database and
the LDAP store.

s multiTenantAware specifies whether the environment is a multi-tenant
environment; applies only to multi-tenant environments; set to TRUE to indicate a
multi-tenant environment. Default value: FALSE. When set to TRUE, the argument
enterprise_id must be passed.

m enterprise_id specifies the tenant id for which the reconciliation will be
performed; if specified, the value passed for mutiTenantAware must be TRUE. This
value is the attribute orc1MTTenantGUID in the LDAP repository that is stored in
the ENTERPRISE_ID column of the ApplCore/Application tables.

4.4.3.3 Examples of Use

Running the program without any arguments prints out the usage instructions; a
sample invocation (in a non-multi-tenant environment) is the following:

java -classpath $CLASSPATH
-Doracle.security.jps.config=/home/sayarram/work/jps/jps-config-jse.xml
oracle.apps.fnd.applcore.dataSecurity.util.DSDataMigrator

-dsdburl myURL -dsdbuser fusion -silentMode true

-forceProcessAllRows true -policyStripe fscm

When run, the program generates a log file with the details of records processed,
warnings, errors, and a summary of what has been processed.
A sample invocation in a multi-tenant environment is the following;:

java -classpath $CLASSPATH
-Doracle.security.jps.config=/home/sayarram/work/jps/jps-config-jse.xml
oracle.apps.fnd.applcore.dataSecurity.util.DSDataMigrator

-dsdburl myURL -dsdbuser fusion -silentMode true -forceProcessAllRows true
-policyStripe fscm -multiTenantAware true -enterprise_id 202

4.4.4 Managing Data Security

For details on topics related to data security management, see the following
documents:

»  Oracle Fusion Applications Security Guide
»  Oracle Fusion Applications Security Hardening Guide

For details about creating data role templates, see the "Oracle Fusion Applications
Data Role Templates" chapter in the Oracle Fusion Middleware Oracle Authorization
Policy Manager Administrator’s Guide (Oracle Fusion Applications Edition).
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4.5 Configuring Roles

An enterprise role or enterprise group is a collection of users and other enterprise
roles, and it is stored in the domain identity store. An application role is a collection of
users, enterprise roles, and application roles, and it is stored in the domain policy
store.

In the Oracle Authorization Policy Manager environment, enterprise roles are referred
to as external roles. In the Oracle WebLogic Administration Console, enterprise roles
are referred to as enterprise groups.

Roles can be structured in a hierarchy by the relation "inherits." If a parent role inherits
a child role, then the parent role can do anything that the child role can do (in addition
to what the parent role can do).

Mapping an enterprise role to an application role establishes that the enterprise role
inherits the application role, thus, the privileges of the enterprise role become the
union of its privileges and those of the application roles to which it is mapped.

For details about managing the role mapping after the application has been deployed,
see the following topics in Oracle Fusion Middleware Oracle Authorization Policy Manager
Administrator’s Guide (Oracle Fusion Applications Edition):

= Managing Role Mapping Policies

= Mapping External Roles to an Application Role

For details about managing data security policies in Oracle Fusion applications, see the
"Managing Oracle Fusion Applications Data Security Policies" section in the Oracle

Fusion Middleware Oracle Authorization Policy Manager Administrator’s Guide (Oracle
Fusion Applications Edition).

For details about generating data roles with data role templates, see the "Oracle Fusion
Applications Data Role Templates" section in the Oracle Fusion Middleware Oracle
Authorization Policy Manager Administrator’s Guide (Oracle Fusion Applications Edition).

This section includes the following topics:
= Configuring Oracle Fusion Application Roles

= Configuring Enterprise Roles

4.5.1 Configuring Oracle Fusion Application Roles

Oracle Fusion applications use the following enterprise and application roles in their
application policies and data security policies:

= Data role, an enterprise role used exclusively in data security policies. It can
inherit Job, Duty, and Abstract roles. A number of data roles are provisioned with
each Oracle Fusion application.

= Job role, or Business role, is an enterprise role that corresponds with a job or
business occupation. A Job role must inherit at least a Duty role.

= Duty role, or Task role, is an application role that corresponds with the duties of a
job.

»  Abstract role is an enterprise role that can be associated with any user, irrespective
of his job or duties. Typical examples of this role are Employee, Manager,
Customer, and Supplier. Several job roles are provisioned with each Oracle Fusion
application. An Abstract role must inherit at least a Duty role.
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Oracle Authorization Policy Manager is the recommended tool to manage application
roles once the application has been deployed. Using this tool an administrator can, for
example, create, remove, or modify an application role; or modify the hierarchy of
application roles; or create, remove, or modify the application role category. For details
about the tool, see the "Managing Applications" section in the Oracle Fusion Middleware
Oracle Authorization Policy Manager Administrator’s Guide (Oracle Fusion Applications
Edition).

Table 4-2 lists the equivalent terms used in the physical and reference
implementations. The terminology in the physical implementation follows the one
used in Oracle Fusion applications; the terminology in the reference implementation
follows the one used in the Oracle Authorization Policy Manager graphic interface.

Table 4-2 Equivalent Terminology

Physical Implementation Reference Implementation

Data role Enterprise role used only in data security policies. Typically,
the name of a data role has the suffix _DATA.

Job Enterprise role mapped to application role. Typically, the name
of this role has the suffix _JOB.

Abstract role Enterprise role, which are persisted as LDAP groups and can
be managed with Oracle Authorization Policy Manager and
Oracle Identity Management.

Duty Application role used only in application policies.
Privilege Entitlement (or permission set).

FND Grant (or Foundation Data security policy, which ties a data role or job role to a
Grant) specific set of data.

For definitions and details about the terms in the reference implementation, see the
"Understanding the Policy Model" section in the Oracle Fusion Middleware Oracle
Authorization Policy Manager Administrator’s Guide (Oracle Fusion Applications Edition).

4.5.2 Configuring Enterprise Roles

A security administrator uses integrated Oracle Identity Management pages to create
and manage enterprise (job) roles in Oracle Fusion applications. For details, see the
"Organization and Role Management" section in the Oracle Fusion Middleware User’s
Guide for Oracle Identity Manager.

4.6 Configuring Audit Trail

Auditing features are provided through Audit Trail, a history of the changes that have
been made to data in Oracle Fusion Applications. Audit Trail enables you to track who
made changes to data, at what time, and how the value changed.

For more information and configuration details, see the "Implementing Audit Trail
Reporting" chapter in Oracle Fusion Applications Developer’s Guide.

Note: Oracle Fusion Middleware Audit Framework is a separate
service that provides a centralized audit framework for the
middleware family of products. For details about this feature, see
"Configuring and Managing Auditing" in the Oracle Fusion Middleware
Application Security Guide.
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4.7 Configuring SSL for Oracle Fusion Applications

SSL provides secure communication between the paths that connect endpoints. For
example, the path between Oracle WebLogic Server and an LDAP directory server is
secured through SSL.

This section contains the following topics:

= SSL Configuration in Oracle Fusion Middleware

= SSL Configuration for Oracle Fusion Applications

= Implementing SSL for Identity Management Configuration
= Additional SSL Configuration

= Enabling Secure Sockets Layer on ECSF

4.7.1 SSL Configuration in Oracle Fusion Middleware

Oracle Fusion Middleware provides SSL configuration features across the three tiers
of the enterprise stack (Web, Middle, and Data tiers). SSL configuration is consistent
and uniform across all Oracle Fusion Middleware system components and
applications.

This section contains the following topics:
= SSL and Infrastructure Hardening

s Communication in the Three-Tier Model

4.7.1.1 SSL and Infrastructure Hardening

SSL-enabling communication paths is one element in a hardening process whose aim
is to ensure that all appropriate security features are activated and configured correctly
in the various major systems and subsystems that comprise Oracle Fusion
Middleware.

The discussion in this document is limited to SSL features available to Oracle Fusion
applications. For information about other elements of hardening, see the Oracle Fusion
Applications Security Hardening Guide.

4.7.1.2 Communication in the Three-Tier Model

Oracle Fusion Middleware supports a three-tier structure: the Web tier contains load
balancers and other components outside the firewall, the middle tier hosts Oracle
WebLogic Server and its applications, and the Data tier contains databases and
directories. Different administration tools are shown at the top of the figure.

Figure 4-2 shows the location of key elements in this architecture:
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Figure 4-2 Oracle Fusion Middleware and the Three-Tier Model
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In the figure, the vertical broken lines represent firewalls. The circles represents
listeners that can be SSL-enabled for secure communication. As the figure shows, all
critical communication paths can be protected with SSL regardless of the tier(s)
involved.

For more information, see the "About SSL in Oracle Fusion Middleware" section in the
Oracle Fusion Middleware Administrator’s Guide.

4.7.2 SSL Configuration for Oracle Fusion Applications

Key connections in Oracle Fusion Applications can be secured either during
provisioning or post-provisioning.

This section contains the following topics:
= Basic Network Topology

= Provisioned SSL. Connections
4.7.2.1 Basic Network Topology

Figure 4-3 shows a high-level representation of a three-tier network topology in the
typical Oracle Fusion Applications environment:
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Figure 4-3 SSL Connections for Basic Network Topology
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Notes:
s The diagram shows some representative domains.

s OAP is the Oracle Access Protocol used by Oracle Access
Manager. LDAPS is the LDAP-over-SSL protocol.

Several approaches to configuring SSL are available in the Oracle Fusion Applications
environment:

1. You can choose not to enable SSL connections during provisioning.

2. You can choose to SSL-enable connections to certain components during
provisioning.

These connections are shown as solid lines (red) in the diagram and include IdM
components like Oracle Access Manager and Oracle Internet Directory. Table 4-3
lists these connections.

3. You can SSL-enable connections post-provisioning.

If you started with Option 2, you can now protect service-to-service connections
like those shown in dotted lines (blue) in the diagram; this includes, for example,
connections to Oracle Business Intelligence, ECSF, and external Web services. For
details about this wiring, see Section 4.7.4.

If you started with Option 1, you would SSL-enable Oracle Identity Management
first (see Section 4.7.3), followed by the service-to-service connections (see
Section 4.7.4).

Note the following assumptions about this topology:
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= In most environments, the Fusion Applications middleware servers operate on an
isolated network within the larger corporate network.

This means that such components as Oracle HTTP Server (OHS), Oracle WebLogic
Server, Oracle Business Intelligence, and others required for the Oracle Fusion
Applications instance all run within a single isolated network.

s Likewise, the Oracle Fusion Applications database runs in either the same isolated
network or on its own isolated network that can only be reached by means of the
application's private network.

= Because most business applications do not face the extranet, the HITTP server
(OHS) tier is typically not segregated into its own DMZ.

= External dependencies for Oracle Identity Management components, represented
in the figure by Oracle Access Manager and Oracle Internet Directory servers, are
assumed to reside outside this isolated network.

4.7.2.2 Provisioned SSL Connections

As mentioned earlier, Oracle Fusion applications are configured with SSL for client
traffic inbound to OHS and traffic to and from the identity management zone.
Table 4-3 shows the connections that are SSL-enabled at provisioning:

Table 4-3  Provisioned SSL Connections

Connection Path Protocol Default SSL Connection

Incoming HTTP Traffic (client to HTTP server) HTTPS One-way SSL (trust in server)

mod_webgate to Oracle Access Manager OAP One-way SSL (trust in server)

Oracle WebLogic Server to LDAP server (Oracle LDAPS One-way SSL (trust in server)
Internet Directory/Oracle Virtual Directory)

SSL can also be enabled for these connections post-provisioning by following the
instructions in Section 4.7.3.

4.7.3 Implementing SSL for Identity Management Configuration

As mentioned, you can SSL-enable the connections shown in Table 4-3 during Oracle
Fusion Applications provisioning.

You can also SSL-enable these connections post-provisioning, by following the
instructions provided in this section.

These instructions rely on the fact that, during the provisioning process, self-signed
server certificates are created and configured for all Oracle Fusion Applications
domain Weblogic Server instances. Thus:

= Each self-signed certificate is associated with an Oracle WebLogic Server instance
through its identity store, located at:

fusionapps/wlserver_10.3/server/lib/hostname_fusion_identity.jks

»  The self-signed certificates are imported as trusted certificates into a common trust
store named fusion_trust.jks, located at:

fusionapps/wlserver_10.3/server/lib

This common trust store also contains the identity management trust CA
certificates provided during provisioning's configuration steps.

4-18 Oracle Fusion Applications Administrator's Guide



Configuring SSL for Oracle Fusion Applications

s The common trust store is ready for all outbound SSL connections to external web
services deployed with the same trusted certificates.

Using the common trust store fusion_trust.jks and the identity key store hostname_
fusion_identity.jks, you can configure SSL between the Oracle HTTP Server
instances and the related Oracle Fusion Applications domain Weblogic Server
instances as follows:

1. Enable outbound SSL for the Web tier. For each OHS instance:

a. Locate the configuration file FusionVirtualHost_fs.xml, which resides in the
following directory:

ohs_instance/CommondDomain_

webtier/config/0OHS/ohsl/moduleconf/FusionVirtualHost_fs.xml

b. Check Enable SSL in the configuration file FusionVirtualHost_fs.xml.

c. Change the current (non-SSL HTTP) ports to point to the Oracle Fusion
Applications Weblogic instance SSL ports.

All OHS virtual hosts are now configured for HTTPS.

2. Enable SSL for inbound connections to the middle tier. For each Oracle WebLogic
Server instance in the Oracle Fusion Applications domain:

a. Enable SSL for the configured SSL port. You can use the Oracle WebLogic
Server administrative console or a WLST command.

b. For Oracle WebCenter Portal, change all connections specified in the
connections.xml file to use HTTPS instead of HTTP. Change all ports to SSL
ports. As an alternative, the internal virtual host can be configured to route all
incoming traffic to use HTTPS.

For an example of connections.xml, see Oracle Fusion Middleware Developer's
Guide for Oracle WebCenter Portal (Oracle Fusion Applications Edition).

c. For Oracle SOA Suite composite deployment connections, all composites must
be rewired and redeployed.

Since all composites are already wired to the internal virtual host, a simpler
approach is to redirect all HTTP traffic coming in to the internal virtual host to
use HTTPS.

3. If the topology includes a load balancer (LBR), since LBR and OHS are both SSL
endpoints, you must SSL-enable all internal virtual IP's, and import the CA
certificates from the Web tier (Oracle HTTP Server or Oracle Web Cache)
cwallet.sso to the LBR trust store:

a. Export all the trusted certificates to PEM (text format) using the orapki utility.

b. Import the PEM format certificates to the load balancer. Refer to the LBR
documentation for SSL trust configuration.

4.7.4 Additional SSL Configuration

Besides the connections that are SSL-enabled during provisioning, there are additional
connections in the Oracle Fusion Applications environment that can be SSL-enabled.
For example, you can secure traffic to Oracle Database.

This section contains the following topics:

= SSL-enable Oracle Identity Management
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»s  SSL-enable Oracle Business Intelligence
= SSL-enable ECM
= SSL to External Web Services

4.7.4.1 SSL-enable Oracle Identity Management

Oracle Identity Management components reside in either the middle tier or the data
tier of Oracle Fusion Middleware and can be individually configured for SSL.

Table 4—4 lists the components and references for configuration details.

Table 4-4  SSL for Oracle Identity Management Components

Task Reference

SSL-enable Oracle Internet ~ "Enabling SSL on Oracle Internet Directory Listeners" section in
Directory the Oracle Fusion Middleware Administrator’s Guide

SSL-enable Oracle Virtual "Enabling SSL on Oracle Virtual Directory Listeners" section in
Directory the Oracle Fusion Middleware Administrator’s Guide

Enable SSL Between Oracle "Enabling Outbound SSL from Oracle Internet Directory to
Internet Directory and the ~ Oracle Database" section in the Oracle Fusion Middleware
Database Administrator’s Guide

Enable SSL Between Oracle  "Creating LDAP Adapters" section in the Oracle Fusion
Internet Directory and Middleware Administrator’s Guide for Oracle Virtual Directory
Oracle Virtual Directory

Enable SSL for data source "SSL-Enable a Data Source" section in the Oracle Fusion
Middleware Administrator’s Guide

4.7.4.2 SSL-enable Oracle Business Intelligence

You can configure the components of Oracle Business Intelligence to communicate
over SSL.

For configuration details, see "SSL Configuration in Oracle Business Intelligence"
chapter in the Oracle Fusion Middleware Security Guide for Oracle Business Intelligence
Enterprise Edition.

4.7.4.3 SSL-enable ECM

You can configure SSL for Oracle ECM applications running in a production or
development environment.

For configuration details, see "Configuring SSL for Oracle WebCenter Content
Applications" section in the Oracle WebCenter Content Installation Guide.

4.7.4.4 SSL to External Web Services

For information about securing Oracle Fusion Web Services, see the following:

= "Locking Down Web Services: Points to Consider" section in the Oracle Fusion
Applications Security Hardening Guide

» "Hardening Web Services" section in the Oracle Fusion Applications Security
Hardening Guide
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4.7.5 Enabling Secure Sockets Layer on ECSF

Enable Secure Sockets Layer (SSL) on ECSF to secure all connections that transmit
passwords. These include connections to Oracle WebLogic Server, the ECSF servlet,
and the Oracle SES server.

To enable SSL for ECSF, perform the following tasks:

s Task 1, "Generate a Certificate for the Oracle WebLogic Server Instance"

s Task 2, "Enable SSL on the Oracle WebLogic Server Instance"

s Task 3, "Add the Oracle WebLogic Server's Certificate to Oracle SES's Trust Store"
s Task 4, "Enable SSL for Oracle SES Services"

s Task 5, "Configure Search Engine Instances to Use SSL"

Task 1 Generate a Certificate for the Oracle WebLogic Server Instance

A certificate that contains the public key of the Oracle WebLogic Server instance
hosting ECSF must be generated. This can be either a CA-signed certificate or a
self-signed server certificate.

For information about how to generate the certificate, see Oracle Fusion Middleware
Securing Oracle WebLogic Server.

As described later (Task 3), if this is a self-signed certificate, then it must be imported
to Oracle SES's truststore. If it is a CA-signed certificate, it likely already exists in the
truststore; if not, you must import the CA certificate into Oracle SES's truststore.

Task 2 Enable SSL on the Oracle WebLogic Server Instance

Enabling SSL connections on the Oracle WebLogic Server instance, on which the ECSF
application is running, secures the ECSF servlet connections used to access the feeds
and the security service. For more information, see the "Configuring SSL" chapter in
Oracle Fusion Middleware Securing Oracle WebLogic Server.

To enable SSL on Oracle WebLogic Server:
1. Configure SSL.
= Select the server on which the ECSF application is running.

= Make sure that the Allow Unencrypted Null Cipher checkbox is deselected
(default).

2. Configure the listen ports to enable the SSL listen port (check the SSL Listen Port
Enabled checkbox).

Note: The SSL Listen Port is usually set as 7002. You can use this
port number to access the ECSF servlet through SSL (for example
https://mywlsserver.oracle.com:7002/approot/searchfeedservle
t/ConfigFeed). Also note that the protocol in the URL must be https.

3. Save your changes.

Task 3 Add the Oracle WebLogic Server's Certificate to Oracle SES's Trust Store

When Oracle SES initiates SSL connections to ECSF, the Oracle WebLogic Server
instance on which the ECSF Servlet is running sends a digital certificate containing its
public key to Oracle SES. If this certificate is a self-signed certificate, then the certificate
must be extracted from Oracle WebLogic Server and added to Oracle SES's trust store.
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(If a CA certificate, ensure that it exists in the SES trust store.) For more information
about adding the certificate to the trust store, see the Oracle Secure Enterprise Search
Administrator’s Guide.

To add the Oracle WebLogic Server certificate to the Oracle SES trust store:

1. Use the keytool utility (located in ORACLE_HOME/jdk/bin) to export the Oracle
WebLogic Server's certificate from the keystore, for example:

keytool -export -alias weblogic -keystore JAVA_
HOME/jre/lib/security/cacerts -file /temp/weblogic.cer

where Oracle WebLogic Server's certificate, located in the keystore at JAVA_
HOME/jre/lib/security/cacerts, is exported to the weblogic.cer file in the
/temp directory; this file now contains the server's certificate.

2. Navigate to the Oracle SES installation directory, and use keytool to import the
Oracle WebLogic Server's certificate into the Oracle SES keystore, for example:

keytool -import -alias weblogic -file weblogic.cer -keystore ORACLE_
HOME/jdk/jre/lib/security/cacerts

where Oracle WebLogic Server's certificate in the weblogic. cer file is imported
into the Oracle SES keystore at ORACLE_HOME/jdk/jre/lib/security/cacerts.

Task 4 Enable SSL for Oracle SES Services

You must also enable SSL on Oracle SES Query and Admin Services. For more
information about how to enable SSL, see Oracle Secure Enterprise Search Administrator’s
Guide.

Since the Oracle SES server's certificate has not been signed by a reputable certificate
authority (CA) but instead is a self-signed certificate, you must extract the certificate
from Oracle SES and add it to both Oracle WebLogic Server's trust store and ECSF
Command Line Administration Utility's trust store using these steps:

1. Use keytool to add the extracted Oracle SES server's certificate to the trust store
that Oracle WebLogic Server is configured to use, for example:

keytool -import -alias oses -file oses.cer -keystore WLS_keystore

where Oracle SES server's certificate in the oses. cer file is imported into WLS_
keystore, which is the keystore that Oracle WebLogic Server is configured to use.

2. Add the extracted Oracle SES server's certificate to ECSF Command Line
Administration Utility's trust store by modifying the runCmdLineAdmin.bat and
runCmdLineAdmin. sh scripts, located in ORACLE_HOME/jdeveloper/ecst, so that
JAVA_HOME points to the path of the keystore that Oracle WebLogic Server is using.

Task 5 Configure Search Engine Instances to Use SSL

After SSL is enabled, you must reconfigure the search engine instance parameters that
contain URLs that point to the ECSF server. These parameters are ECSF_DATA_SERVICE,
ECSF_SECURITY_SERVICE, and ECSF_REDIRECT_SERVICE.

The protocol must change from http to https, and the http port must change from
7101 to 7002, the SSL port. For example, you need to change
http://wlsserver.com:7101/approot/searchfeedservlet to
https://wlsserver.com:7002/approot/searchfeedservlet.

You must also reconfigure the search engine instance parameters that contain URLs
that point to the Oracle SES server. These parameters are SES_ADMIN_SERVICE and SES_
QUERY_SERVICE.
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The protocol must change from http to https. For example, you need to change
http://sesserver.com:7777/search/api/admin/AdminService to
https://sesserver.com:7777/search/api/admin/AdminService. You do not need to
change the port number because the instructions will switch the current port to be an
SSL port instead of adding a separate SSL port.

You can use Fusion Applications Control to configure the engine instance parameters.
For information, see Section 7.5.3.2.

4.8 Managing Wallets, Keystores, Credentials, and Certificates

Enabling SSL requires the use of a number of security artifacts such as certificates and
keys, as well as the containers (keystores) where they are stored. Oracle Fusion
Middleware provides a number of tools to create and maintain these artifacts.

This section contains the following topics:

= Wallets and Keystores

=  Management Tools

= Managing Wallets and their Contents

= Managing Keystores and their Contents

= Managing Credentials

4.8.1 Wallets and Keystores

Oracle Fusion Middleware provides two types of repositories (keystores) for keys and
certificates:

= JKS Keystore and Truststore
= Oracle Wallet

For more information about wallets and keystores, see Section 4.7.2.

4.8.1.1 JKS Keystore and Truststore

A JKS keystore is the default JDK implementation of Java keystores. In 11g Release 1
(11.1.1), all Java components and Java EE applications use the JKS-based keystore and
truststore.

While creating a keystore, you can pre-populate it with a keypair wrapped in a
self-signed certificate. Such a keystore is typically used in development and testing
phases.

You can also generate a certificate signing request for a keypair and request a signed
certificate back from a Certificate Authority (CA). Once the CA sends the certificate
back, it is imported into the keystore. The keystore now contains a trusted certificate
since it comes from a trusted third-party. Such a keystore is typically used in
production.

For more information about creating and managing keystores, see the"JKS Keystore
and Truststore" section in the Oracle Fusion Middleware Administrator’s Guide.

4.8.1.2 Oracle Wallet

An Oracle wallet is a type of keystore or container that stores your credentials, such as
certificates, trusted certificates, certificate requests, and private keys. You can store
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Oracle wallets on the file system or in LDAP directories such as Oracle Internet
Directory.

In the Oracle Fusion Applications environment, Oracle wallets are used by Oracle
HTTP Server, LDAP clients, and SQL*net clients.

When creating a wallet, you can pre-populate it with a self-signed certificate. Such a
wallet is called a test wallet and is typically used in development and testing phases.

You can also create a certificate request and request a signed certificate back from a
Certificate Authority (CA). Once the CA sends the certificate back it is imported into
the wallet. Such a wallet is called a third-party wallet.

For more information about creating and managing wallets, see the "Oracle Wallet"
section in the Oracle Fusion Middleware Administrator’s Guide.

4.8.1.3 Keystore Types Used by Products

Table 4-5 shows the type of keystore, either Oracle wallet or JKS keystore, used by
various products:

Table 4-5 Keystore Types for Products

Product Type of Keystore Used
Oracle HTTP Server Oracle Wallet

Oracle Internet Directory Oracle Wallet

Oracle Virtual Directory JKS-based Keystore
Oracle WebLogic Server JKS-based Keystore
Oracle SES Services JKS-based Keystore
Oracle ECM JKS-based Keystore

Oracle Business Intelligence JKS-based Keystore

See Section 4.8.2 for a survey of common tools used to create and manage keystores.
See the SSL references in Section 4.7 for the keystore management tools used by
individual products.

4.8.2 Management Tools

Oracle Fusion Middleware provides these tools for keystore operations:
s WLST, a command-line interface for JKS keystores and wallets

= orapki, a command-line tool for wallets

»  Fusion Middleware Control, a graphical user interface

s Oracle Wallet Manager, a stand-alone GUI tool for wallets, recommended for
managing PKCS#11 wallets

» the keytool utility

For more information about these management tools, see the "Keystore Management
Tools" section in the Oracle Fusion Middleware Administrator’s Guide.
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4.8.3 Managing Wallets and their Contents

When working with certificates and the wallets in which they are stored, you must be
aware of the operations that can be performed on these objects in the course of routine
administration:

Wallet Lifecycle
Wallet Operations
Certificate Lifecycle

Certificate Operations

4.8.3.1 Wallet Lifecycle

Typical life cycle events for an Oracle wallet are as follows:

The wallet is created. Wallets can be created directly, or by importing a wallet file
from the file system.

The list of available wallets is viewed and specific wallets are selected for update.

Wallets are updated or deleted. Update operations for password-protected wallets
require that you enter the wallet password.

The wallet password can be changed for password-protected wallets.
The wallet can be deleted.

Wallets can be exported and imported.

4.8.3.2 Wallet Operations
Typical operations for the Oracle Wallet include the following;:

Creating wallets, including auto-login, self-signed, and password-protected
wallets

Changing a self-signed wallet to a third-party wallet

Note: Third-party wallets contains certificates signed by a trusted
Certificate Authority (CA).

Exporting and importing wallets to and from the file system

Deleting a wallet.

4.8.3.3 Certificate Lifecycle

The following provides a summary of the steps in a certificate's lifecycle:

1.

o g & 0 b

Create an empty wallet (that is, a wallet that does not contain a certificate request).
Add a certificate request to the wallet.

Export the certificate request.

Use the certificate request to obtain the corresponding certificate.

Import trusted certificates.

Import the certificate.
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4.8.3.4 Certificate Operations

Common certificate operations include:

Creating a certificate request

Exporting a Certificate, Certificate Request, or a Trusted Certificate
Importing a Certificate or a Trusted Certificate

Deleting a Certificate Request, a Certificate, or a Trusted Certificate

Converting a Self-Signed Certificate into a Third-Party Certificate.

Note: Third-party certificates are signed by a trusted Certificate
Authority (CA).

4.8.4 Managing Keystores and their Contents

When working with JKS certificates and the keystores in which they are stored, you
must be aware of the operations that can be performed on these objects in the course of
routine administration:

Keystore Lifecycle
Keystore Operations
Certificate Lifecycle

Certificate Operations

4.8.4.1 Keystore Lifecycle

Typical life cycle events for a JKS keystore are as follows:

The keystore is created. Keystores can be created directly, or by importing a
keystore file from the file system.

The list of available keystores are viewed and specific keystores selected for
update.

Keystores are updated or deleted. Update operations require that the keystore
password be entered.

The keystore password can be changed.
The keystore can be deleted.

Keystores can be exported and imported.

4.8.4.2 Keystore Operations

Typical keystore operations include the following;:

Creating or updating a keystore.
Exporting and importing keystores.
Deleting a keystore.

Changing the keystore password.

4.8.4.3 Certificate Lifecycle

Typical life cycle events for a certificate residing in a keystore are as follows:
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= A self-signed certificate is automatically created for the keypair.
= A certificate signing request (CSR) is generated, and can then be exported to a file.

s Certificates are imported into the keystore. You can import both user certificates
and trusted certificates (also known as CA certificates) in this way.

»  Certificates or trusted certificates are exported from the keystore out to a file.

»  Certificates or trusted certificates are deleted from the keystore.

4.8.4.4 Certificate Operations
Common operations on JKS certificates include the following:

= Generating a new key (that is, a new self-signed certificate) for a keystore.
= Generating a certificate signing request.
» Importing/exporting a certificate or trusted certificate into/from a keystore.

s Deleting a certificate or trusted certificate from a keystore.

4.8.5 Managing Credentials

In Oracle Fusion Applications, user and role information such as passwords are
maintained in a domain credential store. The tools you use to update existing
passwords (for routine administration or regulatory compliance), depend on the type
of credentials:

= WebLogic data sources

These objects contain properties such as the URL or user name and password.
Application components use data sources to obtain connections to a relational
database.

You can create and manage JDBC data sources using the administration tools
provided with Oracle WebLogic Server. For more information about managing
data sources, see Oracle Fusion Middleware Configuring and Managing JDBC Data
Sources for Oracle WebLogic Server and the "Configure JDBC data sources" topic in
Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.

= Application-specific credentials

These credentials provide access to different components of your application. An
example is the credential associated with the designated super-user.

Application credentials are maintained through Fusion Middleware Control or
Oracle WebLogic Scripting Tool (WLST). For details, see the "Configuring the
Credential Store" topic in the Oracle Fusion Middleware Application Security Guide.

This section contains the following topics:
s Changing App ID Passwords

s Changing the Oracle Fusion Middleware Administrative User Password

4.8.5.1 Changing App ID Passwords

When invoking Web services, Oracle Fusion Applications must rely on a type of
credential known as the Application ID or App ID. Each application has its own App
ID which is initially provisioned for the application.

Securing Oracle Fusion Applications 4-27



Managing Wallets, Keystores, Credentials, and Certificates

For information about resetting App ID passwords (a task typically done during
scheduled downtime), see the Application Identity Password Reset And Password
Policy Management section in the Oracle Fusion Applications Security Guide.

4.8.5.2 Changing the Oracle Fusion Middleware Administrative User Password

During the Oracle Fusion Applications installation, you must provide a password for
the Oracle Fusion Middleware administration user. By default, this administrator takes
the Super User value you specified on the Identity Management page when creating
the provisioning plan. The password is the one specified when adding the user to the
identity store.

Then, you can use this account to log in to Fusion Applications Control and the Oracle
WebLogic Server Administration Console for the first time. You can create additional
administrative accounts using the WLST command line or the Oracle WebLogic Server
Administration Console.

You can change the password of the administrative user using the Oracle WebLogic
Server Administration Console or the WLST command line.

This section contains the following topics:

s Changing the Oracle Fusion Middleware Administrative User Password Using the
Command Line

s Changing the Oracle Fusion Middleware Administrative User Password Using the
Administration Console

4.8.5.2.1 Changing the Oracle Fusion Middleware Administrative User Password Using the

Command Line

To change the Oracle Fusion Middleware administrative user password or other user
passwords using the command line, you invoke the
UserPasswordEditorMBean.changeUserPassword method, which is extended by the
security realm's AuthenticationProvider MBean.

For more information, see the changeUserPassword method in the Oracle Fusion
Middleware Oracle WebLogic Server MBean Reference.

4.8.5.2.2 Changing the Oracle Fusion Middleware Administrative User Password Using the
Administration Console

To change the password of the Oracle Fusion Middleware administrative user using
the Oracle WebLogic Server Administration Console:

1. Navigate to the Oracle WebLogic Server Administration Console. (For example,
from the home page of the domain in Fusion Applications Control, select To
configure and managed this WebLogic Domain, use the Oracle WebLogic Server
Administration Console.)

2. From the target navigation pane, select Security Realms.
The Summary of Security Realms page is displayed.

3. Select a realm, such as myrealm.
The Settings for the realm page is displayed.

4. Select the Users and Groups tab, then the Users tab. Select the user.
The Settings for user page is displayed.

5. Select the Passwords tab.
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6. Enter the new password, then enter it again to confirm it.

7.

Click Save.

4.9 Data Masking

Data masking is the ability to replace sensitive data with realistic but false data on test
and development databases. Features include:

the ability to keep data properties (data type, width, and so on) intact and provide
realistic data sets for analysis and testing.

ensuring various constraints like (Primary Keys, Uniqueness, Foreign keys) are
maintained, preserving relational integrity.

using user specified formatting rules that ensure custom and packaged
applications continue to work after the data is masked.

This section contains the following topics:

Introduction to Data Masking

Data Masking in Oracle Fusion Applications

Managing the Masking Definitions

Data Masking in Oracle Enterprise Manager Cloud Control
Best Practices when Masking Test Databases

References

4.9.1 Introduction to Data Masking

Data masking is an on-going activity for the Oracle Fusion Applications administrator.
It requires an understanding of masking concepts, methodology, and the
implementation tools:

Masking Terminology
Types of Sensitive Data
The FAST Methodology

Administration Tools

See Also: Oracle Database Real Application Testing User’s Guide.

4.9.1.1 Masking Terminology

Key terms used in data masking are as follows:

Pre Masking script - A SQL script that runs prior to the start of masking.

Post masking script - A SQL script that executes after all masking completes. For
example, such a script can be used to recompute aggregated columns after the
detailed data is masked. This ensures that aggregated and masked columns are
consistent and the totals match.

User-Defined Function (UDF) - A user-defined function takes the original value,
the row id, and column name to generate the mask value. A single column format
can be a combination of one of more formats including UDFE.

Post-processing function - This is a special case of a user-defined function. A post
processing function (PPF) is called after the mask value is generated using the
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specified format. The function takes the generated mask value and further
modifies it to produce the actual mask value.

For example if the format used Random Number (1000,10000) and Post Processing
Function (checksum) a number between 1000 and 10000 is generated and this
value is fed into the PPF. The PPF computes the checksum and appends it to the
original number and returns the new mask value.

There can be only one PPF to a column. A PPF cannot be the only format for a
column. There has to be some other format preceding the function.

4.9.1.2 Types of Sensitive Data

Examples of sensitive data include:

= Salary information

s Government IDs like drivers' license numbers and social security numbers
s Geographical data such as GPS coordinates

Each product family has its own set of sensitive data types.

For details about sensitive data types, see the Oracle Fusion Applications Security Guide.

4.9.1.3 The FAST Methodology

Data masking requires the user to implement the FAST (Find, Assess, Secure, Test)
methodology:

[ ] Find

The first step is to identify sensitive data that should be subject to data masking.
This includes personally identifiable data or information that could be misused.
Examples include:

- Salary Information

— Diriver's License Number
- Military Service ID

— Biometrics Data

Another aspect of this effort is to determine where this data is located. The
recommended procedure involves:

- Defining pattern-matching rules against sensitive tables and columns.
Examples of such rules include a column name like "*SSN*" or column format
T - H

For database independence, applications typically do not store the primary
key-foreign key relationships in the database itself; rather, the relationships are
enforced in the application. To support this, the Data Masking Pack provides
administrators with the ability to register these relationships so that columns
in related tables, such as EMPLOYEE_ID, MGR_ID, are masked identically using
the same masking rules.

- Searching Oracle databases to find these patterns.
— Importing the relevant database fields into a data privacy catalog.
— Maintaining the catalog as new fields are identified.

m Assess
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In this phase you specify how each sensitive field is to be masked, that is,
transformed into a non-sensitive representation while maintaining the field's
structure. This is typically accomplished through a data masking definition, which
associates tables and columns in a schema with appropriate masking formats. An
example is a mask format that converts the name "John" in the Employee table to
"Andy".

The Data Masking definition contains a list of sensitive columns in the application
tables, such as employee social security numbers, and its corresponding
association with data masking formats, such as a fictitious social security number
generator.

Note: Oracle Fusion Applications provide a set of default mask
templates for basic sensitive fields; administrators can update these
definitions according to application requirements. For details about
viewing and updating masking templates, see Section 4.9.3

s Secure

This phase enables the masks to be executed securely to generate the masked data.
Notable aspects of this phase include:

— Production database cloned in restricted mode for the execution

- Privilege delegation allowing the mask to be executed with tools like sudo or
PowerBroker

— Generation of test database
s Test

The test phase involves comparing before and after values for verification. Redo
logs are available to restore data to pre-mask state.

4.9.1.4 Administration Tools

Data masks and masking definitions are created and managed with Oracle Enterprise
Manager Grid Control.

4.9.2 Data Masking in Oracle Fusion Applications

The Oracle Fusion Applications administrator must take certain considerations into
account when implementing data masking for an application. For example, free space
requirements must be evaluated to ensure that adequate resources are available to the
masking job. The following instructions provide guidelines:

= Requirements for Data Masking
= Sensitive Data in Oracle Fusion Applications

= Masking Definitions

4.9.2.1 Requirements for Data Masking

You should be aware of certain background information, prerequisites, and
requirements before undertaking data masking operations in your environment.

This section contains the following topics:

= Data Model Descriptions
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= Required Versions

= Preliminary Steps

s Temporary Space Requirements

s Database Free Space Requirements

= Role Requirements

s Custom Field Masks

s Production-to-Test Requirement

4.9.2.1.1 Data Model Descriptions You must understand the data model for your
application data when deciding how and what to mask. For data model descriptions,
see the product-specific documentation from Oracle Enterprise Repository for Oracle
Fusion Applications.

4.9.2.1.2 Required Versions

Data masking requires the following:

s Oracle Database 10g Release 2 or Oracle Database 11g Release 1

s Oracle Enterprise Manager Grid Control 10g Release 4 or Oracle Enterprise
Manager Cloud Control 12c

s The Oracle Data Masking Pack

4.9.2.1.3 Preliminary Steps

You must perform certain steps, such as installing a format library and configuring
temp spaces, before using data masking in an Oracle Fusion Applications
environment:

1. Install the FMTLIB package, which contains functions needed to perform data
masking.

a. Locate these scripts in your Oracle Enterprise Manager installation:

SORACLE_HOME/sysman/admin/emdrep/sql/db/latest/masking/dm_fmtlib_pkgdef.sqgl
SORACLE_HOME/sysman/admin/emdrep/sql/db/latest/masking/dm_fmtlib_
pkgbody.plb

b. Copy these scripts to a directory in your target database installation.

c. Execute the scripts using SQL*Plus, connected as a user that can create
packages in the DBSNMP schema.

2. Apply any required patches. Data masking requires a specific Oracle Database
version and patch set. See Section 3.7.

3. Change the temp spaces used for data masking to "Auto Extend" from Grid
Control:

a. Click the Targets tab.
b. Click the Databases secondary tab.
c. Select the database, and click the Server tab.
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ORACLE Enterprise Manager
Grid Control 119

Database Instance: May3_DB

‘ Home | Performance Lwalability Server Schema Data Movement Softvware and Support

General Host CPU
Shurdown )| Black Out
100%
Status Up 75
Up Since Jun 30, 2010 12:00:49 PM PDT Other
Instance Name g0 1ys580 50 Wb
Wersion 11.1.0.7.0 5t SRR
Host dbhostl2.us. exarnple.com
Listener o

Vizws Al Propert i
et aE load 330 Paging 210.19

d. Click Datafiles.

ORACLE Enterprise Manager
Grid Control 11g

Database Instance: May3_DB

Schema Data Movernent Saftware and Support

Horme Performance Lwalability ‘ Server

Storage Database Configuration
Control Files Memory Advisors
T es Autornatic Undo Managernent
Temporary Tablespace Groups Initialization Parameters

Wiew Database Feature Usage
RolBack Segments

Redo Log Groups

Archive Logs

Migrate to ASM

Make Tablespace Locally Managed

Statistics Management Resource Manager
Autornatic Workload Repository. Getting Started
LWWR Baselines Consurmer Groups

Consumer Group Mappings

e. On the Datafiles page, enter temp in the Object Name search box. Press Go.
Two temp spaces are displayed:

ORACLE Enterprise Manager
Grid Control 11g

| all Targets

Database Instance: May3 DB >

Datafiles

Search

Select an object.tyap and optionally enter an object name to filter the data that is displayed in your results set.

Object Mame 7‘ '_)a [%

By default Dtafiles 37EThe-sensitive searches, To run an etsct mstch; double quots the search string. You can use the wilderd symbol (36) in s double quoted string,

Edit )| View ) Delete ) Actions| Create Like ¥ )

Select |Fi|e Name Tablespace Siatus
® jeotferns4207/orackefdhianps stidatafternpl 03.dbf TEMP1 OMNLINE
O jslotfems4207/orackefdbiapps stfdatafternnl 04.dbf TEMPZ OMNLINE

f.  Edit each temp space in turn by selecting its radio button and clicking Edit.
Change the value for each space as shown here:
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Database Instance: Mays DB > Datafiles =
Edit Datafile: temp1_03.dbf

File Marme temp1_03.dbf
File Directory /slot/ems4207/ oracle/db/ apps_st/data/
Tablespace TEMPL
Status & online O Offine
File Size 2550 [mE ]

Storage
[¥] automatically extend datafile when full (AUTOEXTEND)
Increment | 150 Jme ] [%
Maximurn File Size O Urfimited
@vae[3z767  [ME ¥

4.9.2.1.4 Temporary Space Requirements As shown in Step 3 of Section 4.9.2.1.3 it is
recommended that you autoextend your temp files as masking requires additional
space for processing. The amount of additional space you need depends on your data.
Broadly speaking, masking takes up approximately two times the size of the largest
table being masked.

The temp space is needed for two reasons:
s To perform sort and join operations during masking.

The space requirement is not straightforward to estimate as it depends on whether
sorts and joins go to disk, which in turn depends on how much memory is
available on the machine. Try to keep at least as much space as the size of your
biggest masked table for sort and join processing.

= For space taken up in the default user tablespace for temporary masking tables.

The size of the temp tables is twice the size of all the columns being masked. Since
these tables are dropped after processing, the space is released after masking
completes.

4.9.2.1.5 Database Free Space Requirements

Ensure that sufficient free space is available to the database before executing the
masking job.

Calculate the free space requirements as follows:

largest table being masked +

total size of mapping tables for all columns in that table +

temporary tablespace (roughly twice the size of the largest mapping table, as
stated under Temporary Space Requirements above)

4.9.2.1.6 Role Requirements

The user executing the data masking script must have the dba role. If Virtual Private
Database (VPD) security policies are used or Oracle Database Vault is enabled for the
database, the user must be SYS.

Additionally, the user may need to have direct grants to objects for any PL/SQL
objects provided to user-defined functions or post-processing scripts.

4.9.2.1.7 Custom Field Masks

Oracle Fusion Applications include a set of out-of-the-box masking definitions to mask
common sensitive data like employee information and credit card numbers. However,
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these default mask templates cannot account for custom data such as flex fields since
these are specific to your application.

You can update the standard masking definitions to include additional flex fields and
custom data. For details about viewing and updating masking templates, see
Section 4.9.3.

Note: Be aware that certain sensitive custom attributes may depend
on tables in other product families. For example, Procurement
masking is dependent on CRM (for Suppliers and related entities, and
for Procurement Contract terms and deliverables), on SCM (for Items),
on HCM (for Workers and Organizations), on FIN (for Ledgers), and
on Projects (for Projects and related entities).

4.9.2.1.8 Production-to-Test Requirement

During the production-to-test process, you must replace the production user names
with dummy user names. This mandatory step is needed to avoid breaking
anonymization.

4.9.2.2 Sensitive Data in Oracle Fusion Applications

Oracle Fusion Applications identify the common sensitive data types for each product
family.

You can use Oracle Enterprise Manager Grid Control or Oracle Enterprise Manager
Cloud Control to view the sensitive attributes specified in the masking definitions. You

can update the definitions with any additional desired sensitive attributes, such as flex
fields or other customized fields.

For details about how to view and update masking templates, see Section 4.9.3 and
Section 4.9.4.

For additional information about data masking, see the Oracle Fusion Applications
Security Guide.

4.9.2.3 Masking Definitions

A masking definition specifies the columns to be masked and the format of the
masked data. Out-of-the-box "template” masking definitions are provided for each
family of Oracle Fusion Applications.

Masking definitions in XML format masks enable the data masking utility to identify
the database tables, columns, and column formats of the data being masked.

For details, see the Oracle Fusion Applications Security Guide.

4.9.3 Managing the Masking Definitions

You can modify the default masks provided with Oracle Fusion Applications, and
create your own masking definitions. Use Oracle Enterprise Manager Grid Control
(Grid Control) to manage and maintain the data masking definitions.

Note: If using Oracle Enterprise Manager Cloud Control, see
Section 4.9.4.

This section contains the following topics:
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s Viewing and Modifying Data Masking Definitions
= Generating the Masking Script
s Customizing Mask Formats

Oracle Enterprise Manager Grid Control online help provides more details on these
topics.

Note: You must follow the instructions in Section 4.9.2.1 before you
can perform the operations described here.

4.9.3.1 Viewing and Modifying Data Masking Definitions

You can view and modify out-of-the-box data masking definitions as follows with
Grid Control:

1. Click the Targets tab.
2. Click the Databases secondary tab.

3. Select the database whose mask definition you are configuring from the list of
databases, and log in.

4. C(lick the Schema tab.

5. On the database instance page, scroll down to the Data Masking menu. The
options include:

= Definitions: Manage masking definitions.
s Format Library: Manage masking formats.

6. Select Definitions. The Data Masking Definitions page lists the current masks for
the database:

Data Masking Definitions

Data masking is the process of making sensitive information in test or non-production databases safe. ltdisguises sensitive
information by overwriting it with realistic looking but false data of a similar type. A masking definition defines the columns 1o
be masked and the format of masked data. You can create a new masking definition or use an existing definition fora

masking operation. The Format Library contains a collection of ready-to-use masking formats.

Search | Database ¢l ["db.example.com" l (Go) (Impart j{ Create )
| Wiew )| Edit )| Generate Script ) [ Schedule Job ) Delete ) Actions | Clone Database % | | Go
Most Recent
Select|Masking Definition Database Desecription Columns Status Job Ended
® HR_COMPOUND_MASK db. exanple. con . Compound & Masking  Sep 10,2010
Maskof HR Job 9:27:41 PM
Data Succeeded GMT+00:00
O CONDITIONAL_EMPLOYEE_DATA_MASK db.exanple.con pmask Employee 7 Script Not
Data Generated

7. Select the mask definition you wish to view or update and click Edit.

The Edit Mask Definition page appears. It lists the columns included in the mask
definition.
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Edit Masking Definition: CONDITIONAL_EMPLOYEE_DATA_MASK
[Cancel ) [0QK)

+ Mame [CONDITIONAL_E MFLOYEE_DATA_MASK

+ Database [db_examnle.com l /f

Description [Mask Employes Data

Columns

Add columns you want to mask and define masking format for each column. Foreign key columns are
automatically added to maintain referential integrity. Dependentcolumns are columns that do not have foreign
key constraints defined, but reference a masked column due to application level constraints. You can manually

add dependentcolumns to a masked column. Removing a column from this list will remove all forgign key and

dependent columns. [ Add )
| Remove )
Select All | Select None
Depende
Column | Colum

Select Owner|Table Column Group |Data Type Format |Foreign Key Columns [Count hdd|
U wr EMPLCYEES EMPLOYEE_ID NUMBER Ey & 1 ‘{IF'
O nur EMPLCOYEES FIRST_NAME WARCHARZ(20) Ey 0 [} ‘{IF'
U nHr EMPLOYEES LAST_MNAME WARCHARZ2(25) Ey 0 0 CIJ:,

8. A number of operations are available on this page:
s To add another column to the definition, click Add.
s Tomodify a column format, click the Format icon.

s Toremove a column from the mask definition, check the box and click
Remove.

9. To introduce a new column into the definition, for example, click Add. The Add
Columns page appears.

10. To locate the column, enter the schema and table name and click Search.

In this example, we search the EMPLOYEES table in the HR01 schema:

Add Columns
Database db.example.com Logged In As  system | Cancel | | Add | | Define Format And Add )

Add one or more columns for masking. Foreign key columns will be added automatically. You can define masking format at once for all selected

columns if they have the same data type.

Search

Schema [HH01 l y Column Name [

Table Name [EMF’LOYEES ] Column Comment [

| Search | Enter a string in column comments.

[ mask selectea colum%&s agroup

Select All | Select None

Select|0wner |Table Name |00Iumn Name Data Type Comment

HRO1 EMPLOYEES CITY VARCHARZ(30)

O HRO1 EMPLCYEES COMMISSION_PCT MNUMBER(2,2) Commission percentage of the employee; Only
employees in sales department elgible for

11. Select the checkbox for the CITY column and click Add.
The Edit Masking Definition page reappears, with CITY added to the column list.
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Unlike the other columns, the format for CITY is displayed as a toolbox icon,
which means that no mask format has yet been defined for the column. You must
specify a format for this column to complete the definition.

12. Click on the toolbox icon. The Define Column Mask page appears.

13. You can now specify a mask format entry for CITY using the drop-down box.
Click Add to complete the process.

In this example we select a random string format and specify the start and end
lengths. To see how the masked data will appear in this format, click the Sample
icon.

Define Column Mask

Owner HR Table EMPLOYEES Cancel | | QK
Column  CITY Data Type VARCHARZ2(30)

By default all records in the table will be masked using the specified format. You can optionally identify more than one subset of
records using conditions. Each subsetcan be masked using a corresponding masking format. The subsets will be masked in the
order they are specified. A subset will not be masked again even when it matches a subsequent condition.

X

Import Format ] FormatEntry | Random Strings 3] Add

Add Condition

Expand All | Collapse All
Format Entry Properties

Select Condition Property Value Property Value Sample Remove
V Conditions
V Default Condition aaaaaagqoxrb gsj \
Random Strings Start 2 End Length |12 ?’
Length =
Cancel | | 0K

Note: You can use the Import Format button to import an existing
format entry.

14. Click OK. Grid Control checks that the entry is valid for the column's datatype.
The Edit Masking Definition page reappears, and the CITY column now has a
valid mask format.

Click OK to save the masking definition.

Likewise, starting at the Edit Mask Definition page (Step 8 above) you can modify the
definition of an existing column by clicking its Format icon. This is useful, for
example, when you wish to customize the properties of a column's format entry, or
specify a different format entry for the column.

4.9.3.2 Generating the Masking Script

When you modify a data masking definition by adding or removing columns, or by
modifying an existing column's mask format, you must regenerate the SQL masking
script to incorporate your changes. To generate the script:

1. Follow steps 1 through 6 of Section 4.9.3.1 to display the data masking definitions
for the database.

2. After a masking definition is modified, its status is listed as "Script Not
Generated."

Select the definition and click Generate Script.
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3. After processing is complete, you can:
= Integrate the masking script with the clone database process

= Schedule execution of the script to perform the masking operation.

Script Generation Results: CONDITIONAL _EMPLOYEE_DATA_MASK
Database db.example.com Mumberof Tables & ( Return
Logged In As  system Columns 13
Script Options
Use script o clone and mask the database. | Clone And Mask )
Schedule the data masking job. The script will be exscuted by the job to perform the masking operation. | Schedule ]t

—

e
¥ script

The script summary is a list of the database commands that will be used to mask the selected columns. The full script
includes functions, procedures, and other commands needed during the masking operation. The full script will be exe
perform the masking operation.

view @ script Summary O Full script

- Targetdatabase: db,example, com

- Scriptgenerated at: 13-SEP-2010 04:14
COMMIT

ALTER SESSION ENAELE PARALLEL DML

DROP TABLE "MGMT_DM_TT_32"PURGE
declare
adj number.=0;

num number=0

Note: The results page also displays the generated SQL script, which
can be modified as well.

4.9.3.3 Customizing Mask Formats

The format library is a collection of common, ready-to-use masking formats you can
use in masking definitions. Oracle Data Masking enables you to extend the default
mask format library by tailoring the existing formats, or creating new formats to meet
your own business needs.

Take these steps to add a new format:

1. Follow steps 1 through 5 of Section 4.9.3.1 to display the database instance.
2. Select Format Library.

Format Library

The Format Library contains a collection of ready-to-use masking formats which can be used when creating a masking
definition.

— [Forn'lat ¢] [ l (Go) [ Export ) Impart ) Create )
[_view )(_Create Like )(_Edit ) Delete ) Next2 &
Select|Format |Dah Type [Sample |Descripﬁon |0wner |
O Anglo American First Source Mot Generated Anglo American First Name SYSMAN
Mame Type
O Anglo American Last Source Mot Generated Anglo American Last Name k SYSMAN
Mame Type
@] Eay Area Phone Mumber Character (408) 555-6964 Bay Area Phone Number SYSMAN
O |social Security Mumber Character 585758911 Social Security Number SYSMAN
O |social Security String Character 555-22-2309 Social Security String SYSMAN
@] Expiration Date Date 2012-11-07 Expiration Date SYSMAN
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3. When adding a new format, you can take an existing format as a starting point.
For example, to create a new format for credit card number fields, you can select
an existing credit card format and click Create Like.

Create Format

Cancel | | 0K
+ Mame [ l
Description |~1 0 billion unigque American Express credit card numbers |
Format Entries k
Define masking format by adding one or more format entries of different types.
Add [AnayLmt :] Co )
Type Description Edit Remove
Random Digits Digits Length Range: 10-10 E‘f’ =

FPost Processing Function  |DESMMP.DM_FMTLIE.MGMT_DM_GEN_AC

The function can either be a standalbone function (Example: scott. masking_func) or a function specified inside of a§
scott. masking_pkg.checksum).

4. Enter a descriptive name for the new format, and use the format entry drop-down
list to select a masking format. You may also specify a different post-processing
function if desired.

Similarly, you can modify existing formats or create new formats on the Format
Library page.

4.9.4 Data Masking in Oracle Enterprise Manager Cloud Control

Data masking on Cloud Control requires the following templates, which are shipped
in the emfa sysman directory:

ADM_Oracle_Fusion_Applications_1.0_EM_12.1.0.1.0_Combined_Template.xml
Mask_Oracle_Fusion_Applications_1.0_EM_12.1.0.1.0_Combined_Template.xml

Use the following procedure to set up and run data masking on Cloud Control:
1. Grant Permissions.

Use the FUSION user for all subsequent steps. Grant select_catalog_role and
'select any dictionary' and DBA to the FUSION user.

2. Deploy the TDM package.
a. Navigate to Enterprise, then Jobs, then Job Activity.

b. In the "os command" drop-down, select Deploy Test Data management
packages and click Go.

c. Enter the job name, click add, and add the database where masking is to be
run.

d. Click parameters. In the drop-down, select fusion driver.

e. Click credential and enter the FUSION credentials. This user must have all the
privileges specified in Step 1.

f. Click submit.

g. When the job completes, verify that it succeeded. Review the job details and
make sure there are no errors.

3. Import the Application Data Model (ADM).
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a. Navigate to Enterprise, then Quality Management, then Data Discovery and
Modelling menu.

b. Click Action, then Import. Provide the ADM xml file ADM_Oracle Fusion_
Applications_1.0_EM 12.1.0.1.0_Combined_Template.xml, the ADM name,
and the fusion database.

c. If prompted for database credentials, provide the fusion user credentials.

d. You might see one or more warnings indicating that duplicate sensitive types
were not imported; these warnings can be safely ignored.

Create a verification job.

a. Navigate to Enterprise, then Quality Management, then Data Discovery and
Modeling.

b. Click on the ADM you just imported and click verify.

Note: You can also get to this task by navigating to Action, then
Verify.

c. Click Create Verification Job.

d. Provide a job name and job description.

e. Click New Credential, and provide the FUSION credentials.
f.  Schedule the job to start immediately, and click Submit.
Check the job status.

a. When the verification job completes, navigate to Enterprise, then Job Activity,
then select all job status.

b. Click go and check that your job completed successfully.
Import the masking template file.

a. Navigate to Enterprise, then Quality Management, then Data Masking
Definition. The drop-down list contains data masking definitions and formats.

b. Import the masking template file Mask_Oracle_Fusion_Applications_1.0_
EM_12.1.0.1.0_Combined Template.xml.

c. Provide the masking definition name.

d. For the ADM name, specify the name of the fusion ADM you created.
e. For the database name, specify the fusion database.

Select the mask definition and click the generate script button.

Script generation can take a few hours, so consider running it on VNC or on a
terminal that will be available for a while to allow the job to complete. (If you run
it on a laptop and have to disconnect it during execution, you will lose the browser
that was generating the script.)

When the job completes, you can view the impact report and save or view the
script.

Submit the masking script for execution by clicking submit job.

Securing Oracle Fusion Applications 4-41



Securing Web Services

4.9.5 Best Practices when Masking Test Databases

Identity data can reside in a number of repositories: the Oracle Database, the
production identity store (an LDAP store), and the Oracle Identity Manager database.

In the current release, when you implement data masking, the identity attributes are
only masked (anonymized) in the Oracle Fusion Applications database. To preserve

masked values, ensure that these best practices are followed when using the masked
data for a test database:

1. Do not run the Enterprise Scheduler Service (ESS) job to synchronize the LDAP
identity store and the Oracle Fusion Applications database, since doing so would
reset the identity attributes in the database to their unmasked values.

2, Setup "dummy" test users to perform the testing.
3. Donot:
= Log in to the test database as a real user.

= Update a user's attributes in either the LDAP identity store or the Oracle
Identity Manager database.

Doing so will reset that user's attributes to their unmasked values, allowing them
to see their own masked record in employee self-service, deduce other people's
identities by following the hierarchy, and so on.

In short, it is essential that you maintain close access control to databases holding live
cloned data, and make testers aware of their obligations and responsibilities regarding
the data. As far as is possible, the processes around test data based on live data should
mirror the processes around the live data itself. In particular, testers must not use
privileged access to look beyond what they need to perform the required tests. For
example, they must not try to work out to whom the data pertains, or try and find
private information to satisfy their own curiosity.

4.9.6 References

For a detailed tutorial of data masking, see "Replacing Sensitive Data Using the Data
Masking Pack" at:

http://www.oracle.com/technology/obe/11lgrl_
db/security/datamask/datamask.htm

For additional information about securing sensitive data, Oracle Fusion Applications
data security policies, and related topics, see the Oracle Fusion Applications Security
Guide. The Privacy chapter explains how Personally identifiable information (PII) is
defined and protected.

For deployment guidelines, see Oracle Fusion Applications Customer Relationship
Management Enterprise Deployment Guide.

4.10 Securing Web Services

4-42

Oracle Web Services Manager (WSM) provides a policy framework to manage and
secure Web services consistently across your organization. Oracle WSM is available to
the following users:

= Developers, at design time through Oracle JDeveloper

= System administrators in production environments by means of Fusion
Middleware Control and command-line tools
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The Oracle WSM policy framework secures Web services with policies, which describe
capabilities and requirements such as whether and how a message must be secured,
whether and how a message must be delivered reliably, and so on.

This section contains the following topics:

s Local Policy Attachment

s Global Policy Attachment

»  Web Services Security Profiles

= Key Exchange with the Domain Hosting Oracle Identity Manager

s Web Services Security Hardening

For more information about the Oracle WSM policy framework, see the
"Understanding Oracle WSM Policy Framework" section in the Oracle Fusion
Middleware Security and Administrator’s Guide for Web Services.

4.10.1 Local Policy Attachment

A policy subject is the target resource to which the policies are attached. Examples
include Web services endpoints, Web service clients, SOA service endpoints, SOA
clients, and SOA components.

Directly attaching one or more policies to a policy subject is referred to as "Local Policy
Attachment” (LPA). Table 4-6 lists key tasks related to LPAs.

Table 4-6 Common LPA Operations

Operation Reference

Configure LPA using "Attaching a Policy to a Single Subject" section in the Oracle Fusion Middleware Security
Fusion Middleware and Administrator’s Guide for Web Services

Control and WLST

Attach "no behavior"
policies for Web Services
and Web Service Clients

"Disabling a Globally Attached Policy" section in the Oracle Fusion Middleware Security
and Administrator’s Guide for Web Services

Remove LPAs for all Web
services

"Attaching a Policy to a Single Subject” section, subsection titled Attaching a Policy to
a Web Service Using WLST (Step 4) in the Oracle Fusion Middleware Security and
Administrator’s Guide for Web Services

Troubleshoot Web service
security

"Diagnosing Problems" chapter in the Oracle Fusion Middleware Security and
Administrator’s Guide for Web Services

4.10.2 Global Policy Attachment

A policy set, which can contain multiple policy references, enables you to attach
policies globally to a range of endpoints of the same type. By attaching policies
globally in this way, referred to as Global Policy Attachment (GPA), you can ensure
that all subjects are secured by default. Table 4-7 lists key tasks related to GPAs.

Table 4-7 Common GPA Operations

Operation Reference

GPA concepts and usage; "Attaching Policies Globally Using Policy Sets" section in the
determining if a Web service Oracle Fusion Middleware Security and Administrator’s Guide for
or client is security-enabled ~ Web Services

Create GPAs using Fusion  "Creating and Managing Policy Sets" section in the Oracle
Middleware Control and Fusion Middleware Security and Administrator’s Guide for Web
WLST Services
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Table 4-7 (Cont.) Common GPA Operations

Operation Reference

Disable GPAs "Enabling and Disabling a Policy Set" section in the Oracle
Fusion Middleware Security and Administrator’s Guide for Web
Services

Determine what policies are "Calculating the Effective Set of Policies" section in the Oracle
enforced when both LPA Fusion Middleware Security and Administrator’s Guide for Web
and GPA are defined Services

View policies attached toa  "Viewing the Policies That are Attached to a Web Service"
Web service section in the Oracle Fusion Middleware Security and
Administrator’s Guide for Web Services

Validate a policy set "Validating a Policy Set" section in the Oracle Fusion
Middleware Security and Administrator’s Guide for Web Services

4.10.3 Web Services Security Profiles
Oracle Web Services Manager supports three Web services security profiles:
= AuthN Profile
»  SSL Profile - provides transport-level security
= Message Security Profile - provides message-level security

Out-of-the box, Oracle Fusion applications are provisioned with the AuthN profile.
You can move your deployment to a different profile if needed.

4.10.4 Key Exchange with the Domain Hosting Oracle Identity Manager

During provisioning, all Oracle Fusion Applications domains are set up to use a
common keystore and credential store, whereas the Oracle Identity Management
domain (which includes Oracle Identity Manager) uses a separate keystore, and stores
credentials in a logical domain. Provisioning does not set up trust between these
keystores. This section explains how to exchange trust with the Oracle Identity
Manager domain, enabling Web services security when this domain is involved.

For additional background and information on the certificate exchange needed to set
up Web services security trust, see the Oracle Fusion Applications Security Hardening
Guide.

Exporting a Keystore Alias from Application Domain
Take these steps to export the keystore alias:

1. Navigate to the DOMAIN_HOME/config/fmwconfig directory of the domain.

2. Run the keytool command to export the alias into a file called orakey.cert using
syntax like in this example:

JAVAHOME /bin/keytool -exportcert -alias orakey -file orakey.cert -keystore
default-keystore.jks -storepass keystore-password

This command creates a file called orakey.cert containing the exported orakey
alias.

When using this command, specify the alias name and keystore password
applicable to your environment.
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Importing a Keystore Alias into Oracle Identity Manager Domain
Take these steps to import the keystore alias:

1. Copy the file generated by the export procedure (orakey.cert in the export
example) into the DOMAIN_HOME/config/fmwconfig directory of the Oracle Identity
Manager domain where you wish to import the alias.

2. Run the keytool command using the following syntax to import the certificate:

JAVA_HOME/bin/keytool -importcert -alias orakey -file orakey.cert -keystore
default-keystore.jks -storepass keystore-password

This command imports the alias into the Oracle Identity Manager domain's keystore.

Similar steps are used to export the Oracle Identity Manager key and import it into the
other domain.

4.10.5 Web Services Security Hardening

For detailed instructions about Web Services Security hardening, see the "Locking
Down Web Services: Points to Consider" section in the Oracle Fusion Applications
Security Hardening Guide.

4.11 Securing Oracle Fusion Middleware Products

This section describes security guidelines recommended for Oracle Fusion
Middleware products in the context of Fusion Applications. These administrative
tasks, typically carried out with Oracle Authorization Policy Manager, Oracle
Enterprise Manager Fusion Middleware Control, or WLST scripts, apply only to a
specific product.

4.11.1 Administrative Tasks and Features Specific to the IDCCS Stripe

This section describes administrative tasks and features specific to Oracle Universal
Content Management (UCM) in the IDCSS stripe of the policy store, and they do not
apply to any other stripe.

The grants specified in the stripe IDCCS must conform to one of the grants described
in Section 4.11.1.1.

Section 4.11.1.2 explains why not to delete groups or accounts in that stripe.

4.11.1.1 Grants Supported by UCM

Oracle Authorization Policy Manager allows an administrator to specify grants to
accounts and groups in a number of combinations, but not all these combinations are
supported by UCM. The following list identifies the grants in the IDCSS stripe that are
supported and unsupported.

= Grants to Accounts
- User to account resource: supported.
- Enterprise role to account resource: supported.
- Application role to account resource: supported.
= Grants to Security Group Resources
- User to security group resource: not supported.

- Enterprise role to security group resource: not supported.
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- Application role to security group resource: supported.
= Grants to Entitlements
- None supported.

Even though Oracle Authorization Policy Manager allows an administrator to define a
non-supported grant in for UCM, such grants are ignored at runtime.

4.11.1.2 Security Groups and Accounts Associated with Documents
Oracle Authorization Policy Manager allows deleting a security group or account
associated with a document; but UCM does not allow deleting such artifacts.

Security administrators should be cautious never to delete a security group or account
associated with a document stored in the Oracle Content Server. If, however, such
deletion takes place accidentally, the deleted artifact will automatically reappear.

4.12 Extracting Data from an LDAP- Based Store to a File

This section describes the use of the OPSS script migrateSecurityStore to extract the
contents of one stripe and save it in an XML file.

To extract the policies in a given application stripe from an LDAP-based store, proceed
as follows:

1. Create a file with the following content and save it as, for example,
exported-jazn-data.xml in the same directory where your jps-config.xml file is
located:

<?xml version = '1.0' encoding = 'UTF-8' standalone = 'yes'?>
<jazn-data xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xsi:noNamespaceSchemalLocation="http://xmlns.oracle.com/oracleas/schema/jazn-dat

a-11_0.xsd">
<jazn-realm default="jazn.com">
<realm>
<name>jazn.com</name>
</realm>

</jazn-realm>
</jazn-data>

2. Copy of your jps-config.xml file to, for example, copy-jps-config.xml.

3. Edit the file copy-jps-config.xml to contain an instance and two contexts like the
following:

<servicelInstance location="./exported-jazn-data.xml"
provider="policystore.xml.provider"
name="export.xml"/>

<jpsContext name="ldap_source">
<servicelnstanceRef ref="policystore.ldap"/>
</jpsContext>

<jpsContext name="xml_target">
<serviceInstanceRef ref="export.xml"/>

</jpsContext>

4. Run the script migrateSecurityStore as in the following invocation (the
arguments are written in separate lines for the sake of clarity only):
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migrateSecurityStore (type="appPolicies",
configFile="./copy-jps-config.xml",
src="1dap_source",
dst="xml_target",
srcApp="hcm")

The above illustrates the extraction of the contents of the application stripe hcm to
the XML file exported-jazn-data.xml. To extract the contents of any other stripe,
specify the appropriate stripe name in the argument srcApp. No more than one
stripe can be extracted at a time.

Note that in the above example, both copy-jps-config.xml and
exported-jazn-data.xml are assumed to be located in the same directory.

4.13 Customizing Security from Installation to Deployment

This section describes the typical flow of application security data from the application
installation to the application deployment to a production environment, and, in
particular, how to handle GUIDs in application policies throughout that flow; its
phases, performed by developers and administrators, are explained in the following
sections:

Installing a New Oracle Fusion Application
Customizing and Testing Security with Oracle JDeveloper
Migrating to a Staging Environment

Migrating to a Production Environment

4.13.1 Installing a New Oracle Fusion Application

In this phase, an administrator installs a new Oracle Fusion environment whereby the
following application-specific artifacts are installed and provisioned:

An identity store, containing users and security enterprise roles.
An LDAP-based policy store, containing functional policies.

An Oracle Fusion Data Security policy store, containing database resources and
data security policies.

4.13.2 Customizing and Testing Security with Oracle JDeveloper

In this phase, a developer uses Oracle JDeveloper to customize and test functional
security artifacts in the installed application. First, the developer needs an XML
version of the application stripe in the installed LDAP-based store, the XML format
been required by JDeveloper.

The obtain this file, the administrator proceeds as follows:

1.

Runs the OPSS script migrateSecurityStore with the argument
preserveAppRoleGuid set to True to export the contents of the application stripe in
the LDAP-based policy store to the XML file (called jazn-data.xml throughout
this section). For details on this procedure, see Section 4.12.
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Important Note: The use of the argument preserveAppRoleGuid is
strictly restricted to the scenario described above; in particular, that
argument should not be used with migrateSecurityStore ina
production environment or when migrating from a staging to a
production environment.

Edits the generated file jazn-data.xml to replace the group principal for
enterprise roles with the group principal required by Oracle JDeveloper.
Specifically, it runs a command that replaces, in that file, every instance of the
string weblogic.security.WLSGroupImpl with the string
oracle.security.jps.internal.core.principals.JpsXmlEnterpriseRoleImpl.

Delivers the edited jazn-data.xml to the developer, who copies it to the directory
<jdevapphome>/src/META-INF.

Then, within Oracle JDeveloper, the developer proceeds as follows:

1.
2.

Defines a data source to point to the installed database security policy store.

Uses the security policy overview editor to customize function security (in the
XML-based policy store), as documented in the "Implementing Function Security"
chapter of the Oracle Fusion Applications Developer’s Guide.

Creates test users and test groups, and run the application within Oracle
JDeveloper. When the application is run, the WebLogic Server integrated in Oracle
JDeveloper, merges jazn-data.xml with the domain file-based store
system-jazn-data.xml.

Once customization and testing within Oracle JDeveloper are completed, hands
the file jazn-data.xml back to the system administrator.

4.13.3 Migrating to a Staging Environment

In this phase, the administrator proceeds as follows:

1.

If the staging environment already has a stripe for the application and that stripe is
to be preserved, merges the file jazn-data.xml with the staging application policy
store, using Oracle Authorization Policy Manager as described in the "Upgrading
Oracle Fusion Applications Policies" chapter of the Oracle Fusion Middleware Oracle
Authorization Policy Manager Administrator’s Guide (Oracle Fusion Applications
Edition). The relevant artifacts involved in this merge are the baseline store,
represented by the original XML file jazn-data.xml; the production store,
represented by the staging policy store stripe; and the patch store, represented by
the new, customizedjazn-data.xml file

Otherwise, if the application stripe is not present or is present but need not be
preserved, the administrator uses the OPSS script migrateSecurityStore with the
argument overlirite set to TRUE to migrate application policies in the file
jazn-data.xml to the staging policy store.

Reconciles GUIDs in the Oracle Fusion Data Security policy store with GUIDs in
application roles by running the command DSDataMigrator as described in
Section 4.4.3. This operation does not modify the file jazn-data.xml but updates
GUIDs in data security policies.
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Important Note: When migrating to a staging environment,
reconciling GUID's is required only before deploying the application in
the staging environment that will merge policies (from a developer's
file-based policy store) containing newly introduced custom
application roles that are also referenced in data security policies.

Packs the file jazn-data.xml with the application EAR and deploys the
application to the staging environment with the following system property set:

-Djps.deployment.handler.disabled="true"
The above setting disables the OPSS listeners and ensures that when the EAR is

deployed, domain policies do not get overwritten or appended with those in the
packed jazn-data.xml file.

Note: Typically, the application deployment is set so that users and
groups are not migrated during deployment. For details about this
setting within Oracle JDeveloper, see the "Implementing Function
Security" chapter in the Oracle Fusion Applications Developer’s Guide.

4.13.4 Migrating to a Production Environment

In this phase, the administrator proceeds as follows:

1.

Migrates the staging policy store to the production policy store in one of the
following two ways:

»  If the production environment has not undergone changes since the
customization was tested in the staging environment, the administrator moves
the staging policy store to the production store as described in Section 17.4.

»  Otherwise, if the production policy store has undergone changes since the
customization was tested in the staging environment and those changes must
be preserved, the administrator uses Oracle Authorization Policy Manager as
described in the Upgrading Oracle Fusion Applications Policies chapter of the
Oracle Fusion Middleware Oracle Authorization Policy Manager Administrator’s
Guide (Oracle Fusion Applications Edition) to merge the customized, pillar-level
jazn-data.xml with the production policy store.

Reconciles GUIDs in the Oracle Fusion Data Security policy store with GUIDs in
the OID LDAP-based policy store by running the command DSDataMigrator as
described in Section 4.4.3.

Important Note: When migrating to a production environment,
reconciling GUID's is required only if application roles or data security
have been modified in the production environment..

Packs the file jazn-data.xml with the application EAR and deploys the
application to the production environment with the following system property set:

-Djps.deployment.handler.disabled="true"

The above setting disables the OPSS listeners and ensures that when the EAR is
deployed, domain policies do not get overwritten or appended with those in the
packed jazn-data.xml file.
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Managing Oracle Enterprise Scheduler
Service and Jobs

This chapter describes how to configure and manage Oracle Enterprise Scheduler and
Oracle Enterprise Scheduler jobs. Oracle Enterprise Scheduler enables scheduling and
running jobs within a particular time frame, or workshift, using rules to create work
assignments. Oracle Enterprise Manager Fusion Applications Control allows you to
define, control and manage Oracle Enterprise Scheduler job metadata, including job
definitions, job requests, job sets (a collection of job requests), incompatibilities (job
definitions and job sets that cannot run at the same time for a given application) and
schedules governing the execution of job requests.

This chapter includes the following topics:

» Introduction to Managing Oracle Enterprise Scheduler

=  Navigating to the Oracle Enterprise Scheduler Administration Pages
»  The Scheduling Service Home Page

s Configuring Oracle Enterprise Scheduler

s Searching for Configuration Changes to Oracle Enterprise Scheduler in Cloud
Control

= Viewing General Oracle Enterprise Scheduler Instance Information
s Starting and Stopping Oracle Enterprise Scheduler Service Components
= Managing Oracle Enterprise Scheduler Requests

= Monitoring Oracle Enterprise Scheduler Service Activity

= Managing Purge Policies in Fusion Applications Control

= Managing Job Metadata

= Managing Work Assignments and Workshifts

= Managing Oracle ADF Connections

= Managing Application Properties

= Managing Application and Role Policies

= Managing Oracle Enterprise Scheduler Web Services

= Managing Logging for Oracle Enterprise Scheduler

= Managing Alerts for Oracle Enterprise Scheduler in Cloud Control
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5.1 Introduction to Managing Oracle Enterprise Scheduler

Oracle Enterprise Scheduler provides the ability to define, schedule and run different
types of job, including: Java, PL/SQL, spawned jobs and binary scripts. You can run
jobs on demand, or schedule them to run in the future.

Oracle Enterprise Scheduler provides scheduling services for the following purposes:
= Distributing job request processing across a grid of application servers

= Running Java, PL/SQL, spawned and binary jobs

= Processing multiple jobs concurrently

Oracle Enterprise Manager Fusion Applications Control (Fusion Applications Control)
allows you to start and stop, monitor, configure and manage Oracle Enterprise
Scheduler services, components and job requests.

The main Oracle Enterprise Scheduler page provides an overview of the status of
scheduler components, the top running and completed scheduled job requests, as well
as a performance summary of scheduled job requests. You can further monitor activity
and diagnose problems by examining Oracle Enterprise Scheduler logs and comparing
current to historical performance data.

Drilling down to the main components of Oracle Enterprise Scheduler, you can
configure job request processors and dispatchers. A job request processor is bound to a
particular Oracle Enterprise Scheduler server, and is responsible for allocating threads
for job requests. A job request dispatcher polls for job requests.

Once the Oracle Enterprise Scheduler components have been configured, you can
define work allocation and purge policies. Work allocation definitions allow you to
configure windows of time during which jobs can run (workshifts), rules that govern
their execution and bindings to a particular server and request processor (work
assignments). Purge policies allow you to define for a particular request processor the
conditions for retaining and purging job requests associated with that request
processor. You can define a schedule for managing the execution of work assignments,
workshifts and purge policies.

Oracle Enterprise Manager Fusion Applications Control allows you to define, control
and manage Oracle Enterprise Scheduler job metadata, including job definitions, job
requests, job sets (a collection of job requests), incompatibilities (job definitions and job
sets that cannot run at the same time for a given application) and schedules governing
the execution of job requests.

Oracle Enterprise Manager Cloud Control (Cloud Control) allows you to manage a
subset of Oracle Enterprise Scheduler components, including job requests, schedules,
alerts, as well as the starting and stopping of request processors and dispatchers.

5.2 Navigating to the Oracle Enterprise Scheduler Administration Pages

To navigate to Oracle Enterprise Scheduler administrative tasks in Fusion Applications
Control or Cloud Control:

1. From the navigation pane, expand the farm and then Scheduling Services, and
select the Oracle Enterprise Scheduler component.
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v

I EE Farm

3 Application Deployments

[ webLogic Domain

[ Metadata Repositories

= 3 Scheduling Services
(%] [ESSAPP [AdminServer)

[ webCenter

The Scheduling Service home page displays. See Section 5.3 for further
information about the contents of the home page.

2. Select the Scheduling Service menu.

1 ESSAPP @
iz Scheduling Service

Home

Logs

Job Requests

Performance

Request Processor
Request Dispatcher

Purge Policies

Wark Allocation

Job Metadata

ESS Connections

Web Services

1} ESSAPP @

m [startUp O3 Shut

Home
Monitoring
Control
Logs

Job Activity

Information Publisher Reports

Members

Routing Topology
Job Reguests
Performance
Request Processor
Regquest Dispatcher
Configuration

Compliance

Security

General Information

B Weblogic Server Administration Console

B Fusion Middleware Control

Target Setup k

Target Information

The Scheduling Service menu displays the following options.

Menu Option Description

Home Displays the Scheduling Service home page. For more
information about the contents of this page, see Section 5.3.

Control Displays the following options:

= Start Up: This option runs the Oracle Enterprise Scheduler
server. For more information, see Section 5.7.

= Shut Down: This option shuts down the Oracle Enterprise
Scheduler server. For more information, see Section 5.7.
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Menu Option

Description

Logs

The View Log Message option displays the Log Messages page
for viewing the contents of event log files. For more information,
see Section 5.17.

The log files are stored in the following directories:

DOMAIN_HOME/servers/SERVER_HOME/logs
DOMAIN_HOME/servers/SERVER_HOME/logs/apps

DOMAIN_HOME/servers/SERVER
HOME/1ogs/owsm/msglogging/diagnostic.log

DOMAIN_HOME/servers/SERVER_
HOME/sysman/log/emoms.log

Job Requests

Displays the following options:

Search Job Requests: Allows you to search for job requests
according to particular parameters. For more information,
see Section 5.8.2.

Submit Job Request: Allows you to submit an execution
request for a particular job. For more information, see
Section 5.8.1.

Define Schedules: Allows you to create a schedule for
submitting job requests. For more information, see
Section 5.8.1.2.

Performance

Displays the following options:

Service Summary: This option displays a brief overview of
the service performance. For more information, see
Section 10.4.2.1.

Current Activity: This option displays current Oracle
Enterprise Scheduler activity. For more information, see
Section 10.4.2.2.

Historical Reports: This option displays a chart or table
depicting previous Oracle Enterprise Scheduler data. For
more information, see Section 10.4.2.3.

Request Processor

Displays the following options:

Start/Stop: This option causes the request processor to start
or stop running. For more information, see Section 5.7.

Configure: This option displays the Configure Request
Processor page, which allows you to enable the request
processor, create work assignment bindings and so on. For
more information, see Section 5.4.

Request Dispatcher

Displays the following options:

Start/Stop: This option causes the request dispatcher to start
or stop running. For more information, see Section 5.7.

Configure: This option displays the Configure Request
Dispatcher page, which allows you to enable the request
dispatcher, manage polling intervals, and so on. For more
information, see Section 5.4.

Purge Policies

Allows you to configure and manage job request purge policies
including job request purge criteria, retention criteria and purge
policy schedules. For more information, see Section 5.10.
Available in Fusion Applications Control only.
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Menu Option

Description

Work Allocation

Displays the following options:

= Work Assignments: This option displays the Work
Assignments page which allows you to create, edit and
delete work assignments. For more information, see
Section 5.12.

= Workshifts: This option displays the Workshifts page which
allows you to create, edit and delete workshifts. For more
information, see Section 5.12.

= Schedules: This option displays the Schedules page which
allows you to create, edit and delete schedules for work
assignments, workshifts and job request purge policies. For
more information, see Section 5.12.

Available in Fusion Applications Control only.

Job Metadata

Displays the following options:

= Job Definitions: This option displays the Job Definitions
page, which allows you to manage job definitions. See
Section 5.11.1 for further information.

= Job Sets: This option displays the Job Sets page, which
allows you to create and edit job sets for a given application.
For more information, see Section 5.11.2.

= Incompatibilities: This option displays the Incompatibilities
page, which allows you to create and edit incompatibilities
for a given application. For more information, see
Section 5.11.3.

Available in Fusion Applications Control only.

ESS Connections

Displays a page that enables defining connections to Oracle
ADF. For more information, see Section 5.13.

Available in Fusion Applications Control only.

Web Services

Displays a page that provides an overview of the web services in
the application including web service endpoints and
application-level metrics. For more information, see Section 5.16.

Available in Fusion Applications Control only.

Security

Displays the following options:

= Application Policies: This option displays the authorization
policies that an application relies upon for controlling access
to its resources. See Section 5.15 for further information.

= Application Roles: This option displays the roles used by
security aware applications specific to the application. See
Section 5.15 for further information.

Available in Fusion Applications Control only.

General Information

Target Information

Displays general details about the Oracle Enterprise Scheduler
instance. Known as Target Information in Cloud Control. For
more information, see Section 5.6.

5.3 The Scheduling Service Home Page

The Scheduling Service home page provides an overview of the performance of Oracle
Enterprise Scheduler components and jobs, including component status, the number
of completed job requests in the last hour, as well as the processing times for running

jobs.
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You can use this page as a starting point for monitoring and administering Oracle
Enterprise Scheduler. Figure 5-1 shows a portion of the Scheduling Service home

page.
Figure 5-1 Scheduling Service Home Page
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These pages contain the following regions:

s Top Ten Long Running Requests and Top Ten Ready Job Requests Regions
= Scheduler Components Region

s  Completed Requests Region

= Response and Load Region

s Performance Region

= Monitoring and Diagnostics Region (Cloud Control only)

5.3.1 Top Ten Long Running Requests and Top Ten Ready Job Requests Regions

The Top Ten Long Running Requests region displays the top ten long running
scheduled job requests, including request ID, job run time, job definition used,
executing application, job execution type and description. You can set the scope of the
top ten long running requests displayed to the current scheduling service only, or all
scheduling services sharing the Oracle Enterprise Scheduler repository.

The Top Ten Ready Job Requests tab displays the top ten scheduled job requests that
await execution. The tab displays the same information as the Top Ten Long Running
Requests tab, except the wait time displays for each job rather than the run time.
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5.3.2 Scheduler Components Region

The Scheduler Components region displays the components of Oracle Enterprise
Scheduler, including the job request processor and dispatcher. The tab displays the
status of each component, the name of the server to which it is deployed and whether
or not the component is enabled. You can start and stop each component as required.

5.3.3 Completed Requests Region

The Completed Requests region displays the scheduled jobs completed within the last
hour.

5.3.4 Response and Load Region

The Response and Load region displays performance monitoring statistics regarding
the time required to process to job requests.

Table 5-1 describes the performance monitoring statistics in the Response and Load
region.

Table 5-1 Response and Load Statistics

Statistic Description

Average Processing time for  This metric specifies the average time required to process
Last Hour jobs during the last hour.

Requests Completed Per This metric specifies the number of scheduled job requests
Hour completed within the last hour.

5.3.5 Performance Region

The Performance region displays performance data for job requests, such as processing
times and wait times.

Table 5-2 describes the performance monitoring statistics in the Performance region.

Table 5-2 Performance Statistics

Statistic Description

Maximum Processing Time  This metric specifies maximum amount of time required to
process a scheduled job.

Average Processing Time This metric specifies average amount of time required to
process a scheduled job.

Maximum Wait Time This metric specifies maximum amount of time during
which a scheduled job waits before running.

Average Wait Time This metric specifies the average amount of time during
which a scheduled job waits before running.

5.4 Configuring Oracle Enterprise Scheduler

You can run Oracle Enterprise Scheduler as a single instance or as a cluster of servers.
Each Oracle Enterprise Scheduler server includes a request processor and dispatcher,
both of which must be configured.

Configuring Oracle Enterprise Scheduler involves the following main steps:

1. Configure a cluster. Optionally, configure a cluster of Oracle Enterprise Scheduler
servers. For more information about configuring a cluster, see the section
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"Expanding an Oracle Enterprise Scheduling Service Cluster" in the chapter
"Performing Basic Administration Tasks" in Oracle Fusion Middleware
Administrator’s Guide for Oracle Enterprise Scheduler.

2. Configure the request processor. Configure the Oracle Enterprise Scheduler
component which receives and manages job requests. For more information about
configuring the request processor, see the section "Configuring a Request
Processor" in the chapter "Performing Basic Administration Tasks" in Oracle Fusion
Middleware Administrator’s Guide for Oracle Enterprise Scheduler.

3. Configure the request dispatcher. Configure the Oracle Enterprise Scheduler
component that polls the request processor for job requests and dispatches jobs.
For more information about configuring the request dispatcher, see the section
"Configuring a Request Dispatcher" in the chapter "Performing Basic
Administration Tasks" in Oracle Fusion Middleware Administrator’s Guide for Oracle
Enterprise Scheduler.

5.5 Searching for Configuration Changes to Oracle Enterprise Scheduler
in Cloud Control

You can search for changes made to configurations using the search page in Cloud
Control.

To search for changes to configurations to Oracle Enterprise Scheduler in Cloud
Control:

1. Display the alerts for Oracle Enterprise Scheduler as described in Section 5.18.2.

2. In the Monitoring and Diagnostics pane, click the number of configuration
changes to display the search page for configuration changes to Oracle Enterprise
Scheduler alerts.

{3 ESSAPP @
[Eﬁ Scheduling Service Group = Page Refreshed Oct 7, 2011 2:11:03 PM PDT C,
Enterprise Manager automatically collects configuration information for targets such as hosts and databases. Changes to these configurations are recorded and may be
viewed from this page.
~|Search
Target Type | Scheduler Service Group E [¥] Include Member Target Changes
Target Name | is E /domain_name & @ Changes Discovered In Last 72 Days E
Configuration Clear ) Changes Discovered
Trem After
Type of Al E Before

Change

Show History Grouped E
Records

Search Schedule and Notify | History Job Activity | Add Filters =

Configuration Changes(0) Relationship Changes(0)
| view~ | @Export | LfiDetach

|Change
|Discovered

No data to display

|
iTarget MName }Histary Records ‘
|

3. Configure your search as desired.
»  Target Type: Select the Scheduler Service or Scheduler Service Group.

»  Target Name: Search for or enter the name of the target you want to search.
From the dropdown list, select the criterion by which you want to search for
the target name: contains, is, is not, does not contain, starts with, ends with.
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Type of Change: From the dropdown list, select the type of configuration
change for which you want to search.

Show History Records: From the dropdown list, select the way you want the
records to display, Grouped or Show All

Include Member Target Changes: Select to display configuration changes
made to members of the target.

Changes Discovered in Last: Select to search for changes discovered within a
given number of days, weeks or months.

Changes Discovered: Select to search for changes discovered within a
particular time period. Use the After and Before fields to enter the relevant
time period.

4. Click Search to search for the changes.

5.6 Viewing General Oracle Enterprise Scheduler Instance Information

Oracle Fusion Applications Control enables viewing information regarding the
particular instance of Oracle Enterprise Scheduler. The general information popup
window displays the locations of Oracle Fusion Middleware, the domain and the
target application, as well as the version of Oracle Fusion Middleware currently
running and the URI of the hosting server.

To view general information about Oracle Enterprise Scheduler:

1. From the Scheduling Service menu, select one of the following:

In Fusion Applications Control, select General Information.

In Cloud Control, select Target Information.

2. Oracle Fusion Applications Control displays the following information.

Target Name: The location of the target application, in this case, Oracle
Enterprise Scheduler, running on the domain.

Version: The version number of Oracle Fusion Middleware.

Middleware Home: The location of the Oracle Fusion Middleware directory.
Domain Home: The full path of the domain.

Host: The URI of the hosting server.

5.7 Starting and Stopping Oracle Enterprise Scheduler Service

Components

You can start up and shut down an instance of Oracle Enterprise Scheduler from
Oracle Fusion Applications Control.

The following components can be started and stopped:

= Oracle Enterprise Scheduler instance.

= Job request processor and dispatcher.
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Note: Stopping an Oracle Enterprise Scheduler instance or
component is not recommended. Shutting down an Oracle Enterprise
Scheduler component does not stop job requests from accumulating in
the queue.

For more information about starting and stopping Oracle Enterprise Scheduler
components, see the section " Starting and Stopping Oracle Enterprise Scheduling
Service Components" in the chapter "Performing Basic Administration Tasks" in Oracle
Fusion Middleware Administrator’s Guide for Oracle Enterprise Scheduler.

5.8 Managing Oracle Enterprise Scheduler Requests

A job request is a request sent from a deployed application to Oracle Enterprise
Scheduler to execute a job. Jobs are configured using job definitions, which specify the
parameters of the job and associate them with a particular application. A job set is a
collection of job requests that is grouped together.

This section contains the following topics:
= Submitting an Oracle Enterprise Scheduler Job Request
s Searching for Oracle Enterprise Scheduler Job Requests

For more information about searching for jobs, viewing job request details, holding
and canceling jobs, see the section "Searching for Oracle Enterprise Scheduling Service
Job Requests" in the chapter "Managing Oracle Enterprise Scheduler Requests" in the
Oracle Fusion Middleware Administrator’s Guide for Oracle Enterprise Scheduler.

5.8.1 Submitting an Oracle Enterprise Scheduler Job Request

You can submit a job request for a particular application using a job definition and a
schedule by which you want the job to run.

This section contains the following topics:
n  Creating a Job Request
= Specifying a Job Request Schedule

5.8.1.1 Creating a Job Request

Creating a job request involves selecting a job definition for the job request, then
selecting or creating a schedule.

You may want to configure system properties for the job request, such as the number
of retries to attempt in the event of an execution error and a time out value for the job.

To submit a job request:

1. Use a pre-existing job definition, or create a new job definition, as described in
Section 5.11.1.2.

2. Navigate to the Submit job request page by clicking the Scheduling Service menu
and selecting Job Requests. Then select Submit Job Request.

3. Select the application for which you want to submit the job request.
From the application dropdown list, select the J2EE application deployment name.

4. Under Job Request Details, enter details about the job request in the Details text
field.
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Select a job definition.

a. Under Job Definition, click the search button next to the Job Definition text
field.

b. Search for the required job definition.

In the Job Definition Name text field, enter the name of the job definition you
want to find.

Click the arrow next to the text field to search for the job definition.
c. From the search results table, select the job definition name.

In the Parameters region, optionally define any parameters you want to use with
the scheduled job request.

a. Inthe Parameters region, click Add to add a parameter.
Fill in a name and value for the parameter.

b. You can set a value for any of the system properties available. Table 5-3 lists
the names and descriptions of system properties.

For example, you may want to configure the number of permissible retries for
the job (SYS_retries), or a time out value (SYS_request_timeout).

Select a schedule by which the job is to run.
= Once: Select a single date and time by clicking the calendar icon.

= Use existing schedule: Click the search button to search for and select an
existing schedule.

= Specify schedule: Create your own schedule on the fly. Follow the
instructions in Section 5.8.1.2.

5.8.1.2 Specifying a Job Request Schedule

In the Submit Job Request page, selecting Specify a Schedule enables configuring your
own schedule for a job request. You can configure a recurring job request using a job
request schedule. Alternatively, you can configure a job request to run immediately or
before a specified end date. Use a pre-existing job definition, or create a new job
definition, as described in Section 5.11.1.2.

To specify a schedule:

1.

In the Start section, select the starting date and time for the job request.
Select Immediately to submit the job request right away.
Select Later to select a subsequent start date.

In the Repeating section, select the desired frequency of the job request submission
schedule.

From the Repeat dropdown list, select Every N minutes, Every N hours, Every N
days or Every N weeks.

In the Frequency text field, enter the number of minutes, hours, days or weeks.

In the End Date section, select the date and time at which the schedule job is to
end.

= No End Date: Select to specify a continuous schedule for the job request.

= Specified End Date: Select to specify a particular end date for the schedule.
Click the calendar icon next to the Date text field and select a date and time.
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Optionally, save the schedule by selecting the Save Schedule checkbox and
entering a name for the schedule in the Name text field. Optionally, enter the
package name and description.

5.8.2 Searching for Oracle Enterprise Scheduler Job Requests

The Request Search page enables searching for job requests. Using the Request Search
page, you can:

s Conduct a simple search that returns a list of job request details, including job
request ID, executing application, job request status, and so on.

s Conduct an advanced search that returns the same information as the simple
search, as well as the date and time of execution, the run time or wait time of the
job request, the number of retries and any error type that may have occurred
during execution.

= Modify the column display in the search results table.

This section contains the following topics:

= Searching for a Job Request Using Simple Search

= Searching for a Job Request Using the Advanced Search Feature
s Configuring the Display of Columns in the Search Results Table

5.8.2.1 Searching for a Job Request Using Simple Search

Simple search allows you to find a job request according to particular criteria such as
job request ID, related application, job request status, and so on, or by any one of a
number of pre-configured quick searches.

To search for a job request:

1. Navigate to the Request Search page by clicking the Scheduling Service menu and
selecting Job Requests. Then select Search Job Requests.

2. Select the scope of the job request search by selecting one of the following options:

s Current Scheduling Service: Select this option to search for job requests
submitted only to the scheduling service with which you are currently
working.

s All Scheduling Services sharing the ESS repository: Select this option to
search for job requests submitted to all scheduling services sharing the
repository, for example all scheduling services in a cluster of scheduling
services.

3. To run a fast search, from the Quick Search dropdown list, select a pre-configured
search option as shown in the following list.

s Requests submitted in the last hour

= Pending requests submitted in the last 24 hours
s Errored requests submitted in the last 24 hours
s All running requests

= All pending requests

= Requests currently being retried

= Requests retried in the last 24 hours
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Requests that resulted in System Error in the last 24 hours

Requests that resulted in Business Error in the last 24 hours

To run a regular job request search, skip this step.

Select the criteria by which to search for job requests.

Request ID: Enter the ID of the job request for which you want to search.

Application: From the Application dropdown list, select the name of the
application related to the job request for which you want to search.
Alternatively, select All to search for job requests in all applications.

Status: Select the status of the job request for which you want to search.
Alternatively, select All to search for job requests with all statuses. Statuses are
listed in the following table.

Statuses

WAIT VALIDATION_FAILED EXPIRED

READY RUNNING SCHEDULE_ENDED
PENDING_VALIDATION BLOCKED WARNING

Execution Type: Select JAVA_TYPE, SQL_TYPE or PROCESS_TYPE.

Submitted: From the dropdown list, select the time period in which the job
request to be searched has been submitted. Options include Last Hour, Last 24
Hours, Last 7 Days, Last 31 Days.

Submitted By: In the text field, enter the name of the user who submitted the
job request you want to find.

Job Definition: Click the search button next to the text field and select the
relevant job definition name.

Work Assignment: Click the search button next to the text field and select a
work assignment from the list.

Optionally, conduct an advanced search by clicking the Advanced button.

Click Search to submit the job request search.

5.8.2.2 Searching for a Job Request Using the Advanced Search Feature
An advanced search is available in the Request Search page by clicking the Advanced

button.

To search for a job request:

1.

Enter a basic search for a job request. Navigate to the Request Search page by
clicking the Scheduling Service menu and selecting Job Requests. Then Select
Search Job Requests.

Select the scope of the job request search by selecting one of the following options:

Current Scheduling Service: Select this option to search for job requests
submitted only to the scheduling service with which you are currently
working.

All Scheduling Services sharing the ESS repository: Select this option to
search for job requests submitted to all scheduling services sharing the
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repository, for example all scheduling services in a cluster of scheduling
services.

3. Select your basic search criteria. For more information, see Section 5.8.2.1.
4. Click Advanced to display the fields for the advanced search.

5. In the Date Range section, configure the date range in which to search for job
requests. The date on the left is the beginning date and the date on the right is the
end date. For each date, click the calendar icon to the right of the text field to select
the date and time.

= Submitted between: Enter the start and end dates during which the job
request was submitted.

= Scheduled between: Enter the start and end dates during which the job
request is scheduled to run.

s Completed between: Enter the start and end dates during which the job
request finished running.

6. In the Run Time/Wait Time section, select the run or wait time of the job request
for which you are searching, such as long or short running requests.

= None: Select if no run or wait time is to be specified.

= Long running requests: Select to search for requests running longer than a
specified number of seconds, minutes, hours or days.

In the Minimum Run Time text field, enter the lower limit of the time period
for which the job request runs. From the dropdown list, select the required
unit of time.

= Short running requests that waited: Select to search for job requests running
longer than a specified period of time and waiting less than a specified period.

In the Maximum Run Time text field, enter the upper limit of the time period
for which the job request runs. From the dropdown list, select Seconds,
Minutes, Hours or Days.

In the Minimum Wait Time text field, enter the lower limit of the time period
during which the job request waits to run. From the dropdown list, select
Seconds, Minutes, Hours or Days.

= Waiting requests by time: Select to search for job requests waiting to run for a
specified time period.

In the Minimum Wait Time text field, enter the lower limit of the time period
during which the job request waits to run. From the dropdown list, select
Seconds, Minutes, Hours or Days.

In the Maximum Wait Time text field, enter the upper limit of the time period
during which the job request waits to run. From the dropdown list, select
Seconds, Minutes, Hours or Days.

7. In the Retry of Failed Runs section, use the Number of Retries dropdown list to
select an operator such as equal to, greater than, greater than or equal to, and so
on.

In the text field, enter the number of retries.
8. In the Error Type section, use the dropdown list to select the type of error:

= Business: A job ends in a business error when it must abort prematurely due
to unforeseen conditions, but is otherwise able to exit with its datain a
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consistent state. A job request might end in a business error as a result of an
application setup or configuration condition, a functional conflict that requires
an early exit or corrupt or inconsistent data. You cannot retry running a job
request that ends in a business error.

= System: A job ends in a system error when a technical problem occurs from
which the job cannot recover, but otherwise exits on its own. Alternatively, the
computer running the job crashes. Examples include table space issues and
unhandled runtime exceptions. You can retry running a job request that ends
in a system error.

9. Click Search to submit the job request search.

5.8.2.3 Configuring the Display of Columns in the Search Results Table

After running a search for job requests, you can configure the display of columns in
the search results table.

To configure job request search results table display columns:

1. Display the main Oracle Enterprise Scheduler Request search page and display the
search interface.

2. Display the list of available column names.
Click the View dropdown list and select Columns, then Show More Columns.

3. Use the arrows between the columns to move column names from the Visible to
the Hidden column, or vice versa.

4. Optionally, reorder the columns by selecting the relevant column names and using
the vertical arrows on the right to move them up or down.

5. Alternatively, display all columns by clicking the View dropdown list and select
Columns, then Show All.

5.9 Monitoring Oracle Enterprise Scheduler Service Activity

The main Oracle Enterprise Scheduler page displays information regarding the top ten
long running scheduled jobs as well as the top ten job requests awaiting execution in
two different tabs. By default, only the job requests within the current scheduling
service display. However, you can change the scope such that all relevant scheduled
jobs running on all scheduling services sharing the Oracle Enterprise Scheduler
repository display in the tabs.

Each of the Oracle Enterprise Scheduler tabs include a table that displays a short list of
top ten long running and waiting job requests, respectively. The Show All Ready or
Show All Running link at the bottom of the region goes to a search page in which it is
possible to search for a more comprehensive list of relevant job requests.

Each tab displays the following information about scheduled job requests:
s Request ID: The ID associated with the job request.

= Run Time/Wait Time: The period of time during which the job request has been
running or awaiting execution, respectively.

= Job Definition: The job definition associated with the job request.
= Submitted by: The name of the user who submitted the job request.
= Application: The name of the application with which the job request is associated.

= Execution Type: The category of job being executed—Java, SQL or process job.
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= Description: An optional description of the scheduled job request.

You can also monitor Oracle Enterprise Scheduler job requests related to a given
product. For more information about viewing the top scheduled job requests related to
a product, see Section 9.2.4.

This section contains the following topics:
s Viewing Top Ten Long Running Oracle Enterprise Scheduler Requests

s Viewing Top Ten Oracle Enterprise Scheduler Jobs Ready to Be Executed

5.9.1 Viewing Top Ten Long Running Oracle Enterprise Scheduler Requests

Use the Top Ten Long Running Job Requests tab to view the job requests that have
been running for the longest period of time on the Oracle Enterprise Scheduler service.
You can alternatively change the scope of the region to display the top ten long
running job requests on all scheduling services sharing the same repository.

The job requests displayed will all have a status of RUNNING.
To view the top ten long running requests:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. At the top of the Oracle Enterprise Scheduler page, click the Top 10 Long Running
Requests tab to display the ten job requests that have been running the longest.

3. To display all running job requests, click Show All Running at the bottom of the
chart. This displays a search form that searches for all requests that are currently
running. Click Search to display the requests.

5.9.2 Viewing Top Ten Oracle Enterprise Scheduler Jobs Ready to Be Executed

Use the Top Ten Ready Job Requests tab to view the job requests that are awaiting
execution on the Oracle Enterprise Scheduler service. You can alternatively change the
scope of the region to display the top ten ready job requests on all scheduling services
sharing the same repository.

The job requests displayed will all have a status of READY.
To view the top ten ready job requests:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. At the top of the Oracle Enterprise Scheduler page, click the Top 10 Ready
Requests tab to display the ten job requests with the status READY.

3. To display all ready job requests, click Show All Ready at the bottom of the chart.
This displays a search form that searches for all requests with the status READY.
Click Search to display the requests.

5.10 Managing Purge Policies in Fusion Applications Control

Purge policies allow the scheduling service to remove scheduled jobs according to
specified criteria. For example, a purge policy might specify the retention of all Java
type job requests using a particular job definition submitted executed by a given
application for three days. Another purge policy might retain a particular type of job
request, say, all SQL job requests in a successful state, for only one day. You can also
specify the frequency at which the purge policy is to run.
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For more information about managing purge policies, see the section "Managing Purge
Policies" in the chapter "Managing Oracle Enterprise Scheduler Requests" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Enterprise Scheduler.

5.11 Managing Job Metadata

Oracle Enterprise Scheduler job metadata refers to the components that form the basis
of scheduled job requests.

These include the following:

= Job definition: A job definition is the smallest unit of work performed in the
context of the application that executes the job. A job definition is defined by a job
type, such as a Java or SQL job type.

= Job set: A job set is a sequential or parallel set of job steps, where a job step can be
a single job or another job set. A job set and each of its job set steps can have
additional parameters, the values for which are provided when the job or job set is
submitted as a job request.

» Incompatibility: An incompatibility allows you to specify job definitions and job
sets that cannot run concurrently.

This section contains the following topics:
= Managing Job Definitions

= Managing Job Sets

»  Managing Incompatibilities

You can manage job metadata only in Fusion Applications Control.

5.11.1 Managing Job Definitions

The Job Definitions page in Oracle Enterprise Manager Fusion Applications Control
allows you to view, create, edit, duplicate, delete and search for job definitions.
Figure 5-2 shows the Manage Job Definitions tab in the Job Definitions page. The tab
displays a table of job definitions and their attributes, including name, description,
location, execution type and job type.
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Figure 5-2 Manage Job Definitions Tab
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The Job Definitions page in Oracle Enterprise Manager Fusion Applications Control
also allows you to register sources for lists of values related to job definitions and the
applications that run job definitions. Figure 5-3 shows the Manage List of Values
Sources tab in the Job Definitions page.
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Figure 5-3 Manage List of Values Sources Tab
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This section contains the following topics:
= Viewing Job Definitions

= Creating a Job Definition

5.11.1.1 Viewing Job Definitions

You can view the job definitions created for a given application. The table of job
definitions displays details about the jobs related to an application such as the job
definition name, the full path to which it is saved, the job type, and so on.

Note: In the Job Definitions page, an asterisk displays next to those
jobs in the list that are pre-seeded, and are not custom jobs. The
asterisk also displays next to pre-seeded jobs that you have
customized.

To display job definitions:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. From the Scheduling Services menu, select Job Metadata and then select Job
Definitions.

The Job Definitions page displays.
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3. From the Applications dropdown list, select the name of the Ul application whose
job definitions you want to view.
The job definitions for that application display in a table below the application
dropdown list.

Column Name Description

Name This column displays the name of the job definition.

Display Name This column shows the name of the job definition as it displays.

Description This column displays a description of the job definition.

Path This column displays the full directory path to which the job
definition is saved.

Execution Technology This column displays the type of job request that you can create
using the given job definition, such as a Java, C, PL/SQL, Perl or
hosted script job.

Job Type Name This column displays the name of the job type upon which the
job definition is based.

Note: If there are applications with similar names, be sure to select
the Ul application. For example, given an application called
ProjectFinancialsApp and ProjectFinancialsESSApp, select
ProjectFinancialsApp as this is the UI application.

4. To view the details of a specific job definition, click the name of the relevant job

definition.

5.11.1.2 Creating a Job Definition

You can create a new job definition, which you can then use to create a job request for
a particular application. The job definition includes the directory path of the job to be
run, the name of the application with which the job definition is associated and the job
type used for the job definition.

Additional properties can be defined for a job definition as follows:

Parameters. You can configure editable or read-only parameters to be submitted to
the job request.

User properties. You can configure properties to be filled in by end users at run
time, such as boolean, number and string values.

Lists of Values. You can search for and register sources for lists of values to be used
for parameters.

This section contains the following topics:

Configuring Parameters for a Job Definition
Configuring User Properties for a Job Definition
Registering Sources for Lists of Values

Searching for List of Value Sources

To create a job definition:
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7.

From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

From the Scheduling Services menu, select Job Metadata and then select Job
Definitions.

The Job Definitions page displays.

From the Applications dropdown list, select the name of the UI application for
which you want to create a job definition.

Note: If there are applications with similar names, be sure to select
the Ul application. For example, given an application called
ProjectFinancialsApp and ProjectFinancialsESSApp, select
ProjectFinancialsApp as this is the UI application.

Click Create to create a new job definition.

For the new job definition, configure the following required properties:

= Name: Enter a name for the job definition.

= Display Name: Enter the name to be displayed for the job definition.
= Path: Enter the path of the job to be run.

= Application Name: From the dropdown list, select the name of the application
with which you want to associate the job definition.

= Job Type Name: From the dropdown list, select the job type you want to use
for the job definition.

Additional properties may display, depending on the job type selected.

Optionally, configure parameters, user properties, system preferences and access
control. For more information, see Section 5.11.1.2.1, Section 5.11.1.2.2,
Section 5.11.1.2.3 and Section 5.11.1.2.4.

Click Save and Close.

5.11.1.2.1 Configuring Parameters for a Job Definition A parameter enables passing data of
type string, boolean, number or date time to the job request. Parameters can be passed
using a number of display controls, such as a text box, date picker, choice list or list of
values.

To configure parameters for a job definition:

1.
2.

In the job definition creation user interface, click the Parameters tab.
Select Actions and then select New or click the New icon.

The Create Parameter dialog box displays.

In the Create Parameter dialog, enter the following information:

= Prompt: Enter the text to be displayed at the prompt that displays during run
time.

= Data Type: From the dropdown list, select a data type for the parameter:
String Numeric, DateTime, Number or Boolean. Required.

»  Field Type: Select Editable or Read Only as desired.
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Value: Enter a value for the parameter. This field displays for String type
parameters. Required.

Default Value: Enter a default value for the parameter.
Tooltip Text: Enter documentation for the parameter.
Required: Select this checkbox if the parameter must be filled in.

Do Not Display: Select this checkbox if you want to hide the parameter in the
user interface.

Display Control: From the dropdown list, select the control you want to
display in the user interface. Display control options include Text Box,
Choicelist, List of Values (with search), Date Picker.

Once you select a data type, you must configure its display.

Boolean: From the Default Value dropdown list, select true or false.
DateTime: Select the Date Only or Date and Time radio buttons.

From the Date Format dropdown list, select the format in which to display the
date.

From the Default Value dropdown list, select any of the following values:
Today, Tomorrow, A week from now or Specific date.

If you select Specific date, use the calendar picker to select a date. This is
required.

Numeric: From the Number Format dropdown list, select the format in which
to display the number.

For the Data Alignment radio button, select Left or Right. This configures the
alignment of the number value in the job request submission UL

In the Default Value field, enter a default value for the number.

String: From the Display Widget dropdown list, select Text Box, Choicelist or
List of Values (with search). Required.

Text Box: When selecting this value from the Display Widget dropdown list,
enter the default text in the Default Value text field.

Choicelist/List of Values (with search): From the List of Values Source
dropdown list, select the source for the list of values. For the List of Values
(with search), enter a default value in the field provided. In the Display
Attributes shuttle list, select the attributes you want to display. For
information about searching for and registering a list of values, see
Section 5.11.1.2.3 and Section 5.11.1.2.4.

Click Save and Close or Save and Create Another.

5.11.1.2.2 Configuring User Properties for a Job Definition If your job definition requires
additional properties to be filled in by end users at runtime, you can add these
properties in the User Properties tab of the job definition creation user interface.

To configure user properties for a job definition:

1.
2.

In the job definition creation user interface, click the User Properties tab.

Select Actions and then select New or click the New icon.

The Create User Property dialog box displays.

In the Create User Property dialog, enter the following information:
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= Name: Enter a name for the user property.

= Data Type: From the dropdown list, select a data type for the property. Data
types include Boolean, Date, Number and String.

s Default Value: Enter a default value for the property.

= Read Only: Select Read Only if you want the property to be displayed only,
not edited.

Click Save and Close.

5.11.1.2.3 Registering Sources for Lists of Values If you define a user property or
parameter that uses a list of values, you must first register the source for the list of
values.

To register a source for a list of values:

1.

4.

In the job definition creation user interface, click the Manage List of Value
Sources tab.

Select Actions and then select New or click the New icon.
The Create List of Value Source dialog box displays.
In the Create List of Value Source dialog, enter the following information:

= Application Name: From the dropdown list, select the name of the application
for the list of value. Required.

s List of Values Source Definition Name: Enter the name of the source
definition file for the list of values. Required.

s User List of Values Source Name: Enter the name of the source for the list of
values to be displayed to users. Required.

s Description: Enter a description for the list of values.

Click Save and Close.

5.11.1.2.4 Searching for List of Value Sources When defining a user property or
parameter using a list of values, you must register a source for the list of values. The
Search field enables searching for a source for a list of values. You can also save the
search for future use.

For information about registering a source for a list of values, see Section 5.11.1.2.3.

To search for list of value sources:

1.

In the job definition creation user interface, click the Manage List of Value
Sources tab.

In the Search field, select any of the following:
= Match: Select the All or Any radio button to search for any or all of the criteria.

= Application Name: From the dropdown list, select the name of the application
you want to search. Then select an operator such as Greater than or equal to.

s User List of Values Source Name: Enter text for the user list of values source
name. Then select an operator such as Contains.

Optionally, you can add additional fields to search by. Click Add Fields and select
any of the following fields to search by:

= Application ID
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s Created by

n  Creation Date

= Data Source ID

s Description

= Last Update Date

= Last Update Login

= Last Updated By

» List of Values Source Definition Name
= Object Version Number

s Product Short Name

»  User List of Values Source Name

4. C(lick Search to run the search, or Save to reserve the search for future use.

5.11.2 Managing Job Sets

5-24

The Job Sets page in Fusion Applications Control allows you to view, create, edit,
delete and search for job sets.

A job set is a collection of job requests that can be grouped together to run as a single
unit. A job set may be nested, such that it may contain a collection of job requests or
one or more child job sets. Each job request or job set included within a job set is called
a job set step.

Figure 5-4 shows the Results table in the Job Sets page. The Results table displays job
sets and their attributes, including name, package, execution mode and description.

Figure 5-4 The Job Sets Page and Results Table
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This section contains the following topics:

= Viewing Job Sets
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s Creating or Editing a Job Set
s Deleting a Job Set

5.11.2.1 Viewing Job Sets

You can view the job sets created for a given application.
To display job sets:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. From the Scheduling Services menu, select Job Metadata and then select Job Sets.
The Job Sets page displays.

3. From the Applications dropdown list, select the name of the application whose job
sets you want to view.

4. Enter the name and package name of the job set you want to find, and click Go.

The job sets for that application display in a table below the application dropdown
list.

Column Name Description

Name This column displays the name of the job set.

Package This column displays the name of the Java package associated
with the job set.

Execution Mode This column displays the execution mode of the job set, Serial or
Parallel.

Description This column displays a description of the job set.

5. To view the details of a specific job set, click the name of the relevant job set.

5.11.2.2 Creating or Editing a Job Set

A job set is defined as either a serial or a parallel job set. At run time, Oracle Enterprise
Scheduler runs parallel job set steps together, in parallel. When a serial job set runs,
Oracle Enterprise Scheduler runs the steps one after another in a specific sequence.
Using a serial job set Oracle Enterprise Scheduler supports conditional branching
between steps based on the execution status of a previous step.

For each step in a job set, you can configure an action to be take upon completion of
the step, depending on the state of the step. You can also configure parameters and
system properties for the job set, such as elevating access privileges to complete a
particular job request or specifying the number of times a job can be retried in the
event of failure.

To create or edit a job set:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. From the Scheduling Services menu, select Job Metadata and then select Job Sets.
The Job Sets page displays.

3. Click Create to define a new job set, or Edit to modify an existing job set.
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4. In the Job Set field, enter the name of the job set in the text field provided.
Optionally, add a description in the Description text field, and the name of the
relevant job set Java package in the Package text field.

5. In the Job Set Steps field, select Serial or Parallel to create a serial or parallel job

set.

6. Add steps as required by clicking the Add icon. Define each step as required.

a.

In the Step tab, in the Step ID field, enter a meaningful ID for the step.

In the Job field, enter search text and click the browsing button. In the window
that displays, select the job definition that you want to use for this step.

In the Effective Application region, select Insert into main diagram or Add to
list of available steps. If you choose to add the step to the list of available
steps, use the dropdown lists that display to define an action for the possible
job outcomes, namely On Success, On Error and On Warning.

In the Parameters tab, click the Add icon to define any required parameters
and enter their initial value in the field provided. For more information about
defining parameters, see Section 5.11.1.2.1.

In the System Properties tab, click the Add icon to define any system
parameters required for the step.

From the Name dropdown list, select the system property you want to specity.
Possible system properties are shown in Table 5-3.

In the Initial Value text field, enter the value you want to assign to the system
property.

Table 5-3 System Properties

System Property

Description

SYS_allowMultPending

This property specifies whether multiple pending requests for the same job
definition is allowed. This property has no meaning for a job set step. True or
false.

SYS_application

This property specifies the logical name of the J2EE application used for
request processing. This property is automatically set by Oracle Enterprise
Scheduler during request submission.

SYS_bizErrorExitCode

This property specifies the process exit code for a process job request that
denotes an execution business error. If this property is not specified, the
system treats a process exit code of 4 as an execution business error.

This property is optional for a process job type. It is not used for other job
types.

SYS_className

This property specifies the Java executable for a Java job request. This should
be the name of a Java class that implements the
oracle.as.scheduler.Executable interface. This property is required for a
Java job type. It is not used for other job types.

SYS_cmdLine

This property specifies the command line used to invoke an external
program for a process job request.

This property is required for a Process job type. It is not used for other job
types.

SYS_effectiveApplication

This property specifies the logical name of the J2EE application that will be
the effective application used to process the request. A job definition, job
type, or a job set step can be associated with a different application by
defining the EFFECTIVE_APPLICATION system property. This property can
only be specified via metadata and cannot be specified as a submission
parameter.
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Table 5-3 (Cont.) System Properties

System Property

Description

SYS_environmentVariables

This property specifies the environment variables to be set for the spawned
process of a process job request.The property value should be a comma
separated list of name value pairs (name=value) representing the
environment variables to be set.

This property is optional for a Process job type. It is not used for other job
types.

SYS_executePast

This property specifies whether instances of a repeating request with an
execution time in the past should be generated. Instances are never
generated before the requested start time nor after the requested end time. To
cause past instances to be generated, you must set this property to TRUE and
specify the requested start time as the initial time from which instances
should be generated. Note that a null requested start time defaults to the
current time.

Valid values for this property are:

= TRUE: All instances specified by a schedule are generated regardless of
the time of generation.

= FALSE: Instances with a scheduled execution time in the past (that is,
before the time of generation) will not be generated.

If this property is not specified, the system defaults to TRUE.

SYS_extensionlListener

This property is for internal use only.

SYS_external_id

This property specifies an identifier for an external portion of an
asynchronous Java job. For example, an asynchronous Java job usually
invokes some remote process and then returns control to Oracle Enterprise
Scheduler. This property can be used to identify the remote process. This
property should be set by the job implementation of asynchronous Java jobs
when the identifier is known. It is never set by Oracle Enterprise Scheduler.

SYS_groupName

This property specifies the name of the Oracle Enterprise Scheduler isolation
group to which this request is bound. This property is automatically set by
Oracle Enterprise Scheduler during request submission.

SYS_inputList

This property specifies input to a job request. The input to a serial job set is
forwarded as input to the first step only. The input to a parallel job set is
forwarded as input to all the parallel steps.

Oracle Enterprise Scheduler imposes no format on the value of this property.

SYS_inputWorkDirectory

This property specifies the working directory used during job request
processing for input files. Oracle Enterprise Scheduler sets the value of this
property during job request processing.

SYS listener

This property specifies the event listener class associated with the request.
This should be the name of a Java class that implements the
oracle.as.scheduler.EventListener interface.

SYS_locale

This property specifies a language code to apply to the job.

SYS_logWorkDirectory

This property specifies the logging working directory.

SYS_outputList

This property specifies output from a request.

The output of a serial job set is the OUTPUT_LIST of the last step. The output
of a parallel job set is the concatenation of the OUTPUT_LIST of all the steps, in
no guaranteed order, with oracle.as.scheduler. SystemProperty.OUTPUT_
LIST_DELIMITER as a separator.

SYS_outputWorkDirectory

This property specifies the working directory used during job request
processing for output files. Oracle Enterprise Scheduler sets the value of this
property during job request processing.
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Table 5-3 (Cont.) System Properties

System Property

Description

SYS_postProcess

This property specifies the post-process callout handler class. This should be
the name of a Java class that implements the
oracle.as.scheduler.PostProcessHandler interface.

SYS_preProcess

This property specifies the pre-process callout handler class. This should be
the name of a Java class that implements the
oracle.as.scheduler.PreProcessHandler interface.

SYS_priority

This property specifies the request processing priority. The priority interval
is [0...9] with 0 as the lowest priority and 9 as the highest.

Default: If this property is not specified, the system default value used is 4.

SYS_procedureName

This property specifies the name of the PL/SQL stored procedure to be
called for a SQL job request. The stored procedure should be specified using
schema.name format.

The property is required for a SQL job type. It is not used for other job types.

SYS_product

This property specifies the product within the application that submitted the
request.

SYS_redirectedOutputFile

This property specifies the file where standard output and error streams are
redirected for a Process job request. This represents the full path of the log
file where the standard output and error streams are redirected for the
spawned process when the request is executed.

This property is optional for process job types. It is not used for other job
types.

SYS_reprocessDelay

This property specifies the callout handler processing delay time. This
represents the time, in minutes, to delay request processing when a delay is
requested by a callback handler.

Default: If this property is not specified, the system default used is 5. Integer
type.

SYS_request_timeout

This property enables the job request to time out.

SYS_requestCategory

This property specifies an application-specific label for a request. The label,
defined by an application or system administrator, allows administrators to
group job requests according to their own specific needs.

SYS_requestedProcessor

This property specifies the request processor node on which the request
should be processed. This allows processor affinity to be specified for a job
request. If this property is not specified, the request can run on any available
request processor node. In general, this property should not be specified.

If this property is specified for a request, the request processor's work
assignments oracle.as.scheduler.WorkAssignment (specialization) must
allow the execution of such requests, otherwise the request will never be
executed. If the specified node is not running, the request will remain in
READY state and will not be executed until the node is restarted.

SYS_requestExpiration

This property specifies the expiration time for a request. This represents the
time, in minutes, that a request will expire after its scheduled execution time.
A expiration value of zero (0) means that the request never expires. If this
property is not specified, the system default value used is 0.

Request expiration only applies to requests that are waiting to run. If a
request waits longer than the specified expiration period, it does not run.
After a request starts running the request expiration no longer applies.

SYS_retries

This property specifies the retry limit for a failed request. If request execution
fails, the request will retried up to the number of times specified by this
property until the request succeeds. If retry limit is zero (0), a failed request
will not be retried.

If this property is not specified, the system default used is 0.
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Table 5-3 (Cont.) System Properties

System Property

Description

SYS_runasApplicationID

This property enables elevating access privileges for completing a scheduled
job.

Normally, a request runs as the submitting user. However, if this property is
set in the metadata of the job associated with the request, then the request
executes under the user identified by this property. This property can only be
specified via metadata and cannot be specified as a submission parameter.

SYS_selectState

This property specifies whether the result state of a job set step affects the
eventual state of its parent job set. In order for the state of a job set step to be
considered when determining the state of the job set, the SELECT_STATE must
be set to true. If SELECT_STATE is not specified on a job set step, the state of
the step will be included in the determination of the state of the job set.
Boolean type.

SYS_sqgldobClass

This property specifies an Oracle Enterprise Scheduler job class to be
assigned to the Oracle Enterprise Scheduler job used to execute a SQL job
request. This property need not be specified unless the job used for a job
request is associated with a particular Oracle Database resource consumer
group or has affinity to a database service.

If this property is not specified, a default Oracle Enterprise Scheduler job
class is used for the job that executes the SQL request. That job class is
associated with the default resource consumer group. It belongs to the
default service, such that it has no service affinity and, in an Oracle RAC
environment, any one of the database instances within the cluster might run
the job. No additional privilege or grant is required for an Oracle Enterprise
Scheduler SQL job request to use that default job class.

This property is optional for a SQL job type. It is not used for other job types.

SYS_submittingApplication

This property specifies the logical name of the J2EE application for the
submitted (absolute parent) request. This property is automatically set by
Oracle Enterprise Scheduler during request submission.

SYS_substitutionHandlers

This property has been deprecated.

SYS_successExitCode

This property specifies the process exit code for a process job request that
denotes an execution success. If this property is not specified the system
treats a process exit code of 0 as execution success.

This property is optional for a process job type. It is not used for other job
types.

SYS_userFileDir

This property specifies a base directory in the file system where files, such as
input and output files, may be stored for use by the request executable.

Oracle Enterprise Scheduler supports a configuration parameter that
specifies a file directory where requests may store files. At request
submission, a USER_FILE_DIR property is automatically added for the request
if the configuration parameter is currently set and USER_FILE_DIR property
was not specified for the request. If the property is added, it will be
initialized to the value of the configuration parameter. The property will not
be added if the configuration parameter is not set at the time of request
submission.
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Table 5-3 (Cont.) System Properties

System Property Description

SYS_userName This property specifies the name of the user used to execute the request.
Normally, this is the submitting user unless the RUNAS_APPLICATIONID
property was set in the job metadata. This property is automatically set by
Oracle Enterprise Scheduler during request submission.

SYS_warningExitCode This property specifies the process exit code for a process job request that
denotes an execution warning. If this property is not specified, the system
treats a process exit code of 3 as execution warning.

This property is optional for a process job type. It is not used for other job
types.

SYS_workDirectoryRoot This property specifies the working directory for the spawned process of a
Process job request.

This property is optional for a process job type. It is not used for other job
types.

e. If you configured the step as a serial step, it displays in the job set flow
diagram. Configure the action to be taken upon reaching error and warning
states, respectively. From the dropdown list for the error and warning icons,
select Stop or the name of the job definition to run upon reaching an error or
warning state.
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7. Continue to define steps as required for the job set.

8. Define parameters and system properties as required towards the bottom of the
job set window.

9. Configure access control for the job set.

a. In the Access Control section of the Create Job Set page, click the Add icon to
add access control to the job set.

The Add Access Control dialog box displays.
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b. From the Role dropdown list, select the name of the role you want to apply to
the job set. The role defines the users with sufficient permissions to access the
job set.

c. Select the actions you want to allow role members to take: Read, Execute,
Update and Delete.

10. Click OK to save the job set.

5.11.2.3 Deleting a Job Set

You can delete a job set.
To delete a job set:
1. Search for the relevant job set, as described in Section 5.11.2.1.

2. In the Results table, select the job set you want to delete and click the Delete icon.

5.11.3 Managing Incompatibilities

An Oracle Enterprise Scheduler incompatibility specifies which job definitions are
incompatible with other job definitions. At runtime, when job definitions are specified
in an incompatibility, any job requests associated with the job definitions that are
incompatible cannot run simultaneously.

A given incompatibility defines either a global incompatibility or a domain-specific,
property-based incompatibility.

This section contains the following topics:
= Viewing Incompatibilities
s Creating or Editing an Incompatibility

s Deleting an Incompatibility

5.11.3.1 Viewing Incompatibilities

The Incompatibilities page displays information about incompatibilities including
name, the Java package associated with a given incompatibility and a description for
the incompatibility.

To view job incompatibilities:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. From the Scheduling Services menu, select Job Metadata and then select
Incompatibilities.

The Incompatibilities page displays.

3. From the Applications dropdown list, select the name of the application whose
incompatibilities you want to view.

4. Enter the name and package name of the incompatibilities you want to find, and

click Go.
The incompatibilities for that application display in a table below the application
dropdown list.

Column Name Description

Name This column displays the name of the incompatibility.
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Column Name Description

Package This column displays the name of the Java package associated
with the incompatibility.

Incompatibility Type This column displays the type of incompatibility, global or
domain specific.

Description This column displays a description of the incompatibility.

5. To view the details of a specific incompatibility, click the name of the relevant
incompatibility.

5.11.3.2 Creating or Editing an Incompatibility

An incompatibility consists of two or more job definitions configured as incompatible,
and the resource over which they need to be incompatible. A resource is not specified
for a global incompatibility. This resource is represented by the property name that
forms the Incompatibility. The property name might be different across job definitions.
For example, if two job definitions, JobA and JobB, are made incompatible, then the
property identified for incompatibility might have different names in JobA and JobB.

»  Domain-specific: Two or more job definitions are marked as incompatible within
the scope of a resource, where the resource is identified by a system property
name or a user-defined parameter name. An incompatibility specifies two or more
incompatible entities where each entity consists of a job definition or a job set
definition and a property name that represents the resource over which the entities
are incompatible. Each entity can use the same property name or a different
property name. A property-based incompatibility is used when the incompatible
entities are incompatible over a given property. For property-based
incompatibility, a job definition or a job set and a property name must be specified
for each entity. Oracle Enterprise Scheduler ensures that requests for the
incompatible jobs or job sets, with a property that has the same property value, do
not run at the same time.

= Global: Two or more job definitions cannot run together at any time. A global
incompatibility is used when the incompatible entities are not to be run at the
same time regardless of any property. For global incompatibility, only the job
definition or job set is specified for each entity. Oracle Enterprise Scheduler
ensures that requests for the incompatible Jobs or job sets do not run at the same
time.

Defining an incompatibility involves the following:

= Package and scope: Select a relevant Java package to use for the incompatibility
and set the scope for the incompatibility (global or domain only).

= Jobs: Select the jobs that are incompatible.

s Parameters and properties: Define parameters and properties as required.
= Access control: Define access control as required.

To create or edit an incompatibility:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. From the Scheduling Services menu, select Job Metadata and then select
Incompatibilities.

The Incompatibilities page displays.
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3. (Click Create to define a new incompatibility, or Edit to modify an existing
incompatibility.

The Create Incompatibilities page displays.
4. Enter the following information:
= Name: Enter a name for the incompatibility.
s Package: Enter the name of the relevant incompatibility Java package.
s Description: Optionally, add descriptive text for the incompatibility.

s Type: Configure the scope of the incompatibility by selecting Global or
Domain.

5. In the Entities field, click the Add icon to add jobs to the incompatibility.
The Add Entity dialog box displays.
6. Select one or more jobs and click OK.

7. Define parameters and system properties as required towards the bottom of the
incompatibility window. For more information about defining parameters and
system properties, see Section 5.11.2.2.

8. Configure access control for the incompatibility, as described in step 9 of
Section 5.11.2.2.

9. Click OK to save the incompatibility.

5.11.3.3 Deleting an Incompatibility

Deleting an incompatibility results in the incompatible job requests or job sets
becoming compatible again.

To delete an incompatibility:
1. Search for the relevant incompatibility, as described in Section 5.11.3.1.

2. In the Results table, select the incompatibility you want to delete and click the
Delete icon.

5.12 Managing Work Assignments and Workshifts

Work allocation is the process of defining constraints on where and when jobs run as
well as the amount of resources that can be used to process the jobs. This process
includes creating a work assignment, and binding the work assignment to a request
processor.

A work assignment consists of a specialization rule and one or more workshifts. The
specialization rule defines restrictions on which jobs can be processed. A workshift
defines the temporal windows when the jobs can be processed and what resources can
be used during those periods. The resources defined in a workshift include threads,
which are a local resource of the request processor, and asynchronous workers, a
global resource. The number of asynchronous workers can be specified to throttle the
use of a shared global resource, such as database jobs.

Binding associates a work assignment with a request processor on a server,
determining where the jobs can run. An exclusive binding mode is supported to not
only determine when the jobs can run but to prevent them from running anywhere
else.
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By default, no work assignments are bound. When there is no bound or active work
assignment, a virtual default work assignment will be started to process all jobs using
all available resources.

For more information about managing work assignments, workshifts and schedules,
see the section "Managing Work Assignments and Workshifts" in the chapter
"Managing the Work of Oracle Enterprise Scheduler Jobs" in the Oracle Fusion
Middleware Administrator’s Guide for Oracle Enterprise Scheduler.

5.13 Managing Oracle ADF Connections

The ADF Connections Configuration page allows you to create connections to services
such as ADF Business Components services, Oracle Business Activity Monitoring,
Oracle Enterprise Scheduler, URLs and web services.

Figure 5-5 shows the ADF Connections Configuration page.

Figure 5-5 The ADF Connections Configuration Page
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Use the ADF Connections Configuration page to configure the following properties for
Oracle Enterprise Scheduler:

= Request Files Store (RequestFileDirectory): From the dropdown list, select File
System or Content Repository to store job request logs to the file system or a
repository. This property is used for job requests submitted by Oracle ADF
applications.

Note: Ensure that the requestFileDirectory property is not
configured to any location under the directory /tmp when running on
a Linux server. When restarting the computer, the operating system
may delete files from the /tmp directory, thus losing any related Oracle
Enterprise Scheduler information stored there.
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Request Files Location: Configure this property to indicate the path of the folder
to which job request logs are to be written. This property displays only when
selecting File System from the Request Files Store dropdown list.

UMS Server URL (NotificationServiceURL): Configure this property when using
the notification service with Oracle Enterprise Scheduler. Set the URL of this
property to that of the UMS Server NotificationServiceURL.

SAML Token Policy (SAMLTokenPolicyURI): Set this property to the URI of the
SAML policy used to secure job requests submitted by Oracle ADF applications.

Client Callback Policy (EssCallbackClientSecurityPolicyURI): Configure this
property to enable the security policy used in the WS-Security headers for web
service invocations from Oracle Enterprise Scheduler for web service callbacks.

You can manage ADF connections in Fusion Applications Control only.

To create or edit an ADF connection:

1.

From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

From the Scheduling Services menu, select Configuration and then select ADF
Connections.

The ADF Connections Configuration page displays.

In the Create Connection field, click the Connection Type dropdown list and select
the type of connection you want to create.

In the Connection Name field, enter a name for the connection.
Click Create Connection to add the connection.
The new connection displays under the relevant connection category.

To configure the connection, scroll down to the relevant connection category and
select the new connection. Click Edit.

The connection window displays.

Configure the connection accordingly. For more information about the attributes
you can configure for each type of connection, see the online help by clicking the
help icon on the ADF Connections Configuration page.

Click Apply to activate the connection.

5.14 Managing Application Properties

The Managing Application Properties page allows you to define Oracle Enterprise
Scheduler or application properties for a given deployed application.

Figure 5-6 shows the Applications Properties page.
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Figure 5-6 The Application Properties Page
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To create or edit an application property:

1. From the navigation pane, expand the Scheduling Services folder and select the
Oracle Enterprise Scheduler application.

2. From the Scheduling Services menu, select Configuration and then select
Application Properties.

The Application Properties page displays.

3. From the Application dropdown list, select the name of the application for which
you want to configure a property.

4. In the Configuration Properties region, click Add to create a new property.
The Add Property window displays.

5. Inthe Add Property window, configure the following.
= Type: From the dropdown list, select ESS or APP.

= Name: When configuring an application property, enter a name for the
property in the field provided. When configuring an Oracle Enterprise
Scheduler property, select a property from the dropdown list. Properties
include PerlCommand and EssCallbackClientSecurityPolicyURI (for more
information about this property, see Section 5.13).

= Value: Enter a value for the property.
Click OK to save the property.
6. Click Apply to activate the application property.

5.15 Managing Application and Role Policies

Oracle Enterprise Scheduler application and role policies are the same as other
application and role policies. For more information about managing application and
role policies, see Chapter 4.
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5.16 Managing Oracle Enterprise Scheduler Web Services

Oracle Enterprise Scheduler web services are the same as other Fusion application web
services. For information about managing the web services related to Oracle Fusion
Applications, see the "Understanding Oracle WSM Policy Framework" chapter in the
Oracle Fusion Middleware Security and Administrator’s Guide for Web Services.

5.17 Managing Logging for Oracle Enterprise Scheduler

You can search for and view log data for individual job requests, as well as set log
levels for Oracle Enterprise Scheduler. You can also save job request logs to a file, and
trace job requests for additional troubleshooting information.

For more information about logging, see Chapter 13 and the section "Managing
Logging for Oracle Enterprise Scheduling Service" in the chapter "Monitoring Oracle
Enterprise Scheduler” in the Oracle Fusion Middleware Administrator’s Guide for Oracle
Enterprise Scheduler. For more information about managing log files and diagnostic
data, see the chapter "Managing Log Files and Diagnostic Data" in the Oracle Fusion
Middleware Administrator’s Guide.

This section contains the following topics:

s Finding Log Information for a Job Request

= Setting Oracle Enterprise Scheduler Log Levels
= Saving Job Request Logs

Note: The Oracle WebLogic Server logger (logging.xml) only shows
logs written by Oracle Enterprise Scheduler job running in Oracle
WebLogic Server. Once Oracle Enterprise Scheduler transfers control
of running PL/SQL and C jobs to the PL/SQL or C process,
respectively, PL/SQL and C job logging data is not written to the
Oracle Enterprise Scheduler logs as they run in a separate process.

5.17.1 Finding Log Information for a Job Request

Job request logs can often be written to different files. You can find log data regarding
a given job request using its Execution Context Identifier (ECID), a unique identifier
that enables finding log data for the job request.

For more information about finding the ECID for a job request, see Section 14.5.3

5.17.2 Setting Oracle Enterprise Scheduler Log Levels

It is possible to configure Oracle Enterprise Scheduler server logging for a Oracle
WebLogic Server by modifying the logging.xml file of that Oracle WebLogic Server.
By default, there is no explicit logger entry for Oracle Enterprise Scheduler. Oracle
Enterprise Scheduler inherits the logging level and log handlers configured for the
parent logger, typically the oracle logger or the root logger.

By default, the log messages for the Oracle Enterprise Scheduler logger can be found
in the Oracle WebLogic Server diagnostic log file for that Oracle WebLogic Server. The
logging.xml file is located under DOMAIN
HOME/config/fmwconfig/servers/WebLogic_Server_ Name, where DOMAIN_ HOME is the
domain home directory for the Oracle WebLogic Server domain and WebLogic_
Server_Name is the name of the Oracle WebLogic Server that uses the logging.xml file.
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Table 5-4 shows the Oracle Enterprise Scheduler logger names, log levels and a
description for each level.

Table 5-4 Loggers and log levels for Oracle Enterprise Scheduler

Logger Name Log Level Description

oracle.as.ess SEVERE Problems encountered by Oracle Enterprise
Scheduler runtime in the context of request
processing that result in the request errors. Errors
include exceptions thrown by the job code,
unchecked exceptions when running the job code
and exceptions when running Oracle Enterprise
Scheduler code.

Problems encountered by Oracle Enterprise
Scheduler runtime outside the context of request
processing, such as dispatching, system event
handling, and so on.

WARNING Less severe problems encountered by Oracle
Enterprise Scheduler runtime during or outside of
request processing, which might not cause
requests to enter error state.

INFO Messages for request state transitions.
Messages related to work assignment activities.
Messages about batch delete failures.

Start and stop of Oracle Enterprise Scheduler
resource adapter.

CONFIG Application endpoint activation and de-activation
for Oracle Enterprise Scheduler resource adapter.
oracle.apps.fnd.applcp.srs WARNING Any problems that occur during Ul rendering to
submission.
INFO Messages related to job fetch and submission API
calls.
FINEST Details tracing messages for the scheduled job
request submission UL
oracle.apps.fnd.applcp.monitor WARNING Any problems that occur during Ul rendering to
operations in the UL
INFO Messages related to job request fetch and various
API calls.
FINEST Details tracing messages for the job request

monitoring UL

oracle.apps.fnd.applcp SEVERE Records any errors occurred when creating a
session for Oracle Fusion Middleware Extensions
for Applications, or when creating a file during
pre- and post-processing.

WARNING Records messages related to terminating sessions
and closing files during pre- and post-processing

FINE Messages related to pre- and post-processing
execution activity.

= Application Logging: Oracle Enterprise Scheduler job implementation might call
standard Oracle Fusion Applications logging code. For proper operation, the
AFLOG_ENABLED profile option must be set to Y. For PL/SQL jobs, set AFLOG_PLSQL_
FILENAME to Y. For C jobs, set AFLOG_FILENAME to Y. For more information about
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configuring log settings, see Section Section 13.7 and Section 14.2. For more
information about setting the AFLOG_ENABLED property, see the section "Enabling
JBO Logging in the Provisioned Environment" in the "Debugging Oracle ADF and
Oracle SOA Suite" chapter in the Oracle Fusion Applications Developer’s Guide.

= Request Logging: Oracle Enterprise Scheduler job implementation might write
business-specific job request execution log information to the job request log file.
This log file is specific to each request, and is automatically enabled by default. For
more information about viewing the log file for a job request, see the section
"Viewing Job Request Logs" in the chapter "Monitoring Oracle Enterprise
Scheduler" in the Oracle Fusion Middleware Administrator’s Guide for Oracle
Enterprise Scheduler.

For information about setting the log levels for Oracle WebLogic Server, see the section
"Tracing Oracle Enterprise Scheduling Service Jobs" in the chapter "Monitoring Oracle
Enterprise Scheduler" in the Oracle Fusion Middleware Administrator’s Guide for Oracle
Enterprise Scheduler. For more information about Oracle Diagnostic Logging levels, see
Section 13.7.3.

Set the log levels for the Oracle WebLogic Server running Oracle Enterprise Scheduler
as described in the Oracle WebLogic Server documentation.

5.17.3 Saving Job Request Logs

By default, job request logs are written to the fnd_log API if Oracle Fusion
Applications logging is set to FINER.

It is possible to save job request log data to the server log file. Job request logs are
normally stored to Oracle WebCenter Content. However, when setting the log level to
FINER, all job request logs are copied to the server log file.

To save job request logs to the server diagnostic file in Fusion Applications Control:

1. In Fusion Applications Control, in the navigation pane, select WebLogic Domain
and then select the domain and server names.

2. Click the WebLogic Server menu and select Logs and then select Log
Configuration.

The Log Configuration pane displays.
3. Inthe Log Configuration pane, click the Log Levels tab.

4. In the Search text field, search for oracle.as.scheduler. and find the
oracle.as.scheduler.security.internal.SecurityExecutorFactory logger.

5. Set the log level to FINER and click Apply.

6. Run a diagnostic test, as described in Chapter 13. The log messages are now saved
to the <server>-diagnostic. log file.

The logs are saved to the server diagnostic file, <Oracle Enterprise Scheduler
server name>-diagnostic.log.

5.18 Managing Alerts for Oracle Enterprise Scheduler in Cloud Control

Cloud Control enables you to configure, view and manage alerts for Oracle Enterprise
Scheduler entities including the scheduling service itself, work assignments and job
definitions. Alerts are based on performance metrics for Oracle Enterprise Scheduler.
Each metric includes named objects with upper and lower thresholds indicating
warning or critical states for that particular metric. For example, you can configure an
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alert for all job requests that have entered a state of error, such that 10 errors constitute
a warning state, and 20 errors a critical state. Once you have configured alerts, you can
view any existing alerts as well as any configuration changes made within a specified

period of time.

Table 5-5 lists the alerts available for Oracle Enterprise Scheduler.

Table 5-5 Oracle Enterprise Scheduler Alerts

Alert

Scope

Collected Data

Alert Automatically Cleared?

Alert for job requests in ready state
and the average wait time for job
requests in ready state.

Work assignment

The number of job
requests in ready state
and average wait time of
the ready job requests by
work assignment.

No. The alert is only cleared when the
number of ready job requests is smaller
than the threshold. The same is true for
alerts pertaining to the average wait
time of a ready job request.

Alert for job requests that have
entered a state of error.

Work assignment

The number of job
requests that have
entered an error state
following the last
collection.

Yes. The alert is automatically cleared if
the delta value of the subsequent
collection is below the threshold.

Alert for long running job requests.

Job definition

The longest running time
of a job request listed by
job definition. The data is
queried for only those
job definitions for which
a threshold is specified.

No. The alert is only cleared when a job
request runs for the job definition
beyond the threshold value.

Alert for job requests that have gone

to a state of ERROR_MANUAL_RECOVERY.

Scheduling service

The number of job
requests in a state of
ERROR_MANUAL_RECOVERY.

No. An administrator must recover the
job request in order to clear the alert.

Alert for timed out job requests.

Scheduling service

The number of timed out
job requests.

No. An administrator must cancel or
recover the job request in order to clear
the alert.

Alert for job requests that have gone
into ERROR state.

Scheduling service

The number of job
requests that have gone
into ERROR state during
the last hour.

Yes. The alert automatically clears if the
delta value in the subsequent collection
is below the threshold.

Alert for blocked job requests.

Scheduling service

The number of job

requests in BLOCKED state.

No. An administrator must cancel the
job request, or the job request must be
selected for processing in order to clear
the alert.

This section contains the following topics:

»  Configuring Metric Alerts for Oracle Enterprise Scheduler in Cloud Control

= Viewing Alerts for Oracle Enterprise Scheduler in Cloud Control

5.18.1 Configuring Metric Alerts for Oracle Enterprise Scheduler in Cloud Control

You can configure the thresholds for each object monitored by the metric. For a given
metric, you can configure alert rules as follows:

= Select an object that the metric monitors, such as job requests in an errored state.

= Configure the values at which the object reaches warning and critical states,
including an operator value such as greater than (>) or less than (<).

m Enter a corrective action to be taken in the event that the alert criteria are fulfilled.

= Arrange the alert rules in the order you desire.

To configure metric alerts for Oracle Enterprise Scheduler in Cloud Control:

1. Navigate to the scheduling service.
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8.
9.

a. From the Targets menu, choose Fusion Applications.

b. In the table on the Fusion Applications page, click the relevant Oracle Fusion
Applications instance with Oracle Enterprise Scheduler deployed.

c. In the Target Navigation pane, click the name of the domain where Oracle
Enterprise Scheduler is deployed, and then click Scheduling Services.

Click the Oracle Enterprise Scheduler cluster or an individual Oracle Enterprise
Scheduler server.

From the Targets menu, select Monitoring and then click Metric and Collection
Settings.

A list of metrics displays.

Select the metric for which you want to configure alert thresholds and click the
Edit icon. For example, you can configure the thresholds for the Average Wait
Time for Requests in Ready State (in seconds) metric.

The Edit Advanced Settings page displays, including the Monitored Objects list.

In the Edit Advanced Settings page, click Add to add a row to the list of
monitored objects.

Select the object you want to monitor.

a. In the Name field of the new row, click the Search button.
The Search and Select Objects window displays.

b. Search for the object you want to use and click Select.

In the spaces provided, enter the values to be used for the Critical and Warning
thresholds.

Click Continue, then click OK to save your settings.

Configure any additional thresholds as required.

For more information about configuring alerts, see the following topics in the Cloud
Control online help:

"Incident Rules—Common Tasks"

"Incident Rules—Advanced Tasks"

5.18.2 Viewing Alerts for Oracle Enterprise Scheduler in Cloud Control

The Oracle Enterprise Scheduler Service home page displays a summary of alerts. You
can navigate to the Incident Manager page to view additional information about
incidents by clicking the number of incidents displayed in the Monitoring and
Diagnostics area.

To view alerts for Oracle Enterprise Scheduler with Cloud Control:

1.

Navigate to the scheduling service.
a. From the Targets menu, choose Fusion Applications.

b. In the table on the Fusion Applications page, click the relevant Oracle Fusion
Applications instance with Oracle Enterprise Scheduler deployed.

c. In the Target Navigation pane, click the name of the domain where Oracle
Enterprise Scheduler is deployed, and then click Scheduling Services.
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Click the Oracle Enterprise Scheduler cluster or an individual Oracle Enterprise

Scheduler server.

The Scheduling Service summary page displays. The Monitoring and Diagnostics
pane displays the following information.

2.
"
"
"
3.

Incidents: The number of incidents that have occurred in the scheduling
service instance displays here. The number of incidents is determined by those
incidents collected as a result of configuring job request alerts. For more
information about configuring job request alerts, see Section 5.18.1. If the
number of incidents is greater than zero, click the number for more
information about the incidents that have occurred.

Descendant Target Incidents: The number of incidents that have occurred
anywhere in the scheduling service cluster displays here. If the number of

incidents is greater than zero, click the number for more information about the
incidents that have occurred.

Configuration Changes: The number of changes that have been made to alert
configurations displays here. Click the number of configuration changes to
search for the changes made within a particular period of time. The default
time period is seven days. For more information, see Section 5.5.

Click the number of incidents to display detailed information about the alerts in

the Incident Manager pane.
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The Incident Manager displays incidents in a table, with the following information
listed for each incident: severity, summary, target, priority, status, last updated,
owner, acknowledged, escalated, type and category.

You can click an incident to display its details. For more information about using
Incident Manager, see the following topics in the Cloud Control online help:

"Incident Manager—Common Tasks"

"Incident Manager—Advanced Tasks"
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Managing Report Delivery Servers

This chapter describes report delivery server administration in Oracle Fusion
Applications.

This chapter contains the following topics:

» Introduction to Managing Report Delivery Servers

= Navigating to the Oracle BI Publisher Administration Page
s Configuring Report Delivery Servers

= Understanding the Report and Delivery Processors

»  Managing Report Processing and Delivery Server Load

= Scaling Out Report Processors

s Diagnosing Report Processing Issues

s Configuring System Properties for Reporting

6.1 Introduction to Managing Report Delivery Servers

Oracle Business Intelligence Publisher is the report generation and delivery engine for
Oracle Fusion Applications. Oracle BI Publisher receives report requests from Oracle
Fusion Applications in the following ways:

s Through Oracle Enterprise Scheduler
s Through the Reports and Analytics pane
s From an application page

Requests submitted through Oracle Enterprise Scheduler are processed by the Oracle
BI Publisher scheduler. Requests submitted through the Reports and Analytics pane
can be either real-time online requests or scheduled requests. Requests submitted
through an application may invoke Oracle Enterprise Scheduler or may return report
request results directly back to the application page.

After installing Oracle Fusion Applications, Oracle BI Publisher is configured to accept
requests from Oracle Fusion Applications. However, before you can deliver report
documents to their destinations you must define the delivery servers in Oracle BI
Publisher. Use the Oracle BI Publisher Administration page to define your delivery
servers.

Once set up, you can then further configure the number of report processor and
delivery threads to best handle your processing and delivery requirements. In
addition, you can configure report properties for the system or at the report level to
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tune performance of your reports. To diagnose report processing issues, BI Publisher
provides a set of scheduler diagnostics.

6.2 Navigating to the Oracle Bl Publisher Administration Page
Use the Oracle BI Publisher Administration page to:
= Configure delivery servers
= Manage report and delivery processors
= View scheduler diagnostics

= Set system properties and report runtime configuration properties

Note: You must be assigned the BIAdministrator role to access the
BI Publisher Administration page.

To navigate to the Oracle BI Publisher Administration page:

»  From the Oracle Fusion Applications Navigator, under Tools, click Reports and
Analytics. In the Reports and Analytics pane, click Catalog to display the Oracle
Business Intelligence presentation catalog page. From here, click Administration
and then click Manage BI Publisher.

Alternatively, log in to Oracle Business Intelligence directly (example:
http://example.com:port/analytics). Click Administration and then click
Manage BI Publisher.

Figure 6-1 shows the BI Publisher Administration page:

Figure 6—1 BI Publisher Administration Page
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@ JNDI Connection @ Scheduler Configuration
@ File @ Scheduler Diagnostics
@ LDAP Connection
@ OLAP Connection
: Security Center |[§j==. Runtime Configuration
A 1 L
W, Security Configuration "=l 2 Properties
@ Users @ Font Mappings
@ Roles and Permissions @ Currency Formats
@ Digital Signature
_-ﬁ@ Delivery [i=\ Integration
= 2 Delivery Configuration 8. Orade BI Presentation Services

@ Printer

@ Fax

@ Email

@ WebDAV

@ HTTP

@ FTP

@ CUPS Server
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6.3 Configuring Report Delivery Servers
To configure delivery servers:
1. From the BI Publisher Administration page, click Delivery Configuration.

2. Enter values in the Delivery Configuration Options tab to set general properties
for email deliveries and notifications. Figure 6-2 shows the Delivery Configuration
Options tab:

Figure 6—2 Delivery Configuration Options Tab

Home | Catalog | [ Mew ~ B Open~ | Signed In As administrator ~

Administration > Delivery Configuration

Delivery
Delivery Configuration | Printer | Fax | Email WebDAV | HTTP FTP | CUPS Server

“TIP Any changes wil only take effect after the application is restarted.

Apply Cancel

SSL Certificate File
Email From Address |bipublisher-report@oracle.com

{Drefzult Vale: bipublisher-report@oracle.com )

Delivery Motification Email From Address | bipublisher-notification@oracle.com
{Drefault Vale: bipublisher-notificztion@aoracle.com )
Success Motification Subject |Auto: Success
Warning Motification Subject |Auto: Report Generated with errors

Failure Motification Subject |Auto: Failed

For more information about this tab see "Setting Delivery Configuration Options"
in the Oracle Fusion Middleware Administrator's Guide for Oracle Business
Intelligence Publisher (Oracle Fusion Applications Edition).

3. To configure a delivery server, click the appropriate tab.

The following table lists the report delivery channels supported by Oracle BI
Publisher. See the corresponding section in the Oracle Fusion Middleware Administrator’s
Guide for Oracle Business Intelligence Publisher (Oracle Fusion Applications Edition) for
configuration information.

Delivery Type Section

Printer and Fax Adding a Printer or Fax Server
E-mail Adding an E-mail Server
WebDAV Adding a WebDAYV Server
HTTP Adding an HTTP Server

FIP Adding an FTP Server

Note that printing is supported through Internet Printing Protocol (IPP). If Oracle BI
Publisher is operating in a UNIX environment, you must set up the Common Unix
Printing Service (CUPS) and then define your CUPS server to Oracle BI Publisher. For
a Windows environment, you must set up Windows Print Server for IPP. For
information on setting up CUPS and Windows IPP, see "Setting Up Print Servers" in
the Oracle Fusion Middleware Administrator’s Guide for Oracle Business Intelligence
Publisher (Oracle Fusion Applications Edition).
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6.4 Understanding the Report and Delivery Processors

When Oracle Enterprise Scheduler initiates a job, it is picked up by the BI Publisher
scheduler queue. The processors perform as follows:

Job Processor - listens for requests from the scheduler queue. When the job
information is received, the job processor executes the data model (and splits the
data for bursting jobs), stores the data in the shared temporary folder, and sends
the report metadata to the report queue.

Report Processor - listens for requests from the report queue. When the report
information is received, the report processor generates the report documents,
stores it in the shared temporary folder and puts the delivery information in the
delivery queue.

Delivery processors - each delivery processor listens to the delivery queue and
handles the delivery of reports for its channel. The delivery processors are:

— Email Processor

— File Processor

— FIP Processor

—  Print Processor

— WebDAV Processor

— Fax Processor

You can configure the number of threads dedicated to each processor.

6.5 Managing Report Processing and Delivery Server Load

Manage the processors in the BI Publisher Scheduler Configuration page. By default,
each processor is enabled and the thread count for each is set to five. For each
managed server that is running in the BI cluster, a table for that instance's processors
will display. Use the table to enable or disable processors for the instance and
configure the thread counts.

To configure processor threads:

1.
2.

From the BI Publisher Administration page, click Scheduler Configuration.
On the Scheduler Configuration page scroll to the Cluster Instances region.

Figure 6-3 shows the Oracle BI Publisher Scheduler Configuration page,
highlighting the JMS Configuration and Cluster Instances regions:
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Figure 6-3 Bl Publisher Scheduler Configuration Page

Home | Catalog | [ New ~ B Open~ | Signed In As administrator

Administration > Scheduler Configuration

System Maintenance
Server Configuration = Scheduler Configuration = Scheduler Diagnostics

JMS Configuration
IMS Provider |WebLogic %
WebLogic JNDI URL |t3://host.example.com:7001

Threads Per JMS Processor |5
Shared Directory |/scratch/apphome/xmipserver/wlms/shared

Test JMS

Cluster Instances

Instance Mame |2211.1343
Instance ID 3211.1343

JMS Processor  |[Enable|Number Threads

HobProcessor

ReportProcessor

EmailProcessor

FileProcessor

FTPProcessor

PrintProcessor

VebDavProcessor

H|EEE|E|EE|E

FaxProcessor

3. Enter the Number Threads value in the processor configuration table.

Note that all processors will automatically be set to use the number of threads
defined in the Threads Per Processor value of the JMS Configuration region of
the page. Enter a value in the Number Threads column to change the value from
this default.

6.6 Scaling Out Report Processors

To add managed servers to enable more report and delivery processors to handle your
reporting throughput see the "Scaling Out the Oracle Business Intelligence Domain"
chapter in the Oracle Fusion Applications Customer Relationship Management Enterprise
Deployment Guide.

After performing the scale-out procedure, follow the steps in "Managing Report
Processing and Delivery Server Load" to configure the processor threads for each
cluster instance.

6.7 Diagnosing Report Processing Issues
The following tools enable you to diagnose report processing and delivery issues:
= Scheduler Diagnostics page

= Oracle Enterprise Manager Fusion Applications Control (Fusion Applications
Control)
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6.7.1 Using the Scheduler Diagnostics Page

The Scheduler Diagnostics page provides the runtime status of the scheduler. It
provides status of its JMS configuration, JMS queues, cluster instances, scheduler

Database, Toplink, and Oracle Enterprise Scheduler.

To access the Scheduler Diagnostics page:

1.
2.

Figure 6—4 BI Publisher Scheduler Diagnostics Page

Navigate to the Oracle Business Intelligence Publisher Administration page.

In the System Maintenance group, click Scheduler Diagnostics.

The Scheduler Diagnostics page is shown in Figure 6—4:

Home | Catalog | B

Bs Open ~

Signed In As administrator ~

Administration > Scheduler Diagnostics

System Maintenance

Server Configuration = Scheduler Configuration | Scheduler Diagnostics
Last Refreshed June 9, 2010 8:18:00 PM UTC | Diagnose

Result: Passed
Diagnostic Ttem Value Status Details
Enterprise Scheduler Passed
-JMS Passed
—---3MS Cluster Config ﬁ:’:_ﬁggffcoorg;g;n!g:ixirsfrepositoryfAdmin;’Sﬁeduler Paceed
—-—JM5_PROVIDER_TYPE WebLogic Info WebLogic JMS is selected.
-—--JM5_WEBLOGIC_VERSION 10.3 Info
———JM5_WEBLOGIC_INDI_FACTORY weblogic.jndi. WLInitialContextFactory Info
———JM5_WEBLOGIC_INDI_LURL t3:/f example. com: 7001 Info
-—BIP_CONNECTION_FACTORY_NAME BIP.IMS.CF Info
——BIP_SYSTEM_TOPIC_NAME BIP.System.T Info
——BIP_BURST_JOB_QUELE_NAME BIP.Burst.Job.Q Info
——$IP_BURST_REPORT_QUELE_NAME BIP.Burst.Report.Q Info
———BIP_DELIVERY_EMAIL_QUELE_NAME BIP.Delivery.Email.Q Info
——IP_DELIVERY_FILE_QUELE_NAME BIP.Delivery.File.Q Info
——IP_DELIVERY_FTP_QUELE_NAME BIP.Delivery. FTP.Q Info
———BIP_DELIVERY_PRINT_QUELE_NAME BIP.Delivery.Print.Q Info
———BIP_DELIVERY_WEBDAYV_QUEUE_NAME  |BIP.Delivery. WebDAV.Q Info
———BIP_DELIVERY_FAX_QUELE_NAME BIP.Delivery.Fax.Q Info
-—-MUMBER_THREADS_PER._PROCESSOR 5 Info
—-—JM5_Shared_Temp_Directory [scratchapphome fxmipserver fwljms/shared Info
----JMS Runtime Passed
———Topic - BIP.System. T Passed

For more information about this page see the "Scheduler Diagnostics" topic in the
Oracle Fusion Middleware Administrator’s Guide for Oracle Business Intelligence
Publisher (Oracle Fusion Applications Edition).

6.7.2 Using Fusion Applications Control

For information on using Fusion Applications Control to diagnose issues with Oracle
BI Publisher, see the "Diagnosing and Resolving Issues in BI Publisher" topic in the
Oracle Fusion Middleware Administrator’s Guide for Oracle Business Intelligence Publisher
(Oracle Fusion Applications Edition).

6.8 Configuring System Properties for Reporting

Use the Oracle BI Publisher Runtime Configuration page to set the system-level
runtime properties for reports.

To access the Runtime Configuration page:
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Navigate to the Oracle Business Intelligence Publisher Administration page (see
"Navigating to the Oracle BI Publisher Administration Page").

In the Runtime Configuration group, click Properties.

For more information about this page see the "Defining Runtime Configurations"
chapter in the Oracle Fusion Middleware Administrator’s Guide for Oracle Business
Intelligence Publisher (Oracle Fusion Applications Edition).
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Managing Search with Oracle Enterprise
Crawl and Search Framework

This chapter describes how to manage search using Oracle Enterprise Crawl and
Search Framework (ECSF).

This chapter includes the following topics:

s Introduction to Oracle Fusion Applications Search

= Validating the Environment for ECSF

s Getting Started with Managing ECSF with Fusion Applications Control
s Administering Search

s Performing Advanced Administration Tasks

7.1 Introduction to Oracle Fusion Applications Search

Knowledge workers can spend up to 24% of their time looking for information. Good

search tools help them find this information more quickly. Expectations about the ease
of use of search tools are high because searches are so easy to perform on the Internet.

Oracle Fusion Applications Search is designed to exceed user expectations.

Oracle Fusion Applications Search is embedded within Oracle Fusion Applications.
Any application that connects to multiple data sources or manages a significant
amount of unstructured (non-database) information—or both—needs advanced search
capabilities so that application users can easily locate and take action on data that is
relevant to them. Powered by the Oracle Enterprise Crawl and Search Framework and
Oracle Secure Enterprise Search, Oracle Fusion Applications Search not only provides
a seamless search experience to the Oracle Fusion Applications end user for getting the
right content at the right time, but also enhances the Oracle Fusion Applications
developer's experience by providing a metadata-driven, declarative design time and
runtime interface to manage enterprise search capabilities.

7.1.1 Oracle Fusion Applications Search Use Case Example

Simone Sterling is a new sales representative at Cobalt Inc. a computer hardware
company. She is taking over for Jim Anderson, who just left the company. Simone
needs to learn about Jim's interactions with his customers and about how to sell
Cobalt's new line of energy-saving displays.

Simone starts by entering "Jim Anderson" in the Oracle Fusion Applications Search
box that is available at the top of every Oracle Fusion Applications page. Simone
retrieves hundreds of documents pertaining to Jim Anderson and to people named
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"Jim" or "Anderson". Simone is only interested in documents related to sales or
customers, so she de-selects all the search categories except Sales and Customers and
then re-runs her search.

Now that Simone is only looking at potentially relevant records, she decides to start
exploring the results for specific customers. Simone expands the Customer Account
node under the Customer node in the Available Filters tree to display a list of customer
accounts. Simone can only view the search results for documents to which she has
been granted access. Likewise, she can only view the search categories and filters to
which she has access.

Simone clicks "ABC Corporation" to display only the records that involve both Jim
Anderson and ABC Corporation. Simone hovers her mouse pointer over result items
for Customer Notes and Customer Interactions to see the first 244 characters of each
document. She drills down to view details for a note about the new energy-saving
displays.

Simone continues to explore her search results. She filters the results by selecting new
customers from the Customer Accounts node, views result items in the Search Results
window, then drills into Oracle Fusion Applications to view details for interesting
items.

Simone finds a particularly useful set of results by searching for the new
energy-saving displays, then filtering for recent customer interactions. She decides to
save her search so she can monitor customer interactions around the energy-saving
displays, so she clicks the Save... button and names her search "Energy Saver
Interactions". This enables her to re-run her search at any time from any page within
Oracle Fusion Applications.

Thus, Simone reaps the benefits of the powerful Oracle Fusion Applications Search
feature that helps her tailor the search results to meet her specific business needs. She
can also save the searches that she wants to reuse often.

7.1.2 Oracle Fusion Applications Search Ul

The user interface for Oracle Fusion Applications Search, shown in Figure 7-1, offers a
variety of useful features.
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Figure 7-1 Oracle Fusion Applications Search Ul
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In the preceding figure, the following features are called out:

The Search Categories dropdown list allows Oracle Fusion Applications users to
scope their searches to one or more selected categories. Each search category
corresponds to one Oracle Secure Enterprise Search (Oracle SES) data source
group. Search categories (Oracle SES data source groups) are used for display
purposes and for organizing searchable objects (Oracle SES data sources).

The Keywords field allow users to enter terms or Oracle SES-supported operators
for search.

Tabbed Browsing organizes the search results for Oracle Fusion Applications and
Oracle Business Intelligence (BI) Catalog into separate tabs. In Oracle Fusion
Applications V1, Oracle Fusion Applications Search federates queries to the Oracle
SES instance that searches the Oracle Business Intelligence (BI) Catalog. Search
results from the Oracle Fusion Applications Oracle SES instance appear on the
Oracle Fusion Applications tab. Search results from the Oracle Business
Intelligence (BI) Catalog Oracle SES instance appear on the Business Intelligence
tab.

Faceted Browsing allows Oracle Fusion Applications users to filter their search
results by selecting nodes in the Available Filters tree. Applied filters are shown in
bold in the Available Filters tree and as tiles in the Selected Filters region. The
numbers in parentheses next to the applied filters in the Available Filters tree
represent the number of documents in the search result set that have that facet
value.
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Users can filter by category (Oracle SES data source group), subcategory
(searchable object /Oracle SES data source), and values of one or more facets
defined for a given subcategory. Filtering on a facet value automatically filters on
its parent subcategory and category.

Filters can be removed via the delete icons in the Available Filters tree and the
Selected Filters region. Removing a parent filter also removes all its children.

Saved Searches allows Oracle Fusion Applications users to save the searches they
create. Saved searches comprise all characters in the Keywords field and all the
filters the user applies. Selecting a saved search runs the query and display all
filters in the Available Filters tree and the Selected Filters region.

The Main Link identifies the object or page to which a search result item links. It is
the primary link and search result item title, as defined in the Default Action Title
by the Oracle Fusion Applications developer.

The Title provides key information about each search result item in addition to the
main link. The title is part of the search result item's fixed content that appears
regardless of where the user's keywords match the searchable document.

The Body of each search result item includes a context snippet that comprises one
or more instances of the keywords and the surrounding text extracted from the
body of the searchable document.

The Actionable Results are the list of the action links that appear below the body
of each search result item. The action links allow Oracle Fusion Applications users
to navigate directly to the pages for the objects represented by the search result
items so that they can take specific actions on those objects. Action links can also
take the user to third party web sites or any page accessed by a fully qualified
URL.

7.1.3 Oracle Enterprise Crawl and Search Framework

Oracle Fusion Applications Search functionality is fundamentally made possible by
the integration of three systems, each playing a role in forming the complete search
platform:

Search engine, as provided by Oracle Secure Enterprise Search (Oracle SES), which
provides the fundamental search capability that includes indexing, querying, as
well as some value added functionalities such as security. For more information
about Oracle SES, see Oracle Secure Enterprise Search Administrator’s Guide.

Source system, such as a relational database, where the searchable information
resides

Search development framework, such as Oracle Enterprise Crawl and Search
Framework (ECSEF), that supports the integration of applications with search
engines

ECSF is an Oracle Fusion Middleware search framework that enables the exposure of
application context information on various business objects to enable full-text
transactional search. Benefits of ECSF include:

Transparent integration of applications with search engines, which minimizes
development time and maximizes the user experience with search

Code reuse, through use of a well designed set of abstract classes, to reduce long
design cycles

Basic platform for developing search, which helps new developers to grasp the
conceptual flow of work easily
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s Centralized process and control mechanism, which enhances search functionality

= Wide range of optimizations that offer better control to leverage search results

7.1.3.1 ECSF Management Features

ECSF management features include:

= Runtime server, a metadata-driven runtime engine that serves as an integration
framework between enterprise data sources and Oracle SES. It enables crawling,
indexing, and the security service. It also serves as the semantic engine that
provides "smart" search features, such as faceted navigation, actionable results,
and related search.

s Oracle Enterprise Manager Fusion Applications Control (Fusion Applications
Control), an administration user interface for configuring and administering the
ECSF runtime server, managing the searchable object lifecycle, and synchronizing
with Oracle SES. Support for a command line administration option is also
provided. For information, see the "ECSF Command Line Administration Utility"
appendix in the Oracle Fusion Applications Developer’s Guide.

7.1.3.2 Key ECSF Features

Key ECSF features that are built on top of Oracle SES and enhance the Oracle Fusion
Applications user experience with search include:

= Basic search, which allows query based on keyword and search category.

= Advanced search, which allows query based on keyword, search category, and up
to 100 attribute filters.

= Faceted navigation, which allows the filtering of search results based on attributes
of the business objects. Users can navigate a search result set based on a set of
predefined facets, or dimensions. This feature returns a list of facets and their
associated set of available values with the search result. Users can select a value
for each facet, which is then submitted with the search query in order to narrow
down the result set.

s Actionable results, which are search results with action links associated with the
searchable objects. From the search results users can either go straight to the page
displaying the record they selected, or they can invoke a specific task on a search
result.

s Saved searches, which allows saved search criteria for later use. Users can create
new saved search entries, edit and delete existing saved search entries, and
retrieve user-specified or public saved search entries.

»  File attachments, which allow the crawling of attachments that are associated with
Oracle Fusion Applications transactional objects or records.

s Crawling Oracle WebCenter Portal tags, which supports crawling searchable
objects that contain Oracle WebCenter Portal tags.

»  Crawling tree structures, which supports search functionality on source systems
containing data that is organized in a tree structure (for example, Oracle Business
Intelligence (BI) Catalog).

»  Search support for external data sources, which allows querying against search
groups that contain external data sources, which are non-ECSF related data
sources, such as wiki pages and blogs, that are directly crawled by Oracle SES.
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7.1.3.3 ECSF Process Flow

The process flow for search using the ECSF architecture, illustrated in Figure 7-2,
begins from the time the Oracle Fusion Applications developer makes a view object
searchable to the time the Oracle Fusion Applications user receives the search results.
The arrows indicate the direction of flow, and the numbered circles indicate the
sequence of the steps, which correspond to the list immediately following the
illustration.

Figure 7-2 ECSF Process Flow
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The process flow includes the following steps:
1. The Oracle Fusion Applications developer creates a searchable object.
2. The Oracle Fusion Applications developer configures the security rules.

3. The Oracle Fusion Applications administrator deploys the searchable objects to the
ECSF runtime environment by registering them in the Oracle Fusion Applications
database.

4. The Oracle Fusion Applications administrator deploys the searchable objects to
Oracle SES. The Oracle SES search engine crawls the searchable objects in the
Oracle Fusion Applications and indexes them as documents.

5. The Oracle Fusion Applications administrator creates search categories containing
the searchable objects and deploys them to Oracle SES. When the Oracle Fusion
Applications user issues a search query, the Oracle Fusion Applications Search Ul
performs the query through the ECSF Query Service.

6. The Query Service applies the Oracle Fusion Applications-specific rules and sends
the query to the Oracle SES search engine.

7. The Oracle SES search engine returns the result set to the Query Service.

8. The Query Service applies post query security rules and constructs the search hits,
and the Oracle Fusion Applications Search Ul renders the search results for the
Oracle Fusion Applications user.

7.1.4 Item Business Object and Data Level Security

Oracle SES does not apply data level security to Item business objects to determine if
the object can be viewed by the user. All qualified users will see a limited amount of
information when the Item business object is enabled for search. The information
displayed in the search results includes the item number and description. The Oracle
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Product Information Management application checks the data level security when the
user elects to view item details through the links within the search results.

Review your internal security policies prior to enabling the Item business object for
search to determine if item information should be viewed by the end users.

7.2 Validating the Environment for ECSF

Before you begin to manage search with ECSE, make sure that the environment is set
up properly for using ECSF.

To validate the ECSF setup, follow the procedures in the following tasks:

»  Task 1, "Make Sure That Oracle Fusion Applications Includes Search
Functionality"

»  Task 2, "Make Sure That Oracle SES Is Installed and Configured Properly”
»  Task 3, "Make Sure That Fusion Applications Control Is Available"

»  Task 4, "Provide Access to ECSF Pages in Fusion Applications Control"

s Task 5, "Validate the Application Identities"

Task 1 Make Sure That Oracle Fusion Applications Includes Search
Functionality

Oracle Fusion Applications Search should be embedded within Oracle Fusion
Applications, but it must be enabled in the user interface by setting the profile option
FUSION_APPS_SEARCH_ENABLED to Y. For information, see Task 6, "Enable the Oracle
Fusion Applications Search UI".

To make sure that Oracle Fusion Applications includes search functionality:

1. Log in to Oracle Fusion Applications. If you cannot log in to Oracle Fusion
Applications, contact your installation team.

2. Verify that the Enterprise Search box is available at the top of every Oracle Fusion

Applications page.

3. View the Search Categories dropdown list. There should be no search categories
listed.

4. Logout.

Task 2 Make Sure That Oracle SES Is Installed and Configured Properly

Oracle SES provides the fundamental search capability that includes crawling,
indexing, and querying. For more information about Oracle SES, see Oracle Secure
Enterprise Search Administrator’s Guide.

To make sure that Oracle SES is installed and configured properly:

1. Check the administration endpoint by logging in to the Oracle SES Administration
GUI with the administration username and password at the following URL.

http: host_name:7777/search/admin/index.jsp

The default port number is 7777. Make sure that you use the correct port number
for your installation. If you cannot access the Oracle SES search engine, contact
your installation team.

2. Make sure that the Oracle SES identity plug-in has been registered.
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3. Make sure that the federated trusted entities are created. Depending on what
product families are installed, you should see one to three proxy users listed. The
valid values are:

s FUSION_APPS_CRM_ECSF_SEARCH_APPID
m FUSION_APPS_FSCM_ECSF_SEARCH_APPID

s FUSION_APPS_HCM_ECSF_SEARCH_APPID

Task 3 Make Sure That Fusion Applications Control Is Available

Fusion Applications Control must be available for configuring and administering the
ECSF runtime server, managing the searchable object lifecycle, and synchronizing with
Oracle SES.

To make sure that Fusion Applications Control is available:
1. Log in to Oracle Enterprise Manager.

2. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

3. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page, shown in Figure 7-3.

The search engine types (Oracle SES) should be listed.

4. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, and validate the
Oracle SES search engine instance parameters.

5. From the table of search engine instances, select a search engine instance record,
and then select the Searchable Objects tab to view the table of searchable objects,
and validate the list of searchable objects for the application. For a list of seeded
searchable objects, see Appendix C.

6. Select the Search Categories tab to view the table of search categories, and
validate the list of search categories and objects associated with the search
categories for the application. For a list of seeded search categories, see
Appendix C.

7. From the navigation pane, re-select the application to open the Enterprise Crawl
and Search Framework Configuration Settings page, then click the Search
Application Service Component link to open the Search Application Service
Component administration page, and validate that the search applications for the
product families are installed.

Task 4 Provide Access to ECSF Pages in Fusion Applications Control

In order to access the ECSF pages in Fusion Applications Control, users must have
Operator privileges in Oracle WebLogic Server. You must add the users to the
Operator group and above on Oracle WebLogic Server. For information, see Oracle
Fusion Middleware Securing Oracle WebLogic Server.

Task 5 Validate the Application Identities

Oracle Fusion Applications include seven search-related application identities that are
seeded and are stored in the identity store:

m FUSION_APPS_CRM_SES_CRAWL_APPID

s FUSION_APPS_CRM_ECSF_SEARCH_APPID
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s FUSION_APPS_FSCM_SES_CRAWL_APPID

m FUSION_APPS_FSCM_ECSF_SEARCH_APPID
m FUSION_APPS_HCM_SES_CRAWL_APPID

s FUSION_APPS_HCM_ECSF_SEARCH_APPID
s FUSION_APPS_ECSF_SES_ADMIN_APPID

ECSF is powered by Oracle SES. To integrate with Oracle SES, a number of integration
identities known as application identities are used. For each Oracle Fusion
Applications application, there are a pair of application identities, for example,
FUSION_APPS_HCM SES_CRAWL_APPID and FUSION_APPS_HCM ECSF_SEARCH_APPID. The
CRAWL application identities are used by Oracle SES to interact with ECSF for crawling
and security requests, while the SEARCH application identities are used by Oracle SES
to query Oracle SES as proxy users.

FUSION_APPS_ECSF_SES_ADMIN_APPID is the application identity used by ECSF to
integrate with Oracle SES for administration tasks, such as deployment, scheduling,
and so on.

Application identities are provisioned as users in the Oracle Fusion Applications
identity store. They often have high level privileges, and their credentials are
generated and stored in the credential store. These users are used mainly for machine
to machine (application to application) integration.

The Lightweight Directory Access Protocol (LDAP) credential store stores the
passwords for the identities that Oracle Fusion Applications and ECSF uses to retrieve
passwords for Oracle SES integration.

View the LDAP credential store to make sure the application identities exist.

7.3 Getting Started with Managing ECSF with Fusion Applications
Control

Fusion Applications Control is an administration user interface that can be used for
configuring and administering the ECSF runtime server, managing the searchable
object lifecycle, and synchronizing with Oracle SES.

ECSF also provides support for a command line administration option. The ECSF
Command Line Administration Utility offers a command line interface, and has no
external dependencies on Oracle Enterprise Manager. The utility is available in the
ECSF Library (ecsf.jar) and can be started as a Java program. For more information,
see the "ECSF Command Line Administration Utility" appendix in the Oracle Fusion
Applications Developer’s Guide.

Both Fusion Applications Control and the ECSF Command Line Administration
Utility require connection to the Oracle Fusion Applications database.

Note: While both Fusion Applications Control and the ECSF
Command Line Administration Utility can be used concurrently, it is
recommended that ECSF be administered using one or the other to
facilitate data control.

Key points of administration include:

s ECSF Configuration: ECSF currently supports only the Oracle SES search engine
and its different versions. The Oracle SES search engine with its versions are
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stored in the ECSF_SEARCH_ENGINE_TYPE table, which resides in the FUSION schema,
and is rendered in Fusion Applications Control. Every Oracle SES search engine
instance must be configured using a set of Oracle SES parameters. Every instance
created for search must also be configured using a set of ECSF parameters. Both
sets of parameters and their values are stored in the ECSF_PARAMETER table and are
rendered in Fusion Applications Control. Parameter names are read-only, while
parameter values can be updated.

s ECSF Administration

- Search engine instances and parameters: ECSF supports more than one search
engine instance of a given search engine type (currently only Oracle SES). It
supports the declarative distribution of index over several search engine
instances. Each search engine instance belongs to exactly one version of the
Oracle SES search engine type. All the supported search engines instances are
stored in the ECSF_ENGINE_INSTANCE table and managed using Fusion
Applications Control.

— Searchable objects: Searchable object definitions are configured at design time,
and the information is stored in metadata XML files. This information is
imported into the Oracle Fusion Applications database and rendered in Fusion
Applications Control in the form of searchable objects.

— Search categories: The metadata for search categories, also called search
groups (for Oracle SES), is collected and rendered in Fusion Applications
Control.

- External search categories: Fusion Applications Control enables you to import
external search categories (registered Oracle SES data source groups that are
crawled and created directly using Oracle SES Administration UI) to be used
directly for querying.

— Index schedule: The index schedule is created in Fusion Applications Control.
A corresponding Oracle SES index schedule is then created.

Security administration for ECSF is handled outside the framework and Fusion
Applications Control.

For general information about Fusion Applications Control, see Chapter 2.

7.3.1 Navigating to the ECSF Administration Pages

7-10

To navigate to the ECSF administration pages in Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder, and select the application engine instance that contains
the searchable objects you want to manage.

Bl 52 ecsfvi_DefaultDomain

3 Application Deployments

3 WebLogic Domain

B 3 Enterprise Crawl and Search Framewaork |
@ EcsfServer_approot(V2.0)
@ EcsfServer_cm(V2.0)
@ EcsfServer_hem{v2.0)

3 Metadata Repositories

3 webCenter

The Enterprise Crawl and Search Framework Configuration Settings page
displays. For information about the Configuration Settings page, see Section 7.3.2.

2. Expand the Enterprise Crawl and Search Framework target menu.

Oracle Fusion Applications Administrator's Guide



Getting Started with Managing ECSF with Fusion Applications Control

@ Enterprise Crawl and Search Framewaork

Home

Logs

Register Searchable Object
Unregister Searchable Object
System MBean Browser

Performance Summary

B Weblogic Server Administration Console
General Information
The menu displays the options described in Table 7-1.
Table 7-1 Enterprise Crawl and Search Framework Target Menu Options
Menu Option Description
Home Displays the Enterprise Crawl and Search Framework
Configuration Settings page. For more information about this
page, see Section 7.3.2.
Logs Displays the options to either view log messages or access the

Log Configuration page to configure basic and advanced log
configuration settings. For more information, see "Managing Log
Files and Diagnostic Data" chapter in Oracle Fusion Middleware
Administrator’s Guide.

The log files are stored in the following directory:

DOMAIN_HOME/sysman/log/emoms.log

Register Searchable Object

Displays the Register Searchable Object page. For information
about the Register Searchable Object task, see Task 2, "Register
the Searchable Objects".

Unregister Searchable
Object

Displays the Unregister Searchable Object page. For information
about the Unregister Searchable Object task, see Task 4,
"Unregister the Searchable Objects".

System MBean Browser

Displays the MBean browser that allows to you browse the
MBeans for the selected application.

Performance Summary

Displays performance information for the selected component or
application. For information, see Section 10.4.1.

WebLogic Server
Administration Console

Launches the Oracle WebLogic Server Administration Console
in a separate browser window.

General Information

Displays general information about the application instance.

7.3.2 Understanding the Enterprise Crawl and Search Framework Configuration

Settings Page

The Enterprise Crawl and Search Framework Configuration Settings page, shown in
Figure 7-3, displays the search engine types and their corresponding search engine
instance parameters. This page is your starting place for administering and managing

search.
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Figure 7-3 Enterprise Crawl and Search Framework Configuration Settings Page
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Name Required

SES_ADMIN_SERVICE
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SES_QUERY_PROXY_PASSWORD
SES_QUERY_SESSION_TIMEQUT
ECSF DATA SERVICE
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From the Enterprise Crawl and Search Framework Configuration Settings page, you
can navigate to the Search Application Service Component Administration page to
create and configure Search Application Service Component instances.

You can also navigate to the Search Engine Instance Administration page (by selecting
a search engine type) to define search engine instances, manage data sources and
schedules, and extend search.

7.4 Administering Search

Administer search by managing data sources and schedules and modifying data
sources.

Note: Administration of searchable objects, search categories, and
index schedules must be performed using Fusion Applications
Control. You can use the Oracle SES Administration GUI for all other
Oracle SES related administration tasks.

To access the ECSF pages in Fusion Applications Control, you must
have Operator privileges in Oracle WebLogic Server. For information,
see Task 4, "Provide Access to ECSF Pages in Fusion Applications
Control".

You can perform the following procedures to administer search using Fusion
Applications Control:

= Making Seeded Searchable Objects Available for Search
= Managing Index Schedules
» Changing the Association of Searchable Objects with Search Categories
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= Renaming Search Categories

s Deleting Search Categories

= Making External Search Categories Available for Federated Search

s Deleting External Search Categories

= Modifying the Display Name of Deployed Searchable Objects

= Undeploying Searchable Objects

s Unregistering Searchable Objects from the Oracle Fusion Applications Database
= Modifying Search Application Service Component Instance Parameters

In order to avoid disrupting running schedules, it is highly recommended that you
administer search when the index schedules are not running.

7.41 Making Seeded Searchable Objects Available for Search

The Oracle Fusion Customer Relationship Management, Oracle Fusion Human Capital
Management, and Oracle Fusion Supply Chain Management product families each has
its own set of seeded searchable objects that are packaged into its corresponding
search application. For example, the seeded searchable objects for Oracle Fusion
Customer Relationship Management are packaged in the Oracle Fusion Customer
Relationship Management search application. For more information, see Appendix C.

Note: While Oracle Fusion Financials searchable objects, search
categories, and index schedules are seeded, they are not available for
search. Do not use Oracle Fusion Financials searchable objects, search
categories, and index schedules to enable search.

To manage the searchable objects for a particular product family, you must select the
search application corresponding to that product family.

To make seeded searchable objects available for search, follow the procedures in the
following tasks:

s Task 1, "Deploy the Searchable Objects to the Oracle Secure Enterprise Search
(Oracle SES) Instance"

»  Task 2, "Activate the Searchable Objects"

»  Task 3, "Deploy the Search Categories"

s Task 4, "Deploy the Index Schedules"

s Task 5, "Start the Index Schedules"

»  Task 6, "Enable the Oracle Fusion Applications Search UI"

» Task 7, "Validate That Searchable Objects Are Available for Search”

Task 1 Deploy the Searchable Objects to the Oracle Secure Enterprise Search
(Oracle SES) Instance

Deploying searchable objects to the Oracle Secure Enterprise Search (Oracle SES)
instance makes the objects available for the search engine instance to crawl. The
searchable objects deployed to Oracle SES must have a unique and fully qualified
name, for example, oracle.apps.crm.Opportunity or oracle.apps.hcm.Opportunity.
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To deploy searchable objects to the Oracle SES instance using Fusion Applications
Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, shown in
Figure 7-4.

Figure 7-4 Search Engine Instance Administration Page

Administration: Search Engine Instance

Define search engine instances for the selected search engine type. You can create, modify, and delete engine instances, and configure e
search categories,

Search Engine Type: Oracle SES

Actions »  View w H 38 Siregister [@)Refresh  EfiDetach

Mame Comments
[ ) N
CRM Search Engine Instance Instance for CRM Searchable Objects
FSCM Search Engine Instance Instance for FSCM Searchable Objects
HCM Search Engine Instance Instance for HCM Searchable Objects
Help Instance Instance for Help Portal Objects

Parameters | Searchable Objects | Search Categories | External Search Categories | Index Schedules

Actions = View = b4 etach &% Deploy Parameters

MName Required Value

SES_ADMIM_SERVICE hittp: fhostserver: 527 0izear chiapifadmin/AdminService
SES_ADMIM_USERMAME searchsys

SES_ADMIN_PASSWORD sennas

SES_ADMIN_SESSION_TIMEQUT &0

SES_QUERY_SERVICE
SES_QUERY_PROXY_LISERNAME
SES_QUERY_PROXY_PASSWORD

http: hostserver: 527 Dizearchiguery JOracle Search
scott
*RRERN

SES_QUERY_SESSION_TIMEQUT &0

18489988444

mns Hidden 4

4. From the table of search engine instances, select the record of the search engine
instance that contains the searchable object you want to deploy, and then select the
Searchable Objects tab, shown in Figure 7-5, to view the table of searchable
objects for the selected search engine instance.
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Figure 7-5 Searchable Objects Tab
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5. Click the Deploy icon. Alternatively, select Deploy from the Actions menu or use
the Ctrl+Shift+P keyboard shortcut.

A green check mark appears in the Deployed column of the selected searchable
object to indicate that the source has been created in Oracle SES.

Note: When a searchable object is registered to ECSF, by default it is
inactive and not deployed. You can deploy the searchable object to the
search engine instance regardless of whether the searchable object is
active or inactive. Once deployed successfully, the searchable object is
flagged as deployed and inactive until you activate it. Once a
searchable object is deployed, the search engine instance can crawl the
searchable object. However, a query of that object will return no
results until the object is activated.

Task 2 Activate the Searchable Objects

A query of deployed and crawled searchable objects will return results only if the
objects are activated.

To activate searchable objects using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance that contains the searchable object you want to activate, and then select
the Searchable Objects tab, shown in to view the table of searchable objects for the
selected search engine instance.

5. Select the desired searchable object from the table, and click the Activate icon.
Alternatively, select Activate from the Actions menu or use the Ctrl+Shift+T
keyboard shortcut.

A green check mark appears in the Active column of the selected searchable object
to indicate that the searchable object is available for search.
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Note: A query of this object will return results only if the object has
been deployed to a search engine instance and has been crawled.

Task 3 Deploy the Search Categories

Deploying search categories pushes them to the Oracle SES instance. Only search
categories with associated searchable objects that are activated can be deployed. Only
deployed search categories appear in the Search Categories dropdown list in the
Oracle Fusion Applications Search UL

To deploy search categories using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance to which you want to deploy a search category, and then select the Search
Categories tab to view the table of search categories for the selected search engine
instance.

Select the record of the search category you want to deploy.

Set the scope of the search category to GLOBAL to display the search category on the
Oracle Fusion Applications Search UL

Click the Deploy icon. Alternatively, select Deploy from the Actions menu or use
the Ctrl+Shift+P keyboard shortcut.

A green check mark appears in the Deployed column of the selected search
category to indicate that the source group has been created in Oracle SES.

Note: You cannot deploy a search category that contains a searchable
object that is not activated. All searchable objects in the search
category must be activated. For more information, see Task 2,
"Activate the Searchable Objects".

The Oracle Fusion Applications Search Ul reflects this change after the
ECSF cache expires and the user logs out and logs back in. The default
is 30 minutes after the change is added to the cache.

Task 4 Deploy the Index Schedules

Deploying index schedules pushes them to the Oracle SES instance. Only index
schedules with associated searchable objects can be deployed.

Caution: Deploying index schedules to Oracle SES automatically sets
the value for recrawlPolicy to Process Documents That Have
Changed in Oracle SES. Do not change the value of recrawlPolicy.
ECSF supports only incremental crawling.

To deploy index schedules using Fusion Applications Control:
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1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine

instance for which you want to deploy an index schedule, and then select the
Index Schedules tab, shown in Figure 7-6, to view the table of index schedules for
the selected search engine instance.

Figure 7-6 Index Schedules Tab
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Select the desired index schedule from the table, and click the Deploy Index
Schedule icon. Alternatively, select Deploy from the Actions menu or use the
Ctrl+Shift+P keyboard shortcut.

A green check mark appears in the Deployed column of the selected index
schedule, and the Status column indicates Scheduled. This indicates that the
schedule has been created in Oracle SES.

Task 5 Start the Index Schedules

Starting an index schedule initiates the crawling and indexing of data. You cannot start
an index schedule that has not been deployed. You must first deploy the index

schedule to add it to the search engine instance. For more information, see Task 4,
"Deploy the Index Schedules".

To start index schedules using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance for which you want to start an index schedule, and then select the Index
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Schedules tab to view the table of index schedules for the selected search engine
instance.

5. Select the desired index schedule from the table, and click the Start Index
Schedule icon. Alternatively, select Start from the Actions menu or use the
Ctrl+Shift+W keyboard shortcut.

The Status column of the selected index schedule indicates that the schedule is
Launching. The date and time appear in the Start Time column when you start the
index schedule.

You must manually refresh the page to view the status updates.

Task 6 Enable the Oracle Fusion Applications Search Ul

After you have configured search and started the crawl, enable the Oracle Fusion
Applications Search Ul by setting the value of the FUSION_APPS_SEARCH_ENABLED
profile option to Y. This setting makes the search controls visible in the user interface.
The default value is N, which disables the search controls in the user interface.

To set the FUSION_APPS_SEARCH_ENABLED profile option to Y:

1. Sign in to Oracle Fusion Applications with a user account that is provisioned with
the Manage All Application Profile Values role. Contact your security
administrator for details.

2. From the Administration menu in the work area of Oracle Fusion Applications,
choose Setup and Maintenance.

3. From the Setup and Maintenance Overview page, search for profile tasks.
The Manage Administrator Profile Values page displays.

4, Edit profile option values.

5. Query the profile option using the code FUSION_APPS_SEARCH_ENABLED.

6. Set the value to Yes at the site level. This profile option is defined at the site level
only.

For information about configuring profile options, see Section 13.7.5.

Task 7 Validate That Searchable Objects Are Available for Search
Make sure that you can see valid search results by running a query on a selected
search category.

To validate that searchable objects are available for search using Fusion Applications
Control:

1. Make sure that the index schedule you started has completed crawling and
indexing the content for search, which is indicated by Scheduled in the Status
column for the index schedule.

2. Login to your application and expand the Categories field in the global area. You
should see all the search categories you deployed.

3. Select one search category, enter * (wildcard) in the Search Term field, and click
the Play button to initiate the search.

Search results should appear, confirming the readiness for search.

7.4.2 Managing Index Schedules
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Creating the Index Schedules

Associating the Searchable Objects with Index Schedules
Deploying the Index Schedules

Starting the Index Schedules

Stopping Index Schedules

Disassociating Searchable Objects from Index Schedules
Starting Full Indexing

Undeploying Index Schedules

Deleting Index Schedules

Note: Repetitive deployment of index schedules is not supported.

7.4.2.1 Creating the Index Schedules

You can either create new index schedules for the new searchable objects or add the
new searchable objects to existing index schedules. Creating an index schedule adds a
new record to the ECSF_INDEX_SCHEDULE table in the Oracle Fusion Applications
database.

To create index schedules using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance for which you want to create an index schedule, and then select the Index
Schedules tab, shown in Figure 7-6, to view the table of index schedules for the
selected search engine instance.

Click the New Index Schedule icon. Alternatively, select New Record from the
Actions menu or use the Ctrl+Shift+N keyboard shortcut.

A new record is added to the top of the table of index schedules.
Enter a value for the Name column.

From the Frequency Type dropdown list, select the desired value for how often
you want the index schedule to run.

Complete the Time Between Launches, Schedule Launch Days, and Schedule
Launch Time columns that become enabled based on your selection in the
Frequency Type column. Table 7-2 lists the valid values for the required columns
based on the frequency type.

Table 7-2 Index Schedule Frequency Values

Frequency Type | Launches Schedule Launch Day | Schedule Launch Time

Time Between

Manual --- - -
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Table 7-2 (Cont.) Index Schedule Frequency Values

Time Between
Frequency Type | Launches Schedule Launch Day | Schedule Launch Time
Hourly 1to 23 -— -—
Daily 1to 99 - 1:00 AMto 12:00 AM
Weekly l1to12 Monday to Sunday 1:00 AMto 12:00 AM
Monthly lto12 1to31 1:00 AMto 12:00 AM
9. Click the Save Index Schedule icon to save the selected record. Alternatively,

select Save Record from the Actions menu or use the Ctrl+Shift+S keyboard
shortcut.

Caution: A save will occur only for the selected record. You can only
save one record at a time.

Note: To proceed with other operations, you must first select any
record. Creating or deleting ECSF objects removes the focus from the
window.

7.4.2.2 Associating the Searchable Objects with Index Schedules

Associating searchable objects with an index schedule adds the objects to that index
schedule. You can only associate each searchable object with one index schedule. Only
a searchable object that is not already associated with an index schedule can be added
to an index schedule. If the searchable object is already associated with an index
schedule, you must disassociate it from that index schedule before you can associate it
with another index schedule. For information, see Section 7.4.2.6.

You can only associate searchable objects with index schedules that are not already
deployed. If the index schedule has already been deployed, you must undeploy it
before you can associate searchable objects with it. For information, see Section 7.4.2.8.

To associate searchable objects with index schedules using Fusion Applications
Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the desired search
engine instance, and then select the Index Schedules tab, shown in Figure 7-6, to
view the table of index schedules for the selected search engine instance.

Select the desired index schedule to which you want to add searchable objects, and
click the Bind icon.

The Bind icon is disabled if the index schedule is deployed. You cannot associate
or disassociate searchable objects if the index schedule is deployed.
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6. In the Bound Searchable Objects to the Selected Index Schedule dialog, shown in
Figure 7-7, select the checkboxes of the desired searchable objects from the
Available Objects list, and click the Move icon to add them to the Selected
Objects list.

Figure 7-7 Bound Searchable Objects to the Selected Index Schedule Dialog
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7. Click OK.

The IS_ID column in the ECSF_SEARCH_INDEX OBJECT table is populated with the
Index Schedule ID.

Note: A searchable object can be assigned to only one index
schedule. If a searchable object has been assigned to an index
schedule, it will not be listed in the table of available searchable
objects.

7.4.2.3 Deploying the Index Schedules

Deploying index schedules pushes them to the Oracle SES instance. For information,
see Task 4, "Deploy the Index Schedules".

7.4.2.4 Starting the Index Schedules

Starting an index schedule initiates the crawling and indexing of data. For
information, see Task 5, "Start the Index Schedules".

7.4.2.5 Stopping Index Schedules

Stopping an index schedule that has been started aborts the index process.
To stop index schedules using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance for which you want to stop an index schedule, and then select the Index
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Schedules tab, shown in Figure 7-6, to view the table of index schedules for the
selected search engine instance.

5. Select the desired index schedule from the table, and click the Stop Index
Schedule icon. Alternatively, select Stop from the Actions menu or use the
Ctrl+Shift+O keyboard shortcut.

The Status column of the selected index schedule indicates that the schedule has
Failed, or that the index process was aborted. The date and time appear in the
Stop Time column when you stop the index schedule.

7.4.2.6 Disassociating Searchable Objects from Index Schedules

Disassociating a searchable object from an index schedule removes it from that index
schedule and makes it available to be added to another index schedule. You can only
disassociate a searchable object from an index schedule with which it is associated.
You can only disassociate a searchable object from an index schedule that is not
deployed. If the index schedule has been deployed, you must undeploy it before you
can disassociate a searchable object from it. For information, see Section 7.4.2.8.

To disassociating searchable objects from index schedules using Fusion Applications
Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the desired search
engine instance, and then select the Index Schedules tab, shown in Figure 7-6, to
view the table of index schedules for the selected search engine instance.

5. Select the desired index schedule from which you want to remove searchable
objects, and click the Bind icon.

The Bind icon is disabled if the index schedule is deployed. You cannot associate
or disassociate searchable objects if the index schedule is deployed.

6. In the Bound Searchable Objects to the Selected Index Schedule dialog, shown in
Figure 7-7, select the checkboxes of the desired searchable objects from the
Selected Obijects list, and click the Remove icon to remove them from the
Selected Objects list and make them available for adding to an index schedule.

7. Click OK.

7.4.2.7 Starting Full Indexing

Full indexing is the process by which the search engine creates indexes from all
crawled and indexable documents for a particular data source. In contrast, incremental
indexing builds indexes on top of existing indexes.

To start full indexing using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.
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Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the desired search engine instance
record, and then select the Index Schedules tab, shown in Figure 7-6, to view the
table of index schedules for the selected search engine instance.

From the table of index schedules, select the desired schedule for which you want
to build a full index.

Click the Start Full Indexing icon. Alternatively, select Full Index from the
Actions menu or use the Ctrl+Shift+L keyboard shortcut.

A confirmation dialog appears. Click OK.

The Status column indicates that the full indexing is Launching. Indexing will
occur only on the active and deployed searchable objects.

7.4.2.8 Undeploying Index Schedules

Undeploying an index schedule removes it from the Oracle SES instance. Only
deployed index schedules can be undeployed.

To undeploy index schedules using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance for which you want to undeploy an index schedule, and then select the
Index Schedules tab, shown in Figure 7-6, to view the table of index schedules for
the selected search engine instance.

Select the desired index schedule from the table, and click the Undeploy Index
Schedule icon. Alternatively, select Undeploy from the Actions menu or use the
Ctrl+Shift+U keyboard shortcut.

The green check mark disappears from the Deployed column of the selected index
schedule, and Scheduled disappears from the Status column. This indicates that
the schedule has been deleted from Oracle SES.

7.4.2.9 Deleting Index Schedules

Deleting an index schedule disassociates it from the search engine instance and
removes its corresponding record from the ECSF_INDEX_SCHEDULE table in the Oracle
Fusion Applications database. Only undeployed index schedules can be deleted.

To delete index schedules using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.
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Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance from which you want to delete an index schedule, and then select the
Index Schedules tab, shown in Figure 7-6, to view the table of index schedules for
the selected search engine instance.

Select the record of the index schedule you want to delete.

Click the Delete Index Schedule icon. Alternatively, select Delete Record from the
Actions menu or use the Ctrl+Shift+D keyboard shortcut.

The selected record is removed from the table of index schedules.

Note: To proceed with other operations, you must first select any
record. Creating or deleting ECSF objects removes the focus from the
window.

7.4.3 Changing the Association of Searchable Objects with Search Categories

Changing the association of searchable objects with a search category disassociates the
searchable objects from the search category and or associates additional searchable
objects with the search category.

To change the association of searchable objects with search categories, follow the
procedures in the following tasks:

Task 1, "Undeploy the Search Categories"

Task 2, "Disassociate the Searchable Objects from Search Categories"
Task 3, "Associate Searchable Objects with the Search Categories"
Task 4, "Deploy the Search Categories"

Task 1 Undeploy the Search Categories

Undeploying a search category removes it from the Oracle SES instance. Only
deployed search categories can be undeployed.

To undeploy search categories using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance in which you want to undeploy a search category, and then select the
Search Categories tab, shown in Figure 7-15, to view the table of search categories
for the selected search engine instance.

Select the record of the search category you want to undeploy.
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6. Click the Undeploy icon. Alternatively, select Undeploy from the Actions menu or
use the Ctrl+Shift+U keyboard shortcut.

The green check mark disappears from the Deployed column of the selected
search category to indicate that the source group has been removed from Oracle
SES.

Note: The Oracle Fusion Applications Search Ul reflects this change
after the ECSF cache expires and the user logs out and logs back in.
The default is 30 minutes after the change is added to the cache.

Task 2 Disassociate the Searchable Objects from Search Categories

Disassociating a searchable object from a search category removes it from that search
category. The searchable object is still available for association to other search
categories.

To disassociate searchable objects from search categories using Fusion Applications
Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the desired search
engine instance, and then select the Search Categories tab, shown in Figure 7-15,
to view the table of search categories for the selected search engine instance.

5. Select the desired search category from which you want to remove searchable
objects, and click the Bind icon.

The Bind icon is disabled if the search category is deployed. You cannot associate
or disassociate searchable objects if the search category is deployed.

6. In the Bound Searchable Objects to the Selected Search Category dialog, shown in
Figure 7-16, select the checkboxes of the desired searchable objects from the
Selected Objects list, and click the Remove icon to remove them from the
Selected Objects list.

7. Click OK.

Task 3 Associate Searchable Objects with the Search Categories

Associate searchable objects with a search category to add the objects to that search
category. For information, see Task 8, "Associate the Searchable Objects with Search
Categories".

Task 4 Deploy the Search Categories

Deploy the search categories to push them to the Oracle SES instance. For information,
see Task 3, "Deploy the Search Categories".

7.4.4 Renaming Search Categories

Renaming a search category changes the name of the search category.
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To change the name of a search category using Fusion Applications Control:

1. If the search category is deployed, you must undeploy it. For information, see Task
1, "Undeploy the Search Categories".

2. Inthe Name column of the Search Categories tab, edit the value corresponding to
to the record of the search category you want to modify.

3. Click the Save Search Category icon. Alternatively, select Save Record from the
Actions menu or use the Ctrl+Shift+S keyboard shortcut.

4, If the search category was deployed prior to renaming it, redeploy it. For
information, see Task 4, "Deploy the Search Categories".

7.4.5 Deleting Search Categories

Deleting a search category disassociates it from the search engine instance and
removes its corresponding record from the ECSF_SEARCH_INDEX_GROUP table in the
Oracle Fusion Applications database.

To delete search categories using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance from which you want to delete a search category, and then select the
Search Categories tab, shown in Figure 7-15, to view the table of search categories
for the selected search engine instance.

5. Select the record of the search category you want to delete.

6. Click the Delete Search Category icon. Alternatively, select Delete Record from
the Actions menu or use the Ctrl+Shift+D keyboard shortcut.

The selected record is removed from the table of search categories.

Note: To proceed with other operations, you must first select any
record. Creating or deleting ECSF objects removes the focus from the
window.

7.4.6 Making External Search Categories Available for Federated Search

External search categories are the registered Oracle SES data source groups that
contain external data sources (that is, data sources created using Oracle SES
administration). External data sources are not registered in the ECSF_SEARCH_INDEX_
OBJECT table. They include data sources such as Intranet, mail, database, and federated
data sources (that is, data sources from another search engine instance). Oracle SES
data source groups can also contain federated ECSF data sources. For more
information, see Section 7.5.4.

External search categories are directly used for querying. Executing the import
operation pulls all the external search categories into the Oracle Fusion Applications
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database. All external search categories in the Oracle Fusion Applications database are
available during ECSF query time through the ECSF query APL.

Note: Since external search categories are not managed by ECSF, you
must use Oracle SES to modify the external search categories.

To make external search categories available for federated search, follow the
procedures in the following tasks:

s Task 1, "Import the External Search Categories"
n  Task 2, "Set the Application ID Value"
s Task 3, "Associate the Application ID with an Active Search Application"

Task 1 Import the External Search Categories

Importing external search categories adds new records to the ECSF_SEARCH_INDEX
GROUP table in the Oracle Fusion Applications database. The import also automatically
sets the IS_EXTERNAL flag to TRUE to indicate that the search category is an external
search category.

To import external search categories using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance that points to an Oracle SES instance, and then select the External Search
Categories tab, shown in Figure 7-8, to view the table of external search categories
for the selected search engine instance.

Figure 7-8 External Search Categories Tab

Parameters | Searchable Objects | Search Categories | External Search Categories | Index Schedules

l; Import
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5. Click the Import button.

The Import External Categories dialog, shown in Figure 7-9, appears.
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Figure 7-9 Import External Categories Dialog
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In the Available Categories column, select the checkbox of the external search
categories you want to import and click the Move icon to shuttle your selection to
the Selected Categories column.

Click OK to import the selected external search categories.

Note: All existing external search categories in the Oracle Fusion
Applications database are replaced by the latest import from Oracle
SES.

Clicking OK without selecting any external search categories also
deletes all the existing external search categories in the Oracle Fusion
Applications.

The selected search categories from the selected Oracle SES instance display in the
table of external search categories. Fusion Applications Control currently only
displays the name of each external search category that is imported.

Clicking Cancel cancels the import operation, preserves any existing external
search categories in the Oracle Fusion Applications database, and returns you to
the External Search Categories page.

Task 2 Set the Application ID Value

Setting the Application ID value allows the external search categories to be queried
using the GLOBAL scope, which is the default scope for Oracle Fusion Applications.

To set the Application ID value using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance that points to an Oracle SES instance, and then select the External Search
Categories tab, shown in Figure 7-8, to view the table of external search categories
for the selected search engine instance.
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5. From the table of external search categories, select the record of the external search
category that you want to modify.

6. In the Application ID column corresponding to the external search category you
want to modify, enter an application ID (for example, CRM) based on the desired
Service Component to which this category is to be assigned.

7. Click the Save External Search Category icon to save the selected record.
Alternatively, select Save Record from the Actions menu or use the Ctrl+Shift+S
keyboard shortcut.

Task 3 Associate the Application ID with an Active Search Application

The application ID set for the external search category must be associated with an
active search application in order for the external search category to be available for
federated search.

To associate the application ID with an active search application, update the ECSF_
QUERY_SERVICE_APP_IDS parameter value to include the application ID in the comma
separated string. For information, see Section 7.4.11.

7.4.7 Deleting External Search Categories

You can delete individual external categories once they are imported into the Oracle
Fusion Applications database. Deleting an external search category removes its
corresponding record from the ECSF_SEARCH_INDEX_GROUP table in the Oracle Fusion
Applications database, and will make it unavailable for querying.

To delete external search categories using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance from which you want to delete an external search category from the
Oracle Fusion Applications database, and then select the External Search
Categories tab, shown in Figure 7-8, to view the table of external search categories
for the selected search engine instance.

5. Select the record of the external search category you want to delete.

6. Click the Delete Search Category icon. Alternatively, select Delete Record from
the Actions menu or use the Ctrl+Shift+D keyboard shortcut.

The selected record is removed from the table of external search categories.

Note: This deletion removes the external search category from the
Oracle Fusion Applications database. It does not undeploy the search
group from Oracle Secure Enterprise Search (Oracle SES).

7.4.8 Modifying the Display Name of Deployed Searchable Objects

You can change a deployed searchable object's display name and application ID
without first having to deactivate and undeploy the searchable object.
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Caution: Do not modify the Oracle Fusion Applications Help
searchable object named TopicSearchPVo.

To change the display name and application ID using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance that contains the searchable object you want to modify, and then select the
Searchable Objects tab, shown in Figure 7-5, to view the table of searchable
objects for the selected search engine instance.

5. In the Display Name column, edit the value corresponding to the searchable
object you want to modify.

6. In the Application ID column, edit the value corresponding to the searchable
object you want to modify.

7. Click the Save Searchable Object icon to save the selected record. Alternatively,
select Save Record from the Actions menu or use the Ctrl+Shift+S keyboard
shortcut.

7.4.9 Undeploying Searchable Objects

Undeploying searchable objects from the Oracle SES instance makes the objects
unavailable for the search engine instance to crawl. While undeployed, the searchable
object is still associated with the search engine instance record and can be redeployed
to the physical engine. When a searchable object is undeployed, any association to a
search category or index schedule is removed.

To undeploy searchable objects from the Oracle SES instance, follow the procedures in
the following tasks:

»  Task 1, "Deactivate the Searchable Object"
s Task 2, "Undeploy the Searchable Object from the Oracle SES Instance"

Task 1 Deactivate the Searchable Object
Deactivated searchable objects are still available for the search engine instance to
crawl, but a query of the deactivated searchable objects will return no results.

To deactivate searchable objects on search engine instances using Fusion Applications
Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.
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Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance that contains the searchable object you want to deactivate, and then select
the Searchable Objects tab, shown in Figure 7-5, to view the table of searchable
objects for the selected search engine instance.

Select the desired searchable object from the table, and click the Deactivate icon.
Alternatively, select Deactivate from the Actions menu or use the Ctrl+Shift+I
keyboard shortcut.

The green check mark disappears from the Active column of the selected
searchable object to indicate that the searchable object is not available for search.

Note: When the searchable object is inactive, a query of that object
will return no results until the object is activated.

Task 2 Undeploy the Searchable Object from the Oracle SES Instance

Undeploy searchable objects from the Oracle SES instance to make the objects
unavailable for the search engine instance to crawl. While undeployed, the searchable
object is still associated with the search engine instance record and can be redeployed
to the physical engine. You can undeploy only searchable objects that are inactive.

Note: When a searchable object is undeployed, any association to a
search category or index schedule is removed.

To undeploy searchable objects from the Oracle SES instance using Fusion
Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

From the table of search engine instances, select the record of the search engine
instance that contains the searchable object you want to undeploy, and then select
the Searchable Objects tab, shown in Figure 7-5, to view the table of searchable
objects for the selected search engine instance.

Select the desired searchable object from the table, and click the Undeploy icon.
Alternatively, select Undeploy from the Actions menu or use the Ctrl+Shift+U
keyboard shortcut.

The green check mark disappears from the Deployed column of the selected
searchable object to indicate that the source has been deleted from Oracle SES.

7.4.10 Unregistering Searchable Objects from the Oracle Fusion Applications Database

Unregistering searchable objects removes the searchable object records from the Oracle
Fusion Applications database. Using Fusion Applications Control, you can remove
records of searchable objects from the Oracle Fusion Applications database.
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Only those searchable objects that are inactive, undeployed, and not associated with
any engine instance can be unregistered.

To remove searchable object records from the Oracle Fusion Applications database,
follow the procedures in the following tasks:

n  Task 1, "Deactivate the Searchable Objects"
s Task 2, "Undeploy the Searchable Objects from the Oracle SES Instance"
s Task 3, "Disassociate the Searchable Objects from Search Engine Instances"

s Task 4, "Unregister the Searchable Objects"

Task 1 Deactivate the Searchable Objects

Deactivate the searchable object you want to remove from the Oracle Fusion
Applications database. For information, see Task 1, "Deactivate the Searchable
Objects".

Task 2 Undeploy the Searchable Objects from the Oracle SES Instance

Undeploy the searchable object you want to remove from the Oracle Fusion
Applications database. For information, see Task 2, "Undeploy the Searchable Object
from the Oracle SES Instance".

Task 3 Disassociate the Searchable Objects from Search Engine Instances

Disassociating a searchable object from the search engine instance removes that object
from the specified instance and makes it available for association to another search
engine instance.

To delete searchable objects from search engine instances using Fusion Applications
Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance to which you want to add a searchable object, and then select the
Searchable Objects tab, shown in Figure 7-5, to view the table of searchable
objects for the selected search engine instance.

5. Select the desired searchable object from the table, and click the Delete Searchable
Object icon. Alternatively, select Delete Record from the Actions menu or use the
Ctrl+Shift+D keyboard shortcut.

The selected searchable object is removed from the table for the selected search
engine instance, but it is not deleted from the Oracle Fusion Applications
database. It can be assigned to another search engine instance. Once assigned, you
can deploy and activate the searchable object.

Note: To proceed with other operations, you must first select any
record. Creating or deleting ECSF objects removes the focus from the
window.
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Task 4 Unregister the Searchable Objects

Unregistering a searchable object removes its record from the Oracle Fusion
Applications database.

To unregister the searchable object using Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage containing searchable objects to open the Enterprise Crawl and
Search Framework Configuration Settings page.

From the Enterprise Crawl and Search Framework target menu, select Unregister
Searchable Object.

On the Unregister Searchable Objects page, shown in Figure 7-10, select the
searchable object you want to unregister.

Figure 7-10 Unregister Searchable Objects Page
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Click the Unregister icon.

A dialog with a confirmation message appears.

7.411 Modifying Search Application Service Component Instance Parameters

You can modify the Search Application Service Component instance parameters to edit
the query web service reference name and activate or deactivate the search application.

To modify Search Application Service Component instance parameters using Fusion
Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Search Application Service Component link.

On the Search Application Service Component administration page, shown in
Figure 7-11, select the desired Search Application Service Component instance
record.
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Figure 7-11 Search Application Service Component Administration Page
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5. On the Parameters tab, modify the value for the desired parameter of the Search
Application Service Component instance.

6. Save.

7.5 Performing Advanced Administration Tasks
You can extend search by performing any of the following tasks:
= Modifying the Title, Body, Keyword, and Action Title of Searchable Objects
= Making New Searchable Objects Available for Search
s Defining Search Engine Instances
s Enabling Search on External Data Sources

» Adding Product Families for Federated Search

Note: Administration of searchable objects, search categories, and
index schedules must be performed using Fusion Applications
Control. You can use the Oracle SES Administration GUI for all other
Oracle SES related administration tasks. Oracle Enterprise Crawl and
Search Framework only exposes the Oracle SES functionality for
deploying and undeploying index schedules.

To access the ECSF pages in Fusion Applications Control, you must
have Operator privileges in Oracle WebLogic Server. For information,
see Task 4, "Provide Access to ECSF Pages in Fusion Applications
Control".

7.5.1 Modifying the Title, Body, Keyword, and Action Title of Searchable Objects

You can customize searchable objects by changing the title, body, keywords, and
search result action title using Fusion Applications Control.
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Caution: Do not modify the Oracle Fusion Applications Help
searchable object named TopicSearchPVo.

To change the title, body, keywords, and action title of searchable objects, follow the
procedures in the following tasks:

s Task 1, "Deactivate the Searchable Object"

»  Task 2, "Undeploy the Searchable Object"

» Task 3, "Edit the Title, Body, Keywords, and Action Title"
s Task 4, "Enable the Customization"

s Task 5, "Deploy the Searchable Object"

»  Task 6, "Activate the Searchable Object"

» Task 7, "Validate the Changes"

Task 1 Deactivate the Searchable Object

If the searchable object that you want to customize is active, deactivate it. For
information, see Task 1, "Deactivate the Searchable Object".

Task 2 Undeploy the Searchable Object

If the searchable object that you want to customize is deployed, undeploy it. For
information, see Task 2, "Undeploy the Searchable Object from the Oracle SES
Instance”.

Task 3 Edit the Title, Body, Keywords, and Action Title

Edit the title, body, keywords, and search result action title to customize the searchable
objects.

To edit the title, body, keywords, and action title of a searchable object using Fusion
Applications Control:

1. From the Actions menu on the Searchable Objects tab, select Modify.
Alternatively, use the Ctrl+Shift+Z keyboard shortcut.

2. In the Customize Searchable Objects dialog, shown in Figure 7-12, edit the Groovy
expression in the field for the property you want to modify.
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Figure 7-12 Customize Searchable Objects Dialog
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The Available Attributes table displays the attributes of the parent view object.

Note: You can use only stored attributes (for example, SRNumber) in
the default action title. Using unstored attributes in the default action

title results in an error during validation.

3. Click the Validate button to validate the Groovy expression.

4. Click the Save button to save your input to the database.

Task 4 Enable the Customization

Enable the customization by selecting Enable Customization from the Actions menu,

or using the Ctrl+Shift+O keyboard shortcut.
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This validates all the modified expressions for title, body, keywords, and action title
and sets the customization flag. A green check mark appears in the Customized
column to indicate that the searchable object is customized.

You can remove the customization flag by selecting Disable Customization from the
Actions menu, or using the Ctrl+Shift+Q keyboard shortcut.

Task 5 Deploy the Searchable Object

Deploy the searchable object to the Oracle SES instance to make it crawlable. For
information, see Task 1, "Deploy the Searchable Objects to the Oracle Secure Enterprise
Search (Oracle SES) Instance".

Task 6 Activate the Searchable Object

Activate the searchable object so that a query of that object will return results. For
information, see Task 2, "Activate the Searchable Objects".

Task 7 Validate the Changes
Validate that the Oracle Fusion Applications Search Ul reflects the changes you made.

To validate your changes to the searchable objects title, body, keywords, and action
title:

1. Log in to the search application.

2. Select the single category that contains the object.
3. Perform a query using the * wild card.
4

Check the search results for your changes to the title, body, keywords, and action
title.

7.5.2 Making New Searchable Objects Available for Search

New searchable objects are objects in addition to the set of transactional objects that
are available out of the box.
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To make new searchable objects available for search, follow the procedures in the
following tasks:

s Task 1, "Obtain the Necessary Information”

s Task 2, "Register the Searchable Objects"

s Task 3, "Associate the Searchable Objects with Search Engine Instances"
s Task 4, "Deploy the Searchable Objects to the Oracle SES Instance"
n  Task 5, "Activate the Searchable Objects"

»  Task 6, "Create the Search Categories"

s Task 7, "Undeploy the Search Categories"

s Task 8, "Associate the Searchable Objects with Search Categories"
s Task 9, "Deploy the Search Categories"

s Task 10, "Create the Index Schedules"

s Task 11, "Undeploy the Index Schedules"

s Task 12, "Associate the Searchable Objects with Index Schedules"
s Task 13, "Deploy the Index Schedules"

s Task 14, "Start the Index Schedules"

Task 1 Obtain the Necessary Information

In order to more efficiently make new searchable objects available for search, you
should collect information from the Oracle Fusion Applications developer who creates
the searchable objects, as well as from the business unit to which the new objects
belong.

Obtain the following information before you begin the process of making new
searchable objects available for search:

»  Fully qualified object name of the searchable object (for example,
oracle.ecsf.demo.model .UX_CustomerVo)

= Display name of the searchable object (for example, Customer)

= Name of the search category (existing or new) to which the searchable object must
be associated (for example, Customers)

= Name of the index schedule (existing or new) to which the searchable object must
be associated (for example, CRM_Customers)

= Name of the search engine instance with which the searchable object must be
associated (for example, CRMSES1)

= Name of the search engine type to which the search engine instance belongs (for
example, SES11.2.1)

Task 2 Register the Searchable Objects

Registering searchable objects creates searchable object records in the Oracle Fusion
Applications database.

To create searchable object records in the Oracle Fusion Applications database using
Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.
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Select the application engine instance that contains the searchable objects you
want to manage containing searchable objects to open the Enterprise Crawl and
Search Framework Configuration Settings page.

From the Enterprise Crawl and Search Framework target menu, select Register
Searchable Object.

On the Register Searchable Object page, shown in Figure 7-13, enter a display
name for the searchable object in the Display Name field.

Figure 7-13 Register Searchable Object Page

¢ /Farm_CRMDomain/CRMDomain/SearchServer_1/EarCrmSea... ® Logged in &

@ Enterprise Crawl and Search Framework

Register Searchable Object:

Register Cancel

Register searchable objects in the ECSF database by providing a searchable object name and a fully qualified view object as specified in your application.

* Display Mame

* Searchable Object Mame

5.

6.

In the Searchable Object Name field, enter the fully qualified searchable object
name that is defined in your application.

Click the Register button.

Task 3 Associate the Searchable Objects with Search Engine Instances

Associating a searchable object with a search engine instance adds that object to the
specified instance. Only an unassigned object, which is a searchable object that is not
associated with a search engine instance, can be added to a search engine instance, so a
searchable object can only be associated with one search engine instance at a time.

To associate searchable objects with search engine instances using Fusion Applications

Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the search engine
instance to which you want to add a searchable object, and then select the
Searchable Objects tab, shown in Figure 7-5, to view the table of searchable
objects for the selected search engine instance.

5. Click the Add button to open the Add a Searchable Object to Selected Engine

Instance dialog, shown in Figure 7-14.
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Figure 7-14 Add a Searchable Object to Selected Engine Instance Dialog

[Add a Searchable Object to Selected Engine Instance [

Oracle SES >> CRM Search Engine Instance

Display Name Searchable Object Name
Competitors  oracle.apps.sales. baseSales. competitors, publicviewE. ..
WorkerPVO  orade.apps.hcm.people. core. publicViewEcsf. Worker. ..
GlobalWorkerPVQ  oradle.apps.hcm.people. core.publicViewEcsf,Globalw...

OK Cancel

6. Select the desired searchable object from the table, and click OK.

The searchable object you selected appears in the table of searchable objects on the
Searchable Objects tab. The value in the Application ID column indicates the
application with which the searchable object is associated.

Note: A searchable object can be assigned to only one search engine
instance. If a searchable object has been assigned to a search engine
instance, it will not be listed in the table of available searchable
objects.

To proceed with other operations, you must first select any record.
Creating or deleting ECSF objects removes the focus from the window.

Task 4 Deploy the Searchable Objects to the Oracle SES Instance

Deploy the searchable objects to the Oracle SES instance to make the objects available
for the search engine instance to crawl. For information, see Task 1, "Deploy the
Searchable Objects to the Oracle Secure Enterprise Search (Oracle SES) Instance".

Task 5 Activate the Searchable Objects

Activate the searchable objects so that a query of the deployed and crawled searchable
objects will return results. For information, see Task 2, "Activate the Searchable
Objects".

Task 6 Create the Search Categories

You can either create new search categories for the new searchable objects or add the
new searchable objects to existing search categories. Creating a search category adds a
new record to the ECSF_SEARCH_INDEX_GROUP table in the Oracle Fusion Applications
database.

To create search categories using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.
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4. From the table of search engine instances, select the record of the search engine
instance for which you want to add a search category, and then select the Search
Categories tab, shown in Figure 7-15, to view the table of search categories for the
selected search engine instance.

5. Click the New Search Category icon. Alternatively, select New Record from the
Actions menu or use the Ctrl+Shift+N keyboard shortcut.

A new record named CHANGE_ME is added to the table of search categories.
6. Enter a new value in the Name column.
7. Select a value (LOCAL or GLOBAL) from the Scope column dropdown list.

8. Click the Save Search Category icon to save the selected record. Alternatively,
select Save Record from the Actions menu or use the Ctrl+Shift+S keyboard
shortcut.

Caution: A save will occur only for the selected record. You can only
save one record at a time.

Note: To proceed with other operations, you must first select any
record. Creating or deleting ECSF objects removes the focus from the
window.

Task 7 Undeploy the Search Categories

To add the new searchable objects to existing search categories, you must first
undeploy the search categories. For more information, see Task 1, "Undeploy the
Search Categories".

Task 8 Associate the Searchable Objects with Search Categories

Associating searchable objects with a search category adds the objects to that search
category. You can only associate deployed searchable objects with search categories.
You can associate the same searchable object with multiple search categories. You
cannot associate searchable objects with search categories that have been deployed. If
the search category has been deployed, you must undeploy it before you can associate
searchable objects with it. For information, see Task 1, "Undeploy the Search
Categories".

To associate searchable objects with search categories using Fusion Applications
Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page.

4. From the table of search engine instances, select the record of the desired search
engine instance, and then select the Search Categories tab, shown in Figure 7-15,
to view the table of search categories for the selected search engine instance.
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Figure 7-15 Search Categories Tab

Parameters | Searchable Objects | Search Categories | External Search Categories | Index Schedules
i
Actions v  View w 3 HfiDetach Deploy i Undeplay
MName Deployed Deployed Since Application ID Scope
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. o . .
[This table lists the Search Groups Far the selected Instance | marketing GLOBAL
Tea marketing LOCAL
Leads o marketing GLOBAL
Opportunity o sales LOCAL
Opportunities o sales GLOBAL
References [ sales GLOBAL

5. Select the desired search category to which you want to add searchable objects,

and click the Bind icon.

The Bind icon is disabled if the search category is deployed. You cannot associate
or disassociate searchable objects if the search category is deployed.

6. In the Bound Searchable Objects to the Selected Search Category dialog, shown in
Figure 7-16, select the checkboxes of the desired searchable objects from the
Available Objects list, and click the Move icon to add them to the Selected
Objects list. Only deployed searchable objects are listed as available objects.

Figure 7-16 Bound Searchable Objects to the Selected Search Category Dialog

Bound Searchable Objects to the Selected Search Category =
[ Selected Search Category: Customer
Available Objects Selected Objects
[JEcM Cantracts ® [contracts
Orurchasing Contracts Maove [ customer References
[Jcontract Documents 553 [ customer Opportunities
|:| Sourcing Contracts Mave All |:| Customer Motes
[references Q [Jcustomer Leads
|:| Opportunities |:| Customer Interactions
[Leads Remove [contacts
[Biling Accounts @R
|:| Customer Assessments nemove Al
[Jcampaigns
Ok Cancel
7. Click OK.

A new record is created in the ECSF_SIO_SIG_INT intersection table.
Task 9 Deploy the Search Categories
Deploy the search category. For information, see Task 4, "Deploy the Search

Categories".

Task 10 Create the Index Schedules

You can either create new index schedules for the new searchable objects or add the
new searchable objects to existing index schedules. For information on how to create
index schedules, see Section 7.4.2.1.
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Task 11 Undeploy the Index Schedules

To add the new searchable objects to existing index schedules, you must first undeploy
the index schedules. For more information, see Section 7.4.2.8.

Task 12 Associate the Searchable Objects with Index Schedules

Associate the new searchable object to either the newly created index schedule or an
existing, undeployed index schedule. For information, see Section 7.4.2.2.

Task 13 Deploy the Index Schedules

Deploy the index schedules. For information, see Task 4, "Deploy the Index
Schedules".

Task 14 Start the Index Schedules
Start the index schedules. For information, see Task 5, "Start the Index Schedules".

7.5.3 Defining Search Engine Instances

ECSF supports multiple search engine instances for each search engine type. Each
search engine instance belongs to exactly one version of the Oracle SES search engine
type and is stored in the ECSF_ENGINE_INSTANCE table.

You can perform the following tasks to define search engine instances:
s Creating Search Engine Instances

= Configuring Search Engine Instance Parameters

= Modifying Search Engine Instances

= Modifying Search Engine Instance Parameters

7.5.3.1 Creating Search Engine Instances
Creating a search engine instance adds a new search engine instance to the specified
search engine type.

To create search engine instances using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, shown in
Figure 7-4.

4. In the Search Engine Instance toolbar, click the New Engine Instance icon.
Alternatively, select New Record from the Actions menu or use the Ctrl+N
keyboard shortcut.

A new record is added to the top of the table of search engine instances.

5. Enter values for the Name and Comments columns.

Caution: A save will occur only for the selected record. You can only
save one record at a time.
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6. Click the Save Engine Instance icon to save the selected record. Alternatively,
select Save Record from the Actions menu or use the Ctrl+S keyboard shortcut.

7. Configure the search engine instance parameters. For information, see
Section 7.5.3.2.

8. (Click the Register icon to register the identity plug-in and create the federated
trusted entity for the selected search engine instance. Alternatively, select Register
from the Actions menu or use the Ctrl+G keyboard shortcut.

A dialog with a confirmation message appears.

Registering the identity plug-in for search engine instances allows users to
perform secure searches.

7.5.3.2 Configuring Search Engine Instance Parameters
Configuring search engine instance parameters sets parameter values to the search
engine instance.

To configure search engine instance parameters using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, shown in
Figure 7-4.

4. From the table of search engine instances, select the record of the search engine
instance for which you want to configure the parameters.

The parameters of the selected search engine instance appears in the Parameters
table, shown in Table 7-3.

Table 7-3 Search Engine Instance Parameters

Parameter Name Description Sample Value

SES_ADMIN_SERVICE URL to Oracle SES http://example.com:7777/s
administrative web service earch/api/admin/AdminServ
endpoint. ice

SES_ADMIN_USERNAME Oracle SES user for logging searchsys
into Oracle SES

administrative web service.

SES_ADMIN_PASSWORD Password for user SES_ welcomel
ADMIN_PROXY_USERNAME.

SES_ADMIN_SESSION_TIMEOUT | Time, in minutes, allowed by | 60
ECSF to keep administration
session to Oracle Secure
Enterprise Search (Oracle
SES) before forcing to
re-login/reestablish session
with Oracle SES. This timeout
is independent of Oracle
SES's internal administration
session timeout.
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Table 7-3 (Cont.) Search Engine Instance Parameters

Parameter Name

Description

Sample Value

SES_QUERY_SERVICE

URL to Oracle SES Query
web service endpoint.

http://example.com:7777/s
earch/query/OracleSearch

SES_QUERY_PROXY_USERNAME | ECSF/Fusion user used by scott
Oracle SES as a proxy user for
queries.

SES_QUERY_PROXY_PASSWORD Password for ECSF user used | tiger
by Oracle SES as a proxy user.

SES_QUERY_SESSION_TIMEOUT | Time, in minutes, allowed by | 60

ECSF to keep query session to
Oracle SES before forcing to
re-login/reestablish session
with Oracle SES. This timeout
is independent of Oracle
SES's internal query session
timeout.

ECSF_DATA_SERVICE

URL to ECSF servlets. This
URL is used to construct
configuration feeds for Oracle
SES.

http://example.com:7101/a
pproot/searchfeedservlet

ECSF_SECURITY_USERNAME

ECSF/Fusion user used by
Oracle SES to invoke ECSF
Security Service.

scott or fusion

ECSF_SECURITY_PASSWORD

Password for ECSF/Fusion
user used by Oracle SES to

invoke ECSF Security Service.

tiger or fusion

ECSF_SECURITY_SERVICE

URL to ECSF servlets. This
URL is used to construct
configuration feeds for Oracle
SES. ECSF runtime URL and
ECSF Security Service URL
can be set to 2 different
servers, which is also what
Oracle SES supports.

http://example.com:7101/a
pproot/searchfeedservlet

ECSF_REDIRECT_SERVICE

URL to ECSF feed servlets.
This URL is used to redirect
drilldowns/actionable
results.

http://example.com:7101/a
pproot/searchfeedservlet

5. Select the record for the desired parameter, and modify the entry in the
corresponding Value column.

Caution:

save one record at a time.

A save will occur only for the selected record. You can only

6. Click the Save Engine Instance Parameter icon to save the selected record.
Alternatively, select Save Record from the Actions menu or use the Ctrl+Shift+S

keyboard shortcut.

7.5.3.3 Modifying Search Engine Instances

Modifying a search engine instance edits the properties of an existing search engine

instance.
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To modify search engine instances using Fusion Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, shown in
Figure 7-4.

4. Modify the entries in the Name and Comments columns.

Caution: A save will occur only for the selected record. You can only
save one record at a time.

5. Click the Save Engine Instance icon to save the selected record. Alternatively,
select Save Record from the Actions menu or use the Ctrl+S keyboard shortcut.

7.5.3.4 Modifying Search Engine Instance Parameters

Modifying search engine instance parameters updates the parameter values. Once the
parameter values are updated, you must update all the deployed searchable objects of
the same search engine instance with the latest search engine instance parameters on
the Oracle SES server. Only searchable objects that have been deployed can be updated
with the latest search engine instance parameters on the Oracle SES server.

To modify search engine instance parameters, follow the procedures in the following
tasks:

» Task 1, "Edit the Search Engine Instance Parameters"
» Task 2, "Deploy the Parameters to All Deployed Searchable Objects"
»  Task 3, "Deploy the Parameters to Individual Deployed Searchable Objects"

Task 1 Edit the Search Engine Instance Parameters
You can edit the search engine instance parameters to change their values.

To change the values of the search engine instance parameters using Fusion
Applications Control:

1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, shown in
Figure 7—4.

4. From the table of search engine instances, select the record of the search engine
instance for which you want to modify the parameters.

The parameters of the selected search engine instance appears in the Parameters
tab.
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Select the record for the desired parameter, and modify the entry in the
corresponding Value column.

Tip: It is recommended that you modify these parameters during
system downtime. It is also recommended that you update the objects
when all the parameters are set.

Task 2 Deploy the Parameters to All Deployed Searchable Objects

After you update the search engine instance parameter values, you must update all the
deployed searchable objects of the same search engine instance with the latest search
engine instance parameters on the Oracle SES server.

To deploy the new values of the search engine instance parameters to all the deployed
searchable objects in the search engine instance using Fusion Applications Control:

1.

From the Parameters tab, click the Deploy Parameters icon to update all the
deployed searchable objects with the latest search engine instance parameter
values. Alternatively, select Deploy Parameters from the Actions menu or use the
Ctrl+Shift+Y keyboard shortcut.

A confirmation dialog appears.

Validate that all deployed searchable objects have been updated with the latest
parameter values by selecting the Searchable Objects tab and viewing the
Parameters Applied column.

A green check mark indicates that the searchable object is updated with the latest
parameter values. A red X indicates that the searchable object is not updated with
the latest parameter values. A gray box indicates that the searchable object is not
deployed.

Task 3 Deploy the Parameters to Individual Deployed Searchable Objects

For any deployed searchable objects that were not updated with the latest parameter
values, update them individually.

To deploy the parameters to individual deployed searchable objects using Fusion
Applications Control:

1.

From the Searchable Objects tab, select the record corresponding to a searchable
object that was not updated with the new parameter value.

A green check mark indicates that the searchable object is updated with the latest
parameter values. A red X indicates that the searchable object is not updated with
the latest parameter values. A gray box indicates that the searchable object is not
deployed.

Click the Deploy Parameters icon to update the parameter values for that
deployed searchable object. Alternatively, select Deploy Parameters from the
Actions menu or use the Ctrl+Shift+Y keyboard shortcut.

A confirmation dialog appears.

A green check mark will replace the red X when the latest search engine instance
parameters are updated for the searchable object.

7.5.3.5 Deleting Search Engine Instances
Deleting search engine instances removes them from the specified search engine type.

To delete search engine instances using Fusion Applications Control:
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1. From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

2. Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

3. Click the Oracle SES search engine type name link in the Search Engine Types
table to open the Search Engine Instance administration page, shown in
Figure 7-4.

4. From the table of search engine instances, select the record you want to delete.

5. Click the Delete Engine Instance icon to delete the selected record. Alternatively,
select Delete Record from the Actions menu or use the Ctrl+D keyboard shortcut.

7.5.4 Enabling Search on External Data Sources

In addition to providing search against ECSF data sources (that is, view object based
data sources deployed from ECSF administration) and data sources that are crawled
via ECSFE, ECSF supports search against all registered Oracle SES data source groups
that contain external data sources. External data sources include data sources such as
Intranet, mail, database, and federated data sources (data sources crawled in separate
engine instances). Oracle SES data source groups can also contain federated ECSF data
sources (data sources created in different logical engine instances via the ECSF
administration tools).

ECSF Administration synchronizes categories with the data source groups on Oracle
SES. The data sources are not synchronized.

Figure 7-17 illustrates the process flow for enabling search on external data sources.

Figure 7-17 Process Flow for Search on External Data Sources
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The process flow includes the following steps:

1. Data source groups are imported from Oracle SES via the Fusion Applications
Control. For information, see Task 1, "Import the External Search Categories".
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2. The Oracle Fusion Applications database is synchronized with the data source
groups from Oracle SES.

ECSF sets the IS_EXTERNAL flag to true on records in the ECSF_SEARCH_INDEX_
GROUP table to identify them as external search categories.

3. ECSF-created search categories and external search categories are both accessible
via getSearchGroups ().

4. SearchCtrl can query any search category, and the underlying data may actually
be federated to other Oracle SES instances.

Note: ECSF supports multiple search engine instances for each
application. However, each query can only contain search categories
deployed on the same search engine instance.

Search categories containing ECSF data sources are represented in the ECSF_SEARCH_
INDEX_GROUP table and linked to one or more searchable objects through an
intersection table. Search results are usually grouped by the searchable object name
stored in the ECSF_SO_NAME custom attribute that is returned in each search result.

Note: ECSF currently does not support querying search categories
that contain mixed data sources. Each search category must contain
either only ECSF data sources or only external data sources.

External search categories are not linked to searchable objects. Instead, ECSF creates
the ExternalSearchableObject searchable object type for external search categories.
Search results from external search categories are assigned to the external searchable
object, named oracle.ecsf.meta.ExternalSearchableObject, that is created during
runtime.

Example 7-1 queries an external category called "Oracle Website."

Example 7-1 Sample Code for Querying External Categories

public void federationTest ()

{
SearchCtrl searchCtrl = new SearchCtrl();
SearchHits searchHits = null;
SearchContext searchContext = null;
SearchEngineInstance enginelInstance = null;
SearchGroup[] sgs = new SearchGroup[1l];

QueryMetaDataImpl queryMetaData = new QueryMetaDataImpl();
queryMetaData.setQueryString ("$");
queryMetaData.setPageSize(10);
queryMetaData.setCurrentPage (1) ;

ArrayList<SearchEngineInstance> enginelInstances =
(ArrayList<SearchEnginelInstance>)searchCtrl.getEngineInstances();

for (int 1 = 0; 1 < engineInstances.size(); 1++)

{

if (enginelInstances.get(i).getId() == 1)

enginelnstance = enginelnstances.get(i);
break;
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ArrayList<SearchGroup> groups =
(ArrayList<SearchGroup>)engineInstance.getSearchGroups () ;
for (int j = 0; j < groups.size(); Jj++)
{
if (groups.get(j).getName().equals("Oracle Website"))

sgs[0] = groups.get(J);
break;

queryMetaData.setSearchGroups (sgs) ;
searchContext = ContextFactory.getSearchContext () ;
searchContext.bindUser ("scott") ;
try
{
searchHits = searchCtrl.runQuery (searchContext, queryMetaData);
}
catch (Exception e)

{

fail("Failed runQuery due to "+e.getMessage());

IndexedDocument doc = searchHits.getDocument (0);

String url = null;

try

{
url = doc.getDefaultAction().getRedirectURL();
ActionURLResolver resolver = new ActionURLResolver();
url = resolver.resolveURL (searchContext, doc.getDefaultAction());

}

catch (Exception e)

{

}

}

Since there is no view object or search object definition file where actions can be
defined, the URL attribute of the resulting object returned from Oracle SES will be
used to generate a default action with the name Default.

Advanced search and faceted navigation are not supported for external data sources.

7.5.5 Adding Product Families for Federated Search

To include a new product family for federated search, you must add a Search
Application Service Component instance to engine type Oracle Search Application
and configure the instance.

Note: Manage credentials via the MBean using JConsole. For
information, see Oracle Fusion Middleware Fusion Developer’s Guide for
Oracle Application Development Framework (Oracle Fusion Applications
Edition).

Each product family (Oracle Fusion Customer Relationship Management, Oracle
Fusion Human Capital Management, and Oracle Fusion Supply Chain Management)
has its own search application. Each search application provides the data service,
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query web service, authentication service, and authorization service for the product
family. Each search application also contains all the searchable objects and its
dependencies for the product family as well as the references to the ECSF shared
libraries.

To create and configure a Search Application Service Component instance using
Fusion Applications Control:

1.

From the navigation pane, expand the farm and then the Enterprise Crawl and
Search Framework folder.

Select the application engine instance that contains the searchable objects you
want to manage to open the Enterprise Crawl and Search Framework
Configuration Settings page.

Click the Search Application Service Component link.

On the Search Application Service Component administration page, shown in
Figure 7-11, click the New Engine Instance icon. Alternatively, select New Record
from the Actions menu or use the Ctrl+Shift+N keyboard shortcut.

A new Search Application Service Component instance record is added to the top
of the table of configured search applications.

Enter a value for the Name column.

On the Parameters tab, set the value for the ECSF_QUERY_SERVICE_REF_NAME
parameter of the Search Application Service Component instance. Use the
following format:

{/oracle/ecsf/service/query/common/componentname/}SearchService

replacing componentname with the name of the Search Application Service
Component.

Set the value for the IS_ACTIVE parameter of the Search Application Service
Component instance.

Set the value to Y to specify that the Search Application Service Component is
active. The component is skipped during global search related functions when you
set the value to N. If the IS_ACTIVE parameter value is not defined for the
component in the database, the component is treated as active.

Save.
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Managing Oracle WebLogic Communication
Services for Click-to-Dial Functionality

Oracle WebLogic Communication Services provides click-to-dial functionality for
applications primarily through contextual actions. Contextual actions provide related
information and actions to users within the immediate context of the object instances
upon which they act. This chapter explains how to enable and configure these services.

It includes the following topics:
s Introduction to Third Party Call Web Service

»  Modifying Third Party Call Web Service Default Settings Using the System MBean
Browser

= Call Routing Through a Session Border Controller

8.1 Introduction to Third Party Call Web Service

The Third Party Call Web service in Oracle WebLogic Communication Services enables
click-to-dial functionality in applications by providing an interface to initiate a call
between two parties. The Web service is an implementation of the Parlay X 2.1 Third
Party Call Interface.

The Third Party Call Web service can:

= Set up a call between two parties

= Query the status of an ongoing call
»  Cancel a call it is creating

s Terminate an ongoing call it created

The Third Party Call Web service is provided through the thirdpartycall application,
which is installed with default configuration settings in the domain for the each
product family.

8.2 Modifying Third Party Call Web Service Default Settings Using the
System MBean Browser

You can use the System MBean Browser to modify the default configuration settings
for the thirdpartycall application for the product family domains.

To modify the MBeans for the thirdpartycall application with the System MBean
Browser from the Fusion Applications Control:
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7.

From the target navigation pane, expand the farm and then Application
Deployments.

Select the application thirdpartycall.
From the Application Deployment menu, select System MBean Browser.
Fusion Applications Control displays the System MBean Browser page.

Scroll down to the node that displays oracle.ucs.thirdpartycall. Expand the
oracle.ucs.thirdpartycall node and drill down to the node that displays the
ThirdPartyCallConfiguration MBean.

Click the ThirdPartyCallConfiguration MBean node. The configuration settings
for the thirdpartycall application appear on the right pane. Select the Attributes
tab to display the details for this group of attributes.

For more information about the configurable attributes for the thirdpartycall
application, see Table 8-1.

Update values of the attributes to modify by entering the new value in the Value
field.

Click Apply.

For general information about the System MBean Browser, see the "Getting Started
Using Oracle Enterprise Manager Fusion Middleware Control" section in Oracle Fusion
Middleware Administrator’s Guide.

Table 8-1 contains a list of attributes for configuring the Third Party Call Web service

Table 8-1 Configuration Attributes for Third Party Call Web Service

Attribute Format Description Values
ChargingAllowed String Specifies if charging is allowed. Default: False
Note: No server restart is
required if you change the value.
ControllerUri String in URI format ~ Specifies the Third Party Default: empty

controller Session Initiation
Protocol (SIP) URI that is used
to establish the third party call.
If this value is set, a call appears
to the callee to come from this

By default, no controller URI is

to come from the caller.

URIL Note: You must restart the server

if you change this value.

MaximumCallDuration

int Specifies the maximum time (in Default: 1440 (24 hours)
minutes) for an ongoing call. If
this time expires, the call is
terminated.

Minimum: -1 (0 and -1 means
that call-length supervision is
disabled)

Maximum: Unbounded

Note: No server restart is
required if you decrease this

value. You must restart the server

if you increase the value or set
the value to 0 or -1.
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Table 8-1 (Cont.) Configuration Attributes for Third Party Call Web Service

Attribute Format Description Values
PAssertedIdentityUri String in URI format Specifies the SIP URI used in Default: empty
the P-Asserted-Identity .
header added by the Third Note: You must restart the server
Party Call service. If left blank Y & '
the P-Asserted-Identity
header is not added.
StatusRetentionTime int Specifies the time (in minutes) ~ Default: 5
for retaining the status ., Minimum: -1 (0 and -1 means
information about a call after it . L
. that the status information is
was terminated. .
removed when the call is
terminated).
Maximum: Unbounded
Note: No server restart is
required if you change the value.
PreloadedRouteUri String in URI format  Specifies the SIP URI to putina Default: empty

route header of outgoing SIP
INVITE requests during a call
setup.

Note: You must restart the server
if you change this value.

8.3 Call Routing Through a Session Border Controller

The Third Party Call Web service interfaces on the backend with SIP infrastructure,
such as a SIP-enabled switch or a SIP-to-PSTN gateway. When the SIP infrastructure
lies outside the enterprise network, such as in the case of a hosted SIP trunking service
or if the switch is in an external network, a Session Border Controller (SBC) is typically
used to secure and control the interaction. A SBC is a piece of equipment that is
deployed at the border of the network and controls the signaling and media across
network address translation (NAT) devices and firewall boundaries. In addition, it
prevents unauthorized access and denial of service (DoS) attacks.

You can route the Third Party Call Control (TPCC) requests through an SBC either by
setting up an outbound proxy server or by configuring one TPCC attribute.

This section contains the following topics:
= Setting Up an Outbound Proxy Server
s Configuring the PreLoadedRouteUri Attribute

8.3.1 Setting Up an Outbound Proxy Server

You can set up the SBC as an outbound proxy server and route TPCC requests through
the outbound proxy server. If you define an outbound proxy server (SBC) for a SIP
Servlet container, any request from all SIP servlet applications (including the
thirdpartycall application) on this SIP Servlet container is routed through the SBC.

Oracle WebLogic SIP Server provides Oracle WebLogic Administration Console
extensions that allow you to modify the SIP Servlet container properties. To set up an
outbound proxy:

1. Enter the following URL in a browser:

http://hostname: port_number/console

where the hostname and the port_number correspond to the Administration Server
for the domain.
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2. Log in using the Oracle Fusion Middleware administrative user name and
password.

3. Select the SipServer node in the left pane. The right pane of the console displays
the tabbed pages that are used for configuring and monitoring WebLogic SIP
Server.

4. Select the Proxy tab.
5. Select the Proxy Routing Policy as proxy.

6. In the Proxy Routing URIs section, enter the URI as sip: SBC_hostname: SBC_
portnumber, where SBC_hostname and SBC_portnumber represent the host and port
of the Session Border Controller, respectively.

7. Click Save.

For more information, see the "SIP Server: Configuration: Proxy" topic in the Oracle
WebLogic Administration Console Help.

Note: Oracle recommends that you use the Administration Console
to modify sipserver.xml indirectly, rather than editing the file by
hand. Using the Administration Console ensures that the
sipserver.xml document always contains valid XML.

8.3.2 Configuring the PreLoadedRouteUri Attribute

To route requests only from the thirdpartycall application through SBC, set the
value of the PreLoadedRouteUri attribute as sip:SBC_hostname: SBC_portnumber,
where SBC_hostname and SBC_portnumber represent the host and port of the SBC,
respectively.

For more information about modifying the PreLoadedRouteUri attribute, see
Section 8.2.
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Monitoring

This part provides information about how to monitor the Oracle Fusion Applications
environment. It explains how to find information about the cause of an error and its
corrective action, and how to view and manage log files to assist in monitoring system
activity and to diagnose problems.

Part I1I contains the following chapters:

Chapter 9, "Monitoring Oracle Fusion Applications"
Chapter 10, "Monitoring the Oracle Fusion Applications Middle Tier"
Chapter 11, "Diagnosing the Oracle Fusion Applications Middle Tier Performance”

Chapter 12, "Monitoring and Tuning Oracle Database for Oracle Fusion
Applications"

Chapter 13, "Managing Oracle Fusion Applications Log Files and Diagnostic Tests"
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Monitoring Oracle Fusion Applications

This chapter describes how to manage Oracle Fusion web applications using Oracle
Enterprise Manager Fusion Applications Control (Fusion Applications Control) and
Oracle Enterprise Manager (Cloud Control).

This chapter includes the following topics:

s Introduction to Monitoring Oracle Fusion Applications

s The Product Family Home Page and Sections in Fusion Applications Control
s The Product Home Page and Sections in Fusion Applications Control
s The Fusion Instance Overview Page and Sections in Cloud Control

s The Product Family Home Page and Sections in Cloud Control

s The Product Home Page and Sections in Cloud Control

= Monitoring Product Families and Products

= Monitoring the Detailed Status of Oracle Fusion Applications

= Monitoring Business Performance Metrics for a Product Family

= Monitoring Business Performance Metrics for a Product

= Viewing the Routing Topology of an Oracle Fusion Applications Instance, Product
Family, or Product

= Viewing the Configuration Topology of an Oracle Fusion Applications Instance,
Product Family, or Product

9.1 Introduction to Monitoring Oracle Fusion Applications

Oracle Enterprise Manager Fusion Applications Control (Fusion Applications Control)
is a tool used to monitor Oracle Fusion Applications product families and products
deployed to Oracle WebLogic Server. Oracle Enterprise Manager Cloud Control
(Cloud Control) is a tool used in much the same way, but viewing Oracle Fusion
Applications product families and products within the larger context of Oracle Fusion
Middleware.

Oracle Enterprise Manager Fusion Applications Control provides a large picture view
of your deployments, while also allowing you to drill down for more detailed
information. You can monitor the status of the servers to which product families are
deployed and the databases that store product information, the status of all scheduled
job requests running in the system, as well as the overall state and performance of
product families and products. The customizable performance summary pages allow
you to monitor product performance and diagnose problems. You can modify these
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charts to display statistics that are relevant to your deployment, or add an additional
product to the chart so as to compare the performance information for two

components in one chart.

Using a topographical chart, you can examine the relationship between a deployed
product family and its products, and drill down to view the status of individual
product instances. Out-of-the-box performance metrics provided for each Oracle
Fusion Applications product allow detailed monitoring of the state and performance
of all product families and each individual product.

9.2 The Product Family Home Page and Sections in Fusion Applications

Control

The product family home page provides an overview of the products belonging to a
product family. An example of a product family home page is shown in Figure 9-1.

Figure 9—1 The Product Family Home Page in Fusion Applications Control
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The Product Family home page displays the following sections:

= Applications and Infrastructure Section

s Key Performance Indicators Section

= Topology Section

s Oracle Enterprise Scheduler Sections
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9.2.1 Applications and Infrastructure Section

The Applications and Infrastructure section displays the status of the database,
deployed Oracle Fusion Applications and Oracle Fusion Middleware itself. The Fusion
Applications and Fusion Middleware pie charts display the percentage of Oracle
Fusion Applications and Oracle Fusion Middleware servers that are currently up or
down. The number of applications and servers that are running or down is shown
below each pie chart.

9.2.2 Key Performance Indicators Section

The Key Performance Indicators section displays the main performance metrics related
to the product family or product. By default, these metrics display in graphical format.
Alternatively, you can display the performance metrics in tabular format instead.
Mousing over a particular metric causes the performance graph to display only the
data for that metric.

You can add or remove metrics from the Key Performance Indicators section. You can
also change the order in which metrics display. For more information about
monitoring business metrics for a product family or product, see Section 9.10

9.2.3 Topology Section

The Topology section displays the components of the product family or product. In the
Product home page, the Topology section displays the same information, with the
irrelevant products and Java EE applications grayed out.

The Product Family home page Topology section is shown in Figure 9-2.

Figure 9-2 Product Family Home Page Topology Region
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The Product home page Topology section is shown in Figure 9-3.

Figure 9-3 Product Home Page Topology Section
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Mousing over a component under the Oracle Fusion Applications heading highlights
the related product under the Product heading, and vice versa. In the Product Family
home page, clicking a product in the Topology section displays the Product home page
for that product. Clicking the name of the Oracle Fusion Applications product family
in the Topology section displays the Oracle Fusion application instances running on
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servers in the application cluster. The Fusion Cluster Application home page displays,
as shown in Figure 9-4.

Figure 9-4 Fusion Cluster Application Home Page
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For more information about viewing topology information, see Section 10.2.3.1

9.2.4 Oracle Enterprise Scheduler Sections

The Oracle Enterprise Scheduler sections display information pertaining to scheduled
jobs running in relation to the product or product family. The Oracle Enterprise
Scheduler sections are as follows.

= Top Long Running Job Requests: This section displays information about the top
ten long running scheduled job requests, including request ID, job definition used,
the product and time elapsed since the job executed.

= Recently Completed Job Requests (Last 24 Hours): This section displays
information about the most recent scheduled jobs completed within the last 24
hours, including job definition used, the product, the number of completed and

failed requests, the percentage of successfully completed job requests and the time
elapsed from execution.

= Ready Job Requests: This section displays the scheduled job requests that are
awaiting execution, including the job definition used, the product and the number
of jobs that are ready to run.

For more information about this section, see the online help.

9.2.5 SOA Composite Section

The Recently Completed SOA Composite Requests (Last 24 Hours) section displays
information about the most recent SOA composite execution requests completed
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within the last 24 hours, including the name of the SOA composite, the name of the
partition to which the composite is deployed, the number of completed instances, the
percentage of successfully completed instances and the response time in milliseconds
for synchronously executed SOA composites.

9.3 The Product Home Page and Sections in Fusion Applications Control

The product home page provides an overview of the Oracle Fusion Applications

required to run a given product. An example of a product home page is shown in
Figure 9-5.

Figure 9-5 The Product Home Page in Fusion Applications Control
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The Oracle Fusion Applications Product Home page displays the following sections:

s Key Performance Indicators Section
= Fusion Applications Section

= Servers Section

= Topology Section

»  Oracle Enterprise Scheduler Sections

9.3.1 Fusion Applications Section

The Oracle Fusion Applications section displays the Oracle Fusion Applications that
are part of the product and have been installed. Each application may include
instances running on other servers in the domain.

For more information about this section, see the online help.
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9.3.2 Servers Section

The Servers section displays the names of the domain, clusters and servers running the
Oracle Fusion Application. The table listing the clusters and servers displays the status
of each item, indicating whether they are up or down. Additionally, the table displays
other data such as the number of sessions currently active, the number of requests
received per minute and the time required to process a request.

For more information about this section, see the online help.

9.4 The Fusion Instance Overview Page and Sections in Cloud Control

The Fusion Instance home page allows you to monitor a whole instance at a glance,
including diagnostic values, a summary of member targets, the status of members and
top long running job requests. The Fusion Instance menu provides several
administrative options for managing all the product families.

Figure 9-6 The Fusion Instance Overview Page in Cloud Control
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2. In the table on the Fusion Applications page, click the Fusion Instance whose
overview page you want to display.

The Fusion Instance page displays, as shown in Figure 9-6.
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The Fusion Instance overview page displays the following sections:
= Summary Section

= Member Target Summary Section

= Status Section

= Top Long Running Job Requests

9.4.1 Summary Section

The Summary section displays an overview of the Fusion instance as a whole,
including diagnostic and database information.

The following sub-sections display in the Summary section:
= Monitoring and Diagnostics Region

= Database System Region

9.4.1.1 Monitoring and Diagnostics Region

The Monitoring and Diagnostics sub-section displays major incidents and changes that
have occurred in the Fusion instance, including incidents at the instance level,
incidents that have occurred in descendant targets, any configuration changes that
have occurred over the last seven days and any support workbench problems.
Incidents are listed by severity, namely fatal, critical, warning and escalation levels.

9.4.1.2 Database System Region

The Database System sub-section displays database information related to the Fusion
instance, including the name of the database system, the percentage of available space
on the system and the name of the database to which the Fusion instance writes its
data.

9.4.2 Member Target Summary Section

The Member Target Summary section displays an overview of the member targets of
the Fusion instance, including product families and products. The type of information
displayed in this sub-section is similar to that displayed in the Cloud Control Fusion
Applications overview page described in Section 2.7 4.

9.4.3 Status Section

The Status section displays status information regarding the members of the Fusion
instance. The numbers at the top of the Status section indicate how many members of
the instance are up, down or unavailable. You can click a number or status for more
information.

The table in the Status section displays members that have been affected the most
within the last 24 hours. This includes Oracle WebLogic Servers, application
deployments, clustered application deployments, Fusion Java EE applications, and so
on. The table displays the status and percent availability for each member. You can
click individual member items for more information.

9.4.4 Top Long Running Job Requests

This section displays the same information described in Section 9.2.4.

Monitoring Oracle Fusion Applications 9-7



The Product Family Home Page and Sections in Cloud Control

9.5 The Product Family Home Page and Sections in Cloud Control

When selecting a product family from the Fusion Applications overview page or the
Fusion Instance page, Cloud Control directs you to the product family home page for
the selected product family, as shown in Figure 9-7. The Cloud Control Product
Family home page displays an overview of the product family at a glance, including
the products and Oracle Fusion applications comprising the product family.

Figure 9—7 The Product Family Home Page in Cloud Control
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The Product Family home page includes the following sections:
= Applications and Infrastructure Section

s Key Performance Indicators Section

= SOA Composite Section

= Topology Section

s Oracle Enterprise Scheduler Sections

The Product Family menu provides several administrative options for managing the
the product family, which are similar to those in Fusion Applications Control.

You can click a particular product to display the Cloud Control product home page.

9.6 The Product Home Page and Sections in Cloud Control

When selecting a product from the Fusion Applications overview page, Fusion
Instance page, or Product Family home page, Cloud Control directs you to a home
page for the selected product, as shown in Figure 9-8. The Cloud Control Product
home page displays an overview of a product at a glance, including the Oracle Fusion
applications that compose the product and the servers on which they run.
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Figure 9-8 The Product Home Page in Cloud Control
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The Cloud Control Product home page displays the following sections:
= Summary Section

s Key Performance Indicators Section

= Fusion Applications Section

= Servers Section

= Topology Section

»  Oracle Enterprise Scheduler Sections

The Product menu provides several administrative options for managing the product,
which are similar to those in Fusion Applications Control.

9.7 Monitoring Product Families and Products

The product family and product home pages allow you to monitor various aspects of
your servers and applications.

The main steps in monitoring product families and products are as follows:
= Verify component status.

s View and modify performance metrics.

= Monitor the status of any scheduled jobs.

To monitor a product family or product in Fusion Applications Control or Cloud
Control:

1. Navigate to the product family home page:

s Fusion Applications Control: From the navigation pane, select the name of
the product family.

s Cloud Control:
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a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications page, click the Fusion Instance
whose overview page you want to display.

The Fusion Instance page displays.

c. In the Fusion Instance overview page, expand the Fusion instance and
click the name of the product family.

2. Alternatively, navigate to the product home page:

= Fusion Applications Control: From the navigation pane, expand the product
family, then Products, and then select the product.

= Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications page, click the Fusion Instance
whose overview page you want to display.

The Fusion Instance page displays.

c. In the Fusion Instance overview page, expand the Fusion instance and the
product family. Click the name of the product whose home page you want
to display.

3. Use the following sections on the main product family or product page to verify
the status of various components.

= Applications and Infrastructure: Verify the availability of Fusion Applications
and Oracle Fusion Middleware.

= Topology: View the complete topology of the product or product family. Click
a node to view the home page of the selected component.

= Fusion Applications: Verify the status of Fusion cluster applications, Fusion
applications and the relationship between domain and server.

= Servers: Verify the status of Fusion cluster applications and all related servers.

For more information about the individual sections on the product family and
product home pages, see Section 9.2 and Section 9.3.

For more information about monitoring Fusion applications, see Section 9.8.

4. In the Key Performance Indicators section, view the product or product family
main performance metrics. Click the View Actions menu to carry out any of the
following tasks.

= Modifying performance metrics: You can view and modify the performance
metrics in this section by clicking the View Actions menu in the section and
selecting Select Metrics.

The Select Metrics popup window displays.
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In the Select Metrics dialog, you can search for a particular metric in the
Search field and select or remove the metrics you want to display or hide in
the Key Performance Indicators section.

For more information about monitoring and modifying performance metrics,
see Section 9.9.

= Saving charts: You can save metric charts to a file by selecting View Actions >
Save charts.

= Restoring default charts: You can restore the metric charts to their defaults
such that only the default metrics display, by selecting View Actions >
Restore default charts.

5. Monitor the status of any scheduled jobs by using the Oracle Enterprise Scheduler
sections described Section 9.2.4. You can view more scheduled jobs displayed in
these sections by clicking Show All at the bottom of each section.

Clicking Show All displays the Oracle Enterprise Scheduler section in a larger
pane such that a larger number of relevant jobs display.

9.8 Monitoring the Detailed Status of Oracle Fusion Applications

The Applications and Infrastructure page allows you to verify the status of a given
Oracle Fusion application.

To verify the status of a given Oracle Fusion application:
1. Display the Product Family home page.

» In Fusion Applications Control, from the navigation pane, select the product
family.

= In Cloud Control, from the Targets menu, choose Fusion Applications.
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In the Fusion Applications table, click the desired product family.
Display the Applications and Infrastructure page.

s In Fusion Applications Control, from the Product Family menu, choose
Applications and Infrastructure

s In Cloud Control, from the Product Family menu, choose Monitoring and
then select Applications and Infrastructure.

The Applications and Infrastructure page displays.
Click the Fusion Applications tab.

This tab shows the status of a given clustered Oracle Fusion J2EE application.
When expanding an application, the individual instances of the Oracle Fusion
display, each running on different servers. A status displays for each of these
individual application deployments.

A pie chart indicates the percentage of Fusion applications in the product family
that are up and running within the farm domain.
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9.9 Monitoring Business Performance Metrics for a Product Family

The Key Performance Indicators page displays an overview of the performance
metrics of a given product family. Typically, several default metrics display on the
page in the form of graphs. A number of metrics are tracked, and these can be added
to the Key Performance Indicators page. Each product belonging to a given product
family has its own set of metrics.

You can modify the Key Performance Indicators page as follows:

Add or remove metrics from the page.

Display performance data in tabular format.

Save or delete a set of performance charts.

Re-organize the display of charts, for example move charts up or down.

Display the performance metrics of another instance of the product on top of the
current chart sets, or display earlier metrics of the same product instance on top of
current metrics.
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= Toggle on or off the grid display on the performance chart set.
= Modify the performance time period.

To view and modify a product family's business performance summary page in Fusion
Applications Control or Cloud Control:

1. Navigate to the product family home page.

s Fusion Applications Control: From the navigation pane, choose the product
family.

= Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, click the product
family.

2. Display the Key Performance Indicators page.

= Fusion Applications Control: From the Product Family menu, select Key
Performance Indicators.

s Cloud Control: From the Product Family menu, select Monitoring and then
select Key Performance Indicators.

The product family home page displays. You can view the key metrics for the
product family in the Key Performance Indicators page.

3. Display the metrics pane by clicking Show Metric Palette.
4. You can modify the metrics that display on the Key Performance Indicators pane.

In the Metrics Palette, select the metrics you want to display in the Key
Performance Indicators pane.

5. You can search for a particular metric.

In the Metrics Palette Search field, enter the name of the metric you want to find
and click the Search button.

6. You can change the order in which metrics display on the Key Performance
Indicators pane, or delete a metric from the display.

»  Click the bar to the left of the metric name and drag the metric up or down.

s Click the Close button on the upper right corner of the metric to delete it from
the display.
7. You can optionally click a metric name for more information about that metric.

The Additional Information dialog displays. From this dialog, you can view more
details about the metric using the following links:

s Problem Analysis: Directs to the Problem Analysis page. This page enables
you to see a metric with other related metrics, which are affecting the metrics
being analyzed. It also shows the related targets and the related targets
topology. The Problem Analysis is only available for request-related metrics,
such as the Request Processing Time (ms) and Request (per minute).

= Analyze Logs: Displays a message that enables you to view the logs for a
target on which the metric is viewed.

= Metric Details: Enables you view historical metric data.
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s Target Home: Directs you to the home page.

When used together, Problem Analysis and Analyze Logs can help you inspect
metrics, target status information, and logs during troubleshooting. These links are
not available for all metrics. For more information about these links, see

Section 14.4.6.

For information about viewing and modifying the display of product family
performance indicators, see Section 2.5.7.

9.10 Monitoring Business Performance Metrics for a Product

The Performance Summary page displays an overview of the performance metrics for
a given product. Typically, several default metrics display on the page in the form of
graphs. A number of metrics are tracked, and these can be added to the Performance
Summary page. Each product belonging to a given product family has its own set of
metrics.

You can modify the performance page as follows:

Add or remove metrics from the page.

Display performance data in tabular format.

Save or delete a set of performance charts.

Re-organize the display of charts, for example move charts up or down.

Display the performance metrics of another product family on top of the current
chart sets, or display earlier metrics of the same product family on top of current
metrics.

Toggle on or off the grid display on the performance chart set.

Modify the performance time period.

To view and modify a product's business performance summary page in Fusion
Applications Control or Cloud Control:

1.

2.

Navigate to the product home page.

= Fusion Applications Control: From the navigation pane, expand the product
family, then Products, and then select the product.

s Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, expand a
product family and click an individual product.

Display the Key Performance Indicators page.

= Fusion Applications Control: From the Product menu, choose Key
Performance Indicators.

s Cloud Control: From the Product menu, choose Monitoring and then select
Key Performance Indicators.

The product family home page displays. You can view the key metrics for the
product family in the Key Performance Indicators page.

To modify the display of metrics in the Key Performance Indicators page, follow
the procedure in Section 9.9, beginning with Step 3.
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9.11 Viewing the Routing Topology of an Oracle Fusion Applications
Instance, Product Family, or Product

Cloud Control provides a routing topology viewer, which provides a graphical
representation of routing relationships across targets, components and elements. It
shows you the routing details for the Oracle Fusion Applications environment, from
Oracle HTTP Server to the Oracle WebLogic Servers to the Oracle Database. Targets
are annotated to indicate status and incidents. Tool tips show additional information
about entities and relationships. You can pan and zoom the graph, as in popular map
programs, and also expand and collapse desired areas of the graph. The graph can be
filtered to show only desired nodes. The topology graph is highly interactive. You can
hover over and click on various parts of the graph. The topology graph provides
visibility into the runtime environment.

You can also print the topology or save it to a .png file.
To view the topology with Cloud Control:
1. Navigate to a Fusion Instance, product family, or product home page:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications page, click the appropriate target, the
instance for the Oracle Fusion Applications or product family. You can also
expand a product family to select an individual product.

2. From the Fusion Instance, Product Family, or Product menu, choose Routing
Topology.

The Routing Topology page displays.
3. From the View menu, choose one of the following topology views:

= Routing: Group by Application: Choose to view the topology of the
applications as they relate to the Oracle WebLogic Server domains and servers,
as well as the Oracle Database.

=  Routing: Group by Middleware: Choose to view the topology for the
middleware targets, such as Oracle WebLogic Server.

= Routing: Group by Host: Choose to view the topology of the targets on the
hosts in the enterprise.

= Products: Choose this view the topology of Oracle Fusion Applications
products.

4. To see information about a particular target, place your mouse over the target. To
view additional information, click More. For example, for an Oracle WebLogic
Server domain, you can view general information about the domain home
location, incidents, and configuration.

5. From the Products menu, select and deselect specific products to narrow or
expand the scope of the graph.

6. From the Node Type menu, select or deselect specific node types to narrow or
expand the focus of the graph.

7. From the Options menu, you can save or print the image, expand or collapse all of
the nodes, change the orientation of the topology to be left to right or top to
bottom, or reload the routing navigator.
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In addition, you can refresh the status and the metrics or update the topology. To
refresh the status and metrics, click Refresh Target Status and Metrics. To update
the topology shown in the viewer, click Recreate Topology. If a target has been
added or deleted, the target list and relationships are updated. This option also
updates the status and metrics.

8. With Topology Viewer, you can also:

Search for specific target or node or type of target or node within the topology
with the Toggle Find Toolbar widget from the toolbar at top of the page. This
makes it easier to find a target if you have many targets. After the target is
found, it is highlighted in the topology and the topology is repositioned. This
enables you to see the target, if it was not previously visible in the viewing
area.

View the targets by status. Choose Show Up Targets, Show Down Targets,
Show Targets with Fatal Incidents, and Show Targets with Critical Incidents
from the toolbar at top of the page.

Navigate to the home page of a target. Right-click the target, and choose
Home.

Hide or show the status or metrics. From the Annotations menu, choose
Status or Metrics.

If you select Metrics, one key performance metric for the component is
displayed. (You cannot change the metric that is displayed.)

View the routing relationships between components.

Perform operations directly on the target by right-clicking. The right-click
target menu is displayed.

9. Interact with a topology graph.

For more information, see "Interactive Gestures" in the Cloud Control online help.

9.12 Viewing the Configuration Topology of an Oracle Fusion
Applications Instance, Product Family, or Product

With Cloud Control, you can view the configuration topology of the IT environment in
a graphical format for the Fusion instance, product family, or individual product. The
inter-relationships between targets are used to answer questions such as:

= On what targets does this target rely?

= What targets will be affected if this target goes down?

= How are the members of my system related?

To view a configuration topology:

1. Navigate to a Fusion Instance, product family, or product home page:

a.

From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

In the table on the Fusion Applications page, click the appropriate target, the
instance for the Oracle Fusion Applications or product family. You can also
expand a product family to select an individual product.

2. From the Fusion Instance, Product Family, or Product menu, choose
Configuration > Topology.
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The Configuration Topology page displays.

From the View menu, choose one of the following topology views:

Routing: Group by Application: Choose to view the topology of the
applications as they relate to the Oracle WebLogic Server domains and servers,
as well as the Oracle Database.

Routing: Group by Middleware: Choose to view the topology for the
middleware targets, such as Oracle WebLogic Server.

Routing: Group by Host: Choose to view the topology of the targets on the
hosts in the enterprise.

Products: Choose this view the topology of Oracle Fusion Applications
products.

Use the configuration topology:

View existing configuration topologies. See "Viewing a Configuration
Topology" in the Cloud Control online help.

Create custom configuration topologies. See "Creating a Custom Topology
View" in the Cloud Control online help
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Monitoring the Oracle Fusion Applications
Middle Tier

This chapter describes how to monitor the middle tier using Oracle Enterprise
Manager Fusion Applications Control (Fusion Applications Control) and Oracle
Enterprise Manager (Cloud Control).

This chapter includes the following topics:
s Introduction to Monitoring the Middle Tier
= Monitoring and Viewing Performance Status of Oracle Fusion Middleware

= Monitoring System Performance Metrics for a Fusion Instance, Product Family, or
a Product

= Monitoring Performance for Key Oracle Fusion Middleware Components with
Fusion Applications Control

s Performing Proactive Performance Monitoring with Cloud Control
» Tuning Middle Tiers for Oracle Fusion Applications

The procedures referenced in the Oracle Fusion Middleware guides describe using
Fusion Middleware Control. These procedures also apply to Fusion Applications
Control.

10.1 Introduction to Monitoring the Middle Tier

Both Oracle Enterprise Manager Fusion Applications Control (Fusion Applications
Control) and Oracle Enterprise Manager Cloud Control (Cloud Control) automatically
and continuously measure run-time performance. The performance metrics are
automatically enabled; you do not need to set options or perform any extra
configuration to collect them.

You can monitor the following aspects of the middle tier with this control:

= Monitor the state and performance of the Oracle Fusion Applications products and
applications and an Oracle Fusion Middleware targets by providing out-of-the-box
performance metrics

= Monitor CPU usage, heap usage, Work Manager, JMS servers, and JDBC and JTA
usage for Oracle WebLogic Server

= Monitor JVM performance in terms of heap versus non-heap usage, garbage
collection, and threads performance

= Monitor applications and web services deployed to an Oracle WebLogic Server
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Monitor a wide range of application metrics for servlets, JSPs, and E]Bs are
available, as well as web services metrics for faults, invocations, and violations.
Such metrics are accessible from a target's home page.

Access customizable performance summary pages to help administrators monitor
performance and diagnose problems. These charts can be modified to display
content that is relevant to your domain. A target or component might be added to
the chart so that you can compare the performance information for two targets in
one chart.

You can also monitor a specific set of metrics for performance tuning information.
With Cloud Control, you can also view historical data. See Section 10.5 for more
specific information about usage of Cloud Control.

Use the following sections for specifics on using Fusion Applications Control:

Section 10.2, "Monitoring and Viewing Performance Status of Oracle Fusion
Middleware"

Section 10.3, "Monitoring System Performance Metrics for a Fusion Instance,
Product Family, or a Product”

Section 10.5, "Performing Proactive Performance Monitoring with Cloud Control"

Use the following sections for specifics on using Cloud Control:

Section 10.2, "Monitoring and Viewing Performance Status of Oracle Fusion
Middleware"

Section 10.3, "Monitoring System Performance Metrics for a Fusion Instance,
Product Family, or a Product”

Section 10.4, "Monitoring Performance for Key Oracle Fusion Middleware
Components with Fusion Applications Control"

10.2 Monitoring and Viewing Performance Status of Oracle Fusion

Middleware

Monitoring the health of the underlying Oracle Fusion Middleware environment and
ensuring that it performs optimally is an important task.

This section contains the following topics:

Viewing the General Status of Oracle Fusion Middleware Components for a
Product Family

Viewing the Detailed Status of Oracle Fusion Middleware Components for a
Product Family

Viewing the Routing Topology of Oracle Fusion Middleware
Viewing the Performance of an Oracle WebLogic Server

Monitoring the System Performance of Oracle Fusion Applications Deployed to a
Cluster

10.2.1 Viewing the General Status of Oracle Fusion Middleware Components for a

Product Family

You can view the overall status of the underlying Oracle Fusion Middleware
components from the home page of the product family.

To view the general status with either Fusion Applications Control or Cloud Control:
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1. Navigate to a product family home page:

s From Fusion Applications Control, in the navigation pane, select the product
family.

s From Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, click the
appropriate Product Family target.

2. View the Applications and Infrastructure section. The following figure shows an
example of the tab from Fusion Applications Control.

=l Applications and Infrastructure By
Database Instance URL jdbe: oraclethin:@(DESCRIPTION=(ADDRESS_LIST={ADDRESS=

(PROTOCOL=TCP)(HOST=host.example.com)PORT=1521)))
(CONNECT_DATA=(SERVICE_NAME=sales example comyINSTANCE_NAME=sales)))

Fusion Applications Fusion Middleware

@Up (2} @ Cown (7) @Up (11}

The pie charts in the Fusion Middleware section displays the percentage of Oracle
Fusion Middleware components that are currently up or down.

10.2.2 Viewing the Detailed Status of Oracle Fusion Middleware Components for a
Product Family

You can view the detailed status of Oracle Fusion Applications and Oracle Fusion
Middleware components, including the Administration Server and the Managed
Servers in the Oracle WebLogic Server domain and specific Oracle Fusion Middleware
components.

To view detailed status with Oracle Fusion Middleware components:
1. Navigate to a product family home page:

s From Fusion Applications Control, from the navigation pane, select the
product family.

s From Cloud Control:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, click the
appropriate Product Family target.

2. From the Product Family menu, choose Applications and Infrastructure.

3. From the Applications and Infrastructure page, click the Fusion Middleware tab.
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This tab shows the status of the various components, associated host, and the
percentage of CPU that is being used the component. The following figure shows

an example of the tab from Fusion Applications Control.

Applications and Infrastructure

Fusion Applications Application Dependencies

Mame Status

= [ Weblogic Domain
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5 AdminServer

=l Bl E35Cluster
WDown (13) WU (13) 5 ess_serverl
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= ;@, FinancialZommonCluster
5 FinancialCommonSeryver_1
= ;@, FinancialCommonClusker_1
5 FinancialCommonSeryer_1_1
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4. Select a specific component to gain more insight.

For example, if you select the Oracle WebLogic Server domain, Fusion

Host

examole.com

examole.com

examole.com

examole.com

examole.com

Applications Control directs you to the domain home page. This page shows the

following.

= A general summary of the domain, along with a link to the Oracle WebLogic

Server Administration Console

s Information about the servers, both the Administration Server and the
Managed Servers in the domain

s Information about the clusters in the domain

= Information about the deployments in the domain

10.2.3 Viewing the Routing Topology of Oracle Fusion Middleware

This section contains the following topics:

= Viewing the Routing Topology of Oracle Fusion Middleware Using Fusion
Applications Control

= Viewing the Routing Topology of Oracle Fusion Middleware Using Cloud Control

10.2.3.1 Viewing the Routing Topology of Oracle Fusion Middleware Using Fusion

Applications Control

Fusion Applications Control provides a Topology Viewer for the farm. The Topology
Viewer is a graphical representation of routing relationships across components and

elements of the farm. You can easily determine how requests are routed across
components.

The Topology Viewer enables you to easily monitor your Oracle Fusion Applications

environment. You can see which entities are up and which are down.
You can also print the topology or save it to a .png file.

To view the topology with Fusion Applications Control:
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Click Topology.
The Topology Viewer is displayed in a separate window.

From the View menu, choose Routing: Group By Application to view the
topology of applications or choose Routing: Group by Middleware to view the
topology for the middleware.

To see information about a particular target, place your mouse over the target. To
view additional information, click More. The following figure shows additional
information for the LedgerApp target.
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From the Options menu, you can save or print the image, expand or collapse all of
the nodes, change the orientation of the topology to be left to right or top to
bottom, or show and hide the routing navigator.

In addition, you can refresh the status and the metrics or update the topology. To
refresh the status and metrics, click Refresh Target Status and Metrics. To update
the topology shown in the viewer, click Recreate Topology. If a target has been
added or deleted, the target list and relationships are updated. This option also
updates the status and metrics.

With Topology Viewer, you can also:

= Search for a target within the topology. This makes it easier to find a target if
you have many targets. Enter the name in the Find box. The target is
highlighted and the topology is repositioned so you can see the target if it was
not previously visible in the viewing area.

You can also specify criteria for the search. From Find, choose the one or more
types of Status or one or more of Target Type, or both.

= View the targets by status. Choose Up, Down, or Unknown from the Target
Status at the top of the page.

= Navigate to the home page of a target. Right-click the target, and choose
Home.
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s Hide or show the status or metrics. From the Annotations menu, choose
Status or Metrics.

If you select Metrics, one key performance metric for the component is
displayed. (You cannot change the metric that is displayed.)

= View the routing relationships between components.

= Perform operations directly on the target by right-clicking. The right-click
target menu is displayed.

6. To change what is visible in the topology view, drag the shaded section in the
navigator window, which is located in the bottom right.

Notes:

= If you use Mozilla Firefox, when you click an entity in Topology
Viewer to take you back to the main Fusion Applications Control
window, focus is not returned to the main window. For example,
if you right-click an entity and choose logs from menu, the focus
remains on the Topology Viewer window. (If you go back to the
main window, the Logs page is correctly displayed.)

To workaround this problem, make the following change in
Firefox:

From the Tools menu, choose Options, and then Content. Click
Advanced. In the Advanced JavaScript Settings dialog box, select
Raise and lower windows.

= If you use Internet Explorer, turn off the Always Open Popups in
New Tab option.

10.2.3.2 Viewing the Routing Topology of Oracle Fusion Middleware Using Cloud
Control

See Section 9.11.

10.2.4 Viewing the Performance of an Oracle WebLogic Server

See the following resources in the Oracle Fusion Middleware Administrator’s Guide to
monitor the Oracle WebLogic Server:

= "Monitoring an Oracle WebLogic Server" section to view the status of a domain,
including the servers, clusters, and deployments in the domain

= "Monitoring an Oracle WebLogic Server Administration or Managed Server"
section to view the status of a WebLogic Server Administration Server or Managed
Server in Fusion Applications Control

= "Monitoring a Cluster" section to view the status of a cluster, including the servers
and deployments in the cluster

For information on locating specific metrics to monitor, see Section 10.4.4.1.
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10.2.5 Monitoring the System Performance of Oracle Fusion Applications Deployed to a

Cluster

During installation, Oracle Fusion Applications automatically deploys each
application to a Managed Server in a cluster. For each Managed Server in the cluster,
there is an instance of the application on each Oracle WebLogic Server.

There are times when you want to monitor the system performance of the application
on an individual server, and times when you want to monitor the overall performance
of the application across all the servers in the cluster.

For example, normally, you would manage the overall performance of the application
to determine if there are any performance issues affecting all users of the application,
regardless of which instance users access. If you notice a performance problem, you
can then drill down to a specific instance of the application to determine if the problem
is affecting one or all of the application instances in the cluster. Cloud Control and
Fusion Applications Control provides monitoring pages for both of these scenarios.

This section contains the following topics:

= Monitoring the Performance of Oracle Fusion Applications Cluster Applications
Using Fusion Applications Control

= Monitoring the Performance of Oracle Fusion Applications Cluster Applications
Using Cloud Control

= Monitoring the Performance of Oracle Fusion Applications Cluster Applications
Using Fusion Applications Control

= Monitoring the Performance of Oracle Fusion Application Instances Using Fusion
Applications Control

10.2.5.1 Monitoring the Performance of Oracle Fusion Applications Cluster
Applications Using Fusion Applications Control

To monitor the overall performance of the Oracle Fusion Applications cluster
applications with Fusion Applications Control:

1. From the navigation pane, expand the product family, then Fusion Applications.

Fusion Applications Control lists the applications deployed in the current domain,
as shown in the following figure:

Bl Financials
[ Products
= [ Fusion Applications
@ Financial Commondpp
FscmAnalyticsapp
Ledgerapp
Pavableshpp
@ Receivablesipp
=1 & Farm_FinancialDomain

2. Monitor the overall performance of the applications on a cluster by clicking the
cluster application name, for example, PayablesApp.
The Fusion Cluster Application page displays.

3. View performance metrics. From the Fusion Cluster Application menu, choose
Performance Summary.

The Performance Summary page displays. For more information about using this
page, see Section 2.5.7.
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10.2.5.2 Monitoring the Performance of Oracle Fusion Applications Cluster
Applications Using Cloud Control

To monitor the overall performance of the Oracle Fusion Applications cluster
applications with Cloud Control:

1. Navigate to a product family home page:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications page, click the appropriate Product
Family target.

2. From the navigation pane, expand Fusion Applications.

Cloud Control lists the applications deployed in the current domain, as shown in
the following figure:

“/ |Z| |Dracle Fusion Financials
L= [ products
W [ Fusion Applications
[= '@ FinancialZommaonApp
[= @ FinancialsEssApp
L= @ Ledgerspp
[= '@ Pavablesipp
[= @ Receivablesfpp

3. Monitor the overall performance of the applications on a cluster by clicking the
cluster application name, for example, PayablesApp.

The Fusion Cluster Application page displays.

4. View performance metrics. From the Fusion Cluster Application menu, choose
Monitoring > Performance Summary.

The Performance Summary page displays. For more information about using this
page, see the topic "Using Performance Summary" in the Cloud Control online
help.

5. From the Performance Summary page, you can optionally click on a metric name.

The Additional Information dialog displays. From this dialog, you can view more
details about the metric with the following links:

= Problem Analysis: Directs to the Problem Analysis page. This page enables
you to see a metric with other related metrics, which are affecting the metrics
being analyzed. It also shows the related targets and the related targets
topology. The Problem Analysis is only available for request-related metrics,
such as the Request Processing Time (ms) and Request (per minute).

= Analyze Logs: Displays a message that enables you to view the logs for a
target on which the metric is viewed.

= Metric Details: Enables you view historical metric data.
s Target Home: Directs you to the home page.

When used together, Problem Analysis and Analyze Logs can help you inspect
metrics, target status information, and logs during troubleshooting. These links are
not available for all metrics. For more information about these links, see

Section 14.4.6.
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10.2.5.3 Monitoring the Performance of Oracle Fusion Application Instances Using
Fusion Applications Control
To monitor a specific instance of the application with Fusion Applications Control:

1. From the navigation pane, expand the product family, then Fusion Applications.

2. Expand the cluster application you want to monitor to show each instance of the
application, as shown in the following figure:

El [] Financials
[ Products
[= [ Fusion Applications
FinancialCommondpp
Fsemanalyticsdpp
@ Ledgerfpp
= @ Payablesfpp
PayablesApp (PayableServer 1)1
Receivablesipp
= % Farm_FinancialDomain

3. Monitor the overall performance of an application instance in cluster by clicking
one of the application deployment instances, for example, PayablesApp
(PayablesSever_1).

The Fusion J2EE Application page displays.

4. View performance metrics. From the Fusion J2EE Application menu, choose
Performance Summary.

The Performance Summary page displays. For more information about using this
page, see Section 2.5.7.

10.2.5.4 Monitoring the Performance of Oracle Fusion Application Instances Using
Cloud Control
To monitor a specific instance of the application with Cloud Control:

1. Navigate to a product family home page:
a. From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

b. In the table on the Fusion Applications target home page, click the appropriate
Product Family target.

2. From the navigation pane, expand the product family, then Fusion Applications.

3. Expand the cluster application you want to monitor to show each instance of the
application, as shown in the following figure:

W & orade Fusion Financials

= [ Products

%[22 Fusion applications
[= ﬁ FinancialZarmmaondpp
[= ﬁ FinancialsEssapp
[= @ Ledgerfpp
W ﬁ Payablesipp

% PayablesApp (PayableServer 1)

[= ﬁ Receivablesapp
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4. Monitor the overall performance of an application instance in cluster by clicking

one of the application deployment instances, for example, PayablesApp
(PayablesSever_1).

The Fusion J2EE Application page displays.

View performance metrics. From the Fusion J2EE Application menu, choose
Performance Summary.

The Performance Summary page displays. For more information about using this
page, see the topic "Using Performance Summary" in the Cloud Control online
help.

From the Performance Summary page, you can optionally click on a metric name.

The Additional Information dialog displays. From this dialog, you can view more
details about the metric with the following links:

s Problem Analysis: Directs to the Problem Analysis page. This page enables
you to see a metric with other related metrics, which are affecting the metrics
being analyzed. It also shows the related targets and the related targets
topology. The Problem Analysis is only available for request-related metrics,
such as the Request Processing Time (ms) and Request (per minute).

= Analyze Logs: Displays a message that enables you to view the logs for a
target on which the metric is viewed.

= Metric Details: Enables you view historical metric data.
s Target Home: Directs you to the home page.

When used together, Problem Analysis and Analyze Logs can help you inspect
metrics, target status information, and logs during troubleshooting. These links are
not available for all metrics. For more information about these links, see

Section 14.4.6.

10.3 Monitoring System Performance Metrics for a Fusion Instance,
Product Family, or a Product

If you encounter a problem, such as a product running slowly or hanging, you can
view more detailed performance information, including aggregate system
performance metrics for all the product families or an individual product family. You
can also view metrics specific to a particular product, to find out more information
about the problem. You can only view aggregate system performance metrics for all
the product families with Cloud Control.

This section contains the following topics:

Monitoring System Performance Metrics for a Product Family or a Product with
Fusion Applications Control

Monitoring System Performance Metrics for a Fusion Instance, Product Family, or
a Product with Cloud Control

10.3.1 Monitoring System Performance Metrics for a Product Family or a Product with
Fusion Applications Control

With Fusion Applications Control, you can view detailed aggregate system
performance metrics for the product family or view metrics specific to a particular
product.
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To view the performance metrics for the product family with Fusion Applications

Control:

1. From the navigation pane, select the name of the product family.

2. From the Product Family menu, choose System Performance Summary.

The System Performance page displays. For more information about using this
page, see Section 2.5.7.

To view the performance metrics for a particular product with Fusion Applications

Control:

1. From the navigation pane, expand the product family, then Products.

2. Select the product you want to monitor.

3. From the Product menu, choose System Performance Summary.

The System Performance page displays. For more information about using this
page, see Section 2.5.7.

10.3.2 Monitoring System Performance Metrics for a Fusion Instance, Product Family,
or a Product with Cloud Control

With Cloud Control, you can view aggregate system performance metrics for all the
product families by monitoring the Fusion instance or an individual product family.
You can also view metrics specific to a particular product.

To view the performance metrics for the product family with Cloud Control:

1. Navigate to a Fusion Instance, product family, or product home page:

a.

From the Targets menu, choose Fusion Applications.
The Fusion Applications target home page displays.

In the table on the Fusion Applications target home page, click the appropriate
target, the instance for the Oracle Fusion Applications or product family. You
can also expand a product family to select an individual product.

2. From the Fusion Instance, Product Family, or Product menu, choose Monitoring
> System Performance.

The Performance Summary page displays. For more information about using this
page, see the topic "Using Performance Summary" in the Cloud Control online
help.

3. From the Performance Summary page, you can optionally click on a metric name.

The Additional Information dialog displays. From this dialog, you can view more
details about the metric with the following links:

Problem Analysis: Directs to the Problem Analysis page. This page enables
you to see a metric with other related metrics, which are affecting the metrics
being analyzed. It also shows the related targets and the related targets
topology. The Problem Analysis is only available for request-related metrics,
such as the Request Processing Time (ms) and Request (per minute).

Analyze Logs: Displays a message that enables you to view the logs for a
target on which the metric is viewed.

Metric Details: Enables you view historical metric data.

Target Home: Directs you to the home page.
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When used together, Problem Analysis and Analyze Logs can help you inspect
metrics, target status information, and logs during troubleshooting. These links are
not available for all metrics. For more information about these links, see

Section 14.4.6.

10.4 Monitoring Performance for Key Oracle Fusion Middleware
Components with Fusion Applications Control

Monitoring Oracle Fusion Middleware performance involves monitoring any Oracle
WebLogic Server Managed Servers for a component and as available, performance
metrics. The Oracle Fusion Middleware layer of Oracle Fusion Applications
automatically and continuously measures run-time performance for middle tier
components. Use Table 10-1 to find information on where to find related
documentation for the main Oracle Fusion Middleware components in most Oracle
Fusion Applications environments. As mentioned previously in this chapter,
references to Fusion Middleware Control in the Oracle Fusion Middleware documents
apply to Fusion Applications Control.

Table 10-1 Monitoring Oracle Fusion Middleware Components

Component

Documentation

Oracle Business Intelligence Suite

Status of an Oracle WebLogic Server Managed Server for Oracle
Business Intelligence Suite: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.
Performance metrics: "Monitoring Service Levels" section in the Oracle

Fusion Middleware System Administrator’s Guide for Oracle Business
Intelligence Enterprise Edition

Oracle Enterprise Content Management
Suite, Content Server

Status of an Oracle WebLogic Server Managed Server for Content
Server: "Monitoring an Oracle WebLogic Server Administration or
Managed Server" section in the Oracle Fusion Middleware
Administrator’s Guide for instructions on accessing the server home
page. Specifically, review the Summary section of the page.

Performance Metrics: "Viewing Performance Information for Oracle
Content Server" section in the Oracle WebCenter Content System
Administrator’s Guide for Content Server

Oracle Enterprise Crawl and Search
Framework

Performance metrics: Section 10.4.1

Oracle Enterprise Scheduler Service

Status of an Oracle WebLogic Server Managed Server for Oracle
Enterprise Scheduler: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.
Performance metrics: Section 10.4.2.4 and Section 10.4.4.3

Oracle Identity Management, Oracle Access
Manager

Status of an Oracle WebLogic Server Managed Server for Oracle
Access Manager: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.
Performance metrics: "Viewing Performance in Fusion Middleware

Control" section in the Oracle Fusion Middleware Administrator’s Guide
for Oracle Access Manager with Oracle Security Token Service
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Table 10-1 (Cont.) Monitoring Oracle Fusion Middleware Components

Component

Documentation

Oracle Identity Management, Oracle Identity
Manager

Status of an Oracle WebLogic Server Managed Server for Oracle
Identity Management: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.

Performance metrics: Section 10.4.3

Oracle Identity Management, Oracle Internet
Directory

Status of an Oracle WebLogic Server Managed Server for Oracle
Identity Management: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.
Performance Metrics: "Monitoring Oracle Internet Directory" in the

Oracle Fusion Middleware Administrator's Guide for Oracle Internet
Directory

Oracle Identity Management, Oracle Virtual
Directory

Status of an Oracle WebLogic Server Managed Server for Oracle
Virtual Directory: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.
Performance Metrics: "Monitoring Oracle Virtual Directory Using

Fusion Middleware Control Metrics" in the Oracle Fusion Middleware
Administrator’s Guide for Oracle Virtual Directory

Oracle SOA Suite

Performance metrics: "Monitoring Processing Requests" section in the
Oracle Fusion Middleware Administrator’s Guide for Oracle SOA Suite and
Oracle Business Process Management Suite and Section 10.4.4.2

Oracle WebCenter Portal

Status of an Oracle WebLogic Server Managed Server for Oracle
WebCenter Portal: "Monitoring an Oracle WebLogic Server
Administration or Managed Server" section in the Oracle Fusion
Middleware Administrator’s Guide for instructions on accessing the
server home page. Specifically, review the Summary section of the

page.
Performance metrics: "Monitoring Oracle WebCenter Performance”

section in the Oracle Fusion Middleware Administrator’s Guide for Oracle
WebCenter Portal

Oracle Web Tier, Oracle HTTP Server

Performance metrics: "Monitoring Oracle HTTP Server Performance"
section in the Oracle Fusion Middleware Administrator’s Guide for Oracle
HTTP Server

Oracle WebLogic Server

Section 10.2.4 and Section 10.4.4.1

The section contains the following topics:

= Monitoring Oracle Enterprise Crawl and Search Framework

= Monitoring the Performance of a Single Oracle Enterprise Scheduler Instance

= Monitoring Oracle Identity Manager Performance Metrics

s Locating Key Performance Metrics for Specific Components
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10.4.1 Monitoring Oracle Enterprise Crawl and Search Framework

Fusion Applications Control automatically and continuously measures the runtime
performance of Oracle Enterprise Crawl and Search Framework. If you encounter a
problem, you can view the performance metrics to find out more information about
the problem.

To monitor performance metrics for Oracle Enterprise Crawl and Search Framework
with Fusion Applications Control:

1. From the navigation pane, expand Enterprise Crawl and Search Framework.

2. Select the Oracle Enterprise Crawl and Search Framework application for the
product family.

3. From the Enterprise Crawl and Search Framework menu, choose Performance
Summary to view detailed performance metrics.

The Performance Summary page displays. For more information about using this
page, see Section 2.5.7.

10.4.2 Monitoring the Performance of a Single Oracle Enterprise Scheduler Instance

You can monitor the performance of an Oracle Enterprise Scheduler instance,
specifically current and historical performance data, as well as a summary of all
performance data. Performance data displays in a chart set, which you save, delete
and reorder. Additionally, you can modify the time period for which performance data
displays.

This section contains the following topics:

= Viewing a Summary of Oracle Enterprise Scheduler Activity
s Viewing Current Oracle Enterprise Scheduler Activity

= Viewing Historical Oracle Enterprise Scheduler Reports

= Viewing Oracle Enterprise Scheduler Metrics

= Managing Chart Sets

= Selecting the Performance Time Period

10.4.2.1 Viewing a Summary of Oracle Enterprise Scheduler Activity

The Oracle Enterprise Scheduler Performance Summary page displays current charts
of job requests such as requests completed per hour, running requests, requests by
processing time and requests by status.

To view a summary of Oracle Enterprise Scheduler activity:
1. From the Scheduling Service menu, choose Performance > Service Summary.

By default, this page displays job requests running during a selected time period
in the following categories:

= Requests completed per hour
= Processing times, average, minimum and maximum
= Running requests and maximum running requests

= Requests over the past hour with the status SUCCESS, WARNING, ERROR or
CANCEL.
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You can change the metrics displayed on the Service Summary performance page.
Click the Show Metric Palette button to display the metric palette for Oracle
Enterprise Scheduler.

2. You can change the duration for which performance data display.

3. Optionally, you can change the display format of performance data on the page.
Choose View > Grid to remove the grid display format from the charts.
Click the Table View link to display the performance data in table format.

4. You can overlay an additional scheduler service over the current service
performance metrics.

a. Choose Overlay > Another Scheduler Service.

In the Search and Select: Targets window, enter the name of the target and host
server and click Go to search for the relevant service.

b. From the search results table, select the relevant service and click Select to
choose the scheduler service to overlay.

5. Additionally, you can take any of the following actions.
m  Save the chart set, as described in Section 10.4.2.5.1.
m  Reorder the chart set, as described in Section 10.4.2.5.3.
s Revert to an old chart set, as described in Section 10.4.2.5.4.

s Delete a chart set, as described in Section 10.4.2.5.2.

10.4.2.2 Viewing Current Oracle Enterprise Scheduler Activity

The Oracle Enterprise Scheduler Current Activity page displays pending and running
requests by user and application.

To view current Oracle Enterprise Scheduler activity:
1. From the Scheduling Service menu, choose Performance > Current Activity.

2. You can view pending and running requests by user or application, or workload
by work assignment.

To view pending and running requests by user, choose View > Requests By User.

To view pending and running requests by application, choose View > Requests
By Application.

To view workloads by work assignment, choose View > Workload By Work
Assignment. For more information about work assignment details, see the
"Creating or Editing a Work Assignment" section in the Oracle Fusion Middleware
Administrator’s Guide for Oracle Enterprise Scheduler.

10.4.2.3 Viewing Historical Oracle Enterprise Scheduler Reports

The Oracle Enterprise Scheduler Historical Reports page displays completed job
requests by user, application and work assignment.

To view historical Oracle Enterprise Scheduler reports:
1. From the Scheduling Service menu, choose Performance > Historical Reports.
2. From the View list, choose one of the following report views:

s Completed Request Statistics By Job Name
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s Completed Request Statistics By User
= Request Metrics By Work Assignment
s Completed Request Statistics
3. Adjust the filter criteria as required. The filter criteria vary depending on the

report view you choose.

Table 10-2 Completed Request Statistics by Job Name

Filter Criterion What to Do...
Application From the list, choose the application whose statistics you want to view.
Minimum Run Time Enter the shortest run time period for jobs whose statistics you want to view. Use the

text field to enter a number, and select a unit of time from the list: Seconds, Minutes,
Hours or Days.

Completed between Use the calendar icons on either side of the text fields to select a start and end date
and time.

Table 10-3 Completed Request Statistics by User

Filter Criterion What to Do...

Application From the list, choose the application whose statistics you want to view.

Minimum Total Run Time Enter the shortest total time period for jobs whose statistics you want to view. Use the
text field to enter a number, and select a unit of time from the list: Seconds, Minutes,
Hours or Days.

Completed between Use the calendar icons on either side of the text fields to select a start and end date
and time.

Table 10-4 Request Metrics By Work Assignment

Filter Criterion What to Do...
Application From the list, choose the application whose statistics you want to view.
Completed after Use the calendar icon to choose the date and time after which the work assignment

has completed.

Table 10-5 Completed Request Statistics

Filter Criterion What to Do...

Application From the list, choose the application whose statistics you want to view.

Completed between Use the calendar icons on either side of the text fields to choose a start and end date
and time.

4. Click Go to search for and display the historical data.

10.4.2.4 Viewing Oracle Enterprise Scheduler Metrics

You can view performance metrics for specific components of Oracle Enterprise
Scheduler. Each set of metrics displays performance data that is relevant to the
component.

To view Oracle Enterprise Scheduler performance metrics:
1. From the Scheduling Service menu, choose Performance > Service Summary.

2. Click Key Performance Indicators.
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3. Click Show Metric Palette and select the metrics you want to display for each
component.

10.4.2.5 Managing Chart Sets

You can save or delete the chart set displayed in the Oracle Enterprise Scheduler
Performance Summary page. You can also re-organize the order of a chart and revert
to an old chart set.

This section contains the following topics:

= Saving a Chart Set

s Deleting a Chart Set

= Reordering Charts

= Reverting to an Old Chart Set

10.4.25.1 Saving a Chart Set You can save the chart set displayed in the Oracle
Enterprise Scheduler Performance Summary page. Saving a chart set allows

preserving a specific set of metrics selected for display, as opposed to the default
metrics.

To save a chart set:

1. Display the Oracle Enterprise Scheduler Performance Summary page.

2, Choose View > Save Chart Set.

3. Inthe Save Chart Set dialog box, enter a name for the chart set and click OK.

4. Once you have saved the chart set, you can display it by choosing Chart Set > My
Chart Set.

10.4.2.5.2 Deleting a Chart Set You can delete saved chart set files created in the Oracle

Enterprise Scheduler Performance Summary page.

To delete a chart set:

1. Display the Oracle Enterprise Scheduler Performance Summary page.

2. Choose View > Delete Chart Sets.

3. In the Delete Chart Sets dialog box, select the name of the chart set to be deleted
and click OK.

10.4.2.5.3 Reordering Charts You can organize the display of performance charts in the
Oracle Enterprise Scheduler Performance Summary page. Charts can be moved up or
down, or removed entirely.

To reorder chart sets:
1. Display the Oracle Enterprise Scheduler Performance Summary page.
2. Choose View > Reorder Charts.

3. In the Reorder Charts popup window, select the chart you want to move and click
Move Up or Move Down, respectively.

To delete a chart from the Performance Summary page, select the chart and click
Delete.

4. Click OK.
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10.4.2.5.4 Reverting to an Old Chart Set If you have re-organized your chart sets, you can
can revert to the chart set as you had originally saved it.

To revert chart sets:
1. Display the Oracle Enterprise Scheduler Performance Summary page.
2. From the Chart Set list, choose the chart you want to revert to its original display.

3. Choose View > Revert Chart Set.

10.4.2.6 Selecting the Performance Time Period

In the Oracle Enterprise Scheduler Performance Summary page, you can change the
time period for which the performance summary displays.

To select the performance time period:
1. Display the Oracle Enterprise Scheduler Performance Summary page.
2. Change the duration for which job requests display.
= AllL Click to display all job requests within a specified, finite period.
= 2 hours: Click to display all job requests within the past two hours.
= 15 minutes: Click to display all job requests within the past fifteen minutes.

= Slider: Click to display a slider that enables scrolling horizontally to show job
requests from a specified period. The slider defaults to whichever time
segment is selected, all, 2 hours, or 15 minutes.

s Calendar: Click the calendar icon to select a time period for which you want to
display job requests.

10.4.3 Monitoring Oracle Identity Manager Performance Metrics

To monitor performance metrics for Oracle Identity Manager with Fusion Applications
Control:

1. From the navigation pane, expand Identity and Access and OIM.

2. Select the Oracle Identity Management server.

3. From the Oracle Identity Management home page, view the overall metrics.
4

From the Oracle Identity Manager menu, choose Performance Summary to view
detailed performance metrics.

The Performance Summary page displays. For more information about using this
page, see Section 2.5.7.

10.4.4 Locating Key Performance Metrics for Specific Components

For each component in the Oracle Fusion Applications environment, there are
performance metrics. This section helps you locate the key performance metrics
related to software monitoring and configuration.

This section contains the following topics:
= Monitoring Key Performance Metrics for Oracle WebLogic Server
= Monitoring Key Performance Metrics for Oracle SOA Suite

= Monitoring Key Performance Metrics for Oracle Enterprise Scheduler
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10.4.4.1 Monitoring Key Performance Metrics for Oracle WebLogic Server
Use Table 10-6 to locate the key performance metrics for Oracle WebLogic Server.

Table 10-6 Oracle WebLogic Server Key Performance Metrics

Category Metric Name Location in Fusion Applications Control
JMS Messages Pending 1. From the navigation pane, expand the farm, then WebLogic
. Domain, and then the domain.
Messages Received
2. Expand the Managed Server.
The Managed Server home page displays.
3. From the WebLogic Server menu, choose Performance
Summary.
4. From the Performance Summary page, click Show Metric Palette.
5. From the Metric Palette, expand the JMS Server Metrics folder.
6. Select the metrics to view the charts.
JDBC Available Connections 1. From the navigation pane, expand the farm, then WebLogic
. Domain, and then the domain.
Connection Leaks (per
minute) 2. Expand the Managed Server.
Connection Pool Size The Managed Server home page displays.
Connection Requests 3. From the WebLogic Server menu, choose Performance
(per minute) Summary.
Connections Requests 4. From the Performance Summary page, click Show Metric Palette.
Waiting 5. From the Metric Palette, expand the Datasource Metrics folder.
Connections in Use 6. Select the metrics view the charts.
JVM Memory  Heap Usage (MB) 1. From the navigation pane, expand the farm, then WebLogic
Non Heap Usage (MB) Domain, and then the domain.
2. Expand the Managed Server.
The Managed Server home page displays.
3. From the WebLogic Server menu, choose JVM Performance.
4. In the Memory section, view the charts.
JVM Garbage  Collections (per minute) 1. From the navigation pane, expand the farm, then WebLogic
Collections Domain, and then the domain.
2. Expand the Managed Server.
The Managed Server home page displays.
From the WebLogic Server menu, choose JVM Performance.
4. In the Memory section, view the Collections (per minute) in the
Garbage Collectors table.
Heap Usage (%) 1. From the navigation pane, expand the farm, then WebLogic
Domain, and then the domain.
2. Expand the Managed Server.
The Managed Server home page displays.
3. From the WebLogic Server menu, choose Performance
Summary.
4. From the Performance Summary page, click Show Metric Palette.
From the Metric Palette, expand the JVM Metrics folder.
6. Select the metric to view the chart.
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Table 10-6 (Cont.) Oracle WebLogic Server Key Performance Metrics

Category Metric Name

Location in Fusion Applications Control

Oracle CPU Usage (%)

WebLogic Active Threads
Server

1.

o a &

From the navigation pane, expand the farm, then WebLogic
Domain, and then the domain.

Expand the Managed Server.
The Managed Server home page displays.

From the WebLogic Server menu, choose Performance
Summary.

From the Performance Summary page, click Show Metric Palette.
From the Metric Palette, expand the JVM Metrics folder.

Select the metric to view the chart.

Deadlocked Threads

-

o a &

From the navigation pane, expand the farm, then WebLogic
Domain, and then the domain.

Expand the Managed Server.
The Managed Server home page displays.

From the WebLogic Server menu, choose Performance
Summary.

From the Performance Summary page, click Show Metric Palette.
From the Metric Palette, expand the JVM Threads folder.

Select the metric to view the chart.

Threads

From the navigation pane, expand the farm, then WebLogic
Domain, and then the domain.

Expand the Managed Server.
The Managed Server home page displays.
From the WebLogic Server menu, choose JVM Performance.

View the thread metrics in the Threads section.

Server Work Work Manager Pending
Manager Requests

Work Manager Requests
(per minute)

Work Manager Stuck
Threads

From the navigation pane, expand the farm, then WebLogic
Domain, and then the domain.

Expand the Managed Server.
The Managed Server home page displays.

From the WebLogic Server menu, choose Performance
Summary.

From the Performance Summary page, click Show Metric Palette.
From the Metric Palette, expand the Work Manager folder.

Select the metrics to view the charts.

10.4.4.2 Monitoring Key Performance Metrics for Oracle SOA Suite
Use Table 10-7 to locate the key performance metrics for Oracle SOA Suite.
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Table 10-7 Oracle SOA Suite Key Performance Metrics

Metric Name Location in Fusion Applications Control

Audit Trail Threshold (for 1.
BPEL)
2.
3.

From the navigation pane, expand SOA and then soa-infra.

From the SOA Infrastructure menu, choose SOA Administration > BPEL
Properties.

From the BPEL Service Engine Properties page, view the Audit Trail Threshold.

From the BPEL Service Engine Properties page, adjust the Audit Trail Threshold to
bolster BPEL engine performance and avoid performance overheads of capturing
audit information. From the Audit Level list, you can also level of information
collected by the instance tracking infrastructure.

Composite-level rate 1. From the navigation pane, expand SOA and then soa-infra.
metrics 2. Expand the partitions.
3. Select a specific SOA composite application.
4. From the SOA Composite menu, choose Monitoring > Performance Summary.
5. From the BPEL Service Engine Properties page, view the Audit Trail Threshold.
Dispatcher System 1. From the navigation pane, expand SOA and then soa-infra.
Threads 2. From the SOA Infrastructure menu, choose SOA Administration > BPEL

Dispatcher Invoke Threads

Dispatcher Engine Threads 3.

Properties.

From the BPEL Service Engine Properties page, view the settings for Dispatcher

(for BPEL) System Threads, Dispatcher Invoke Threads, and Dispatcher Engine Threads.
Adjust these thresholds when the response-time is high.
Tune the thread configuration to either increase or decrease the number depending
upon the BPEL engine processing requirement.

Average Request 1. From the navigation pane, expand SOA and then soa-infra.

Processing Time
(synchronous requests)

Average Request
processing time
(asynchronous requests)

From the SOA Infrastructure menu, choose Monitoring > Request Processing,.

From the Request Processing page, in the Service Engines and Service
Infrastructure sections, view the Average Request Processing Time -
Synchronous Requests and the Average Request Processing Time -
Asynchronous Requests columns.
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Table 10-7 (Cont.) Oracle SOA Suite Key Performance Metrics

Metric Name Location in Fusion Applications Control
Audit trail 1. From the navigation pane, expand SOA and then soa-infra.
2. Expand the partitions.
3. Select a specific SOA composite application.
4. In the Oracle SOA Composite page, in the Recent Instances section, select an

instance.
In the Flow Trace window, select a component instance in the Trace section.

The audit trail for the instance displays.

State (for a BPEL instance)

oW bh =

From the navigation pane, expand SOA and then soa-infra.
Expand the partitions.
Select a specific SOA composite application.

In the Oracle SOA Composite page, in the Component Metrics section, select a
BPEL instance.

In the BPEL Component page, in the Recent Instances table, view the State
column.

State (for an Oracle
Mediator instance)

oW bh =

From the navigation pane, expand SOA and then soa-infra.
Expand the partitions.
Select a specific SOA composite application.

In the Oracle SOA Composite page, in the Component Metrics section, select an
Oracle Mediator instance.

In the Mediator Component page, in the Recent Instances table, view the State
column.

10.4.4.3 Monitoring Key Performance Metrics for Oracle Enterprise Scheduler
Use Table 10-8 to locate the key performance metrics for Oracle Enterprise Scheduler.

Table 10-8 Oracle Enterprise Scheduler Key Performance Metrics

Metric Name Location in Fusion Applications Control

Number of active
processor threads for each
instance

a 0 0 bhd =

From the navigation pane, expand Scheduling Services.

Select the Oracle Enterprise Scheduler component.

From the Scheduling Service menu, choose Performance > Current Activity.
From the View list, choose Workload by Work Assignment.

In the Work Assignments with active Workshifts report, view the Thread
Allocation columns.

Processing Time (for jobs)
Wait Time

E

From the navigation pane, expand Scheduling Services.
Select the Oracle Enterprise Scheduler component.
From the Scheduling Service menu, choose Performance > Historical Reports.

In the Historical Reports page, from the View list, choose Request Metrics By
Work Assignment.

In the Results section, view the Wait Time and Processing Time columns.

Job running time 1.

From the navigation pane, expand Scheduling Services.
Select the Oracle Enterprise Scheduler component.

From the Scheduling Service home page, in the Top 10 Long Running Request
tab, select a job.

In the Request Detail page, under Execution Trail, view the Run Time metric.
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10.5 Performing Proactive Performance Monitoring with Cloud Control

Managing applications and the underlying middleware technology can be difficult
and IT organizations often have to rely on a variety of specialized tools. This can lead
to inefficiency and may introduce complexities and risks.

Cloud Control enables you to discover middleware targets. To access these pages, see
the following topic:

= Monitoring Middle Tier Targets

In addition to drilling down to specific targets for performance metrics, Oracle
recommends the following best practices:

s Creating Monitoring Templates
»  Creating Blackouts

= Setting Up Notifications

10.5.1 Monitoring Middle Tier Targets

After you have added a middle tier target through discovery, you can view general
information about the targets, including their status and availability on the
Middleware page. You can select a specific type of target, such as Oracle WebLogic
Server domain, to narrow the view. You then can drill down into each target to get
further details like how the target is performing, where it is deployed, the version,
location of its home directory, and so on.

You can also view the number of critical, warning, and error alerts generated for the
past 24 hours. These alerts indicate that a particular metric condition has been
encountered. For example, an alert is triggered when a metric threshold is reached.
Using these details, you can drill down to investigate the target and the problem that
triggered the alert.

You can also use Cloud Control to monitor performance metrics as a current real time
value (30 seconds, 1 minute, or 5 minutes) or a previous value (past 24 hours, 7 days,
or 31 days). The historical information is displayed as graphs and a table. By using
graphs, you can easily watch for trends, and by using tables, you can examine details
of past metric severity history.

Figure 10-1 shows the Middleware page for Oracle WebLogic Server domains in the
Oracle Fusion Applications environment.
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Figure 10-1 Middleware Target Home Page of Cloud Control
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FIEAENIE)
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To access the Middleware target home page in Cloud Control:
1. From the Targets menu, choose Middleware.
2. From the Search area, click Advanced Search.

3. From the Type list, choose a specific target type to monitor, and then click Search.
In Figure 10-1, the target selected is Oracle WebLogic Domain.

For more information about discovering and monitoring middleware targets, see the
chapters in the "Managing Oracle Fusion Middleware" part in the Oracle Enterprise
Manager Getting with Fusion Middleware Management.

10.5.2 Creating Monitoring Templates

Monitoring templates simplify the task of setting up monitoring for large numbers of
targets by allowing you to specify the monitoring and policy settings once and
applying them as often as needed. You can save, edit, and apply these templates across
one or more targets or groups. A monitoring template is specified for a particular
target type and can only be applied to targets of the same type. For example, you can
configure a monitoring template for Oracle WebLogic Server domains.

To create a monitoring template from Cloud Control:

1. From the Enterprise menu, choose Monitoring > Monitoring Templates to access
the Monitoring Templates main page.

2. Modify a pre-built monitoring template, or create a new template without any
data from another template:

To modify a pre-build monitoring template:
a. Inthe Template Name field, enter Fusion Apps or FMW.

b. Click option Display Oracle provided templates and Oracle Certified
templates.

c. Click Go.
d. From the table, select the template, and click Edit.
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To create a new template, click Create.
3. Fill out the tabs accordingly.

In the Metric Threshold tab, select the metrics to add to the template. Use the
following tables in the Oracle Fusion Applications Performance and Tuning Guide for
tips on recommended metrics to add to the template:

s Host Metrics

s Oracle Enterprise Scheduler Metrics
s Oracle HTTP Metrics

s Oracle Identity Manager Metrics

= Oracle Internet Directory Metrics

s Oracle SOA Composite Metrics

s Oracle SOA Infrastructure Metrics

s Oracle WebLogic Server Metrics

10.5.3 Creating Blackouts

Blackouts allow you to suspend collection of metrics on a target when performing
scheduled maintenance on the target. Blacking out a target suspends monitoring on
the target for the duration of the blackout. Blackouts are named entities that mainly
consist of a list of targets that participate in the blackout and the schedule that defines
when the blackout is in effect. Blackouts may be defined on a single target or on
aggregate targets such as groups, hosts, systems, or web applications.

To create a blackout from Cloud Control:

1. From the Enterprise menu, choose Monitoring > Blackouts to access the
Blackouts main page.

2. From the table, click Create.

Cloud Control displays a wizard page to guide you through the steps required to
create a blackout. Click Help from any wizard page for more information on
specific steps.

10.5.4 Setting Up Notifications

You can associate corrective actions with metrics whose alerts trigger them.

To register corrective actions for these notifications from Cloud Control. From the
Setup menu, choose Notifications > Notification Methods access the Notifications
Methods page.

See the "Notifications" chapter in the Oracle Enterprise Manager Cloud Control
Administrator’s Guide to complete the configuration.

10.6 Tuning Middle Tiers for Oracle Fusion Applications

One of the most challenging aspects of performance tuning is knowing where to begin.
Start with the following documentation resources:

»  Oracle Fusion Applications Performance and Tuning Guide

»  Oracle Fusion Middleware Fusion Developer’s Guide for Oracle Application Development
Framework (Oracle Fusion Applications Edition)
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= "Managing Log Files and Diagnostic Data" in the Oracle Fusion Middleware
Administrator’s Guide
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Diagnosing the Oracle Fusion Applications
Middle Tier Performance

This chapter describes how to diagnose Java applications in the middle tier using
Oracle Enterprise Manager Cloud Control (Cloud Control):

This chapter includes the following topics:
» Introduction to Java Diagnostics in the Middle Tier

= Diagnosing the Oracle Fusion Applications Middle Tier

11.1 Introduction to Java Diagnostics in the Middle Tier

Mission critical Java applications often suffer from availability and performance
problems. Developers and IT administrators spend a lot of time diagnosing the root
cause of these problems. Many times, the problems occurring in production
environments either cannot be reproduced or may take too long to reproduce in other
environments. This can cause severe impact on the business.

Oracle Enterprise Manager Cloud Control (Cloud Control) enables you to diagnose
performance problems in Java applications in the production environment. By
eliminating the need to reproduce problems, it reduces the time required to resolve
these problems. This improves application availability and performance. Using Java
Virtual Machine (JVM) diagnostics, you can identify the root cause of performance
problems in the production environment without having to reproduce them in the test
or development environment. It does not require complex instrumentation or
restarting of the application to get in-depth application details. Application
administrators will be able to identify Java problems or Database issues that are
causing application downtime without any detailed application knowledge.

To configure you environment for JVM Diagnostics, see the "Using JVM Diagnostics"
chapter in the Oracle Enterprise Manager Getting Started with Fusion Middleware
Management.

11.2 Diagnosing the Oracle Fusion Applications Middle Tier

This section describes how to diagnose Java applications in the middle tier using
Cloud Control:

= Viewing JVM Diagnostics Summary Information
»  Finding the Top Java Methods

= Finding the Top SQL Queries

=  Analyzing Stuck Threads
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s Drilling Down from JVM Diagnostics to SQL Instances
= Analyzing Potential Memory Leaks

11.2.1 Viewing JVM Diagnostics Summary Information
To get started with monitoring JVM diagnostics with Cloud Control:

1. From the Targets menu, choose Targets > Middleware.
The Middleware target home page displays.

2. Search for the Oracle WebLogic Server domains:
a. From the Search area, click Advanced Search.

b. From the Type list, select Oracle WebLogic Domain or Oracle WebLogic
Server; deselect the other options.

c. Click Search.

3. Click on a domain or one of its servers which has JVM Diagnostics agents
deployed. For more information about installing JVM Diagnostics, see the Oracle
Enterprise Manager Cloud Control Basic Installation Guide.

The WebLogic Server Domain Home page or WebLogic Server Home page
displays.

4. From the WebLogic Domain or WebLogic Server menu, choose Diagnostics >
JVM Diagnostics Home.

The JVM Diagnostics Home page displays.
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Key G
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5. Take note of the following;:

= In the Summary section, view the make and version of the JVM, optimization
level, and the maximum and minimum heap memory.

s In the Active Threads section, view the number of Java threads that are
currently running in the for the domain or server. It is color-coded by thread
state.
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= In the Realtime Thread State section, view the overall thread state, including

locks.

a. From the WebLogic Domain or WebLogic Server menu, choose Diagnostics >
JVM Diagnostics.

The JVM Diagnostics Pool Performance Diagnostics page displays for an
Oracle WebLogic Server domain and the JVM Performance Diagnostics page
displays for a Managed Server. While the JVM Diagnostics Pool Performance
Diagnostics page provides information for the pool of JVMs in the domain, the
JVM Performance Diagnostics page provides information for a single JVM.
The following figure shows the JVM Diagnostics Pool Performance
Diagnostics page for the domain:
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b. View the various charts:

Server State
Charts For
Selected Period
section

This section displays the Active Threads, CPU Utilization, and
Heap Utilization of 10, CPU, lock, and network resources
during the selected time. The number of Java threads
(daemon and non-daemon) that are currently running in the
virtual machine for this Oracle WebLogic Server

Active Threads by State: This chart displays the number of
Java threads that are currently running in the for the domain
or server. It is color-coded by thread state.

CPU Utilization: This chart shows the CPU utilization across
the JVMs in the pool.

Heap Utilization (%): This chart shows the heap utilization
across the JVMs in the pool.

Garbage Collections (Invocations/min): This chart shows the
number of times the JVM garbage collector was invoked in the
time period. It includes both major and minor garbage
collections.
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General tab This section displays data from the JVM itself:

Active Threads by State: This chart displays the number of
Java threads that are currently running in the for the domain
or server. It is color-coded by thread state.

Top Requests: This chart shows the top page requests in the
selected time period.

Top Methods: This chart shows the most expensive Java
methods in the selected time period.

Top SQLs: This chart displays the list of SQL calls ordered by
their cost (the number of samples).

Top DBWait Events: This chart shows the cross-tier
correlation with the database.

Top Databases: This chart shows where the pool of JVM is
spending in each area.

JVM CPU Utilization: This chart shows the CPU utilization
across the JVMs the pool.

JVM Heap Utilization (%): This chart shows the heap
utilization across the JVMs in the pool.

Threads tab Threads State Transition: This chart shows how the threads
have transitioned from one state to the other in the selected
period. You can change the time interval and move it to a
different time period by using the quick time selection control
at the top of the page. You can hover over the colored bars to
see the transition changes from one state to the other, for
example from Runnable to Not Active or to Runnable. Click
on a bar graph in the State column to view a detailed analysis
on the state of the thread. This feature allows you to analyze
each sample (JVM snapshot at a specific time) in the
monitored data.

Metric By Active States: This chart shows how long each of
the threads have been in the various states.

Top Ecid(s): This chart displays the ECIDs for tracking
transactions

Note: The Compared with feature enables you to compare the
diagnostics across two specified periods of time.

11.2.2 Finding the Top Java Methods

If you have a slow-running application, locate the Java method causing the potential
issue.

To find the top Java methods with Cloud Control:

1. From the Targets menu, choose Targets > Middleware.
The Middleware target home page displays.

2. Search for the Oracle WebLogic Server domains:

a. From the Search area, click Advanced Search.
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10.

b. From the Type list, select Oracle WebLogic Domain or Oracle WebLogic
Server; deselect the other options.

c. Click Search.

Click on a domain or one of its servers which has JVM Diagnostics agents
deployed. For more information about installing JVM Diagnostics, see the Oracle
Enterprise Manager Cloud Control Basic Installation Guide.

The WebLogic Server Domain Home page or WebLogic Server Home page
displays.

From the WebLogic Domain menu or WebLogic Server menu, choose
Diagnostics > JVM Performance Diagnostics.

The JVM Diagnostics Pool Performance Diagnostics page displays for an Oracle
WebLogic Server domain and the JVM Performance Diagnostics page displays for
a Managed Server.

In the Top Methods section, review the list of methods ordered by their cost (the
number of samples).

In the Top Methods section, click on a method to add it as a filter.

In the Method Stack Tree dialog, click on the plus sign next to the method to
investigate further.

The Method Stack Tree dialog displays with a call stack that you can traverse.
In the Method Stack Tree dialog, select the method, and then click OK.

The Filter Options section auto-fills the information on the method and the charts
update to reflect that method, for example:

s Heavy use of IO, CPU, lock, and network resources (Active Threads chart)
= Request causing it to be invoked (Top Requests chart)
= SQL or database state it causes (Top DBStates and Top SQLs charts)

After you are done viewing the method, in Filter Options section, clear out the
Method text box filter and click anywhere to remove the filter.

11.2.3 Finding the Top SQL Queries

If you suspect a slow SQL query is causing a network requests or IO issue, find the
slowest SQL queries.

To find the top SQL calls using JVM diagnostics with Cloud Control:

1.

From the Targets menu, choose Targets > Middleware.
The Middleware target home page displays.

Search for the Oracle WebLogic Server domains:

a. From the Search area, click Advanced Search.

b. From the Type list, select Oracle WebLogic Domain or Oracle WebLogic
Server; deselect the other options.

c. Click Search.

Click on a domain or one of its servers which has JVM Diagnostics agents
deployed. For more information about installing JVM Diagnostics, see the Oracle
Enterprise Manager Cloud Control Basic Installation Guide.
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The WebLogic Server Domain Home page or WebLogic Server Home page
displays.

4. From the WebLogic Domain menu or WebLogic Server menu, choose
Diagnostics > JVM Performance Diagnostics.

The JVM Diagnostics Pool Performance Diagnostics page displays for an Oracle
WebLogic Server domain and the JVM Performance Diagnostics page displays for
a Managed Server.

5. In the Top SQLs section, review the list of SQL calls ordered by their cost (the
number of samples).

6. In the Top SQLs section, click on a SQL call to view the charts for that call.

The Filter Options section auto-fills the information on the method and the charts
update to reflect that method. Adding the statement as a filter enables you to see
everything related to that SQL call, for example:

= Methods that invoke it (Top Methods chart)
= Request causing it to be invoked (Top Requests chart)
»  Database state it causes (Top Databases chart)

7. After you are done viewing the method, in Filter Options section, clear out the
SOQL field and click anywhere to remove the filter.

11.2.4 Analyzing Stuck Threads

If application users report a spinning status indication after clicking in the application,
investigate the stuck threads.

To find the top SQL calls using JVM diagnostics with Cloud Control:
1. From the Targets menu, choose Targets > Middleware.

The Middleware target home page displays.
2. Search for the Oracle WebLogic Server domains:

a. From the Search area, click Advanced Search.

b. From the Type list, select Oracle WebLogic Domain or Oracle WebLogic
Server; deselect the other options.

c. Click Search.

3. Click on a domain or one of its servers which has JVM Diagnostics agents
deployed. For more information about installing JVM Diagnostics, see the Oracle
Enterprise Manager Cloud Control Basic Installation Guide.

The WebLogic Server Domain Home page or WebLogic Server Home page
displays.

4. From the WebLogic Domain menu, choose Diagnostics > Live Thread Analysis.
The Live Thread Analysis page displays.
5. In the JVMs section, click on a thread to show details in the JVM Threads section.

6. Inthe JVM Threads section, look for a thread having the prefix [STUCK
THREAD] and click on it.

7. In the Thread Info and Thread Stack sections, look at the Current Call, File
Name, Line, and State for the thread.
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This information provides you with the key information on how to locate the code
that is causing the problem:

s Current Call: This field displays the name of the method call where the code is
stuck.

s File Name: This column identifies the file with the problem.

»  Line: This column identifies the line number in the file where the problematic
code is.

= State: This column displays the state of the thread (for example, CPU, IO,
Network, DB Wait, Lock, and so on).

Look for the Lock Held in the Thread Info section.

If the stuck thread is in the DB Wait state, then click on the link and go directly to
the database session to see what that thread is doing in the database, or use the
technique described in Section 11.2.5.

11.2.5 Drilling Down from JVM Diagnostics to SQL Instances

If you issue an SQL query and it does not return, then analyze the SQL statement.

To analyze SQL from Cloud Control:

1.

From the Targets menu, choose Targets > Middleware.
The Middleware target home page displays.

Search for the Oracle WebLogic Server domains:

a. From the Search area, click Advanced Search.

b. From the Type list, select Oracle WebLogic Domain or Oracle WebLogic
Server; deselect the other options.

c. Click Search.

Click on a domain or one of its servers which has JVM Diagnostics agents
deployed. For more information about installing JVM Diagnostics, see the Oracle
Enterprise Manager Cloud Control Basic Installation Guide.

The WebLogic Server Domain Home page or WebLogic Server Home page
displays.

From the WebLogic Domain menu, choose Diagnostics > JVM Performance
Diagnostics.

JVM Diagnostics Pool Performance Diagnostics page displays for an Oracle
WebLogic Server domain and the JVM Performance Diagnostics page displays for
a Managed Server.

In the Top SQLs section, click on a SQL call to view the charts for that call.
In Filter Options section, in the SQL field, copy the ID of the SQL call.
Click on Databases in secondary navigator.

Select the relevant target database.

Click the Performance tab.

. In the Additional Instance Monitoring Links section, click Search SQL.
. Paste the ID of the SQL call into the relevant field with any other choices you may

need and then click Search.
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12. Analyze the SQL.

11.2.6 Analyzing Potential Memory Leaks

To find and analyze memory leaks, you can use Cloud Control to take and analyze
snapshots of the heap.

Analyzing heap requires a large amount of free space in the Oracle Database
tablespace being used. As a standard practice, ensure you have five times the size of
heap dump file being loaded in the tablespace. Since you know the size of your dump
file, make sure that there is adequate space to accommodate the dump file before it is
loaded into the database.

To use heap snapshot to analyze memory leaks:

s Task 1, "Review Metrics for a Potential Memory Leak"
s Task 2, "Perform a Live Heap Analysis"

»  Task 3, "Create a Heap Snapshot"

Task 1 Review Metrics for a Potential Memory Leak
To create a snapshot of the heap for later loading and examination for leaks:

1. From the Targets menu, choose Targets > Middleware.
The Middleware target home page displays.
2. Search for the Oracle WebLogic Server domains:
a. From the Search area, click Advanced Search.
b. From the Type list, select Java Virtual Machine; deselect the other options.
c. Click Search.

3. Click on a Java Virtual Machine with JVM Diagnostics agents deployed. For more
information about installing JVM Diagnostics, see the Oracle Enterprise Manager
Cloud Control Basic Installation Guide.

The Java Virtual Machine Home page displays.
4. From the Java Virtual Machine menu, choose Performance Summary.
The Performance Summary page displays.

5. Review the following metrics for any periods of time where the Warning
Thresholds or Critical Thresholds were reached:

JVM GC This metric shows the percentage of CPU the JVM is using for

Overhead garbage collections in relation to total CPU usage including
servicing application workload (the lower, the better). This
metric and its trending can help determine when the garbage
collector is making the CPU spin on garbage collection instead
of on application workload.

JVM Heap Usage This metric shows the heap utilization for the JVM. This
(%) metric provides an indicator of heap size as they fluctuate
between garbage collections.
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JVM Heap Used  This metric shows the percent of heap utilization used after
After GC garbage collection. This metric and its trend over time can

provide a good indication that there is a leak. For example, if
the chart trending up while the application load is stable, then
it is possible there is a leak.

If any of the metrics exceed the Warning Thresholds or Critical Thresholds, it
could indicate memory is a factor in the JVM performance and availability. It could
mean there is a memory leak or that the JVM heap configuration is too small for
the application load. If the heap configuration is correct, assume there is a leak and
investigate the cause.

If any of the metrics exceed the Warning Thresholds or Critical Thresholds,
proceed to Task 2.

Task 2 Perform a Live Heap Analysis
To create a snapshot of the heap for later loading and examination for leaks:

1.

From the Java Virtual Machine menu, choose Live Heap Analysis.
The Live Heap Analysis page displays.

Review the top portion of the page to the analyze the heap and the number of
objects added to the garbage collector; review the JVM Class Detail table to
review the largest-size objects in the heap.

For more information about using this page, see the topic "Viewing the Real-Time
Heap Data" in the Cloud Control online help.

Task 3 Create a Heap Snapshot
To create a snapshot of the heap for later loading and examination for leaks:

1.

On the Live Heap Analysis page, click Create Heap Snapshot.
The Heap Snapshot page displays.
Provide the settings for your environment.

Notice the Heap Snapshot Type under Heap Snapshot Only option enables you
to pick either Oracle's JVMD format or a HROFF for use with other tools.

For more information about using this page, see the topic "Taking a Heap
Snapshot" in the Cloud Control online help.

If you selected Heap Snapshot Only option, click Take Snapshot.

The heap snapshot is generated and the file name in which it is stored is
displayed. You can upload the heap snapshot and analyze it using appropriate
options from the Heap Snapshots menu.

From the Java Virtual Machine menu, choose Heap Snapshots.
The Available Heap Snapshots page displays.
Select the heap you created from the table, and then click Detail.

The Heaps > Roots page displays. The Roots tab displays the objects reachable by
roots, which are objects that are directly reachable from the JVM itself.
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6. Click a root name to drill down and view the objects that consume a lot of
memory.

The Top 40 Objects page displays.

7. In the Heaps > Roots page, click Compare with to compare the current heap with
another previously taken heap dump.

When comparing heaps, load the bigger one first. Otherwise you may see negative
deltas.

8. In the Select a heap record dialog, select the second heap, and then click OK.

9. Compare both the heaps. Compare the number of objects (Objects) and the
occupied memory size (Adjusted Memory) in each heap dump. This measure
indicates the objects that are growing over the period of time when the snapshots
were taken.

10. Drill down into the root which had the largest delta in order to find the biggest
memory leak.
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Monitoring and Tuning Oracle Database for
Oracle Fusion Applications

This chapter describes how to monitor, diagnose, tune, and test changes to Oracle
Database using Oracle Enterprise Manager Database Control. Oracle Database
provides several tools that enable you to monitor performance, diagnose and tune
problems, and test database changes on a test system before implementing them to a
production system. Most of these tools are accessible using Oracle Enterprise Manager
Database Control.

This chapter includes the following sections:
= Monitoring Oracle Database
s Tuning Oracle Database

»  Testing Oracle Database Changes

12.1 Monitoring Oracle Database

Instructions for how to monitor Oracle Database using Database Control is provided
in the following topics:

= Database Statistics

= Monitoring Database Alerts

= Monitoring User and Session Activity
= Monitoring the Database Instance

= Monitoring the Host System

12.1.1 Database Statistics

Database statistics provide information about the type of load on the database and the
internal and external resources used by the database. To accurately diagnose
performance problems with the database using ADDM, statistics must be available.

Oracle Database generates many types of cumulative statistics for the system, sessions,
and individual SQL statements. Oracle Database also tracks cumulative statistics about
segments and services. Automatic Workload Repository (AWR) automates database
statistics gathering by collecting, processing, and maintaining performance statistics
for database problem detection and self-tuning purposes.

By default, the database gathers statistics every hour and creates an AWR snapshot,
which is a set of data for a specific time that is used for performance comparisons. The
delta values captured by the snapshot represent the changes for each statistic over the
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time period. Statistics gathered by AWR are queried from memory. The gathered data
can be displayed in both reports and views.

The database statistics collected and processed by AWR include:
s Time model statistics

Time model statistics measure the time spent in the database by operation type.
The most important time model statistic is database time (DB time). Database
time represents the total time spent in database calls by foreground sessions, and
is an indicator of the total instance workload.

s Wait event statistics

Wait events are incremented by a session to indicate that the session had to wait
for an event to complete before being able to continue processing. When a session
has to wait while processing a user request, the database records the wait by using
one of a set of predefined wait events. The events are then grouped into wait
classes.

= Session and system statistics

A large number of cumulative database statistics are available on a system and
session level. Some of these statistics are collected by AWR.

= Active session history statistics

The Active Session History (ASH) statistics are samples of session activity in the
database. The database samples active sessions every second and stores them in a
circular buffer in the System Global Area (SGA). Any session that is connected to
the database and using CPU, or is waiting for an event that does not belong to the
idle wait class, is considered an active session.

» High-load SQL statistics

SQL statements that are consuming the most resources produce the highest load
on the system, based on criteria such as elapsed time and CPU time.

For more information about database statistics, see the "Gathering Database Statistics
Using the Automatic Workload Repository" section in the Oracle Database 2 Day +
Performance Tuning Guide.

12.1.2 Monitoring Database Alerts

Oracle Database includes a built-in alerts infrastructure to notify you of impending
problems with the database. By default, Oracle Database enables the following alerts:

= Tablespace Usage

= Snapshot Too Old

= Recovery Area Low on Free Space
= Resumable Session Suspended

In addition to these default alerts, you can use performance alerts to detect any
unusual changes in database performance.

This section contains the following topics:
s Configuring Database Alerts
= Responding to Database Alerts

For more information about database alerts, see the "Monitoring Performance Alerts"
chapter in the Oracle Database 2 Day + Performance Tuning Guide.
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12.1.2.1 Configuring Database Alerts

A metric is the rate of change in a cumulative statistic. This rate can be measured
against a variety of units, including time, transactions, or database calls. For example,
the number of database calls per second is a metric. You can set thresholds on a metric
so that an alert is generated when the threshold is passed.

Performance alerts are based on metrics that are performance-related. These alerts are
either environment-dependent or application-dependent.

Environment-dependent performance alerts may not be relevant on all systems. For
example, the AVERAGE_FILE_READ_TIME metric generates an alert when the average
time to read a file exceeds the metric threshold.

Application-dependent performance alerts are typically relevant on all systems. For
example, the BLOCKED_USERS metric generates a performance alert when the number of
users blocked by a particular session exceeds the metric threshold.

To obtain the most relevant information from performance alerts, set the threshold
values of performance metrics to values that represent desirable boundaries for your
system. You can then fine-tune these values over time until your system meets or
exceeds your performance goals.

To set thresholds for alerts, use the Metric and Policy Settings page, accessible from
Related Links on the Database Home page.

12.1.2.2 Responding to Database Alerts

When an alert is generated by Oracle Database, it appears under Alerts on the
Database Home page.

To respond to a database alert, locate the alert that you want to investigate under
Alerts on the Database Home page and click the Message link. Follow the
recommendations provided on the page.

After taking the necessary corrective measures, you can acknowledge an alert by
clearing or purging it. Clearing an alert sends the alert to the Alert History, which can
be viewed from the Database Home page under Related Links. Purging an alert
removes it from the Alert History.

12.1.3 Monitoring User and Session Activity

The Database Performance page displays information in three sections that enable you
to assess the overall performance of the database in real time.

The Average Active Sessions chart of the Performance page shows the average load on
the database. The average active sessions for a time period equals the total DB time of
all sessions during this period divided by the elapsed time (wall clock time) for this
period. The chart shows which active sessions are running on the CPU or waiting on
an event.

The wait classes show how much database activity is consumed by waiting for a
resource such as disk I/O. Values that use a larger block of active sessions represent
bottlenecks caused by a particular wait class, as indicated by the corresponding color
in the legend. To identify each wait class, move your cursor over the block in the
Average Active Sessions chart corresponding to the class.

Click the block of color on the chart or its corresponding wait class in the legend to
drill down to the wait class. The Active Sessions Working page for the wait class
appears. From this page, you can view the details of wait classes in the following
dimensions:
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= TopSQL

On the Active Sessions Working page, the Top Working SQL table shows the
database activity for actively running SQL statements that are consuming CPU
resources. If one or several SQL statements are consuming most of the activity,
then you should investigate them.

»  Top sessions

On the Active Sessions Working page, the Top Working Sessions table displays the
top sessions waiting for the corresponding wait class during the selected time
period.

A session is a logical entity in the database instance memory that represents the
state of a current user login to the database. A session lasts from the time a user
logs in to the database until the user disconnects. If a single session is consuming
the majority of database activity, then you should investigate it.

= Top services

The Top Services table displays the top services waiting for the corresponding wait
event during the selected time period.

A service is a group of applications with common attributes, service-level
thresholds, and priorities. If a service is using the majority of the wait time, then
you should investigate it.

= Top modules

The Top Modules table displays the top modules waiting for the corresponding
wait event during the selected time period.

Modules represent the applications that set the service name as part of the
workload definition. If a single module is using the majority of the wait time, then
it should be investigated.

= Top actions

The Top Actions table displays the top actions waiting for the corresponding wait
event during the selected time period.

Actions represent the jobs that are performed by a module. If a single action is
using the majority of the wait time, then you should investigate it.

= Top clients

The Top Clients table displays the top clients waiting for the corresponding wait
event during the selected time period. A client can be a Web browser or any client
process that initiates requests for an operation to be performed by the database. If
a single client is using the majority of the wait time, then you should investigate it.

= Top PL/SQL

The Top PL/SQL table displays the top PL/SQL subprograms waiting for the
corresponding wait event during the selected time period. If a single PL/SQL
subprogram is using the majority of the wait time, then you should investigate it.

s Top files

The Top Files table displays the average wait time for specific files during the
selected time period. This data is available from the Active Sessions Waiting: User
1/0 page.

= Top objects
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The Top Objects table displays the top database objects waiting for the
corresponding wait event during the selected time period. This data is available
from the Active Sessions Waiting: User 1/O page.

For more information about monitoring user and session activity, see the "Monitoring
User Activity" section in the Oracle Database 2 Day + Performance Tuning Guide.

12.1.4 Monitoring the Database Instance

In the Average Active Sessions section of the Performance page, you can use the
instance charts to monitor database instance activity in the following dimensions:

Throughput

Database throughput measures the amount of work the database performs in a
unit of time. The Throughput charts show any contention that appears in the
Average Active Sessions chart. The Throughput charts on the Performance page
display:

— Number of logons, transactions, physical reads, and redo size per second
— Number of physical reads and redo size per transaction

Compare the peaks on the Throughput charts with the peaks on the Average
Active Sessions chart. If the Average Active Sessions chart displays a large number
of sessions waiting, indicating internal contention, and throughput is low, then
consider tuning the database.

1/0

The I/O charts show I/0O statistics collected from all database clients. The I/0O
wait time for a database process represents the amount of time that the process
could have been doing useful work if a pending I/O had completed. Oracle
Database captures the I/O wait times for all important I/O components in a
uniform fashion so that every I/O wait by any Oracle process can be derived from
the I/O statistics.

The Latency for Synchronous Single Block Reads chart shows the total perceived
I/0O latency for a block read, which is the time difference between when an I/O
request is submitted and when the first byte of the transfer arrives. Most systems
are performing satisfactorily if latency is fewer than 10 milliseconds.

You can also monitor I/O by function, type, and consumer groups using the
various charts provided.

Parallel executions

The Parallel Execution charts show system metrics related to parallel queries.
Metrics are statistical counts per unit. The unit could be a time measure, such as
seconds, or per transaction, or session.

A parallel query divides the work of executing a SQL statement across multiple
processes. The charts show parallel queries that were waiting for a particular wait
event that accounted for the highest percentages of sampled session activity.

Services

The Services charts show services waiting for the corresponding wait event during
the time period shown. Services represent groups of applications with common
attributes, service-level thresholds, and priorities. Only active services are shown.

For more information about monitoring the database instance, see the "Monitoring
Instance Activity" section in the Oracle Database 2 Day + Performance Tuning Guide.
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12.1.5 Monitoring the Host System

The Host chart on the Performance page displays utilization information about the
system hosting the database.

Using the Host chart, you can view CPU, memory, and disk utilization for the host
system. To determine if the host system has enough resources available to run the
database, establish appropriate expectations for the amount of CPU, memory, and disk
resources that your system should be using. You can then verify that the database is
not consuming too many of these resources.

For more information about monitoring the host system, see the "Monitoring Host
Activity" section in the Oracle Database 2 Day + Performance Tuning Guide.

12.2 Tuning Oracle Database

Performance tuning is an iterative process. Removing the first bottleneck (a point
where resource contention is highest) may not lead to performance improvement
immediately because another bottleneck might be revealed that has an even greater
performance impact on the system.

Oracle Database provides several tools that enable you to diagnose and tune
performance problems. Automatic Database Diagnostic Monitor (ADDM) analyzes
statistics to provide automatic diagnosis of major performance problems. You can also
perform your own analysis using statistics from AWR and ASH reports, wait events,
and SQL trace files to identify other bottlenecks in the database.

Instructions for diagnosing and tuning performance problems are provided in the
following sections:

»  Creating a Baseline of the Database
» Diagnosing and Tuning Database Performance Problems Using ADDM
» Diagnosing and Tuning Database Performance Problems Reactively

s Tuning SQL Statements

12.2.1 Creating a Baseline of the Database

Before you can tune your database, you need to have an established performance
baseline that can be used for comparison if a performance problem arises. Oracle
Database automatically maintains a system-defined moving window baseline that
contains all AWR data within the AWR retention period, which by default is 8 days.
Using Database Control, you can also create your own baseline by specifying and
preserving a pair or a range of snapshots as a baseline. The snapshots contained in a
baseline are excluded from the automatic AWR purging process and are retained
indefinitely.

Before creating a baseline, carefully consider the time period you choose as a baseline
because it should represent the database operating at an optimal level. In the future,
you can compare these baselines with other baselines or snapshots to compare
performance. You can create a single baseline captured at a single, fixed time interval,
or a repeating baseline that repeats during a time interval over a specific period.

To create a baseline of the database, use the AWR Baselines page in Database Control,
accessible from the Statistics Management section of the Server tab.

For more information about creating a baseline of the database, see the "Managing
Baselines" section in the Oracle Database 2 Day + Performance Tuning Guide.
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12.2.2 Diagnosing and Tuning Database Performance Problems Using ADDM

Automatic Database Diagnostic Monitor (ADDM) is self-diagnostic software built into
Oracle Database. ADDM examines and analyzes data captured in the AWR to identify
possible database performance problems.

An ADDM analysis is performed after each AWR snapshot (every hour by default),
and the results are saved in the database. The results of ADDM analysis are displayed
as ADDM findings under Diagnostic Summary on the Database Home page in Oracle
Database Control.

Each ADDM finding belongs to one of three types: problem, symptom, and
information. Each problem finding is quantified with an estimate of the portion of DB
time that resulted from the performance problem. When a specific problem has
multiple causes, ADDM may report multiple findings. In this case, the impacts of
these multiple findings can contain the same portion of DB time.

A problem finding can be associated with a list of recommendations for reducing the
impact of a performance problem. Each recommendation has a benefit that is an
estimate of the portion of DB time that can be saved if the recommendation is
implemented. When multiple recommendations are associated with an ADDM
finding, the recommendations may contain alternatives for solving the same problem.
If this is the case, then choose the easiest solution to implement that yields the greatest
benefit.

Recommendations are composed of actions and rationales. You must apply all the
actions of a recommendation to gain its estimated benefit. The rationales explain why
the set of actions was recommended, and provide additional information for
implementing them.

You should review ADDM findings and implement the recommendations as part of
regular database maintenance. Even when the database is operating at an optimal
performance level, you should continue to use ADDM to monitor database
performance on an ongoing basis.

For more information about using ADDM, see the "Automatic Database Performance
Monitoring" chapter in the Oracle Database 2 Day + Performance Tuning Guide.

12.2.3 Diagnosing and Tuning Database Performance Problems Reactively

While ADDM enables you to proactively diagnose database performance problems
when they happen, there may be times when you want to identify database
performance problems reactively. For example, you may want to compare database
performance over time, or analyze a very short duration for short-lived performance
problems. You may also want to examine wait events to determine if user response
time can be improved by reducing the time that is spent waiting by server processes.

Oracle Database provides various tools, aside from ADDM, to enable you to diagnose
and tune database performance problems reactively. The instructions are provided in
the following topics:

s Comparing Database Performance Over Time Using AWR Reports
s Identifying Transient Performance Problems Using ASH Reports
s Identifying Wait Time Using Wait Events

12.2.3.1 Comparing Database Performance Over Time Using AWR Reports

Performance degradation of the database occurs when your database was performing
optimally in the past, such as 6 months ago, but has gradually degraded to a point
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where it becomes noticeable to the users. The Automatic Workload Repository (AWR)
Compare Periods report enables you to compare database performance between two
periods of time to identify any performance degradation that may have occurred over
time.

The AWR Compare Periods report compares a new baseline or a pair of snapshots to
an existing baseline. Before generating this report, you should have an existing
baseline that represents the system operating at an optimal level, as described in
"Creating a Baseline of the Database" on page 12-6. If an existing baseline is
unavailable, you can use this report to compare two periods of time using two pairs of
snapshots. To generate the AWR Compare Periods report, use the Automatic Workload
Repository page in Database Control, accessible from the Database Server page.

For more information about generating AWR Compare Periods reports, see the
"Running the AWR Compare Periods Reports" section in the Oracle Database 2 Day +
Performance Tuning Guide.

12.2.3.2 Identifying Transient Performance Problems Using ASH Reports

ADDM tries to report the most significant performance problems during an analysis
period in terms of their impact on DB time. If a particular problem lasts for a very
short duration, then its severity might be averaged out or minimized by other
performance problems in the analysis period. Therefore, the problem may not appear
in the ADDM findings. Whether a performance problem is captured by ADDM
depends on its duration compared to the interval between the AWR snapshots.

To capture a detailed history of database activity, Oracle Database samples active
sessions each second with the Active Session History (ASH) sampler. ASH gathers
sampled data at the session level rather than at the instance level. By capturing
statistics for only active sessions, the size of the sampled data is directly related to the
work being performed.

To generate the ASH report, under Average Active Sessions on the Database
Performance page, click Run ASH Report.

For more information about generating ASH reports, see the "Running Active Session
History Reports" section in the Oracle Database 2 Day + Performance Tuning Guide.

12.2.3.3 Identifying Wait Time Using Wait Events

Wait events are statistics that are incremented by a server process or thread to indicate
that it had to wait for an event to complete before being able to continue processing.
Whenever an Oracle Database process waits for something, it records the wait using
one of a set of predefined wait events. Wait event data reveals various symptoms of
problems that might be impacting performance, such as latch contention, buffer
contention, and I/0O contention.

Wait event statistics include the number of times an event was waited for and the time
waited for the event to complete. To minimize user response time, reduce the time
spent by server processes waiting for event completion. Not all wait events have the
same wait time. Therefore, it is more important to examine events with high wait time
rather than wait events with a high number of occurrences.

You can query wait event statistics from various V$ dynamic performance views. For
more information about using wait events, see the "Using Wait Event Statistics to Drill
Down to Bottlenecks" section in the Oracle Database Performance Tuning Guide.
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12.2.4 Tuning SQL Statements

When Oracle Database executes a SQL statement, the query optimizer (also called the
optimizer) first determines the best and most efficient way to retrieve the results. It
compares the cost of all possible approaches and chooses the approach with the least
cost. The access method for physically executing a SQL statement is called an
execution plan, which the optimizer is responsible for generating. The determination
of an execution plan is an important step in the processing of any SQL statement, and
can greatly affect execution time

The optimizer can also help you tune SQL statements. By using SQL Tuning Advisor
and SQL Access Advisor, you can run the optimizer in advisory mode to examine a
SQL statement or set of statements and determine how to improve their efficiency.
SQL Tuning Advisor and SQL Access Advisor can make various recommendations.
SQL Access Advisor is primarily responsible for making schema modification
recommendations, such as adding or dropping indexes and materialized views. SQL
Tuning Advisor makes other types of recommendations, such as creating SQL profiles
and restructuring SQL statements. Using Database Control, you can accept and
implement many of these recommendations.

Review the following topics for information on tuning SQL statements:
s Collecting Optimizer Statistics

s SQL Tuning Sets

s SQL Profiles

s Using SQL Tuning Advisor

= Using SQL Access Advisor

= Using SQL Tracing

12.2.4.1 Collecting Optimizer Statistics

Oracle Database can execute an SQL statement in many different ways. The optimizer
determines the most efficient way to execute an SQL statement after considering many
factors related to the objects referenced and the conditions specified in the query. For
the query optimizer to produce an optimal execution plan, the statistics in the data
dictionary should accurately reflect the volume and data distribution of the tables and
indexes.

Oracle Fusion Applications uses the DBMS_STATS package to automatically gather
optimizer statistics. In this case, the database automatically collects optimizer statistics
for tables with absent or stale statistics. If fresh statistics are required for a table, then
the database collects them both for the table and associated indexes. For any
on-demand gathering statistics on a particular table, you can use Database Control.

The output from the optimizer is an execution plan that describes an optimal method
of execution. The plans shows the combination of the steps Oracle Database uses to
execute an SQL statement. Each step either retrieves rows of data physically.

For more information about the optimizer, see "The Query Optimizer" chapter in the
Oracle Database Performance Tuning Guide.

Note: Oracle Fusion Applications require several database
initialization parameters to be set correctly in order to ensure optimal
performance. For more information about these database initialization
parameters and Fusion Applications best practices, see MOS
document 1270340.1.
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12.2.4.2 SQL Tuning Sets

A SQL tuning set is a database object that includes one or more SQL statements and
their execution statistics and context. You can use the set as an input for advisors such
as SQL Tuning Advisor, SQL Access Advisor, and SQL Performance Analyzer. You can
load SQL statements into a SQL tuning set from different SQL sources, such as AWR,
the cursor cache, or high-load SQL statements that you identify. SQL tuning sets are
transportable, enabling SQL workloads to be transferred between databases for remote
performance diagnostics and tuning. When high-load SQL statements are identified on
a production system, it may not be desirable to perform investigation and tuning
activities directly on this system. This feature enables you to transport the high-load
SQL statements to a test system, where they can be safely analyzed and tuned.

To create a SQL tuning set, use SQL Tuning Sets page, accessible from Additional
Monitoring Links on the Database Performance page.

For more information about SQL tuning sets, see the "Managing SQL Tuning Sets" in
the Oracle Database 2 Day + Performance Tuning Guide.

12.2.4.3 SQL Profiles

A SQL profile is a set of auxiliary information that is built during automatic tuning of
a SQL statement. A SQL profile is to a SQL statement what statistics are to a table.

During SQL profiling, the optimizer uses the execution history of the SQL statement to
create appropriate settings for optimizer parameters. After SQL profiling completes,
the optimizer uses the information in the SQL profile and regular database statistics to
generate execution plans. The additional information enables the database to produce
well-tuned plans for corresponding SQL statements.

After running a SQL Tuning Advisor task with a comprehensive scope, a SQL profile
may be recommended. If you accept the recommendation, then the database creates
the SQL profile and enables it for the SQL statement.

To manage SQL profiles, use the Plan Control tab, accessible from the SQL Details
page of the SQL statement that is using a SQL profile.

For more information about SQL profiles, see the "Managing SQL Profiles" section in
the Oracle Database 2 Day + Performance Tuning Guide.

12.2.4.4 Using SQL Tuning Advisor

Oracle Database can generate SQL tuning reports automatically. Automatic SQL
Tuning runs during system maintenance windows as an automated maintenance task,
searching for ways to improve the execution plans of high-load SQL statements.

ADDM also automatically identifies high-load SQL statements. If ADDM identifies
such statements, then click Schedule/Run SQL Tuning Advisor on the
Recommendation Detail page to run SQL Tuning Advisor on these statements.

For more information about SQL Tuning Advisor, see the "Tuning SQL Statements
Using SQL Tuning Advisor" section in the Oracle Database 2 Day + Performance Tuning
Guide.

12.2.4.5 Using SQL Access Advisor

To achieve optimal performance for data-intensive queries, materialized views and
indexes are essential for SQL statements. However, implementing these objects does
not come without cost. Creation and maintenance of these objects can be
time-consuming. Space requirements can be significant. SQL Access Advisor enables

12-10 Oracle Fusion Applications Administrator's Guide



Tuning Oracle Database

you to optimize query access paths by recommending materialized views and view
logs, indexes, SQL profiles, and partitions for a specific workload.

To run SQL Access Advisor, use the SQL Access Advisor link on the SQL Advisors
page, accessible from the Advisor Central page under Related Links on the Database
Home page.

For more information about SQL Access Advisor, see the "Optimizing Data Access
Paths" chapter in the Oracle Database 2 Day + Performance Tuning Guide.

12.2.4.6 Using SQL Tracing

You can use the SQL Trace facility to monitor Oracle Fusion Applications running
against Oracle Database by assessing the efficiency of the SQL statements that Oracle
Fusion applications are running. The SQL Trace facility provides performance
information for individual SQL statements and generates detailed statistics for each
statement.

You can then run the TKPROF program to format the contents of the SQL trace file and
place the output into a readable output file. TKPROF reports each statement executed
with the resources it has consumed, the number of times it was called, and the number
of rows which it processed. This information lets you easily locate SQL statements that
are using the greatest resource.

For more information about using SQL tracing, see the "Using the SQL Trace Facility
and TKPROF" section in the Oracle Database Performance Tuning Guide.

If a performance problem is reported for a particular business transaction for a given
session in Oracle Fusion Applications, you can instruct the user of the session to
enable a SQL trace for that transaction.

To enable SQL trace for a specific business transaction that is reported to be causing
performance problem:

1. Sign in to Oracle Fusion Applications with a user account that is provisioned with
the necessary role. Contact your security administrator for details.

2. From the Help menu, choose Troubleshooting, then Troubleshooting Options.
3. In the Options page, select Database Trace.

4. Select Capture bind variables, Capture wait events as appropriate.

Options > |

i _i{Enable all
[ patabase trace
Capture bind variables
Capkure wait events
[JPL=0L profiler
Applications logging
Severity Level | Sewvere (W
Modules | 9%

Cancel | Sawve and Close

5. Click Save and Close.

This enables SQL trace for the selected transaction and does not affect transactions that
belong to other sessions.
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12.3 Testing Oracle Database Changes

Oracle Real Application Testing enables you to perform real-world testing of Oracle
Database. By capturing production workloads and assessing the impact of system
changes on a test system before production deployment, Oracle Real Application
Testing minimizes the risk of instabilities associated with changes.

See the following sections for more information about Oracle Real Application Testing:
s Testing SQL Changes
»  Testing Database Changes

12.3.1 Testing SQL Changes

System changes—such as a upgrading a database or adding an index—may cause
changes to execution plans of SQL statements, resulting in a significant impact on SQL
performance. In some cases, the system changes may cause SQL statements to regress,
resulting in performance degradation. In other cases, the system changes may improve
SQL performance. Being able to accurately forecast the potential impact of system
changes on SQL's performance by identifying regressed and improved SQLs, enables
you to tune the system beforehand.

Also we can validate and measure the performance gain of the SQL and the system.

SQL Performance Analyzer automates the process of assessing the overall effect of a
change on the full SQL workload by identifying performance divergence for each SQL
statement. A report that shows the net impact on the workload performance due to the
change is provided. For regressed SQL statements, SQL Performance Analyzer also
provides appropriate executions plan details along with tuning recommendations. As
a result, you can remedy any negative changes before the end users are affected.

To use SQL Performance Analyzer, under Real Application Testing on the Software
and Support page, click SQL Performance Analyzer.

For more information about SQL Performance Analyzer, see the "SQL Performance
Analyzer" part in the Oracle Database Real Application Testing User’s Guide.

12.3.2 Testing Database Changes

Before system changes are made, such as hardware and software upgrades, extensive
testing is usually performed in a test environment to validate the changes. However,
despite the testing, the new system often experiences unexpected behavior when it
enters production because the testing was not performed using a realistic workload.
The inability to simulate a realistic workload during testing is one of the biggest
challenges when validating system changes.

Database Replay enables realistic testing of system changes by essentially re-creating
the production workload environment on a test system. Using Database Replay, you
can capture a workload on the production system and replay it on a test system with
the exact timing, concurrency, and transaction characteristics of the original workload.
This enables you to fully assess the impact of the change, including undesired results,
new contention points, or plan regressions. Extensive analysis and reporting is
provided to help identify any potential problems, such as new errors encountered and
performance divergence.

To use Database Replay, under Real Application Testing on the Software and Support
page, click Database Replay.

For more information about Database Replay, see the "Database Replay" part in the
Oracle Database Real Application Testing User's Guide

12-12 Oracle Fusion Applications Administrator's Guide



13

Managing Oracle Fusion Applications Log
Files and Diagnostic Tests

This chapter discusses how to use incidents, log files, QuickTrace, and diagnostics tests
to support normal operations for Oracle Fusion Applications and to prepare for future
troubleshooting.

This chapter contains the following topics:

s Introduction to Incidents, Log File Management, QuickTrace, and Diagnostic Tests
= Relationships Between Log Files and Diagnostic Tests

» Standard Log File Administration Tasks and Tools

= Log Files and Settings

s Log Message Structure

= Viewing and Searching Log Files During Normal Operation

s Configuring Settings for Log Files During Normal Operation

s Standard Diagnostic Testing Administration Tasks and Tools

s Configuring the Diagnostic Testing Framework for Normal Operation
= Using Diagnostic Tests to Monitor Normal System Health

For information about troubleshooting using log settings, log files, the QuickTrace
feature (in-memory logging), diagnostic tests, and incidents, see Chapter 14.

13.1 Introduction to Incidents, Log File Management, QuickTrace, and
Diagnostic Tests

Incidents, log files, QuickTrace, and diagnostic tests can all help you administer Oracle
Fusion Applications. If your Oracle Fusion Applications environment includes Oracle
Enterprise Manager Cloud Control (Cloud Control), then you can use Support
Workbench to help you investigate, report, and resolve problems.

Incidents are collections of information about problematic error conditions. It is
strongly recommended that you follow Information Technology Infrastructure Library
(ITIL) best practices by establishing a help desk or service desk within your
organization to support Oracle Fusion Applications, and have the help desk personnel
use incidents to track the troubleshooting and resolution of all problems. Some
incidents are created and gather information automatically when problems occur. For
example, the information associated with an automatically created incident may
include detailed operational info collected by the QuickTrace (in-memory logging)
feature for Oracle Fusion Applications. For problems that do not automatically create
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incidents, administrators or help desk personnel can manually create incidents and
manually gather and add related system information.

Log files contain information about both normal and problematic events. Log files can
help you both to monitor normal operation diagnose and to address some problems,
yourself. For example, log messages that state that a service cannot be reached might
indicate a hardware failure. If you discover a more complex issue, Oracle Support
personnel may use log files to trace the execution code paths of relevant requests, as
part of diagnosing the problem. And log files are particularly helpful if your Oracle
implementation contains custom code that needs debugging, especially when using a
debugger is not feasible, such as on a production system

The QuickTrace (in-memory logging) feature continuously records a specified level of
log detail in an area of memory. The memory is recycled on an ongoing basis, with the
oldest information being deleted or overwritten first. Because QuickTrace writes to
memory instead of to a log file, it can gather operational information continuously
without significantly affecting system performance. The information that QuickTrace
stores in memory is written to disk only when an incident occurs or when an
administrator manually dumps the contents of a QuickTrace buffer.

Diagnostic tests are executables that are designed to exercise particular aspects of
Oracle Fusion applications, to determine whether they are operating correctly and to
help identify and resolve any problems. The Diagnostic Testing Framework for Oracle
Fusion Applications lets you execute diagnostic tests and collects the results into
detailed diagnostic reports. Oracle provides diagnostics tests that are installed along
with Oracle Fusion Applications releases and patches.

In Cloud Control, Support Workbench helps you investigate, report, and resolve
problems (critical errors). You can use Support Workbench to perform the following
kinds of operations:

= View summary information about recent problems and incidents
s View detailed diagnostic data that was gathered automatically
= Manually trigger additional dumps of diagnostic data

= Connect to the Diagnostic Dashboard for Oracle Fusion Applications, which
provides you with additional diagnostic tests that you can run

= Create or update Service Requests with Oracle Support, including uploading
diagnostic data to Oracle

For information about using Support Workbench to administer Oracle Fusion
Applications targets, specifically, see Chapter 14. For general information about using
Support Workbench, see the topic "Support Workbench Page" in the Cloud Control
online help and the chapter on investigating, reporting, and resolving problems in
Oracle Database 2 Day DBA.

13.2 Relationships Between Log Files and Diagnostic Tests

13-2

The following features are designed to work together to help you administer and
support Oracle Fusion Applications over time:

= Logs and Error-Handling: Oracle developers use mechanisms such as application
programming interface (API) calls in Oracle Fusion Applications code to record
application operations in log files and to provide error messages as appropriate.
You can set system log levels to determine how much information is logged.
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For more information about setting log levels, see Section 13.7. For more
information about using logs to help diagnose a problem, see Chapter 14. For
more information about monitoring log files, see Section 13.6 and Section 13.7 4.

= Diagnostic Tests: Oracle developers create tests that you can use to help diagnose
and resolve Oracle Fusion application problems. A diagnostic test may or may not
be associated with a particular error message. If an Oracle Fusion application
handles a particular error in a way that triggers the creation of an incident, then
any diagnostic tests that are associated with the error message for the incident run
automatically. The test results are associated with the incident and the identity of
the user who received the error message is recorded.

For more information about diagnostic tests, see Section 13.8, Section 13.9,
Section 13.10, and Chapter 14.

It is important to be familiar with the following additional concepts that are related
logs and diagnostic tests:

= Seed Data: Information that Oracle provides to you in the form of database
records. Both error messages and diagnostic tests are included in seed data.

= Profiles: Settings that you can select in order to determine details of how the
application operates. Oracle Fusion applications include profile options that affect
how much information to log either for an entire site or a specific user.

For more information about profiles, see Section 13.7 and the chapter on
maintaining common reference objects in the Oracle Fusion Applications Common
Implementation Guide.

13.3 Standard Log File Administration Tasks and Tools

Under ordinary circumstances, the following administrative tasks are part of necessary
setup and maintenance of Oracle Fusion Applications log files:

»  Tuning system performance by adjusting configuration settings for logs
= Reviewing log files for general monitoring of system health

= Searching for specific information in log files

= Managing available disk space for log files

If your Oracle Fusion Applications environment includes Cloud Control, then you
may find it convenient to use Cloud Control to monitor log files in multiple domains,
simultaneously.

You can use the Oracle Enterprise Manager Fusion Applications Control (Fusion
Applications Control) user interface to complete all of the tasks listed in this section,
but only for one WebLogic domain at a time. In particular, you can use Fusion
Applications Control to configure log profile option values for Oracle Fusion
Applications, although you can also configure profile options by using the Manage
Administrator Profile Values screen in the Setup and Maintenance work area. You can
use either Cloud Control or Fusion Applications Control for viewing and searching
Oracle Fusion Applications log files.

Note: Fusion Applications Control and Cloud Control are compliant
with Information Technology Infrastructure Library (ITIL) best
practices.
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During troubleshooting activities, additional log administration tasks may include
downloading log files from servers and packaging incidents for transmittal to Oracle
Support. For more information about these activities and the tools for accomplishing
them, see Chapter 14.

13.4 Log Files and Settings

Oracle provides settings that determine the amount of information that is gathered
into the log files for your Oracle Fusion applications. You can either use the default
setting values or change one or more values to adjust how much information is
gathered. When your system is operating correctly, you may need log entries only for
particularly important kinds of events. If your system experiences a problem, you can
temporarily increase the amount of information that is logged to get more detailed
information while you attempt to reproduce and resolve the problem.

Most Oracle Fusion applications write log output in Oracle Diagnostic Logging (ODL)
format. For information about the attributes that appear in standard log files for Oracle
Fusion Applications, see the "Understanding ODL Messages and ODL Log Files"
section in the Oracle Fusion Middleware Administrator's Guide.

Some Oracle Fusion applications use nonstandard logging mechanisms that are
disabled by default. For these applications, you must turn on the logging facility when
you need it and specify the kind of information that you want to record in the log file.
For more information about these special logging mechanisms, see Section 13.7.6.

13.5 Log Message Structure
A typical log message consists of three parts:

= Attributes that are logged by the Oracle Fusion Middleware layer or the Oracle
Database layer

= Attributes that are logged by logging APIs for Oracle Fusion Applications,
including AppsLogger

= Message text
This section contains the following topics:

=  Log Message Attributes Supplied by the Oracle Fusion Middleware and Oracle
Database Layers

s Log Message Attributes Supplied by Logging APIs for Oracle Fusion Applications
= Log Message Attributes Supplied by the Application Session

= Log Message Attributes Supplied by Oracle Enterprise Scheduler Job Requests

= Log Message Attributes Supplied by SOA

13.5.1 Log Message Attributes Supplied by the Oracle Fusion Middleware and Oracle
Database Layers

The log message attributes logged by the Oracle Fusion Middleware layer or the
Oracle Database layer may include the following;:

s Date/Time: The date and time when the message was recorded in the log.

s Component ID: The component or Oracle WebLogic Server instance from which
the message originated. For the Oracle Fusion Middleware layer, a typical value is
the name of the Oracle WebLogic Server that was executing the Oracle Fusion
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application when the message was generated. For the database layer, a typical
value is rdbms .

Message Type:Level: Shows the level being logged for the particular message

Message ID: A unique identifier for a seeded message, composed of the product
code and a message number. A typical value for a Message ID might be
FND-12343.

Module ID: The system or application module that generated the message. This is
usually the name of the logger object that generated the message. In some cases,
the logger name may reflect the full Java class name of the application code
module that was executing when the message was logged. In other cases, the
logger object may generate messages for multiple Java classes.

Execution Context ID (ECID): A global unique identifier and a sequence number
of the thread of execution that the originating component participates in. The
identifier can be used to correlate messages from several components that may be
involved in the same thread of execution.

Host: The host name where the message originates. For Java, this should be the
value returned by java.net.InetAddress.getLocalHost().getHostName().

Thread ID (TID): A unique identifier for the thread within the Java process where
the message was generated.

Java EE Application Name: Name of a Java EE application that was executing
when the message was logged.

User Name: A unique identifier that the user enters when signing in to an Oracle
Fusion application. This attribute is logged both by Oracle Fusion Middleware and
by the logging APlIs for Oracle Fusion Applications.

Selective Trace ID (labeled ODL_TRACE_ID in the log file): An identifier for
operations in the Oracle Fusion Middleware layer that match criteria an
administrator supplied as part of a request to log additional information.

Note: Selective trace operations do not affect the information that is
logged from the Oracle Fusion Applications layer, but the Oracle
Fusion Middleware log messages that selective tracing operations
obtain are stored in the same log files as log messages from the Oracle
Fusion Applications layer. Similarly, log messages from the Oracle
Fusion Applications layer are listed along with Oracle Fusion
Middleware log messages in selective trace output if those log
messages match the trace criteria that the administrator specified. For
more information about selective tracing, see the "Configuring and
Using Selective Tracing" section in the Oracle Fusion Middleware
Administrator’s Guide.

13.5.2 Log Message Attributes Supplied by Logging APIs for Oracle Fusion

Applications

The log message attributes logged by logging APIs for Oracle Fusion Applications
include the following:

User Name: A unique identifier that the user enters when signing in to an Oracle
Fusion application. This attribute is logged both by Oracle Fusion Middleware and
by the logging APIs for Oracle Fusion Applications.

User GUID: A global unique identifier representing the user.
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Role IDs: A list of IDs representing the job roles granted to the user.
Session ID: A unique identifier for the application user session.

Thread Name: A name that identifies the thread generating the log in JVM.
Applies only to Oracle Fusion applications that are written in Java. Logging APIs
for Oracle Fusion applications that are written in C and PL/SQL do not populate
this attribute.

Apps Source: The portion of the Oracle Fusion Applications code that is executing
when the message is logged.

Apps Auto Log: Indicates whether the message being logged was logged
implicitly.

DB Connection URL: The URL connection string for the application database data
source.

Depending on the value of the AFLOG_EXTENDED_ENABLED profile option, the following
supplemental attributes may also be logged:

Message Cause: The reason that the message is being logged.

Admin Action: Recommended follow-up action for Oracle Fusion Applications
administrators.

Admin Details: Additional information for administrators about the condition
being logged.

User Action: Recommended follow-up action for Oracle Fusion Applications
users.

User Details: Additional information for users about the condition being logged.

For more information about how the AFLOG_EXTENDED_ENABLED profile option affects
the logging of these supplemental attributes, see Section 13.7.1.

13.5.3 Log Message Attributes Supplied by the Application Session

The log message attributes logged by the application session include the following;:

Product Family: The name of the product family that is executing when the
message is logged.

Product: The name of the product that is executing when the message is logged.

13.5.4 Log Message Attributes Supplied by Oracle Enterprise Scheduler Job Requests

The following attributes appear in the log if the log entry is written from an Oracle
Enterprise Scheduler job request.

Job Request ID: The identifier of the Oracle Enterprise Scheduler job request that is
being executed when this message is logged.

Job Definition Name: The name of the Oracle Enterprise Scheduler job definition.
A job definition is the smallest unit of work that is performed in the context of the
client application.

Job Package Name: The package location of the Oracle Enterprise Scheduler job
definition that is executing when this message is logged.

Job Definition Application: The application that owns the Oracle Enterprise
Scheduler job.
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13.5.5 Log Message Attributes Supplied by SOA

The following attributes appear in the log if the log entry is written from SOA:

s SOA Composite Name: The name of the SOA Composite that is executing when
the message is logged

s SOA Component Name: The name of the SOA Component that is executing when
the message is logged

s SOA Composite Instance ID: The instance ID of the SOA Composite that is
executing when the message is logged

s SOA Component Instance ID: The instance ID of the SOA Component that is
executing when the message is logged

= Log Token Map: one or more primary key values for the logical entity that a BPEL
process is handling when the message is logged. Oracle Support may require this
information for troubleshooting purposes.

13.6 Viewing and Searching Log Files During Normal Operation

To view and search Oracle Fusion application log files effectively, it is important to be
familiar with the software that is available for working with log files. From time to
time you may also find it helpful to know where log files are stored for various
application modules.

This section contains the following topics:

= Viewing Logs from Fusion Applications Control

= Searching for Specific Information in Log Files within a Single Domain

= Searching for Specific Information in Log Files Across Multiple Domains
» Typical Log File Locations

s Location of Logged Information When Using Multiple Managed Servers

Note: Each Oracle Fusion Applications module is written in one of
the following code languages: Java, SOA, PL/SQL, or C. Details of
logging vary depending on the coding language of the application
module.

In general, you can administer logging for Oracle Fusion Applications
without knowing which programming language implements
particular modules. However, it is important to become familiar with
the configuration settings and log file locations used for each
language, so you can monitor or adjust all relevant parts of the system
when necessary.

13.6.1 Viewing Logs from Fusion Applications Control

When you want to view log files for one Oracle Fusion Applications product family or
product that uses standard logging functionality, one typical way that you can view
the log files is to use Fusion Applications Control.

By default, you can use Fusion Applications Control to view standard log files for the
Oracle WebLogic Servers that host Oracle Fusion applications and standard log files
generated by Java code within Oracle Fusion applications. In addition, you can
configure your system to allow Fusion Applications Control to view log files
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generated by PL/SQL or C code within Oracle Fusion applications. For more
information about how to configure this capability, see Section 13.7.7.

From Fusion Applications Control, you can view log messages for different system
components by selecting different targets. In the product family part of the navigation
tree, the following target types allow viewing of log messages for Oracle Fusion
Applications:

= An entire product family. When you select this target type and view log files, you
view the aggregated logs for all of the servers and clusters in the selected product
family's domain.

= A particular Oracle Fusion application, such as Procurement, sometimes called an
Oracle Fusion Applications cluster application. When you select this target type
and view log files, you view the aggregated logs for all of the servers in the
selected cluster.

= A particular instance of an Oracle Fusion application deployed to a Managed
Server. When you select this target type and view log files, you view the log for the
selected individual Managed Server.

The Fusion Applications Control page also gives you access to log files for the
following target types in the farm part of the navigation tree, but the functionality
used to view those logs is part of Fusion Middleware Control. For more information,
see the "Viewing Log Files and Their Messages Using Fusion Middleware Control"
section in the Oracle Fusion Middleware Administrator's Guide.

= A particular Oracle WebLogic Server domain
= A particular server cluster

= A particular server within a particular server cluster

Note: For information about viewing Oracle Fusion Middleware log
files, including log files for Oracle Enterprise Scheduler and Oracle
Enterprise Crawl and Search Framework, see the "Viewing and
Searching Log Files" section in the Oracle Fusion Middleware
Administrator’s Guide.

To view the contents of Oracle Fusion Applications logs from Fusion Applications
Control:

1. From the navigation pane, select the target for which you want to display log
contents.

In the part of the navigation tree for the product family, you can display logs for
the following kinds of targets:

= A product family target lets you display the aggregated log entries for all of
the Oracle Fusion applications in the selected product family. For example,
Financials is a product family target that appears as a top-level folder in the
navigation tree.

= An Oracle Fusion Applications cluster application target lets you display the
aggregated logs for all of the Managed Servers that run the selected
application, including the logs for any other Oracle Fusion applications that
run on those Managed Servers. For example, if you expand the product family,
Financials, and then expand Fusion Applications, then the PayablesApp
listing is a cluster application target.
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= An Oracle Fusion application instance target lets you display just the log
entries for the selected application on the selected sever. For example, if you
expand the product family, Financials, and then expand Fusion Applications,
and then expand PayablesApp, then the PayablesApp (PayablesServer_1)
listing is an application instance target.

Note: When you select a target, the header of the context pane
displays a dropdown menu name that depends on the target type:

»  For a product family target, the menu name is Product Family.

s For an Oracle Fusion Applications cluster application target, the
menu name is Fusion Cluster Application.

s For an Oracle Fusion application instance target, the menu name
is Fusion J2EE Application.

Alternatively, if you want to view a log file for an Oracle Fusion Middleware
target, you can select such a target from the farm part of the navigation tree. For
more information about viewing log files for Oracle Fusion Middleware
components, see the "Viewing Log Files and Their Messages Using Fusion
Middleware Control" section in the Oracle Fusion Middleware Administrator’s Guide.

2. In the context pane, from the dynamic target menu, choose Logs > View Log
Messages to display the log entries for the target you selected.

13.6.2 Searching for Specific Information in Log Files within a Single Domain

For most Oracle Fusion applications, you can use Fusion Applications Control to
search for log messages that have specific characteristics. Searches that use Fusion
Applications Control are very similar to searches that use Fusion Middleware Control.
For more information about these searches, see the "Viewing and Searching Log Files"
section in the Oracle Fusion Middleware Administrator’s Guide.

By default, you can use Fusion Applications Control to search standard log files for
Oracle Fusion applications that are written in Java and the Oracle WebLogic Servers
that host those applications. You can configure your system to allow Fusion
Applications Control to search log files for Oracle Fusion applications that are written
in PL/SQL or C, as well. For more information about the necessary configuration steps
for PL/SQL and C logs, see Section 13.7.7.

To search standard Oracle Fusion Applications log files using Fusion Applications
Control:

1. From the navigation pane for Fusion Applications Control, select the target for
which you want to search log contents.

For your target, you can select a product family such as Financials, an Oracle
Fusion Applications cluster application such as LedgerApp, or an Oracle Fusion
application instance such as LedgerApp (LedgerServer_1). For information about
searching log files in multiple domains, using a Fusion Instance target, see
Section 13.6.3.
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Note: When you select a target, the header of the context pane
displays a dropdown menu name that depends on the target type:

= For a product family target, the menu name is Product Family.

= For an Oracle Fusion Applications cluster application target, the
menu name is Fusion Cluster Application.

s For an Oracle Fusion application instance target, the menu name
is Fusion J2EE Application.

For example, if you want to search the aggregated log entries for all of the Oracle
Fusion applications in the Financials product family, then you would select the
Financials entry in the navigation tree. The Product Family dropdown menu
appears under Financials in the context pane header.

If you want to search the aggregated logs for the Ledger cluster application, you
would expand the Financials entry in the navigation tree, then expand the Fusion
Applications entry, and then select LedgerApp. The Fusion Cluster Application
dropdown menu appears under LedgerApp in the context pane header.

If you would rather search the Ledger application log entries for only a particular
server, you would expand the Financials entry in the navigation tree, then expand
the Fusion Applications entry, then expand the LedgerApp entry, and then select
the individual LedgerApp Managed Server for the log you want to search. The
Fusion J2EE Application dropdown menu appears under LedgerApp in the
context pane header.

2. In the context pane, from the dynamic target menu, choose Logs > View Log
Messages.

If you selected an Oracle Fusion application as your target, the content pane
displays the aggregated log messages from all of the servers for the Oracle Fusion
application that you selected.

If you selected an individual Oracle Fusion application instance running on a
particular Managed Server as your target, the content pane displays just the log
messages for the selected Oracle Fusion application operations that were handled
by the selected server.

If you selected a product family such as Financials as your target, the content pane
displays the aggregated log messages for all of the Managed Servers that handle
Oracle Fusion applications in the selected product family.

3. If necessary, expand the Search area of the content pane.
4, If you selected an Oracle Fusion application instance in Step 1, skip to Step 5.

If you selected a product family or Oracle Fusion Applications cluster application
in Step 1, complete the following substeps to determine which members of the
selected target will be included in the log search:

a. Expand the Selected Targets section of the Search area.

b. If you want to search the log files for only some of the listed target members,
select the ones you want to omit from the search and click Remove.

c. If you want the log search operation to search log files that are not currently
listed, click Add, select the additional targets that you want to search, and
click Select.

d. Proceed to Step 5.
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5. Enter or select applicable search criteria in any visible search fields, such as the
following fields that are visible by default:

In the Date Range fields, specify the time period for which you want to
display log messages.

To specify a specific number of the most recent minutes, hours, or days, select
Most Recent from the dropdown list, enter your preferred number, and select
the appropriate time units.

To specify the time period using starting and ending dates and times, select
Time Interval from the dropdown list and enter the starting and ending dates
and times.

In the Message Types field, select one or more checkboxes to specify the kinds
of log messages that you want to display.

In the Message fields specify some or all of the message text in the log
messages that you want to display.

If you select either the matches search operator or the does not match search
operator, you must either specify the full text of the message, or you must use
a standard Java language expression to specify the characteristics of the
missing text. For example, in standard Java expressions, the period character
(.) acts as a wildcard that matches most single characters, and the combination
of period and asterisk characters (.*) acts as a wildcard to match any string of
characters.

In contrast, the following search operators contain implicit wildcard
semantics, so you do not need wildcard characters or other Java expressions
when you use any of these operators to search for a part of the text of a
message:

— contains

— does not contain

— starts with

— does not start with
— ends with

— does not end with

Note: If you search for multiple values within a single search field,
using commas to separate the values, then the search results display
log entries that match any of the criteria specified for that field (logical
OR). However, if you specify criteria in multiple search fields, the
search results display only log entries that match specified criteria in
all of those search fields (logical AND).

6. If you want to use search criteria in fields that are not currently visible, complete
the following substeps; otherwise, skip this step.

a.

Click Add Fields.

b. Select one or more checkboxes for the additional fields you want to use in

your search, and then click Add.

For example, you might select ECID to search for all log messages that are
associated with a particular execution context identifier.
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7.

c. Ineach field that you added, specify the value that you want the search to
match.

For example, you might enter the ECID value of
004bYSyedEi3v1A5Jb8Dy£0002kx003XF£f.

Click Search.

13.6.3 Searching for Specific Information in Log Files Across Multiple Domains

If your Oracle Fusion Applications environment includes Cloud Control, you can use
Cloud Control to search for information in the log files of multiple domains within a
single Fusion instance.

To search standard Oracle Fusion Applications log files in multiple domains using

Cloud Control:
1. In Cloud Control, from the Target menu, choose Fusion Applications.
2. In the list of Oracle Fusion instances and Oracle Fusion Applications product
families, click the name of the instance that interests you.
3. From the dynamic Fusion Instance target menu, choose Logs > View Log
Messages
4. Ifitis collapsed, expand the Search area of the Log Messages pane.
5. Expand the Selected Targets part of the Search area, and make sure that it lists the
targets for all of the log files that you want to search:
= If you want to search the log files for only some of the listed target members,
select the ones you want to omit from the search and click Remove.
= If you want the log search operation to search log files that are not currently
listed, click Add, select the additional targets that you want to search, and
click Select.
6. Enter or select applicable search criteria in any visible search fields, such as the

following fields that are visible by default:

= In the Date Range fields, specify the time period for which you want to
display log messages.

To specify a specific number of the most recent minutes, hours, or days, select
Most Recent from the dropdown list, enter your preferred number, and select
the appropriate time units.

To specify the time period using starting and ending dates and times, select
Time Interval from the dropdown list and enter the starting and ending dates
and times.

= In the Message Types field, select one or more checkboxes to specify the kinds
of log messages that you want to display.

= In the Message fields specify some or all of the message text in the log
messages that you want to display.

If you select either the matches search operator or the does not match search
operator, you must either specify the full text of the message, or you must use
a standard Java language expression to specify the characteristics of the
missing text. For example, in standard Java expressions, the period character
(.) acts as a wildcard that matches most single characters, and the combination
of period and asterisk characters (.*) acts as a wildcard to match any string of
characters.
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In contrast, the following search operators contain implicit wildcard
semantics, so you do not need wildcard characters or other Java expressions
when you use any of these operators to search for a part of the text of a
message:

— contains

— does not contain

— starts with

— does not start with
— ends with

— does not end with

Note: If you search for multiple values within a single search field,
using commas to separate the values, then the search results display
log entries that match any of the criteria specified for that field (logical
OR). However, if you specify criteria in multiple search fields, the
search results display only log entries that match specified criteria in
all of those search fields (logical AND).

7. If you want to use search criteria in fields that are not currently visible, complete
the following substeps; otherwise, skip this step.

a. Click Add Fields.

b. Select one or more checkboxes for the additional fields you want to use in
your search, and then click Add.

For example, you might select ECID to search for all log messages that are
associated with a particular execution context identifier.

c. Ineach field that you added, specify the value that you want the search to
match.

For example, you might enter the ECID value of
004bYSyedEi3v1A5Jb8DYy£0002kx003XF£f.

8. Click Search.

13.6.4 Typical Log File Locations

Note: The following information is provided for reference purposes.
For maximum clarity and convenience, it is recommended that you
use Fusion Applications Control to work with Oracle Fusion
Applications log files, rather than working directly with the log files.

Each Oracle Fusion application runs in one or more logical Managed Servers. Each
Managed Server is dedicated to a single Oracle Fusion application. Different Managed
Servers do not normally share log files with each other, even if they are running on the
same physical server computer.

Most Oracle Fusion Applications code modules use standard logging code. On each
Managed Server, all Java and SOA application code modules that use standard logging
code write log entries to a single file. The location of this file is specified by a 1og_
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handler entryina logging.xml file. The default location for the logging.xml file is
as follows, where DOMAIN_HOME is the path to your Oracle WebLogic Server domain,
and WebLogic_Server Name is the name of the WebLogic Server that uses the
logging.xml file:

DOMAIN_HOME/config/fmwconfig/servers/WebLogic_Server Name/logging.xml

Example 13-1 shows a typical log_handler entry in the logging.xml file, which
includes the path and file name of the log file.

Example 13-1 Typical log_handler Entry Showing Log File Name and Location

<log_handlers>
<log_handler name='apps-handler'
class='oracle.core.ojdl.logging.ODLHandlerFactory'>
<property name='path'
value='${domain.home}/servers/${weblogic.Name}/logs/apps/
${weblogic.Name}-diagnostic.log'/>
<property name='maxFileSize' value='10485760'/>
<property name='maxLogSize' value='104857600"'/>
<property name='encoding' value='UTF-8'/>
<property name='supplem8entalAttributes' value='APPS_USER_NAME,
APPS_SESSION_ID, APPS_THREAD_NAME, APPS_SOURCE, APPS_USER_ID, APPS_AUTO_LOG,
APPS_JOB_REQUEST ID, APPS_JOB_DEFINITION_NAME, APPS_JOB_PACKAGE NAME,
APPS_JOB_DEFINITION_APP, APPS_COMPOSITE_NAME, APPS_COMPONENT NAME,
APPS_COMPOSITE_INSTANCE_ID, APPS_COMPONENT INSTANCE_ID, APPS_PRODUCT FAMILY,
APPS_PRODUCT, APPS_INDUSTRY, APPS_TERRITORY, APPS_DB_CONNECTION_URL,
APPS_MESSAGE_CAUSE, APPS_USER_ACTION, APPS_ADMIN_ACTION, APPS_USER_DETAILS,
APPS_ADMIN_DETAILS, APPS_LOG_TOKEN_MAP'/>
</log_handler>
</log_handlers>

Example 13-2 shows the default location for the standard log file is as follows, for
Oracle Fusion applications that are implemented in Java and SOA, where DOMAIN_HOME
is the path to your Oracle WebLogic Server domain:

Example 13-2 Default Log File Location for Oracle Fusion Applications Implemented in
Java and SOA

DOMAIN_HOME/servers/domain_name/logs/apps/server_name-diagnostic.log

For Oracle Fusion Applications code modules that are implemented in PL/SQL, the
location of the standard log file is set by the AFLOG_PLSQL_FILENAME profile option. By
default, the value of this profile option is APPLLOG_DIR/diagnostic.log, where
APPLLOG_DIR is a directory object that was defined as a custom variable through use of
the Oracle Fusion Applications Repository Creation Utility during installation. For
more information about directory objects, see the section about the Create Directory
command in the Oracle Database SQL Language Reference

For Oracle Fusion Applications code modules that are implemented in C, the location
of the standard log file is set by the AFLOG_FILENAME profile option. By default, the
value of this profile option is diagnostic.log, but itis recommended that you set the
value to directory path/Cdiagnostic.log, where directory path is alocation that
can be written to by all system users and by the Managed Server where Oracle
Enterprise Scheduler is deployed for your Oracle Fusion applications. For example,
you might set the value of directory_path to /tmp, or to an explicitly specified
directory path that corresponds to the value of the APPLCP_DIR custom variable that
was defined through use of the Oracle Fusion Applications Repository Creation Utility
during installation.
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By default, the following Oracle Fusion Applications code modules do not write log
entries. If you configure these modules to write log entries, then the entries for those
modules are written to nonstandard log file locations. These modules do not specify
any configuration settings using the standard logging.xml file:

= The following kinds of batch jobs for Oracle Fusion Incentive Compensation:
- Calculation
- C(lassification
— Collection
- Crediting
- Rollup

Note: For optimum performance, it is recommended that you use the
logging functionality that is available for these kinds of Oracle Fusion
Incentive Compensation batch jobs only when troubleshooting an
existing problem. For more information about using this feature and
viewing the results, see Section 14.2.10 and Section 14.5.2.

= The following kinds of batch jobs for Oracle Fusion General Ledger:
- OpenPeriod
— DPosting
- Translation
—  Close Process - Create Income Statement Closing Journals

- Close Process - Create Balance Sheet Closing Journals

Note: For optimum performance and log file sizes, it is
recommended that you use the logging functionality for these kinds of
Oracle Fusion General Ledger batch jobs only when troubleshooting
an existing problem. For more information about using this feature
and viewing the results, see Section 14.2.11.

s The Autolnvoice portion of the Oracle Fusion Receivables application

Note: The amount of information that is logged for Autolnvoice
depends on the value of the Log File Message Level system option
setting for each business unit. Any Autolnvoice log messages that
meet the level requirements are written to the standard log file for
Oracle Enterprise Scheduler.

For more information about configuring the Log File Message Level
system option setting, see Section 13.7.6.3. For more information about
adjusting this setting for troubleshooting and viewing the results, see
Section 14.2.12.
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13.6.5 Location of Logged Information When Using Multiple Managed Servers

Note: The following information is provided for reference purposes.
For maximum clarity and convenience, it is recommended that you
use Fusion Applications Control to work with Oracle Fusion
Applications log files, rather than working directly with the log files.

If an Oracle Fusion application is deployed to multiple Managed Servers in a cluster
domain, each Managed Server records log entries in its own log file, for just the
transactions or other operations handled by that server.

For your convenience in monitoring Oracle Fusion applications that run on multiple
Managed Servers, Fusion Applications Control lets you view either individual
standard log files for individual Managed Servers or the aggregated contents of the
standard log files of all of the servers in the cluster domain. The aggregated log is
especially useful if you need to find a particular log entry but do not know which
Managed Server recorded it. For more information about viewing log files, see
Section 13.6.1.

However, Fusion Applications Control does not currently support viewing the
contents of any nonstandard log files generated by Oracle Fusion Incentive
Compensation, Oracle Fusion General Ledger, or the AutoInvoice portion of the
Oracle Fusion Receivables application. For information about viewing nonstandard
log files for Oracle Fusion Incentive Compensation, see Section 14.5.2. For information
about viewing nonstandard log files for Oracle Fusion General Ledger, see

Section 14.2.11. Log entries for the AutoInvoice portion of Oracle Fusion Receivables
are placed in the standard log file for Oracle Enterprise Scheduler. For information
about viewing Oracle Fusion Middleware log files, including log files for Oracle
Enterprise Scheduler, see the "Viewing and Searching Log Files" section in the Oracle
Fusion Middleware Administrator’s Guide.

Note: When an Oracle Fusion application is deployed to multiple
Managed Servers in a cluster domain, it is generally recommended
that you set the log level to the same value for all of the Managed
Servers, so that all of the servers will log comparable amounts and
kinds of information. However, you can configure each Managed
Server's log level independently, if you have a reason to do so.

13.7 Configuring Settings for Log Files During Normal Operation

Although critical business logic sections of Oracle Fusion applications may write more
information to log files than less critical areas of the application code, the amount of
information that Oracle Fusion applications log depends primarily on how the
environment is configured. Oracle supplies default values for log settings, but you can
specify different setting values if you want to adjust the amount of information to be
logged. Most Oracle Fusion Applications components use a standard set of log
configuration settings. For information about the selected components that use
nonstandard log settings, see Section 13.7.6.

This section contains the following topics:
»  Default System Log Settings
= When Changes to Log File Configuration Settings Take Effect
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= Standard Logging Levels

= Managing Log File Size and Disk Space Usage

= Using Profile Options to Configure Standard Log Settings

= Using Additional Settings to Configure Logs for Selected Components
s Configuring Access to Logs for Fusion Applications Control

The concepts of logging levels and profile options apply to most Oracle Fusion
applications. Logging levels are thresholds that can be set to control how much
information to log.

To set logging levels either for a whole site or for a particular user, administrators
change profile option values from either the Log Configuration dialog in Fusion
Applications Control or the Manage Administrator Profile Values screen in the Setup
and Maintenance work area. For more information, see the chapter on maintaining
common reference objects in the Oracle Fusion Applications Common Implementation
Guide.

Under certain specific conditions, Oracle Fusion Applications users can set their own
profile option for logging levels, from the Troubleshooting Options dialog under the
Oracle Fusion Applications Help > Troubleshooting menu. Setting a logging level for
a particular user is useful if you want only that user to gather more detailed log
information while attempting to reproduce a problem. However, the Help >
Troubleshooting menu displays the Troubleshooting Options command only for
Oracle Fusion Applications users who have a job role that is mapped to the following
three duty roles:

= Supportability Level Management Duty (CRM) (FND_SET_SUPPORTABILITY
LEVEL_DUTY_CRM)

= Supportability Level Management Duty (FSCM) (FND_SUPPORTABILITY LEVEL_
MANAGEMENT_DUTY_FSCM)

= Supportability Level Management Duty (HCM) (FND_SUPPORTABILITY_ LEVEL_
MANAGEMENT_ DUTY_HCM)

Note: Oracle Fusion Applications seed data does not include a
preconfigured job role that maps to these three duty roles. It is
recommended that you define such a job role when you first need to
give an Oracle Fusion Applications user access to the Troubleshooting
Options dialog. You can reuse the same job role for other users who
subsequently need the same access.

For more information about making the Troubleshooting Options command and
dialog available to selected Oracle Fusion Applications users, and about working with
those users to gather troubleshooting data, see Section 14.2.1.

The following types of settings affect how logging is done, including the effective
logging level:

m  AFLOG_SettingName profile option values. For information about the AFLOG_
SettingName profile options, see Section 13.7.1 through Section 13.7.5. For general
information about working with profile options at both the SITE and USER levels,
see the "Setting and Accessing Profile Values" and "Managing Profile Definitions"
sections in the Oracle Fusion Applications Developer’s Guide.
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Note: For AFLOG_SettingName profile options, the PRODUCT level is
reserved for future use.

= Oracle Diagnostics Logging Level: The log level for Oracle Fusion applications
that are written in Java or SOA. The value for this setting is specified in each
Managed Server's logging.xml file, in the oracle.apps entry. Log levels for most
entries are adjusted using the Managed Server's Log Configuration page in Fusion
Middleware Control, rather than by directly editing the logging.xml file.
However, the log level for the oracle.apps entry should remain set to the default
value of A11 unless Oracle Support gives you specific instructions to change it. For
more information about this setting, see "Setting the Level of Information Written
to Log Files" in the Oracle Fusion Middleware Administrator’s Guide.

Caution: The logging framework for Oracle Fusion Applications is
designed to work with the Log Level for the oracle.apps logger set
to the default value of A11. If you use other values for this setting, the
diagnostic framework may not appear to work correctly, because
setting values other than A11 can interfere with normal logging
operations.

13.7.1 Default System Log Settings

The seed data for Oracle Fusion Applications contains default values for many profile
option settings. Normal operation settings for log files are described in Table 13-1. For
information about default system settings for incidents and QuickTrace, see

Section 14.2.
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Table 13-1

Profile Options for Oracle Fusion Applications Logging

Profile Option Applicable
Name Possible Profile
(and Display Values or Hierarchy Default
Name) Environment  Description Example Levels Value
AFLOG_ PL/SQLonly  Asynchronous buffer mode for 0, 1 Site, User 0
BUFFER_MODE PL/SQL logging. A value of 0
. disables buffering; a value
ﬁlo\g% f]?) ?ffer greater than 0 enables
PL/SQL) buffering for messages that
have levels lower than
WARNING. PL/SQL log
messages that have SEVERE
level or WARNING level are not
buffered.
You may want to use
asynchronous buffering if you
have set your log levels to
collect very detailed
information and find that your
system is running slowly.
When asynchronous buffering
is enabled, log messages from
PL/SQL code that are at the
INFO log level or below are
written to a buffer rather than
being immediately written to a
log file. This reduces disk I/O
activity. The buffer is written to
the log file only when it
contains the number of records
specified in the AFLOG_BUFFER_
SIZE setting.
AFLOG_ PL/SQLonly = Number of PL/SQL log 1024 Site, User 1000
BUFFER_SIZE records that are buffered in
memory before they are
(SEND' Buffer written}fco the log ﬁ}lle.
ize for
PL/SQL)
AFLOG_ Java, PL/SQL, Enables or disables standard Y, N Site, User Y
ENABLED C, and SOA logging functionality for
. Oracle Fusion Applications. If
gnljgéla)og the value of this profile option

is N, and if the profile option
sets the effective logging level,
then standard Oracle Fusion
Applications logging does not
occur at runtime for
application modules written in
Java, PL/SQL, SOA, or C. This
profile option does not affect
the configuration for Oracle
Fusion Middleware.
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Table 13-1 (Cont.) Profile Options for Oracle Fusion Applications Logging

Profile Option Applicable
Name Possible Profile
(and Display Values or Hierarchy Default
Name) Environment  Description Example Levels Value
AFLOG_ Javaand SOA  Determines whether ornotto Y, N Site Y
EXTENDED_ log the following extended
ENABLED attributes:
(FND: Log s Message Cause
Extension (APPS_MESSAGE_CAUSE)
Enabled) s User Action
(APPS_USER_ACTION)
s User Details
(APPS_USER_DETAILS)
s Admin Action
(APPS_ADMIN_ACTION)
s Admin Details
(APPS_ADMIN_DETAILS)
When the value of this profile
option is ¥, all of these
extended attributes are logged.
When the value of this profile
option is N, none of these
extended attributes are logged.
AFLOG_ Conly Full path and file name of the ~ /temp/ Site, User diagnost
FILENAME log file for all of the Oracle Cdiagnostic.log ic.log
. . Fusion applications that are
ngg) Log File written in C and that use

standard logging functionality.

It is recommended that you set
the value of this profile option
to directory_path/
Cdiagnostic.log, where
directory_pathis a location
that can be written to by all
system users and by the
Managed Server where Oracle
Enterprise Scheduler is
deployed for your Oracle
Fusion applications. For
example, you might set the
value of directory_pathto
/tmp, or to an explicitly
specified directory path that
corresponds to the value of the
APPLCP_DIR custom variable
that was defined through use
of the Oracle Fusion
Applications Repository
Creation Utility during
installation.

If you do not set a directory
path for this log file, the file is
written to the default location
specified by Oracle Enterprise
Scheduler.
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Table 13-1 (Cont.) Profile Options for Oracle Fusion Applications Logging

Profile Option Applicable
Name Possible Profile
(and Display Values or Hierarchy Default
Name) Environment  Description Example Levels Value
AFLOG_LEVEL Java, PL/SQL, Minimum level of information 1000, 900, 800, Site, User 1000
(FND: Lo C, and SOA detail to be logged for Oracle 700, 500, 400, 300
Levelj & Fusion applications that use
standard logging functionality.
If no value is set for this profile
option, the default value is
1000 (SEVERE).
For more information about
log levels, see Section 13.7.3.
AFLOG_MAX_ PL/SQL Specifies the size in megabytes 10 Site 10
FILE_SIZE beyond which the current
(FND: standard log file for Oracle
Maxir'num size Fusion applications that are
for lo file in written in PL/SQL is
MB.) & automatically renamed and a
’ new log file is started.
AFLOG_MODULE Java, PL/SQL, Specifies the Oracle Fusion %, %financial% Site, User %
C, and SOA applications for which loggin,
f\lj[ND. Log tszis place. Use a BB
odule Filter)

comma-separated list of
modules for value of this
setting, and use % as a wild
card character. If no value is
specified, all modules are
logged.
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Table 13-1 (Cont.) Profile Options for Oracle Fusion Applications Logging

Profile Option

Name Possible

(and Display Values or
Name) Environment  Description Example

Applicable
Profile
Hierarchy
Levels

Default
Value

AFLOG_ PL/SQL The maximum number of Any integer greater

NUMBER_OF_ PL/SQL log files the system than zero.
LOG_FILES keeps at any one time.

FND: Number
of old log files

AFLOG_PLSQL_ PL/SQL only The location and name of the APPLLOG_DIR/
FILENAME log file for standard Oracle mylog.log
(FND: Log File Fusion Applications log
for PL/SOL) messages that are generated

from PL/SQL. The location

must be expressed as a

directory object.

By default, the SITE level
value for this profile option is
set to APPLLOG_DIR/
diagnostic.log, where
APPLLOG_DIR is a directory
object that was defined using
the Oracle Fusion Applications
Repository Creation Utility
during installation.

If you would like the log file
name to indicate that the log
messages are generated from
PL/SQL, you can change the
AFLOG_PLSQL_FILENAME profile
option value to a value such as
APPLLOG_DIR/
plsgldiagnostic.log.

For more information about
directory objects, see the
section about the Create
Directory command in the
Oracle Database SQL Language
Reference.

FND_MESSAGE_ Java, PL/SQL, For error conditions that use ADMIN, USER
MODE C, and SOA messages from the message
(Message d1ct10na.1ry, this setting
determines whether
Mode) L
administrator-level or
user-level message details and
suggested actions are
displayed and logged.

Site

Site, User

Site,
Product,
User

10

APPLLOG_
DIR/
diagnost
ic.log

User

13.7.2 When Changes to Log File Configuration Settings Take Effect

For PL/SQL and C processes such as scheduled jobs, changes to log file profile options
take effect in the same ways as changes to any Oracle Fusion Applications profile
option values. For more information, see the chapter on maintaining common
reference objects in the Oracle Fusion Applications Common Implementation Guide.

For user sessions, users may need to log out from an Oracle Fusion application and log
in again in order to have changes to log profile options take effect.
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13.7.3 Standard Logging Levels

Seven severity levels are used for log messages in Oracle Fusion Applications, and
each level is associated with a number. In circumstances where the effective logging
level depends on the AFLOG_LEVEL logging profile option (rather than a lower
odlLevel setting value), then, once the profile option level is set, only application
messages that have a predefined severity level greater than or equal to the value of the
AFLOG_LEVEL profile option are logged.

You can set the value of the AFLOG_LEVEL profile option to one value for the site as a
whole, and to another value for any user whose operations you want to log at a
different level of detail.

For example, setting the level to the lowest severity, 300 (FINEST), for a particular
user means that messages of all seven severities are logged for that user's operations.
Setting the level to 900 (WARNING) or the site means that logging occurs for 900
(WARNING) and 1000 (SEVERE) messages for all site operations initiated by other
users.

Note: The default severity level for Oracle Fusion Applications is
1000 (SEVERE. For optimum performance, it is recommended that you
use this logging level for your sites unless you need to investigate a
problem that specifically requires a change to a site's severity level.
Gathering detailed log information for an entire site (rather than a
single user) can decrease system performance and make it difficult to
find relevant information in a log file.

Table 13-2 describes the seven severity levels that are used for log messages in Oracle
Fusion Applications. The messages in the log file identify the severity of errors using
the ODL Message Type/Level value.

Note: Oracle Fusion applications that are written in PL/SQL have
logging level names that start with LEVEL_. Oracle Fusion
applications that are written in Java, SOA, and C do not use this
LEVEL_ prefix for level names. For example, the log level that is called
LEVEL_SEVERE in PL/SQL application code is comparable to the log
level that is called SEVERE in Java, SOA, or C code.

Most log levels provide information that is useful to Oracle Fusion
Applications administrators. However, the information that is logged
at the FINER and FINEST log levels is primarily intended for use by
Oracle.
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Table 13-2 Severity Levels for Logging Messages

Log Level Name

(in Oracle Enterprise AFLOG_LEVEL

Manager Fusion : :
Applications Control Profile Option

Value
ODL Message and Help > .
TypelLevel Troubleshoot!ng > (mterna_ll values
Troubleshooting stored in
(in Log Files) Options) database tables)

Usage and Examples

Log Levels for Reporting Failures and Normal Events:

ERROR:1 SEVERE 1000
WARNING:1 WARNING 900
NOTIFICATION:1 INFO 800

Log Levels for Tracing and Reporting Progress:

NOTIFICATION:16 CONFIG 700
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Highest severity level. Unexpected errors that
occur during normal execution. Fatal
exceptions or any other serious problems that
require immediate attention from the System
Administrator. An error at this level may also
create an incident. For example, the following
error messages might be associated with this
log level:

The process cannot be started now because
another process is using the data.

The participant's rate could not be
found. Contact your benefits
administrator to validate the standard
rate for this compensation object.

Internal software failures. Non-fatal exceptions
or errors that allow processing to continue
without requiring immediate attention from an
administrator. Any potential problem that
should be reviewed by the System
Administrator.

For example, the following error message
might be associated with this log level:

You must change your password before
date.

Errors, warnings and other kinds of
information that allow processing to continue.
May include key flow steps, high-level
functional progress messages, and major life
cycle events such as the activation or
deactivation of a primary sub-component or
feature.

Configuration properties and environment
settings. This is a finer level of granularity for
reporting normal events.
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Table 13-2 (Cont.) Severity Levels for Logging Messages

Log Level Name

(in Oracle Enterprise AFLOG LEVEL
Manager Fusion Profile (_)ption
Applications Control /., 1o

and Help >

Troubleshooting > (internal values
Troubleshooting stored in

(in Log Files) Options) database tables)

ODL Message
Type/Level

Usage and Examples

TRACE:1 FINE 500

TRACE:16 FINER 400

TRACE:32 FINEST 300

High-level technical progress messages; more
detailed than INFO level. Trace or debug
information for events that are meaningful to
users of the product, such as public application
programming interface (API) entry/exit points.

For example, the following error message
might be associated with this log level:

User has chosen to Cancel the Purge
operation.

Logging messages that are called at the
beginning and end of a routine. Detailed trace
or debug information that can help Oracle
Support diagnose problems with a particular
subsystem.

For example, the following error message
might be associated with this log level:

Entering validateLogin.

Very detailed trace or debug information that
would be useful to an Oracle developer who is
working on the product and who is familiar
with implementation details of the sub-system
that generates the message.

For example, the following error message
might be associated with this log level:

Copying string from buffer xyz to
buffer zzz.

Note: Whenever an incident is created, a different log level,
INCIDENT_ERROR, automatically appears in the corresponding log
entry. This is the only context in which the INCIDENT_ERROR log level
is used. For more information about working with incidents, see

Chapter 14.

13.7.4 Managing Log File Size and Disk Space Usage

In busy computing environments, the amount of disk space used by log files can
become a concern. Very large log files can also affect system performance. Oracle
Fusion applications that are written in Java, SOA, or PL/SQL address this concern

using automatic log file rotation.

This section contains the following topics:

= Managing Rotating Log File Space Usage for Java and SOA Applications

»  Managing Rotating Log File Space Usage for PL/SQL Applications

= Managing Log File Space Usage for C Applications
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Note: Oracle Fusion applications that are written in C require you to
monitor the space used and manually discard log files that are no
longer needed.

13.7.4.1 Managing Rotating Log File Space Usage for Java and SOA Applications

For Oracle Fusion Applications modules that are implemented using Java or SOA and
that use standard logging, when a the log file reaches a specific size or when a specific
time period has passed, the file is automatically renamed, and a new log file is created.

You can use any of the following methods to adjust the settings that determine the
maximum log file size and the maximum length of time that a log file covers:

s Use Fusion Middleware Control commands to change the log rotation policies for
the oracle.apps logger. For more information, see "Specifying Log File Rotation
Using Fusion Middleware Control" in the Oracle Fusion Middleware Administrator’s
Guide.

»  Edit the settings in the log_handler section of the ODL configuration file, at the
following location:

DOMAIN_HOME/config/fmwconfig/servers/WebLogic_Server. Name/logging.xml

where DOMAIN HOME is the domain home directory for the Oracle WebLogic Server
domain, and WebLogic_Server_Name is the name of the WebLogic Server that uses
the logging.xml file.

= Use WebLogic Scripting Tool (WLST) Log Configuration commands to change the
log rotation policies for the apps-handler log handler. For more information, see
the section on the configureLogHandler command in the chapter on logging
commands in the Oracle Fusion Middleware WebLogic Scripting Tool Command
Reference and "Specifying Log File Rotation Using WLST" in the Oracle Fusion
Middleware Administrator’s Guide.

The maxFileSize or Maximum Log File Size setting determines the maximum size
that a standard Java or SOA log file can reach before being renamed. The default value
is 10485760 bytes.

The rotationFrequency or Frequency setting determines the maximum amount of
time that can pass before a standard Java or SOA log file is renamed. There is no
default value for this setting. If no value is specified, then the log file is not renamed
after any particular time period, but only when it reaches its maximum allowed size.
Valid values for the rotationFrequency setting are numbers representing the length
of the time period in minutes, as well as the following case-insensitive values:

= hourly
s daily
= weekly

When a standard Java or SOA log file is renamed, the new name is of the format Iog_
file name-n.log, where nis a positive integer and log_file name is the file name
specified for the path property of the apps-handler log handler in the logging.xml
file. (By default, log_file nameis set to server_name-diagnostic.log).

In log_file name-n.log, the value of n depends on the names of the log files that are
already present in the directory. If the directory contains no previously renamed log
files, then the first renamed log file is called log_file name-1.log. If other log files do
exist, then n is set to the next higher integer after the highest integer that is already in
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use. For example, if the directory contains log_file_name-1.log through log file_
name-8.log atthe time when log_file name.log reaches a time or size limit, then
the Iog_file name.log fileis renamed to Iog file name-9.log

When the aggregated size of current and older log files reaches a specific value, older
log files are deleted automatically, to keep the disk space usage of the log file directory
below that specific value.

The maxLogSize or Maximum Size of All Log Files setting determines the directory
size at which older log files begin to be deleted. The default value is 104857600 bytes.

13.7.4.2 Managing Rotating Log File Space Usage for PL/SQL Applications

For Oracle Fusion Applications modules that are implemented using PL/SQL, when a
diagnostic.log file reaches a specific size, the diagnostic.log file is automatically
renamed, and a new diagnostic.log file is created. If the AFLOG_PLSQL_FILENAME
profile option is set so that the logging framework uses a log file name other than
diagnostic.log, then the file name that the profile option specifies is used, instead of
diagnostic.log.

Use the following profile options settings to specify the maximum log file size:

s AFLOG_MAX_FILE_SIZE: This setting specifies the size in megabytes beyond which
a PL/SQL log file name is automatically renamed and a new log file is started. The
default value is 10 megabytes.

Note: If the AFLOG_BUFFER_MODE profile option is set to a value larger
than 0, enabling asynchronous buffering of PL/SQL log entries, then
the actual maximum size of any single PL/SQL log file is the value of
AFLOG_MAX_FILE_SIZE plus the number of megabytes that are flushed
from the buffer. This value is always approximate, because the
amount of information that can accumulate in the buffer is set using
the AFLOG_BUFFER_SIZE setting, which specifies a specific number of
log records, rather than a specific number of megabytes.

= AFLOG_NUMBER_OF_LOG_FILES: This setting specifies the maximum number of
PL/SQL log files the system keeps at any one time. The default value is 10 files.

PL/SQL log rotation is currently done only on the basis of file size, not on the basis of
the passage of a specified amount of time.

When a PL/SQL log file is renamed, the new name depends on whether or not the
AFLOG_PLSQL_FILENAME profile option is set:

» If the profile option is set, then the new log file name is of the format AFLOG_
PLSQL_FILENAME value-n.log, where n is a positive integer.

» If the profile option is not set, then the new log file name is of the format
diagnostic-n.log, where n is a positive integer.

The value of n depends on the names of the log files that are already present in the
directory. If the directory contains no previously renamed log files, then the first
renamed log file is called diagnostic-1.log or AFLOG_PLSQL_ FILENAME_value-1.log.
If other log files do exist, then n is set to the next higher integer after the highest
integer that is already in use. For example, if the directory contains diagnostic-1.log
through diagnostic-8.1og at the time when the diagnostic.log file surpasses the
size limit set in the AFLOG_MAX_FILE_SIZE profile option, then the diagnostic.log file
is renamed to diagnostic-9.1log.
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When the number of log files reaches the value specified using the AFLOG_NUMBER_OF_
LOG_FILES profile option, then older log files are deleted automatically, to prevent the
disk space usage of the log file directory from growing too large.

Over time, the value of nin diagnostic-n.log or AFLOG_PLSQL FILENAME
value-n.log can grow large enough to cause usability challenges or exceed the
number of characters that the operating system allows in a file name. If you want to
have the value of n start over at 1, you can move all existing log files except the
currently active diagnostic.log file or AFLOG_PLSQL_FILENAME value.log file into
another directory. When the active file surpasses the size limit and the log rotation
code finds no previously renamed log files in the directory, the active file is renamed
using a value of 1 for n.

Note: If your Oracle Fusion Applications environment includes
multiple database nodes such as RAC systems, each database node
corresponds to a server instance that has its own location for log files.

If an incident is created, the server instance that creates the incident
handles all subsequent jobs related to that incident. Identifiers for
incidents are unique within a specific instance, but not across
instances. For more information about working with incidents, see
Chapter 14.

13.7.4.3 Managing Log File Space Usage for C Applications

Oracle Fusion Applications modules that are implemented in C currently produce log
files that continually increase in size.

To manage log file space usage for log files created by Oracle Fusion Applications
modules that are written in C:

1. Navigate to the directory that contains the log files:

= If the AFLOG_FILENAME profile option is set, navigate to the location designated
by the profile option value.

» If the AFLOG_FILENAME profile option is not set, navigate to the location set by
Oracle Enterprise Scheduler Service.

You can use Fusion Applications Control to determine the location of Oracle
Enterprise Scheduler log files, as follows:

a. In the navigation pane, expand the Farm listing, then expand the
Scheduling Services listing, and then select an Oracle Enterprise
Scheduler server as your target.

b. In the context pane, from the Scheduling Service dropdown menu,
choose Logs > View Log Messages.

c. Click Target Log Files to view a list of log files associated with the selected
server.

For example, a typical path and file name might be the following, where
DOMAIN_HOME is the domain home directory, SERVER_HOME is the server
home directory, and serveriName is the name of the Oracle Enterprise
Scheduler server:

DOMAIN_HOME/servers/SERVER_HOME/logs/serverName-diagnostic.log

2. Rename the log file that is currently in use.
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For example, if the current log file is called Cdiagnostic.log, you might rename
it to Cdiagnostic_MMDDYYYY.log, where MMDDYYYY is the current date.

3. Delete any previously renamed log files that you no longer need.

13.7.5 Using Profile Options to Configure Standard Log Settings

Oracle Fusion applications that use standard logging functionality use profile option
values to configure how much information to log. Ordinarily, these profile options are
set at the Site level, but some can also be set at the User level, to gather more
information into the log file for a particular user.

Note: For information about configuring Oracle Fusion Middleware
log settings, including settings for Oracle Enterprise Scheduler and
Oracle Enterprise Crawl and Search Framework, see "Configuring
Settings for Log Files" in the Oracle Fusion Middleware Administrator’s
Guide. For information about configuring profile option values for
incident and QuickTrace settings, see Section 14.2.

You can use either Fusion Applications Control or the Setup and Maintenance work
area to configure profile options for standard Oracle Fusion Applications logging
functionality. For information about how to use the Setup and Maintenance work area
for this purpose, see the chapter on maintaining common reference objects in the
Oracle Fusion Applications Common Implementation Guide.

Note: In order to set logging profile option values that affect other
users, you must log in as a user who has the Manage All Application
Profile Values function security privilege. By default, this privilege is
carried by the Applications Common Application Profile Value
Administration Duty role, which the predefined Application
Administrator job role inherits. You can use Oracle Identity Manager
to determine whether you have the Application Administrator job
role.

If you want to change profile option values for others without being
provisioned with the Application Administrator job role or the
Applications Common Application Profile Value Administration Duty
role, you can use Oracle Authorization Policy Manager to determine
which other duty roles have the Manage All Application Profile
Values function security privilege and which job roles inherit those
duty roles. You can use Oracle Identity Manager to make sure that you
have a job role that inherits one of those duty roles.

For more information about working with roles and privileges, see the
Oracle Fusion Applications Security Guide, the Oracle Fusion Middleware
User’s Guide for Oracle Identity Manager, and the Oracle Fusion
Middleware Oracle Authorization Policy Manager Administrator’s Guide
(Oracle Fusion Applications Edition).

To use Fusion Applications Control to configure profile options for standard Oracle
Fusion Applications logging functionality:

1. From the navigation pane, select one of the following target types:
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A product family target that lets you configure the log profile options for all of
the Oracle Fusion applications in the selected product family. For example,
you could select the Financials product family target.

An Oracle Fusion Applications cluster application target that lets you
configure the log profile options for the selected application on all of the
servers in the selected cluster. For example, you could expand the Financials
listing and the Fusion Applications listing and then select the PayablesApp
cluster application target.

An Oracle Fusion application instance target that lets you configure the log
profile options for the selected application on the selected sever. For example,
you could expand the Financials listing and the Fusion Applications listing
and the PayablesApp listing and then select the PayablesApp
(PayablesServer_1) application instance target.

2. In the context pane, from the target type dropdown menu, choose Logs > Log
Configuration.

3. In the Logging Profile Configuration dialog, click one of the following tabs to
determine whether you set the logging level for the whole site or for a single user:

Site-Level

User-Level

4, If you clicked Site-Level, skip to Step 5.

If you clicked User-Level, complete the following substeps:

a.

Inspect the table on the User-Level tab for the user name for which you want
to change logging levels.

If the user name is listed, select it and click Edit to display the Edit User-Level
Configuration dialog.

If the user name is not listed, click Add and enter it in the Name field of the
Add Logging Profile Configuration dialog.

From the Log Level dropdown list, select the log level that corresponds to the
kinds of information you want to gather.

For more information, see Table 13-2.
In the Logging Enabled field, make sure that the checkbox is selected.

In the Module Filters field, indicate if you want Oracle Fusion Applications to
log only for a particular code module for the selected user—by default, log
entries are written for all Oracle Fusion Applications code modules that use
standard logging implementation for Oracle Fusion Applications.

Note: If you specify that logging for the selected user should be done
only for a particular code module, that setting will not affect the
information that is logged for other users.

If you want to change whether PL/SQL modules buffer log entries of levels
lower than Warning, expand the Advanced profile configuration section of
the dialog and select Enabled or Disabled for the Buffer Mode setting.

If Buffer Mode is set to Enabled and you want to change the number of
PL/SQL log records that will be buffered in memory before they are written to
the log file, enter the number of records to buffer in the Buffer Size field.
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g. If you want PL/SQL log records to be written to a log file location other than
the default, enter the path and file name in the File Name field in the PL/SQL
Settings section.

h. Click OK.

Skip Step 5.

If you clicked Site-Level, complete the following substeps:

a. From the Log Level dropdown list, select the log level that corresponds to the
kinds of information you want to gather.

For more information, see Table 13-2.

b. Make sure that both Logging Enabled and Incident Enabled are selected.

c. Inthe Module Filters field, indicate if you want Oracle Fusion Applications to
log only for a particular code module—by default, log entries are written for
all Oracle Fusion Applications code modules that use standard logging
implementation for Oracle Fusion Applications.

d. Expand the Advanced profile configuration section of the dialog.

e. In the Java Settings section of the dialog, for purposes of normal operation,
verify that the QuickTrace Enabled checkbox is selected and that QuickTrace
Level is set to Fine.

For more information about changing QuickTrace settings for troubleshooting,
see Section 14.2.7.

f. If you want to change whether PL/SQL modules buffer log entries of levels
lower than Warning, select Enabled or Disabled for the Buffer Mode setting.

g. If Buffer Mode is set to Enabled and you want to change the number of
PL/SQL log records that will be buffered in memory before they are written to
the log file, enter the number of records to buffer in the Buffer Size field.

h. If you want PL/SQL log records to be written to a log file location other than

the default, enter the path and file name in the File Name field in the PL/SQL
Settings section.

If you want C log records to be written to a log file location other than the
default, enter the path and file name in the File Name field in the C Settings
section.

Click Apply.

13.7.6 Using Additional Settings to Configure Logs for Selected Components

Some functionality areas in Oracle Fusion Applications use nonstandard logging
mechanisms that are disabled by default. For these areas, you must turn on the logging
facility when you need it and specify the kind of information that you want to record
in the log file. Some other functionality areas use nonstandard logging mechanisms
that are usually set to gather minimal amounts of information. You may want to
change those settings when troubleshooting.

This section contains the following topics:

Configuring Additional Log Settings for Oracle Fusion Incentive Compensation
Batch Jobs

Configuring Additional Log Settings for Oracle Fusion General Ledger

Configuring Additional Log Settings for Oracle Fusion Receivables AutoInvoice
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13.7.6.1 Configuring Additional Log Settings for Oracle Fusion Incentive
Compensation Batch Jobs

The logging functionality for certain Oracle Fusion Incentive Compensation batch jobs
is separate from the standard logging functionality for Oracle Fusion Applications. By
default, the following kinds of Oracle Fusion Incentive Compensation batch jobs do
not write log entries:

» Calculation

»  Classification
= Collection

»  Crediting

= Rollup

For optimum performance and log file sizes, it is recommended that you use the
logging functionality for these areas only when troubleshooting an existing problem.
For more information, see Section 14.2.10.

13.7.6.2 Configuring Additional Log Settings for Oracle Fusion General Ledger

In the Oracle Fusion Financials product family, some logging functionality for the
Oracle Fusion General Ledger application is separate from the standard logging
functionality for Oracle Fusion Applications. By default, the following kinds of Oracle
Fusion General Ledger batch jobs do not write log entries:

s OpenPeriod

= Posting

= Translation

s Close Process - Create Income Statement Closing Journals
s Close Process - Create Balance Sheet Closing Journals

For optimum performance and log file sizes, it is recommended that you use the
logging functionality for these areas only when troubleshooting an existing problem.
For more information, see Section 14.2.11.

13.7.6.3 Configuring Additional Log Settings for Oracle Fusion Receivables
Autolnvoice

In the Oracle Fusion Financials product family, logging functionality for the
Autolnvoice portion of the Oracle Fusion Receivables application is separate from the
standard logging functionality for Oracle Fusion Applications. The amount of
information that is logged for Autolnvoice depends on the value of the Log File
Message Level system option setting.

To set the amount of information that the Oracle Fusion Receivables application logs
for the AutoInvoice functionality area:

1. In the Oracle Fusion Receivables application, choose Setup and Maintenance from
the Navigator menu.

2. Complete the following substeps to navigate to the Edit System Options screen
for the Manage Receivables System Options task.

a. Expand the Search: Tasks pane.

b. Enter Manage Receivables System Options in the Name field and click
Search.
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4,

c. Inthe Manage Receivables System Options row of the Search Results table,
click Go to Task.

d. In the Search area of the Manage Receivables System Options screen, select
Business Unit from the drop-down list, enter the name of a business unit for
which you want to set up the amount of Autolnvoice information to be
logged, and then click Search.

Alternately, you can click Search without specifying a business unit name to
display a list of the available business units.

e. In the Search Results table, click the name of the business unit for which you
want to set up the amount of AutoInvoice information to be logged.

In the Edit System Options screen, scroll down to display the AutoInvoice area of
the screen, and then set Log File Message Level to the value of 0, which is the
recommended value for normal operations.

Note: For optimum performance and log file sizes, it is
recommended that you keep the Log File Message Level system
option set to the lowest value that meets your everyday needs, and
increase the value of the setting only when troubleshooting an existing
problem. For more information about using this setting when
troubleshooting, see Section 14.2.12.

Click Save to put your changes into effect.

Repeat this entire procedure for each additional business unit for which you want
to configure Autolnvoice system options.

For information about configuring the Maximum Memory in Bytes system option for
Autolnvoice, see product-specific documentation in Oracle Fusion Applications Help.

13.7.7 Configuring Access to Logs for Fusion Applications Control

By default, you can use Fusion Applications Control to view log file entries that are
generated by Java code in Oracle Fusion applications. To make it possible to view log
file entries that are generated by PL/SQL or C code, you must perform the following
configuration steps.

To make PL/SQL and C log file entries visible in Fusion Applications Control:

1.

Determine the locations of the PL/SQL and C log files written by your Oracle
Fusion applications.

The values of the AFLOG_PLSQL_FILENAME and AFLOG_FILENAME profile options
normally determine log file locations for PL/SQL and C log files, respectively. For
more information about these profile options and the log file locations that are
used when these profile options are not set, see Section 13.6.4 and Section 13.7.1.

Decide which Managed Server you want to use to view PL/SQL log files, C log
files, or both, and make sure that the server has read access to all log file locations
that you determined in Step 1.

It is recommended that you use an Oracle WebLogic Server that runs Oracle
Enterprise Scheduler for this purpose.
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Note: If you want to use more than one Managed Server to view
PL/SQL log files, C log files, or both, you can do so, provided that
each such server has read access to the log files that you want to view
through that server. However, it is not especially valuable to use
multiple servers to view a particular log file, since each server is
providing access to the same data.

3. OnaManaged Server that you picked in Step 2, navigate to the following location,
where DOMAIN_HOME is the domain home for the Managed Server and server_name
is the name of the Managed Server:

DOMAIN_HOME/config/fmwconfig/servers/server_name/diagnostics-registration

If this location does not currently exist, create it now.

4. Inthe diagnostics-registration subdirectory, for each log file that you
determined in Step 1 and want to view using this server, use a text editor to create
and save a file that contains the following lines, using any file name that has the
format yourChosenFileName.xml:

<?xml version='1.0"' encoding='UTF-8'?>

<logs xmlns='http://www.oracle.com/iAS/EMComponent/ojdl'>

<log path="path_to_log file">
<logreader class="oracle.core.ojdl.reader.ODLLogReaderFactory">
</logreader>

</log>

</logs>

Substitute the full path and name of the log file for path_to_log_file, using the
form of the path that is correct for the current server to use when accessing the file:

= For a PL/SQL log, make sure that the value for path_to_log file
corresponds to the same location and file name as the value that you have set
for the AFLOG_PLSQL_FILENAME profile option.

Note: You must resolve and enter the full path to the path to_log_
file location, explicitly, rather than entering the directory object that
is used to set the value of the AFLOG_PLSQL_FILENAME profile option.

s For a Clog, make sure that the value for path _to_log file indicates the
same location and file name as the value that you have set for the AFLOG_
FILENAME profile option.

Repeat this step as needed to create an individual .xml file for each log file that
you determined in Step 1 and want to view using this server. You can save each
file using any unique legal file name that ends in .xml. For example, the file name
might be plsglfndlog.xml for a PL/SQL log, and cfndlog.xml for a C log.

5. In Fusion Applications Control, verify that each log file from Step 1 is now listed
in an appropriate Target Log Files list:

a. From the navigation pane, select a target for which you created a .xm1 file.

For example, you might expand the Financials product family entry, and then
expand the Fusion Applications and PayablesApp entries, and then select the
PayablesApp (PayablesServer_1) application instance target.
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b.

C.

d.

In the context pane, from the dynamic target menu, choose Logs > View Log
Messages to display the log messages for the selected target.

Click Target Log Files.

Verify that the resulting list includes the all of the log files that are applicable
for the selected target, including any applicable log files for which you created
.xml files.

The View Log Message page includes information from all log files that
appear on this list.

6. Repeat Step 5 for any other targets for which you created a .xml file.

13.8 Standard Diagnostic Testing Administration Tasks and Tools

Under ordinary circumstances, the following administrative tasks are associated with
Oracle Fusion Applications diagnostic tests:

Configuring security to provide appropriate access to diagnostic tests. You can
assign job roles to particular users to grant those users the ability to perform
various diagnostic operations. For more information, see Section 13.9.1.

Caution: In the current release, a job role for diagnostic operations
grants the user the ability to perform the specified operations for all
diagnostic tests that are provided with Oracle Fusion Applications.
When choosing whether to grant a diagnostic job role to specific users,
be aware that some diagnostic tests may include sensitive information
in their results.

Running diagnostic tests. You can use diagnostic tests for the following purposes:

Routinely checking the health of your Oracle Fusion applications
Troubleshooting a problem with an Oracle Fusion application

Collecting detailed data that may help Oracle Support to resolve a problem for
you

Some diagnostic tests require a specific Oracle Fusion application to be running while
the test is performed—these diagnostic tests are called internal diagnostic tests. Other
diagnostic tests can perform their functions even if the Oracle Fusion application to be
tested is not running—these tests are called external diagnostic tests.

The distinction between internal and external tests is important because it affects both
when you can run the tests and which interfaces you can use to run the tests. The
Diagnostic Testing Framework provides two interfaces:

The Diagnostic Dashboard application provides a graphical user interface that lets
you perform the following tasks:

Execute and monitor both internal and external diagnostic tests for Oracle
Fusion applications

Purge diagnostic test results

Register any special-purpose diagnostic tests that Oracle Support may provide
to you

The diagctl command line interface lets you perform the following tasks:
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- Execute external diagnostic tests (tests that do not require a specific Oracle
Fusion application to be running)

Note: Technical constraints prevent the diagctl command line
interface from returning useful results for internal diagnostic tests
(tests that require a specific Oracle Fusion application to be running
when the test is performed). You must use the Diagnostic Dashboard
to run any internal diagnostic test.

You must also use the Diagnostic Dashboard to determine whether a
particular test is an internal or an external test. For more information
about making this determination, see Step 9 through Step 11 in
Section 13.10.1.1.

- View diagnostic test results

- Register any special-purpose diagnostic tests that Oracle Support may provide
to you

13.9 Configuring the Diagnostic Testing Framework for Normal Operation

You can use diagnostic tests to check normal system health and to troubleshoot system
problems. You can configure your Oracle Fusion Applications environment to run all
Oracle Fusion Applications diagnostic tests using the Diagnostic Dashboard
application, and to run external diagnostic tests using the diagctl command line
interface.

This section contains the following topics:
= Controlling Access to Diagnostic Testing Functionality

= Navigating to the Diagnostic Dashboard

Note: Technical constraints prevent the diagctl command line
interface from returning useful results for internal diagnostic tests
(tests that require a specific Oracle Fusion application to be running
when the test is performed). You must use the Diagnostic Dashboard
to run any internal diagnostic test.

You must also use the Diagnostic Dashboard to determine whether a
particular test is an internal or an external test. For more information
about making this determination, see Step 9 through Step 11 in
Section 13.10.1.1.

Both the Diagnostic Dashboard application and the diagctl command line interface
are automatically installed and configured as part of the Oracle Fusion Applications
installation. However, you must assign appropriate job roles to specific users to give
them the ability to display and perform operations using the Diagnostic Dashboard
application. Access to the diagctl command line interface is controlled at the level of
the server operating system. For more information about granting appropriate access,
see Section 13.9.1.

To help you locate diagnostic tests for specific purposes, the diagnostic tests that you
receive with Oracle Fusion applications are all assigned to predefined categories.
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Note: You cannot change the tag name and tag value assignments
that Oracle uses to categorize diagnostic tests, and you cannot remove
those tag names or tag values from the database. The following
related links in the Task pane of the Diagnostic Dashboard application
are intended for use by Oracle personnel, only:

= Add New Tag

= Add New Tag Value

»s  Assign Tags to Tests

s Unassign Tags from Tests
= Remove Tag

= Remove Tag Value

Caution: Do not attempt to modify the diagnostic test seed data
provided to you by Oracle. Unauthorized modification of this seed
data may prevent diagnostic tests from functioning correctly,
lengthening the amount of time required to resolve both current and
future problems.

13.9.1 Controlling Access to Diagnostic Testing Functionality

Access to diagnostic testing functionality is controlled separately for the Diagnostic
Dashboard and the diagctl command line interface.

For the diagctl command line interface, access is controlled at the level of the server
operating system. If a user can log in to the server where diagctl is stored, and if that
user has operating system permissions to read and execute diagctl, then that user
can use diagctl to perform all diagnostic operations that the command line interface
supports.

For the Diagnostic Dashboard, you can use Oracle Identity Manager to assign specific
users to any of the four preconfigured job roles that grant users access to the
Diagnostic Dashboard. Each of these four job roles provides access to a different
amount of the functionality of the dashboard.

Note: Oracle Fusion applications display the Troubleshooting > Run
Diagnostic Tests command in the Help menu only for users who are
associated with the preconfigured job roles that grant access to
Diagnostic Dashboard operations.

s TheDiagnostic Viewer job role can view and analyze diagnostic test results for
Oracle Fusion applications.

s TheDiagnostic Regular User job role can execute diagnostic test runs and view
diagnostic test results for Oracle Fusion applications, and cancel diagnostic test
runs that were started by the current user.

s The Diagnostic Advanced User job role can schedule and execute diagnostic test
runs, view diagnostic test results, attach test results to application incidents for
Oracle Fusion applications, and cancel diagnostic test runs that were started by the
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current user. In general, this job role is recommended for running Oracle Fusion
Applications diagnostic tests, since its added capabilities allow users to work with
administrators more flexibly during troubleshooting.

s TheDiagnostic Administrator job role can use all diagnostic testing
functionality provided for Oracle Fusion applications, including purging test
results from the database and canceling test runs started by other users.

Caution: In the current release, any job role for diagnostic operations
grants the user the ability to perform the role's specified operations for
all diagnostic tests that are provided with Oracle Fusion applications.
When choosing whether to grant any diagnostic job role to specific
users, be aware that some diagnostic tests may include sensitive
information in their results.

To grant specific users permission to use the Diagnostic Dashboard:

1. Decide which users need the capabilities of each of the four preconfigured job
roles for diagnostic operations.

2. Use Oracle Identity Manager to assign the appropriate job role to each user.

13.9.2 Navigating to the Diagnostic Dashboard

The Diagnostic Dashboard application for Oracle Fusion Applications provides a
graphical user interface that lets you execute and monitor diagnostic tests, display and
purge test results, and register any special-purpose diagnostic tests that Oracle
Support may provide to you. Each product family within Oracle Fusion Applications
has its own instance of the Diagnostic Dashboard. Provided that you are assigned to
an appropriate job role, you can navigate to the Diagnostic Dashboard from any Oracle
Fusion application, or from Cloud Control.

13.9.2.1 Navigating to the Diagnostic Dashboard from an Oracle Fusion Application

If you want to use the Diagnostic Dashboard to execute or monitor diagnostic tests or
display or purge test results while you are using an Oracle Fusion application, you can
navigate to the Diagnostic Dashboard directly from the application.

To display to the Diagnostic Dashboard from an Oracle Fusion application:

1. Sign in to the relevant Oracle Fusion application as a user who has access to the
specific Diagnostic Dashboard operations that you need.

For more information about the job roles that grant access to Diagnostic
Dashboard operations, see Section 13.9.1.

2. From the Help menu in the application, choose Troubleshooting > Run
Diagnostic Tests to display the Diagnostic Dashboard.

Note: Oracle Fusion applications display the Troubleshooting > Run
Diagnostic Tests command in the Help menu only for users who are
assigned to the preconfigured jobs roles that grant access to Diagnostic
Dashboard operations. For more information about these job roles, see
Section 13.9.1.

13-38 Oracle Fusion Applications Administrator's Guide



Using Diagnostic Tests to Monitor Normal System Health

13.9.2.2 Navigating to the Diagnostic Dashboard from Cloud Control:

If you want to use the Diagnostic Dashboard to execute or monitor diagnostic tests or

display or purge test results while you are using Cloud Control, such as while you are
using Support Workbench to gather additional information about an existing incident,
you can navigate to the Diagnostic Dashboard directly from Cloud Control.

To display to the Diagnostic Dashboard from Cloud Control:

1. In Oracle Enterprise Manager, select the product family or cluster application for
which you want to run diagnostic tests or view diagnostic test results.

2. From the dynamic drop-down menu, choose Diagnostics > Fusion Applications
Diagnostic Dashboard.

A login screen for the Diagnostic Dashboard appears in a new window.

3. Log in using an account for the Oracle Fusion Applications product family that
you intend to test.

The account that you use must also be assigned to a job role that provides access to
the Diagnostic Dashboard. For more information, see Section 13.9.1.

13.10 Using Diagnostic Tests to Monitor Normal System Health

Oracle Fusion Applications diagnostic tests are designed to help you to monitor the
health of your system and to help you troubleshoot when necessary.

This section contains the following topics:

= Running Diagnostic Tests

s  Searching for Diagnostic Tests by Name, Categorization Tag, or Module
s Checking Diagnostic Test Availability

= Providing Input Parameters for Diagnostic Tests

= Running Diagnostic Tests Immediately

= Scheduling Diagnostic Tests to Run Later

s Checking the Status of a Diagnostic Test

s Canceling Diagnostic Test Runs

= Viewing the Results of Diagnostic Tests

= Identifying Diagnostic Test Launch Methods from Test Run Names
= Purging the Results of Selected Diagnostic Test Runs

Note: The user name that you use to sign in to an Oracle Fusion
application affects which diagnostic operations are available to you.
Be sure that you sign in using an account that has a job role for the
diagnostic operations that you need. For more information, see
Section 13.9.1.

Some diagnostic tests can be used with all Oracle Fusion applications. Other tests
apply to specific product families within Oracle Fusion Applications. For information
about the individual diagnostic tests that are provided with this release, see the Oracle
Fusion Applications Common User Guide in Oracle Fusion Applications Help.
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13.10.1 Running Diagnostic Tests

You can use either the Diagnostic Dashboard or the diagctl command line interface to
run external diagnostic tests—tests that do not depend on the availability of any
specific Oracle Fusion application. However, for technical reasons, you must use the
Diagnostic Dashboard to run internal diagnostic tests—tests that require a specific
Oracle Fusion application to be running at the time when the test is run. For
information about determining whether a particular test is an internal or an external
test, see Step 9 through Step 11 in Section 13.10.1.1.

This section contains the following topics:
= Using the Diagnostic Dashboard to Run Diagnostic Tests

= Using the diagctl Command Line Interface to Run Diagnostic Tests

13.10.1.1 Using the Diagnostic Dashboard to Run Diagnostic Tests

The Diagnostic Dashboard application provides a graphical user interface that lets you
execute and monitor diagnostic tests, display and purge test results, and register any
special-purpose diagnostic tests that Oracle Support may provide to you.

To run a diagnostic test from the Diagnostic Dashboard:

1. Navigate to the Diagnostic Dashboard for the Oracle Fusion applications you are
administering, and log in using an account for the application you intend to test
that has one of the following job roles:

" Diagnostic Regular User
s Diagnostic Advanced User
s Diagnostic Administrator

For more information about these job roles, see Section 13.9.1. For more
information about navigating to the Diagnostic Dashboard, see Section 13.9.2.

2. In the Regional area on the left side of the Diagnostic Dashboard, locate, and, if
necessary, expand one of the following panels:

= Search by Tests
= Search by Tags

3. In the search panel, use standard Oracle query techniques to specify the test
characteristics that you want to search for, and then click Search.

For information about the kinds of test characteristics that you can specify, see
Section 13.10.2.

The results of the search appear in a table below the Search button.

Note: In the current release, you can search for and display
information about all diagnostic tests that are associated with a tag
name that you specify. You cannot currently limit those searches to
particular pairs of tag names and tag values. If you need to locate
diagnostic tests that are associated with a particular tag name and tag
value, you must search for the tag name and then scan the results for
the tag value you require.

4. In the search results table, select the checkbox for each test that you want to run,
then click Add To Run.
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The Choose Tests to Run and Supply Inputs table appears in the upper Local area
of the screen, listing characteristics of the tests you selected.

From the View menu, use standard techniques to adjust how the table displays its
data.

If you want to display nested tests and test steps, you can also expand the tree
structure in the Choose Tests to Run and Supply Inputs table.

In the Choose Tests to Run and Supply Inputs table, inspect the Input Status
column and perform the appropriate action for the value you find:

= For any root level test that displays the message Required Input Values
Missing, either clear the checkbox to omit that test (and its nested tests and
test steps) from the test run and skip to Step 8, or click the alert icon in the
Input Status column to display the Input Parameters dialog and proceed to
Step 7.

= For any root level test that displays the message Required Input Values
Validated or the message Input Values Validated, consider whether you
want to inspect the parameter values the test is currently set to use. If so, or if
you know that you want to change an existing input parameter value, click the
check mark icon in the Input Status column to display the Input Parameters
dialog and proceed to Step 7.

Note: You can use the Input Parameters dialog to override current
input parameter values, including in tests that have a valid input
status.

= For any root level test that displays the message No Inputs Required, skip to
Step 8. A test that displays this message does not use input parameters.

If you clicked the alert icon in the Input Status column to display the Input
Parameters dialog, specify new parameter values as needed, according to the
parameter type, as follows; otherwise, skip this step.

= For Boolean parameters, select the appropriate button in the New Value field.

s For numerical parameters and general text parameters, enter the appropriate
value in the New Value field.

= For date parameters, click the icon in the New Value field to display a
calendar pop-up, and then select an appropriate year, month, and day.

»  For parameters that must be supplied from a list of values (LOV), click the
magnifying glass icon in the New Value field to display the Search and Select
dialog. In the Search and Select dialog, select the appropriate value for the
parameter and click OK.

Note: The values that are available in the list of values are
determined in the metadata for the diagnostic test.

= If you want to save your current input values for convenient future use, click
Save to display the Save As Input Set dialog. Supply a name for the set of
values that you are saving, plus any additional information about the input set
that you want to store, and then click OK.
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= If you want to use a set of previously stored input values, select the
appropriate set from the Input Set dropdown list, and click Load.

= If you want to revert to the default values for all parameters in the current test,
click Defaults. The Diagnostic Test Framework removes all values for text
parameters and resets other parameter types to default values.

When you are finished setting input parameters for the current test, click OK.

8. Repeat Step 6 through Step 7 for any other tests that are missing input values, or
that have parameter values that you want to override in your test run.

9. From the View menu for the Choose Tests to Run and Supply Inputs table,
choose Availability to display the Diagnostic Test Availability dialog.

10. In the Select a Diagnostic Test for Details table, select each test listing and inspect
the icon displayed in its Availability column:

» If the Availability column shows a check mark icon, then the selected test is
currently available to be run.

= If the Availability column shows a triangular warning icon, or if you want to
determine whether the test is internal or external, click Detach in the
Available Details table header to display the Available Details table in a
larger window, and then proceed to Step 11.

If all listed tests are available to be run and if you do not need to know whether
they are internal or external, skip to Step 13.

11. Inspect the expanded Detached Table for messages about whether the selected
test depends on particular Oracle Fusion applications or about why the test is not
available, and take the appropriate action:

s If you want to know whether the selected test is internal or external, inspect
the Details of Required Test Components column of the Web Applications
Accessible row.

— If that cell of the Detached Table contains the name of an Oracle Fusion
application, then the test is an internal diagnostic test that you can run
only by using the Diagnostic Dashboard when the specified application is
available. You cannot run such a test by using the diagctl command line
interface or when the application is not present.

— If that cell of the Detached Table does not list an application, then the test
is an external diagnostic test.

= If the Error column says, "The following Java classes were not loadable:" This
message indicates that the diagnostic testing framework cannot locate the JAR
file that contains the selected test. Contact your help desk for assistance in
searching for a solution in the My Oracle Support Knowledge Base. If the
Knowledge Base does not yield a solution, ask your help desk to open an
Oracle Support service request.

= If the Error column says, "The following PL/SQL procedures were not located
in the database:" This message indicates that the diagnostic testing framework
cannot locate the test code for the selected PL/SQL diagnostic test in your
database. Contact your help desk for assistance in searching for a solution in
the My Oracle Support Knowledge Base. If the Knowledge Base does not yield
a solution, ask your help desk to open an Oracle Support service request.

= If the Error column says, "The following Web Applications were inaccessible:"
Use the Oracle WebLogic Server console or Fusion Applications Control to
check whether the listed applications are running correctly. This message
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12.

13.

14.

indicates that the Diagnostic Testing Framework must have access to running
instances of the listed Oracle Fusion applications in order to run the selected
diagnostic test—the test is an internal test.

For more information about installing and deploying Oracle Fusion
Applications, see the "Provisioning a New Applications Environment" chapter
of the Oracle Fusion Applications Installation Guide.

If the problem persists when the listed Oracle Fusion applications and the
relevant database instance are all running, contact Oracle Support for
assistance.

= If the Error column says, "The current user does not have execution privileges
for the following tests:" You must log in as a user who has appropriate
privileges to execute the selected test. For information about the privileges
required, see Section 13.9.1.

= If the Error column says, "The current user does not have privileges to view
reports for the following tests:" You must log in as a user who has appropriate
privileges to view the results of the selected test. For information about the
privileges required, see Section 13.9.1.

Note: It is possible to have the necessary privileges to view
diagnostic test results without having the necessary privileges to run
those tests. Use an appropriate user account for the action you want to
perform.

If you have not already done so, close the Detached Table window and the
Diagnostic Test Availability dialog, repeat Step 9 and Step 10 to verify that all
listed tests are now available to be run, and then proceed to Step 13.

If you wish, enter a name for your test run in the Run Name field in the control
bar.

Note: Do not use the word error in your test run name. If you use
the word error, or if you leave the Run Name field blank, the
Diagnostic Testing Framework automatically assigns the test run a
name. For information about the formats used in automatically
assigned test run names, see Section 13.10.10.

When the Input Status column of the Choose Tests to Run and Supply Inputs
table displays Required Input Values Validated in all of the selected rows,
choose one of the following from the Run Options menu:

= Run Now: Run the selected test or tests immediately after you click Run.

Note: Do not click Run until you have completed Step 15 and Step
16.

= Run Later: Schedule when the test or tests will be run. This option is
integrated with Oracle Enterprise Scheduler Service. When you select this
option, the Run button on the toolbar changes to a Schedule Run button.
Complete the following sub-steps to schedule when the test or tests will be
run:
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a. Click the Schedule Run button to display a Schedule Tests dialog.
b. Click the Schedule tab and then select Use a schedule.

c. From the Frequency dropdown list, select how often to run the selected
test or tests.

d. In the Start field, specify the date and time to start the testing.
e. Click Submit.

15. Adjust option settings to determine whether or not to run the prerequisite tests for
the diagnostic tests you have selected:

= If you want to run prerequisite tests, make sure that the No Prerequisites
option in the Run Options menu is not selected.

s If you do not want to run prerequisite tests, make sure that the No
Prerequisites option in the Run Options menu is selected.

16. Adjust option settings to determine how many threads to use when running the
selected diagnostic tests:

»  To use multiple threads, choose Run in Parallel from the Run Options menu.
Then choose Number of Threads from the Run Options menu and select a
value from 2 through 5. The default number of threads for running in parallel
is 3.

= To use a single thread, choose Run Synchronously from the Run Options
menu.

17. If you chose Run Now in Step 14, click Run to start executing the test run.

If you chose Run Later in Step 14, the test run will start executing at the time you
set in the Schedule Tests dialog.

13.10.1.2 Using the diagctl Command Line Interface to Run Diagnostic Tests

The Diagnostic Test Framework command line utility, diagctl, lets you specify
which tests to run in several different ways: by test name, by associated product codes,
by associated tag names and tag values, and by associated module IDs or module
keys.

You can run one or more diagnostic tests using a single diagctl command. It is
particularly appropriate to use diagctl when you do not have access to a WebLogic
Server.

Note: Technical constraints prevent the diagctl command line
interface from returning useful results for internal diagnostic tests
(tests that require a specific Oracle Fusion application to be running
when the test is performed). You must use the Diagnostic Dashboard
to run any internal diagnostic test.

You must also use the Diagnostic Dashboard to determine whether a
particular test is an internal or an external test. For more information
about making this determination, see Step 9 through Step 11 in
Section 13.10.1.1.

To run Diagnostic Tests from the diagctl command line interface:

1. Obtain the user name and password for the Oracle Fusion Applications account
that will run the diagnostic test or tests, and the password for that account.
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A user name and password is required for any diagnostic test that you run using
the diagctl command line interface. The command line syntax for specifying the
user name and password is un=user_name and pwd=password.

Decide which of the following methods to use to specify the diagnostic test or tests
that you want to run:

Specify a single test name: To run a single specific test without specifying
input parameters, the command line syntax is test=test_name

Specify a test name and parameters: To run a single specific test with one or
more input parameters, the command line syntax is test=test_name
input:parameter namel=parameter_valuel input:parameter_
nameZ2=parameter_valueZ2

Specify multiple test names: To run several specific tests, the command line
syntax is test=test_namel, test_name2, test_name3

Note: If you are specifying multiple tests on a single command line,
then you cannot specify input parameters on that command line.

Specify by product codes: To run all of the tests that are associated with one or
more specific product codes in the Applications taxonomy, the command line
syntax is app=product_codel, product_code2, product_code3

Specify by module ID: To run all of the tests that are associated with specific
module IDs in the Applications taxonomy, and all of the tests that are
associated with child modules of the module that you specify, the command
line syntax is modid=moduleIDI, moduleID2, moduleID3

Specify by module key: To run all of the tests that are associated with specific
module keys in the Applications taxonomy, the command line syntax is
modkey=module keyl,module_key2,module_key3

Specify by tag name and tag value: To run all of the tests that are associated
with a specific tag and tag value in the diagnostic test repository, and to run
any tests that are associated with any child tag values of the tag name and tag
value that you specify, the command line syntax is tag: tagnamel=tagvaluel
tag: tagname2=tagvalue? tag:tagname3=tagvalue3

You must use at least one these options in each command to run a diagnostic test
from diagctl. You can include more than one of these options in a single
command, if you prefer.

Decide whether to use any, some, or all of the following additional options for the
test run:

Specify a test run name: To specify a particular name for the test run, use the
command line syntax runname=run_name.

Note: Do not include the word "error" in your test run name. If you
include the word "error," or if you do not specify a test run name, the
command line utility automatically generates a name for the test run.
Automatically generated test run names start with the test name,
product code, module ID, module key, or tag name and value that you
specified, followed by a colon, a timestamp, another colon, and a
sequence number.
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= Specify whether to test recursively: To run all of the specified tests recursively,
use the command line syntax recurse=Y. The default value is N.

= Specify whether to run prerequisite tests: To identify and run any tests that are
prerequisites before running the specified tests, use the command line syntax
prereg=Y. The default value is N.

= Specify monitoring interval: To specify how often the status of the test run is
uploaded to the test repository, use the command line syntax
moninterval=time_in seconds. The default value is 30 seconds.

= Specify number of threads: To specify the number of parallel threads to spawn
for processing this test run, use the command line syntax nthreads=number._
of_threads. The default value is 5. A value of 1 directs the utility to run the
tests serially.

4. Atacommand prompt for your operating system, enter the following commands
that are appropriate for your operating system, making these substitutions:

Replace FA_Mw_HOME with the location of the fusionapps Oracle Fusion
Applications Middleware Home directory.

Replace JROCKIT_ORACLE_HOME with the location of the jdk6 Oracle JRockit Oracle
Home directory (the Java Development Kit that was included in the Oracle Fusion
Applications media pack).

Replace ATGPF_ORACLE_HOME with the location of the atgpf Applications Core
Oracle Home directory.

For more information about the locations of Oracle Fusion Applications home
directories, see Figure 1-6.

(UNIX) export JAVA_HOME=JROCKIT ORACLE_HOME
(UNIX) export MW_HOME=FA_MW_HOME
(UNIX) export DIAGJPSCONFIGFILE=ATGPF_ORACLE_HOME/bin/jps-config-jse.xml

(Windows) set JAVA_HOME=JROCKIT ORACLE_HOME
(Windows) set MW_HOME=FA MW _HOME
(Windows) set DIAGJPSCONFIGFILE=ATGPF_ORACLE_HOME/bin/jps-config-jse.xml

Note: For successful authentication, the DIAGIPSCONFIGFILE
environment variable must be correctly set for any operating system
session in which the diagctl.sh command line interface is used.

5. Still at an operating system command prompt, navigate to the location of the
diagctl executable:

(UNIX) ATGPF_ORACLE_HOME/bin/diagctl.sh
(Windows) ATGPF_ORACLE_HOME\bin\diagctl.cmd

6. Enter diagctl.sh run (for UNIX) or diagctl run (for Windows) followed by the
user name and password from Step 1 and the options that you decided upon in
Step 2 and Step 3, using the syntax described in those steps.
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Note: You can list command arguments that appear after the word
run in any order. If you do not specify the password on the command
line, the utility will prompt you to supply it. For detailed help about
running diagnostic tests, enter diagctl.sh run help (for UNIX) or
diagctl run help (for Windows)

For example, to run a single test with two input parameter values specified, you
would enter a command such as the following;:

(UNIX) diagctl.sh run test=oracle.apps.fnd.appltest.sampleTest
input:paraml=valuel input:param2=value2 un=sysadmin

(WINDOWS) diagctl run test=oracle.apps.fnd.appltest.sampleTest
input:paraml=valuel input:param2=value2 un=sysadmin

Note: If you specify an invalid parameter value, the command line
interface returns an error message and does not run the test.

Or, to run all tests that belong to the Application Object Library (FND) and
General Ledger products, and to run them recursively and with prerequisite
analysis you would enter a command such as:

(UNIX) diagctl.sh run app=FND,GL recurse=Y prereg=Y un=sysadmin
(WINDOWS) diagctl run app=FND,GL recurse=Y prereg=Y un=sysadmin

Or, to run all tests that are associated with the given module id, you would enter:

(UNIX) diagctl.sh run modid=modulel,module2 un=sysadmin
(WINDOWS) diagctl run modid=modulel,module2 un=sysadmin

13.10.2 Searching for Diagnostic Tests by Name, Categorization Tag, or Module

You can use the Diagnostic Dashboard to search for available diagnostic tests.

One way you can search is to use Search by Tags to search for diagnostic tests that are
associated with a particular categorization tag name that you specify.

Another way you can search is to use Search by Tests to search for tests with values
that you specify for one or more of the following characteristics:

s Test name
»  Test description
= Name of the Oracle Fusion Applications code module that the test exercises

The Diagnostic Testing Framework treats any search value that you enter as a
case-insensitive matching pattern, returning the result if the pattern appears in
anywhere in the specified field. However, if you specify more than one search value to
match, the framework returns results only for diagnostic tests that match all of the
values that you specify (logical AND).

In general, searching for diagnostic tests is done as a portion of the process of running
diagnostic tests from the Diagnostic Dashboard. For more information, see
Section 13.10.1.1.
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13.10.3 Checking Diagnostic Test Availability

Whether or not you can run a diagnostic test at any given time depends on both the
specific requirements of the test and the current state of your Oracle Fusion
Applications system. Any of the following factors can prevent a test from being
available:

= Java class availability

s PL/SQL procedure availability

s Oracle Fusion Applications accessibility
= Execution privileges for the test

= Report viewing privileges for the test

In general, checking the availability of diagnostic tests is done as a portion of the
process of running diagnostic tests. For more information, see Section 13.10.1.

Note: Some diagnostic tests require a specific Oracle Fusion
application to be running while the test is performed—these
diagnostic tests are called internal diagnostic tests. Other diagnostic
tests can perform their functions even if the Oracle Fusion application
to be tested is not running—these tests are called external diagnostic
tests.

13.10.4 Providing Input Parameters for Diagnostic Tests

Diagnostic tests often have input parameters. Oracle supplies default values for some
input parameters. When you are in the process of preparing to run one or more
diagnostic tests, you can change the values for input parameters that have default
values and enter values for input parameters that do not have default values. If you
know that you will use the same parameter values more than once, you can save those
values into an input set that you can reuse for later test runs.

All required input parameters must have values assigned before you can run a
diagnostic test. If there are required parameter values missing, the Diagnostic
Dashboard application displays Required Input Values Missing in the Input Status
column of the Choose Tests to Run and Supply Inputs table.

To specify input parameter values, click the icon in the Input Status column to display
the Input Parameters dialog. Then you can either enter parameter values individually
in the New Value column of the Edit Input Set table, or you can select a previously
saved set of values from the Input Set dropdown list. After you have specified all
required input parameters, the Diagnostic Dashboard application displays a check
mark icon with the message Inputs Edited: Required Input Values Validated.
For more information, see Section 13.10.1.

13.10.5 Running Diagnostic Tests Immediately

13-48

You can use either the Diagnostic Dashboard or the diagctl command line interface
to run diagnostic tests immediately.

In the Diagnostic Dashboard, you specify that you want to run a diagnostic test
immediately by choosing Run Now from the Run Options menu.
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For the diagctl command line interface, you specify that you want to run a
diagnostic test immediately by entering the command to run the test from an
interactive session prompt.

For more information, see Section 13.10.1.

13.10.6 Scheduling Diagnostic Tests to Run Later

In the Diagnostic Dashboard, you can specify a particular time to run diagnostic tests
by choosing Run Later from the Run Options menu. For more information, see
Section 13.10.1.1.

To run a delayed diagnostic test using the diagctl command line interface, create a
script that calls diagctl.sh (for UNIX) or diagctl.cmd (for Windows) and then use
standard Oracle Enterprise Scheduler techniques to schedule when the script runs. For
information about submitting and monitoring Oracle Enterprise Scheduler jobs, see
Chapter 5.

13.10.7 Checking the Status of a Diagnostic Test

You can check the status of a diagnostic test from the Diagnostic Dashboard or from
the diagctl command line interface. The command line interface is primarily
intended for use if the Diagnostic Dashboard is temporarily unavailable.

This section contains the following topics:
= Using the Diagnostic Dashboard to Check the Status of a Diagnostic Test
= Using the diagctl Command Line Interface to Check the Status of a Diagnostic Test

13.10.7.1 Using the Diagnostic Dashboard to Check the Status of a Diagnostic Test
In the Diagnostic Dashboard, the Diagnostic Test Run Status table displays two types
of status information:

= Execution Status: This column displays status information about whether or not a
test run request can be executed successfully.

= Diagnostic Status: This column displays status information about whether or not
individual diagnostic tests detect problems.

Note: After running a diagnostic test using the Diagnostic
Dashboard, you may need to click Refresh to display the latest status
information, including rows for the following kinds of test runs:

»  Test runs that were run immediately from the Diagnostic
Dashboard

s Test runs that were scheduled to be run later from the Diagnostic
Dashboard

s Test runs that were submitted using the diagctl command line
interface.

When you click Refresh, the Diagnostic Dashboard displays listings
for any additional test runs that you or other users have submitted in
your current Oracle WebLogic Server domain. If your Oracle Fusion
Applications deployment uses Global Single Instance (GSI), the
Diagnostic Dashboard also displays listings for test runs that were
submitted in other domains.
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To check the status of a diagnostic test using the Diagnostic Dashboard:

1. If you started the diagnostic test from your current Diagnostic Dashboard
application session, the Diagnostic Test Run Status table automatically displays in
the lower right portion of the screen after you click Run. Skip to Step 4.

2. If you are not already displaying the Diagnostic Dashboard for the Oracle Fusion
applications you are administering, navigate to the dashboard and log in using an
account for the application you are testing. For more information, see
Section 13.9.2.

3. Inthe Regional area of your screen, expand the Tasks panel and click Run Status.

4. If you want the Diagnostic Test Run Status table to display only certain types of
rows, select one of the following options from the Find dropdown list:

= All Runs Submitted in Last Hour

= All Runs Submitted in Last 24 Hours

= All Running

= All Running Submitted in Last Hour

= All Runs with Diagnostic Failures in Last 24 Hours
= All Runs with Diagnostic Failures

= All Runs with Diagnostic Warnings

= All Runs with Execution Errors

= All Completed

= All Completed with No Issues

= All Runs

= All Runs Run By the Current User in the Last Hour
= All Runs Run By the Current User

5. If you want to search for specific rows in the Diagnostic Test Run Status table,
click the Search Test Runs icon, enter search criteria, and click OK.

Available search criteria include:

»  Test run dates

s Test run names

s Test display names

= User names of those who launched test runs
s Execution status

6. If you want to display additional columns in the Diagnostic Test Run Status table,
choose the additional columns from the View menu.

7. Expand test run nodes as needed to view the list of test executions for each test,
and then inspect the Execution Status column for information about whether tests
and test runs have completed or encountered execution errors.

8. Inspect the Diagnostic Status column for information about whether completed
tests and test runs encountered any issues before completing.

9. For additional information about any test execution, click the icon in the Report
column of the appropriate row of the table.
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13.10.7.2 Using the diagctl Command Line Interface to Check the Status of a
Diagnostic Test

The Diagnostic Test Framework command line utility, diagctl, provides three
different ways that you can specify the diagnostic test for which you want status
information: by test run name, by test run ID, and by test execution ID.

To check the status of a diagnostic test using the diagctl command line interface:

1. Obtain the user name and password for the Oracle Fusion Applications account
that will run the diagnostic test or tests, and the password for that account.

A user name and password is required whenever you use the diagctl command
line interface to check the status of a diagnostic test. The command line syntax for
specifying the user name and password is un=user_name and pwd=password.

2. Decide which of the following methods to use to specify the diagnostic test run for
which you want status information:

= Specify a test run name: To check the status of a diagnostic test run for which
you have the run name, the command line syntax is runName=run_name.

= Specify a test run ID: To check the status of a diagnostic test for which you
have the test run ID, the command line syntax is runid=run_ID.

= Specify a test execution ID: To check the status of a diagnostic test for which
you have the execution ID, the command line syntax is execid=execution_ID.

You must use at least one these options in each command to check the status of a
diagnostic test using diagctl.

3. Decide whether you want to view the status of nested test runs.

To check the status of all diagnostic tests that are nested within the specified test,
the command line syntax is printtree=Y. This setting defaults to a value of N,
meaning that the status is reported only for the specified test.

4. Atacommand prompt for your operating system, navigate to the location of the
diagctl executable under the fusionapps Oracle Fusion Middleware home
directory:

(UNIX) FA_MW_HOME/atgpf/bin/diagctl.sh
(Windows) FA_ MW _HOME\atgpf\bin\diagctl.cmd

5. Enter diagctl.sh status (for UNIX) or diagctl status (for Windows) followed
by the user name and password from Step 1 and the options that you decided
upon in Step 2 and Step 3, using the syntax described in those steps.

Note: You can list command arguments that appear after the word
status in any order. If you do not specify the password as part of the
command, the utility will prompt you to supply it. For detailed help
about getting status information, enter diagctl.sh status help (for
UNIX) or diagctl status help (for Windows).

For example, to check the status of a test by using a test run name, you would
enter a command such as:

(UNIX) diagctl.sh status runName=TrialRunl un=sysadmin
(Windows) diagctl status runName=TrialRunl un=sysadmin

Or, to check the status of a test and its nested test runs by using a run ID, you
would enter a command such as:
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(UNIX) diagctl.sh status runid=RunID] printtree=Y un=sysadmin
(Windows) diagctl status runid=RunIDI printtree=Y un=sysadmin

Or, to check the status of a test by using an execution key, you would enter:

(UNIX) diagctl.sh status execid=TestExecIDl un=sysadmin
(Windows) diagctl status execid=TestExecIDl un=sysadmin

13.10.8 Canceling Diagnostic Test Runs

From time to time, you may want to stop a diagnostic test or test run that is currently
running. Several constraints affect your ability to cancel a diagnostic test or test run:

In the current release, you must use the Diagnostic Dashboard to cancel a
diagnostic test or test run that is currently running. The diagctl command line
interface does not provide this capability.

To cancel a test or test run that you started, you must use an account that has been
assigned the Diagnostic Regular User, Diagnostic Advanced User, or
Diagnostic Administrator job role.

To cancel a test or test run that another user started, you must use an account that
has been assigned the Diagnostic Administrator job role.

When a diagnostic test is scheduled to run at a later time, it is immediately
submitted to the Oracle Enterprise Scheduler Service. The procedure for canceling
such a test depends on whether or not the test has already started to execute at the
time when you want to cancel it:

— To cancel a scheduled diagnostic test that has not yet started to execute, use
standard Oracle Enterprise Scheduler techniques to cancel the job. For more
information about cancelling scheduled jobs, see the "Cancelling Oracle
Enterprise Scheduling Service Job Requests" section in the Oracle Fusion
Middleware Administrator’s Guide for Oracle Enterprise Scheduler.

— To cancel a scheduled diagnostic test that the Diagnostic Test Run Status
dashboard panel indicates is already running, use the Diagnostic Dashboard
to cancel it in the same way that you would cancel a test that ran immediately.

When you cancel a diagnostic test or test run, the consequences may vary slightly
depending on how much of the test run has executed and the language in which the
test code is written:

If you cancel a diagnostic test run while a test step from that test run is in progress,
the test step that is currently running is canceled. No additional tests or test steps
in the remainder of the cancelled test run are executed. The Diagnostic Test Run
Status panel displays an Execution Status of Canceled for the run, and a pop-up
window displays a message such as the following, but no log messages are
recorded to indicate that a diagnostic test run has been canceled:

Test Run "test_name" has been canceled.
Please check the test run report for further details.

When you cancel a diagnostic test step that has been implemented in Java, the
diagnostic framework automatically closes the test step's database connection,
using an asynchronous command to kill the thread. However, when you cancel a
diagnostic test step that has been implemented using PL/SQL, the diagnostic
framework cannot interrupt the test step and use the existing database connection
to close that connection. To reclaim the resources allocated to a canceled PL/SQL
diagnostic test step, you must establish a separate connection to the database and
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use an alter system kill session command to close the connection that the
canceled test step was using, as described later in this section.

To cancel a diagnostic test using the Diagnostic Dashboard:

1.

If you started the diagnostic test from your current Diagnostic Dashboard
application session, the Diagnostic Test Run Status table automatically displays in
the lower right portion of the screen after you click Run. Skip to Step 4.

If you are not already displaying the Diagnostic Dashboard for the Oracle Fusion
applications you are administering, navigate to the dashboard and log in using an
account for the application you are testing. For more information, see

Section 13.9.2.

In the Regional area of your screen, expand the Tasks panel and click Run Status.

In the Diagnostic Test Run Status panel, locate and select the test run that you
want to cancel, verify that its Execution Status is Running, and then click Cancel.

In the Diagnostic Test Run Status panel, click the Report icon for the canceled test
run.

Inspect the test run report to determine whether the canceled test step was
implemented using Java or PL/SQL.

s If the canceled test step was implemented using Java, skip all of the remaining
steps in this procedure.

»  If the canceled test step was implemented using PL/SQL, proceed to Step 7.

If the canceled test step was implemented using PL/SQL, make a note of the
session ID and serial number for the database connection that the step was using.

For example, the report might display information similar to the following:

Step Report - Diagnostics_Engine Log

Session Information

The test test_name is using a database connection with Session Id 944 and
Serial Number 817

Using your preferred database client or database monitoring application and a
separate connection to the database, determine whether the database connection
for the canceled test step is still open.

For example, you could use a SQL client to execute the following query,
substituting the session identifier and serial number values that you obtained in
Step 7 for session_Id and serial number:

select * from v$session where sid = session_Id and serial# =
serial_number

If this query returns a row that contains the session ID and serial number that you
specified, then the database connection from the canceled test is still open and
consuming resources. Proceed to Step 9.

If the query does not return a row that contains the session ID and serial number
that you specified, then the database connection from the canceled test has been
closed. In this case, skip Step 9.

If the database connection for the cancelled test step is still open, use a command
such as the following to close that connection, substituting the correct session
identifier and serial number values for session_Id and serial_ number.

alter system kill session 'session Id, serial_number';
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13.10.9 Viewing the Results of Diagnostic Tests

You can use either the Diagnostic Dashboard or the diagctl command line interface
to view reports that show the results of diagnostic tests, whichever you prefer.

This section contains the following topics:
= Using the Diagnostic Dashboard to View the Results of Diagnostic Tests

= Using the diagctl Command Line Interface to View the Results of Diagnostic Tests

13.10.9.1 Using the Diagnostic Dashboard to View the Results of Diagnostic Tests

You can view the results of a diagnostic test in the dashboard by checking the status of
the test and then clicking the icon in the Report column of the selected table row. For
more information, see Section 13.10.7.1.

13.10.9.2 Using the diagctl Command Line Interface to View the Results of
Diagnostic Tests

The diagctl command line utility provides three different ways of requesting the

results of diagnostic test results: by test run name, by test run ID, and by test execution
ID.

To view diagnostic test result reports using the diagctl command line interface:

1. Obtain the user name and password for the Oracle Fusion Applications account
that you will use to view the test results, and the password for that account.

A user name and password is required whenever you use the diagctl command
line interface to view the results of a diagnostic test. The command line syntax for
specifying the user name and password is un=user._name and pwd=password.

2. Decide which of the following methods to use to specify the diagnostic test run for
which you want to view results:

= Specify a test run name: To view the results of a diagnostic test run for which
you have the run name, the command line syntax is runName=run_name. This
option includes results for all the executions in the test run.

= Specify a test run ID: To view the results of a diagnostic test for which you
have the test run ID, the command line syntax is runid=run_ID. This option
includes results for all of the executions in the run.

= Specify a test execution ID: To view the results of a diagnostic test for which
you have the execution ID, the command line syntax is execid=execution_ID.
This option includes results for the specified execution and any nested
executions.

You must use at least one these options in each command to view the results of a
diagnostic test using diagctl.

3. Decide whether you want to use one or more of the following additional options:

= Specify a destination directory for results: To write the test results to a specific
directory, the command line syntax is destdir=destination_directory. If
you do not specify a directory, reports are placed in the
java.io. tmpdir/user.name/diagfwk directory where java.io.tmpdir and
user.name are Java system properties.

= Specify a format for the result report: Valid values are XML and HTML. The
default value is HTML. XML report files are created as a step toward creating

13-54 Oracle Fusion Applications Administrator's Guide



Using Diagnostic Tests to Monitor Normal System Health

HTML report files. These XML report files remain in the same directory as the
HTML report files.

»  Specify if the report should be translated: Valid values are Y and N. If the
value is Y, any NLS keys that are specified in the report are translated to your
session language. If the value is N, no translation is performed. The default
valueis Y.

4. Atacommand prompt for your operating system, navigate to the location of the

diagctl executable under the fusionapps Oracle Fusion Middleware home
directory:

(UNIX) FA MW _HOME/atgpf/bin/diagctl.sh
(Windows) FA_ MW _HOME\atgpf\bin\diagctl.cmd

Enter diagctl.sh report (for UNIX) or diagctl report (for Windows),
followed by the user name and password from Step 1 and the options that you
decided upon in Step 2 and Step 3, using the syntax described in those steps.

Note: You can list command arguments that appear after the word
report in any order. If you do not specify the password as part of the
command, the utility will prompt you to supply it. For detailed help
about viewing reports, enter diagctl.sh report help (for UNIX) or
diagctl report help (for Windows).

For example, to view the results of a test by using a run name, and to place the
results in a particular directory, you would enter a command such as:

(UNIX) diagctl.sh report runName=TrialRunl destdir=/dl/testreport un=sysadmin
(Windows) diagctl report runName=TrialRunl destdir=/dl/testreport un=sysadmin
Or, to view the results of a test run by using a run ID, with the results placed in the
default location, you would enter a command such as:

(UNIX) diagctl.sh report runid=RunIDl un=sysadmin

(Windows) diagctl report runid=RunIDl un=sysadmin

Or, to check the status of a test by using an execution key, with the results placed
in the default location, you would enter:

(UNIX) diagctl.sh report execid=TestExecIDl un=sysadmin

(Windows) diagctl report execid=TestExecIDl un=sysadmin

Navigate to the location of the results file, and use a browser or text editor of your
choice to view it.

13.10.10 Identifying Diagnostic Test Launch Methods from Test Run Names

Any test run name that the Diagnostic Testing Framework supplies follows naming
conventions that reflect how the test was launched. If you find that an unfamiliar
diagnostic test run occurred at an unexpected time, then knowing the test run naming
conventions can help you to understand the circumstances in which the test run was
launched:

When you submit a test run to run immediately, without specifying a run name,
the name that is automatically assigned to the test run has the format TestRun_
runID, where runID is a unique string of alphanumeric characters generated by
the Diagnostic Testing Framework, such as TestRun_
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91D818BA54BB29C8E040578C495D6956. This naming convention applies both
when tests are submitted from the Diagnostic Dashboard and when tests are
submitted using diagctl.

When you schedule a diagnostic test run to run later, using Oracle Enterprise
Scheduler Service, the name that is automatically assigned to the test run has the
format [TestRunName ]ESS_requestID timestamp, where TestRunName is an
optional name that the you may specify when submitting the test, requestID is a
unique identifier supplied by the Oracle Enterprise Scheduler when it schedules
the job, and timestamp indicates the time when the job is scheduled to run. This
naming convention applies to tests that are submitted from the Diagnostic
Dashboard to run later. (Tests that are submitted using diagctl always run
immediately.)

For example, if you enter a test run name of routine, the full test run name might
be:

routine ESS-417-2010-09-09T17:07:09.115-0700

When a test run is submitted automatically because an incident occurred, the
name that is automatically assigned to the test run has the format
AppsLogger-DiagnosticTestingFrameworkIntegration_id timestamp, where id
is a number that uniquely identifies the incident, and timestamp indicates when
the diagnostic test run starts.

13.10.11 Purging the Results of Selected Diagnostic Test Runs

From time to time, you may want to remove diagnostic test run results from your
database, to keep the Run Status table from becoming too large.

Note: To remove the results of one or more diagnostic test runs from
your database, you must use the Diagnostic Dashboard application
with an account that has been assigned the Diagnostic
Administrator job role.

The diagctl command line interface does not currently provide a
way to purge test run results.

To purge selected diagnostic test run results from the database:

1.

If you started the diagnostic test from your current application session, the
Diagnostic Test Run Status table automatically displays in the lower right portion
of the screen after you click Run. Skip to Step 4.

If you are not already displaying the Diagnostic Dashboard for the Oracle Fusion
applications you are administering, navigate to the dashboard and log in using an
account for the application that needs its test results purged. For more information
see Section 13.9.2.

In the Regional area of your screen, expand the Tasks panel and click Run Status.

In the Diagnostic Test Run Status table header, use either of the following
methods to locate the test run status records that represent the test results that you
want to remove from the database:

= Select any appropriate filter from the Find dropdown list.

s Click the Search Test Runs icon, enter search criteria, and click OK.
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5.

After searching or filtering, inspect the listings displayed in the Diagnostic Test
Run Status table, and decide whether you want to remove listed test results from
the database individually or as a group:

s Toremove listed test results from the database individually, proceed to Step 6.
= Toremove all of the listed test results from the database, skip to Step 7.

To remove a single test run status result record from the database, complete the
following substeps in the Diagnostic Test Run Status table:

a. Select the test run status record that represents the results that you want to
remove from the database, and click the delete button in the Diagnostic Test
Run Status table header.

b. In the Delete Test Run dialog, select Delete test run "TestRunName" and
click OK.

The selected record is removed from the database immediately.
Skip Step 7 and Step 8.

To remove all of the listed test run status result records from the database, click the
delete button in the Diagnostic Test Run Status table header.

Depending on whether or not you selected a record in the Diagnostic Test Run
Status table, either the Delete Test Run dialog or the Confirm Test Run Delete
dialog appears.

Complete the purge process using the appropriate instructions for the dialog
displayed on your screen:

= If your screen displays the Delete Test Run dialog, select Delete all test
runs in the list and click OK to remove all of the listed test run results
from the database immediately.

s If your screen displays the Confirm Test Run Delete dialog, click Yes to
remove all of the listed test run results from the database immediately.
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Troubleshooting Oracle Fusion Applications
Using Incidents, Logs, QuickTrace, and
Diagnostic Tests

This chapter discusses how to use incidents, log settings, log files, QuickTrace, and
diagnostic tests to help diagnose and resolve problems with Oracle Fusion
Applications.

This chapter also discusses how incidents are related to log files, QuickTrace output,
and diagnostic tests.

This chapter contains the following topics:

s Introduction to Troubleshooting Using Incidents, Logs, QuickTrace, and
Diagnostic Tests

s Configuring Log, QuickTrace, and Incident Settings for Troubleshooting
s Configuring the Diagnostic Testing Framework for Troubleshooting

= Investigating, Reporting, and Solving a Problem

= Troubleshooting Using Log Settings

s Troubleshooting Using the Diagnostic Testing Framework

For information about using log settings, log files, and diagnostic tests to monitor
normal operations for Oracle Fusion Applications, and for information about how log
files and diagnostic tests are related to each other, see Chapter 13. For more
information about the individual diagnostic tests that are provided with this release,
see the Oracle Fusion Applications Common User Guide in Oracle Fusion Applications
Help.

14.1 Introduction to Troubleshooting Using Incidents, Logs, QuickTrace,
and Diagnostic Tests

Incidents are collections of information about problematic system events. Incidents can
be created automatically or manually. An automatically created incident normally
contains information about the state of a particular Oracle WebLogic Server domain at
the time when a specific problem occurred. Monitoring for and responding to
incidents is a standard activity for help desk staff who support Oracle Fusion
Applications in organizations that use Information Technology Infrastructure Library
(ITIL) best practices.

This section contains the following topics:
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= Relationships Between Incidents, QuickTrace Dumps, Log Files, and Diagnostic
Tests

s Introduction to the Oracle Fusion Middleware Diagnostic Framework
s Standard Incident Administration Tasks and Tools

You can use incidents to diagnose and resolve problems, or to supply your help desk
personnel or Oracle Support personnel with information about more complex
problems. Oracle developers set up error messages in such a way that incidents are
created automatically when certain high-priority error conditions occur. You can also
create incidents manually.

Automatically created Oracle Fusion Applications incidents normally include
diagnostic dump files. Dump files are provided in order to assist you in resolving
incidents for your organization and to assist Oracle representatives in providing you
with effective support when needed. The types of dump files provided depend on the
nature of the incident. Some incidents include Oracle Fusion Middleware dump files
such as Oracle WebLogic Server diagnostic images, Java Virtual Machine thread
dumps, and Dynamic Monitoring Service metric dumps. For more information about
Oracle Fusion Middleware dumps, see the "Diagnosing Problems" chapter in the
Oracle Fusion Middleware Administrator’s Guide.

Note: Each Oracle Fusion Applications module is written in one of
the following code languages: Java, SOA, PL/SQL, or C. The amount
and type of information automatically included with an incident may
vary depending on the coding language of the relevant application
module.

In general, you can administer Oracle Fusion Applications without
knowing which programming language implements particular
modules. However, in order to monitor and diagnose all types of
incidents successfully, it is important to become familiar with all of the
incident configuration settings and the types of diagnostic dump files
that are automatically provided for different kinds of incidents.

For more information about incident configuration settings for Oracle
Fusion Applications, see Section 14.2.4.

Oracle Fusion Applications incidents may also contain diagnostic log excerpts and
diag